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Chapter 1 Introduction

1.1 Introduction

Congratulations on your purchase of this outstanding product: 5G WAN Extender. For M2M (Machine-to-
Machine) applications, TELEWELL 5G WAN Extender is absolutely the right choice. With built-in world-class 5G
NR cellular module (latest Qualcom 5G module with fw made for TeleWell only, NSA and SA support) , you just
need to insert SIM card from local mobile carrier to get to Internet. The redundant SIM design provides a more
reliable WAN connection for critical applications. By VPN tunneling technology, remote sites easily become a
part of Intranet, and all data are transmitted in a secure (256-bit AES encryption) link.

This ROUTER series product is loaded with luxuriant security features including VPN, firewall, NAT, port
forwarding, DHCP server and many other powerful features for complex and demanding business and M2M
(Machine-to-Machine) applications.

Main Features:

Built-in a high speed 5G NR cellular module for high bandwidth and low latency traffic.

Support dual SIMs for the redundant wireless WAN connection.

Provide Gigabit Ethernet ports for comprehensive LAN connection and LAN-2 port can be configured to
be another WAN interface.

Equip 802.11b/g/n 2T2R WiFi access point.

Feature with VPN and NAT firewall to have powerful security.

Support the robust remote or local management to monitor network.

Lowered deployment cost with integrated Power over Ethernet (via LAN-2 port) for areas where power
source is unavailable.

Designed by solid and easy-to-mount metal body for business and loT environment to work with a
variety M2M (Machine-to-Machine) applications.

Before you install and use this product, please read this manual in detail for fully exploiting the functions of this

product.
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1.2 Contents List

1.2.1 Package Contents
#Standard Package

_ltems _____ Descripton_______________ Contents_____ Quantity

_/

ROUTER-0GP21

! 5G WAN Extender Lpes
2 Cellular Antenna - 4pcs
3 WiFi Antenna e ——— 2pcs
Power Adapter -
4 (DC 12Vv/2.5A) 1pcs
(*4)
5 RJ45 Cable -‘i‘— 1pcs
6 2 Pin Terminal Block & 1pcs
. ~ &
7 DIN-Rail Bracket 1pcs
8 Rubber Feet 4pcs
9 Screw 3pcs

1 The maximum power consumption of ROUTER series product is 20W.
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1.2.2 Optional Accessories

#Optional parts (these parts are sold separately)

Description

Contents

Comments

802.3at Compliant
1 PoE Injector
(Gigabit, 30W)

Standard 802.3 af/at compliant

Compatible Passive PoE Injector
(Gigabit, 30W)

Passive PoE Injector

Proprietary Passive PoE Power
Supply (Gigabit)

Passive PoE Injector.

These parts are sold separately. If necessary, please contact us via myynti@telewell.fi
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1.3 Hardware Configuration

> Front View

WiFi Auto MDI/MDIX RJ45 Ports LED Reset WiFi
Antenna 1x FE LAN to connect local devices Indicators Button Antenna
s%Reset Button

The RESET button provides user with a quick and easy way to restore the default setting. Press the RESET button
continuously for 10 ~ 15 seconds, and then release it. The device will restore to factory default settings.
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» Left View

5G
Antenna

> Right View

I

5G
Antenna

Power Terminal
Block

5G
Antenna

5G
Antenna

MicroSD

SIM-A
SIM-B

10
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1.4 LED Indication

Power Source

WiFi

SIM-A

SIM-B

Cellular Signal

LAN1~LAN2/WAN

Blue

Blue

Blue

Blue

Blue

Green

OFF: Device is powered off.
Steady ON: Device is powered on and works normally.
Flash(very fast): Device is in Recovery Mode or abnormal

OFF: Wireless Radio is disabled.

Steady ON: Wireless radio is enabled.

Flash: Data packet transferred via WiFi LAN interface.

OFF : SIM card is not inserted, or not used for 5G cellular connection.
Steady ON : Cellular connection already established via SIM-A.

Flash(per second) : SIM-A is selected and connecting to cellular network.
Flash(per 0.5 second): while data packet transferred via SIM-A interface.

OFF : SIM card is not inserted, or not used for 5G cellular connection.
Steady ON : Cellular connection already established via SIM-B.

Flash(per second) : SIM-B is selected and connecting to cellular network.
Flash(per 0.5 second): while data packet transferred via SIM-B interface.

Steady ON : Signal Strength is more than 61%
Flash(per 2 seconds) : Signal Strength is 31~60%
Flash(per second) : Signal Strength is 0~30%
OFF: Not connect to cellular signal

OFF : Ethernet Not connect to the host yet.
Steady ON: Ethernet connection of LAN or WAN is established.
Flash: Data packet transferred via Ethernet.

11
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1.5 Installation & Maintenance Notice

1.5.1 SYSTEM REQUIREMENTS

e A Gigabit Ethernet RJ45 cable
e 4G/5G cellular service subscription
Network Requirements e |EEE 802.11b/g/n wireless network
o IEEE 802.11b/g/n wireless clients
e 10/100/1000 Ethernet adapter on PC
Computer with the following:
e  Windows®, Macintosh, or Linux-based operating
system
e Aninstalled Ethernet adapter
Browser Requirements:
o Internet Explorer 6.0 or higher
o Chrome 2.0 or higher
o Firefox 3.0 or higher
e  Safari 3.0 or higher

Web-based Configuration Utility
Requirements

1.5.2 WARNING

/ ® Only use the power adapter or PoE Injector that \
complys with the power specification of the gateway.
Using an out-of-spec voltage rating power source is
dangerous and may damage the product.
Attention ® Do not open or repair the case yourself. If the
product is too hot, turn off the power immediately

\ and have it repaired at a qualified service center. /

12
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Federal Communication Commission Interference Statement

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may
not cause harmful interference, and (2) this device must accept any interference received, including interference that may
cause undesired operation.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the
FCCRules. These limits are designed to provide reasonable protection against harmful interference in a residential installation.
This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the
instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will
not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one of
the following measures:

- Reorient or relocate the receiving antenna.

- Increase the separation between the equipment and receiver.

- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

FCC Caution: Any changes or modifications not expressly approved by the party responsible for compliance could void the

user's authority to operate this equipment.
This transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

FOR PORTABLE DEVICE USAGE (<20m from body/SAR needed)

Radiation Exposure Statement:

The product comply with the FCC portable RF exposure limit set forth for an uncontrolled environment and are safe for
intended operation as described in this manual. The further RF exposure reduction can be achieved if the product can be kept
as far as possible from the user body or set the device to lower output power if such function is available.

FOR MOBILE DEVICE USAGE (>20cm/low power)

Radiation Exposure Statement:

This equipment complies with FCC radiation exposure limits set forth for an uncontrolled environment. This
equipment should be installed and operated with minimum distance 20cm between the radiator & your body.

FOR COUNTRY CODE SELECTION USAGE (WLAN DEVICES)

Note: The country code selection is for non-US model only and is not available to all US model. Per FCC regulation, all
WiFi product marketed in US must fixed to US operation channels only.

13
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1.5.3 HOT SURFACE CAUTION

Burn hazard.

Hot surface inside.

Allow to cool before
servicing.

CAUTION: The surface temperature for the metallic enclosure can be very high!
Especially after operating for a long time, installed at a closed cabinet
without air conditioning support, or in a high ambient temperature

space.
DO NOT touch the hot surface with your fingers while servicing!!

14
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1.5.4 Product Information for CE RED Requirements

The following product information is required to be presented in product User Manual for latest CE RED
requirements. 2

(1) Frequency Band & Maximum Power
1.a Frequency Band for 5G NR / 4G LTE Connection (for RXL-G1 version) 3
Latest support LTE CA + NR5G NSA if needed and NR5G SA

PG NR n1,n2,n3,n5,n7,n8,n12,n20,n25,n28,n40,n41,n66,n71,n77,n78,n79

LTE-TDD B1/B2/B3/B4/B5/B7/B8/B12/B13/B14/B17/B18/B19/B20/B25/B26/B28/B29/B30/B32/B66/B71

LTE-TDD  B34/B38/B39/B40/B41/B42/B43/B48

\WCDmMA  B1/B2/B3/B4/B5/B8

1.b Frequency Band for WiFi Connection

Band Operating Frequency Max. Output Power (EIRP)
2.4G 2.4 —-2.4835 GHz 100 mW
5G Not supported NA

(2) DoC Information
You can get the DoC information of this product from the following URL:
https://www.telewell.fi

(3) RF Exposure Statements
The antenna of the product, under normal use condition, is at least 20 cm away from the body of user.

(4) Unit Mounting Notice
The product is suitable for mounting at heights <= 2m (approx. 6 ft), or in a cabinet.
Ensure the unit is fixed tightly to reduce the likelyhood of injury due to exposure to mechanical hazards if
dropped.

(5) Manufacture Information
Manufacture Name: TeleWell OY.
Manufacture Address: Kinnarinkatu 1, Jarvenpaa, Finland

2 The information presented in this section is ONLY valid for the EU/EFTA regional version. For those non-CE/EFTA versions, please
refer to the corresponding product specification.

3 There can be different cellular module intrgrated in the device for EU/EFTA regional version. Refer to the cellular module identifier
printed on the device label for the purchased device.

15
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1.6 Hardware Installation

This chapter describes how to install and configure the hardware.

1.6.1 Insert SIM Card

WARNNING: BEFORE INSERTING OR CHANGING SIM CARD, PLEASE MAKE SURE
GATEWAY IS POWERED OFF.

The SIM card slots are located at the right side of the housing. You need to unscrew and remove the outer SIM
card cover before installing or removing the SIM card. Please follow the instructions to insert a SIM card. After
SIM card is well placed, screw back the outer SIM card cover.

Step 1: Step 2: Step 3:

Loosen the screws as Push the SIM card Push the inserted SIM card
below and remove the into the slot A (SIM- again to eject it from the
SIM cover. A) or slot B (SIM-B). SIM slot.

1.6.2 Mount the Unit

The ROUTER series can be placed on a flat surface, mounted on the wall with mounting brackets (*4) or mounted
on a DIN-rail. The mounting brackets are not screwed on the product when out of factory. Please screw the
mounting brackets on the product first.

4 Mounting brackets are optional accessories, and not included in the standard package..
17
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1.6.3 Connecting Power

The ROUTER-0GP21 can be powered by connecting a power source to either 802.3at PoE PD via WAN/LAN2 port,
or the terminal block power connector.

(1) For Powering through PoE cabling, the ROUTER-OGP21 can be powered by 802.3at compliant PoE Injector,
PoE Switch, or proprietary passive PoE Injector that is listed in optional parts in Section 1.2.2. Use other 3rd-
party’s passive PoE Injector is dangerous and may cause damage to the device.

(2) For using an external DC power supply, the ROUTER supports 9 to 36V DC power input. Following picture is
the power terminal block pin assignments. Please check carefully and connect to the right power
requirements and polarity.

anNo
dMd

There is a DC12V/2.5A power adapter’ in the package for you to easily connect DC power adapter to this
terminal block.Default adapter is EU version:

WARNNING: This commercial-grade power adapter is mainly for ease of powering up the purchased
device while initial configuration. It’s not for operating at wide temperature range environment. PLEASE
PREPARE OR PURCHASE OTHER INDUSTRIAL-GRADE POWER SUPPLY FOR POWERING UP THE DEVICE.

You can choose the proper one to power the gateway for your application. If both PoE power and DC power via
terminal block port are applied to the gateway simultaneously, the PoE power gets higher priority to supply the
required power to the gateway.

5 The maximum power consumption of ROUTER series product is 20W.
18
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1.6.4 Connecting to the Network or a Host

The ROUTER series product provides RJ45 ports to connect 10/100Mbps Ethernet. It can auto detect the
transmission speed on the network and configure itself automatically. Connect one Ethernet cable to the RJ45
port (LAN) of the device and plug another end of the Ethernet cable into your computer’s network port. In this
way, you can use the RJ45 Ethernet cable to connect to the host PC’s Ethernet port for configuring the device.

1.6.5 Setup by Configuring WEB Ul

You can browse web Ul to configure the device.

Type in the IP Address (http://192.168.123.254)°

€ Windows Internet Explorer
() [e] 192168123254 -] x|

When you see the login page, enter the user name and password and then click ‘Login’ button.
The default setting for both username and password is ‘admin’.

Welcome to the device's configuration Ul.
Enter your Username & Password, then
click 'Login'.

Username

Password
S
——

For the security consideration, you will be asked to change the login password while the first
time login to the device.

6 The default LAN IP address of this gateway is 192.168.123.254. If you change it, you need to login by using the
new IP address.
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Change Password

For security consideration, you are being asked to change the password
while the first time login to the device.

Enter the new password below.

(NOTE: The password must be at least 10 characters long, and must contain at
least 1 English letter and 1 number. The password cannot be the same as the
login account.)

New Password:

New Password Confirmation:

A < =)
.- .

After that, you will be asked to login again with the new password.

Note 1: Keep the login password properly for further device configuration.

Note 2: If, someday, you lose or forget the login password, the ONLY way to remedy is to recover
the device to its factory default settings via long-pressing the Reset button.

Note 3: Under such situation, your device configuration will be erased accordingly. So, In
addition to keep the login password, you may have to backup the device donfiguration
and keep it properly for any unexpected accidence.
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Chapter 2 Basic Network
2.1 WAN & Uplink

Basic Network

Connection Setup

[ wang uplink |

Physical Interface

Interface Name Physical Interface Operation Mode Action
Internet Setup

WAN-1 Cellular Always on

Loading Balance WAN-2 - Disable Edit

WAN-3 - Disable

The gateway provides multiple WAN interfaces to let all client hosts in Intranet of the gateway access the
Internet via ISP. But ISPs in the world apply various connection protocols to let gateways or user's devices dial
in ISPs and then link to the Internet via different kinds of transmit media.

So, the WAN Connection lets you specify the WAN Physical Interface, WAN Internet Setup and WAN Load
Balance for Intranet to access Internet. For each WAN interface, you must specify its physical interface first and
then its Internet setup to connect to ISP. Besides, since the gateway has multiple WAN interfaces, you can assign
physical interface to participate in the Load Balance function.
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2.1.1 Physical Interface

Physical Interface

Physical WAN-1
Interface List
WAN-2

Interface WAN-3
Configuration
\L Select
Physical
Interface
\L Select

Operation Mode
*Always on

o

Item

Interface Name

» Physical Interface | Ethernet v

» Operation Mode

nwvy

» VLAN Tagging (] Enable 2

Physical Interface
Ethernet

Cellular

Setting

(1-4095)

Operation Mode
Always on
Always on

Disable

Action
ED
E1
En

M2M gateways are usually equipped with various WAN interfacess to support different WAN connection
scenario for requirement. You can configure the WAN interface one by one to get proper internet connection
setup. Refer to the product specification for the available WAN interfaces in the product you purchased.

The first step to configure one WAN interface is to specify which kind of connection media to be used for the
WAN connection, as shown in "Physical Interface" page.

In "Physical Interface" page, there are two configuration windows, "Physical Interface List" and "Interface
Configuration". "Physical Interface List" window shows all the available physical interfaces. After clicking on the
"Edit" button for the interface in "Physical Interface List" window the "Interface Configuration" window will

appear to let you configure a WAN interface.

Physical Interface:

+ Ethernet WAN: The gateway has one or more RJ45 WAN ports that can be configured to be WAN

connections. You can directly connect to external DSL modem or setup behind a firewall device.

+ Cellular WAN: The gateway has one built-in 5G NR modem as WAN connection. For each cellular WAN,

there are 1 or 2 SIM cards to be inserted for special failover function.
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-

!

_ =

® Please MUST POWER OFF the gateway before you
insert or remove SIM card.
® The SIM card can be damaged if you insert or

remove SIM card while the gateway is in operation.

J

* WiFi Uplink WAN: For the product with WiFi Uplink function, one WiFi module can be configured to be
WAN connections. For the WiFi module with Uplink function activated, you can further create some uplink

profiles for ease of connecting to an uplink network.

Operation Mode:

There are three option items “Always on”, “Failover”

, and “Disable” for the operation mode setting.

Always on: Set this WAN interface to be active all the time. When two or more WAN are established at "Always
on" mode, outgoing data will through these WAN connections base on load balance policies.

Failover:

Diagram For Failover

(D)

@Dlsconnected
) . 'WAN-1

® Fallover

ISP-DSLAM

*WAN-2 Failover WAN1

WAN-2 Gateway

(«g) /
Cellular/ @ Change Routing to WAN-2

a C @ Connection Recovery ()
ISP- LAI

« >))

Cellular /f

WAN-1
Physical Interface: Ethernet
Operation Mode: Always on

WAN-
®) Failback to WAN- 1|

WAN-2 Gateway

® WAN-2 Terminate Connection

WAN-2
Physical Interface: 3G/4G
Operation Mode: Failover (WAN-1)

*WAN-1 Failback, WAN-2 Terminate

Seamless Failover:

A failover interface is a backup connection to the
primary. That means only when its primary WAN
connection is broken, the backup connection will be
started up to substitute the primary connection.

As shown in the diagram, WAN-2 is backup WAN for
WAN-1. WAN-1 serves as the primary connection with
operation mode "Always on". WAN-2 won’t be
activated until WAN-1 disconnected. When WAN-1
connection is recovered back with a connection, it will
take over data traffic again. At that time, WAN-2
connection will be terminated.
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Diagram For Seamless Failover

" @Disconne{cted
. . 7N |wAN-1

ISP-DSLAM .
® Failover
WAN-2 Gateway

CeIIuIar/é& @ Change Routing to WAN-2

*WAN-2 Failover WAN1

DLW

®) Failback to WAN-1

«

Cellular /f

)

()]

@ Connection Recovery

WAN-

WAN 2 Gateway

@ Keep alive, no traffic

*WAN-1 Failback, WAN-2 Keep Alive

In addition, there is a "Seamless" option for Failover
operation mode. When seamless option is activated
by checking on the "Seamless" box in configuration
window, both the primary connection and the failover
connection are started up after system rebooting. But
only the primary connection executes the data
transfer, while the failover one just keeps alive of
connection line. As soon as the primary connection is
broken, the system will switch, meaning failover, the
routing path to the failover connection to save the dial
up time of failover connection since it has been alive.

When the “Seamless” enable checkbox is activated, it
can allow the Failover interface to be connected
continuously from system booting up. Failover WAN
interface just keeps connecting without data traffic.
The purpose is to shorten the switch time during

failover process. So, when primary connection is disconnected, failover interface will take over the data
transfer mission instantly by only changing routing path to the failover interface. The dialing-up time of
failover connection is saved since it has been connected beforehand.

VLAN Tagging

Sometimes, your ISP required a VLAN tag to be inserted into the WAN packets from Gateway for specific services.
Please enable VLAN tagging and specify tag in the WAN physical interface. Please be noted that only Ethernet
and ADSL physical interfaces support the feature. For the device with Cellular WAN only, it is disabled.
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Physical Interface Setting

Go to Basic Network > WAN > Physical Interface tab.

The Physical Interface allows user to setup the physical WAN interface and to adjust WAN’s behavior.

Note: Numbers of available WAN Interfaces can be different for the purchased gateway.

* Physical Interface List -

Interface Name

Physical Interface

Operation Mode

Action

WAN-1 Ethernet Always on
WAN-2 Cellular Always on
WAN-3 - Disable

When Edit button is applied, an Interface Configuration screen

example.

Interface Configuration:

* Interface Configuration ( WAN-1)

will appear. WAN-2 interface is used in this

Item

Setting

» Physical Interface

| Ethernet

v

» Operation Mode

Always on v

[] Enable 2

(1-4095)

» VLAN Tagging

Interface Configuration

Item Value setting

Description

Select one expected interface from the available interface dropdown list.
It can be Cellular, Etherent or WiFi Module.

Depending on the gateway model, Disable and Failover options will be

1. A Must fill setting
2. WAN-1 is the primary

Physical Interface . )
interface and is factory

available only to multiple WAN gateways. WAN-2 ~ WAN-n interfaces are
only available to multiple WAN gateways.

Define the operation mode of the interface.

Select Always on to make this WAN always active.

Select Disable to disable this WAN interface.

set to Always on.

Operation Mode A Must fill setting
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VLAN Tagging

Optional setting

Select Failover to make this WAN a Failover WAN when the primary or
the secondary WAN link failed. Then select the primary or the existed
secondary WAN interface to switch Failover from.

(Note: for WAN-1, only Always on option is available.)

Check Enable box to enter tag value provided by your ISP. Otherwise
uncheck the box.

Value Range: 1 ~ 4095.

Note: This feature is NOT available for Cellular WAN connection.
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2.1.2 Connection Setup

= Internet Connection List

Internet Setup

Interface Name Physical Interface Operation Mode WAN Type Action
WAN-1 Ethernet Always on Dynamic IP
Internet
. - WAN-2 Cellular Always on Cellular
Connection List |
WAN-3 Disable E

l,Repeat Edit

= Internet Connection Configuration { WAN-1)

'
‘ I
Q

Item Setting

» WAN Type Dynamic IP v

= Dynamic IP WAN Type Configuration

Internet Connect
Configure (WAN-x

Item Setting
» Host Name » [ | (Optional)
, ISP Registered MAC Address | | | [ Clone | (optional)
» Connection Control [Auto-reconnect ~|
xxx WAN Type » MTU Setup () Enable
Configuration
» NAT Enable
> IGMP
» WAN IP Alias | O Enable 10.0.0.1

After specifying the physical interface for each WAN connection, administrator must configure their connection
profile to meet the dial in process of ISP, so that all client hosts in the Intranet of the gateway can access the
Internet.

In "Connection Setup" page, there are some configuration windows: "Internet Connection List", "Internet
Connection Configuration"”, "WAN Type Configuration" and related configuration windows for each WAN type.
For the Internet setup of each WAN interface, you must specify its WAN type of physical interface first and then
its related parameter configuration for that WAN type.

After clicking on the "Edit" button of a physical interface in "Internet Setup List" window, the "Internet
Connection Configuration" window will appear to let you specify which kind of WAN type that you will use for
that physical interface to make an Internet connection. Based on your chosen WAN type, you can configure
necessary parameters in each corresponding configuration window.
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Internet Connection List - Ethernet WAN

Internet Connection List

Internet Connect
Configure

DynamiclP
Static IP
PPPoOE
2TP
PPTP ; L4 Setup
XXX WAN Type
Configuration

L4 Setup
Ethernet Connection
Common Configure

= Internet Connection Configuration { WAN - 1) a

Item Setting
» WAN Type |Dynamic IP v |
Static IP
= Dynamic IP WAN Type Confi Dynamic IP_jy. a
PPPoE
Item PPTP Setting
» Host Name L2TpP (Optional)
» ISP Registered MAC )
Address [ || Clone | (Optional)
» Connection Control [Auto-reconnect v
» MTU Setup () Enable
» NAT « Enable
» IGMP
» WAN IP Alias 0 Enable [10.0.0.1 |

= Network Monitoring Configuration

Item Setting
» Network Monitoring @ Enable
Configuration
» Checking Method [DNS Query v |
» Loading Check @ Enable
» Query Interval 5 (seconds)
» Latency Threshold 3000 (ms)

WAN Type for Ethernet Interface:
Ethernet is the most common WAN and uplink interface for M2M gateways. Usually it is connected with xDSL
or cable modem for you to setup the WAN connection. There are various WAN types to connect with ISP.

e Static IP: Select this option if ISP provides a fixed IP to you when you subsribe the service. Usually is more
expensive but very importat for cooperate requirement.
* Dynamic IP: The assigned IP address for the WAN by a DHCP server is different every time. It is cheaper and
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usually for consumer use.

* PPP over Ethernet: As known as PPPoE. This WAN type is widely used for ADSL connection. IP is usually
different for every dial up.

* PPTP: This WAN type is popular in some countries, like Russia.

* L2TP : This WAN type is popular in some countries, like Israel.

Configure Ethernet WAN Setting

When Edit button is applied, Internet Connection Configuration screen will appear. WAN-1 interface is used in
this example.
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WAN Type = Dynamic IP

# Internet Connection Configuration { WAN -1)

Item

Setting

Dynamic IP v

» WAN Type

When you select it, "Dynamic IP WAN Type Configuration" will appear. Items and setting is explained below

« Dynamic IP WAN Type Configuration °

Item Setting
» Host Name I | (Optional)
ISP Registered MAC )
' Address I | l Clone |(0pt|onal)

Dynamic IP WAN Type Configuration

Value setting
An optional setting

Item
Host Name

Description
Enter the host name provided by your Service Provider.

ISP Registered MAC

A ional i
Address n optional setting

Enter the MAC address that you have registered with your service

provider. Or Click the Clone button to clone your PC’'s MAC to this field.
Usually this is the PC’'s MAC address assigned to allow you to connect to
Internet.

WAN Type= Static IP

# Internet Connection Configuration { WAN -1) ’

Item

Setting

Static IP v

» WAN Type

When you select it, "Static IP WAN Type Configuration" will appear. Items and setting is explained below

» Static IP WAN Type Configuration a

Item

Setting

» WAN IP Address

» WAN Subnet Mask

1255.255.255.0 (/24)

]

» WAN Gateway

» Primary DNS

» Secondary DNS

(Optional)
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Static IP WAN Type Configuration

Item

Value setting

Description

WAN IP Address A Must filled setting Enter the WAN IP address given by your Service Provider

WAN Subnet Mask A Must filled setting Enter the WAN subnet mask given by your Service Provider

WAN Gateway A Must filled setting Enter the WAN gateway IP address given by your Service Provider
Primary DNS A Must filled setting Enter the primary WAN DNS IP address given by your Service Provider
Secondary DNS An optional setting Enter the secondary WAN DNS IP address given by your Service Provider

WAN Type= PPPoE

# Internet Connection Configuration ( WAN - 1) ~

Item

Setting

» WAN Type

[PPPOE

v

When you select it, "PPPoE WAN Type Configuration" will appear. Items and setting is explained below

* PPPoE WAN Type Configuration

Item

Setting

» IP Type

» PPPoE Account

» PPPoE Password

» Primary DNS

| (Optional)

» Secondary DNS

| (Optional)

» Service Name

| (Optional)

» Assigned |P Address

| (Optional)

PPPoE WAN Type Configuration

Item

Value setting

Description

PPPoE Account A Must filled setting Enter the PPPoE User Name provided by your Service Provider.
PPPoE Password A Must filled setting Enter the PPPoE password provided by your Service Provider.
Primary DNS An optional setting Enter the IP address of Primary DNS server.

Secondary DNS An optional setting Enter the IP address of Secondary DNS server.

Service Name An optional setting Enter the service name if your ISP requires it

Assigned IP Address An optional setting Enter the IP address assigned by your Service Provider.
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WAN Type= PPTP

# Internet Connection Configuration { WAN - 1) -

Item

Setting

» WAN Type

[PPTP

v

When you select it, "PPTP WAN Type Configuration" will appear. ltems and setting is explained below

%1 PPTP WAN Type Configuration -

Item Setting
» IP Mode ' Dynamic IP Address v |
» Server IP Address / Name | |
» PPTP Account | |
» PPTP Password I |
» Connection ID | | (Optional)

» MPPE

() Enable

PPTP WAN Type Configuration

Item

Value setting

Description
Select either Static or Dynamic IP address for PPTP Internet connection.
[ ] When Static IP Address is selected, you will need to enter the WAN
IP Address, WAN Subnet Mask, and WAN Gateway.
B WAN IP Address (A Must filled setting): Enter the WAN IP
address given by your Service Provider.

IP Mode A Must filled setting B WAN Subnet Mask (A Must filled setting): Enter the WAN
subnet mask given by your Service Provider.
B WAN Gateway (A Must filled setting): Enter the WAN gateway
IP address given by your Service Provider.
®  When Dynamic IP is selected, there are no above settings required.
Server IP A Must filled setting Enter the PPTP server name or IP Address.
Address/Name
PPTP Account A Must filled setting Enter the PPTP username provided by your Service Provider.
PPTP Password A Must filled setting Enter the PPTP connection password provided by your Service Provider.

Connection ID

An optional setting

Enter a name to identify the PPTP connection.

MPPE

An optional setting

Select Enable to enable MPPE (Microsoft Point-to-Point Encryption)
security for PPTP connection.
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WAN Type= L2TP

# Internet Connection Configuration { WAN - 1) -

Item

Setting

» WAN Type

[L2TP

v

When you select it, "L2TP WAN Type Configuration" will appear. Iltems and setting is explained below

* L2TP WAN Type Configuration -

Item

Setting

» IP Mode

' Dynamic IP Address v |

» Server IP Address / Name |

» L2TP Account

» L2TP Password

» Service Port

 User-defined

v | [1702 |

» MPPE

() Enable

L2TP WAN Type Configuration

Item

Value setting

Description
Select either Static or Dynamic IP address for L2TP Internet connection.
[ ] When Static IP Address is selected, you will need to enter the WAN
IP Address, WAN Subnet Mask, and WAN Gateway.
B WAN IP Address (A Must filled setting): Enter the WAN IP
address given by your Service Provider.

IP Mode A Must filled setting B WAN Subnet Mask (A Must filled setting): Enter the WAN
subnet mask given by your Service Provider.
B WAN Gateway (A Must filled setting): Enter the WAN gateway
IP address given by your Service Provider.
®  When Dynamic IP is selected, there are no above settings required.
Server IP A Must filled setting Enter the L2TP server name or IP Address.
Address/Name
L2TP Account A Must filled setting Enter the L2TP username provided by your Service Provider.
L2TP Password A Must filled setting Enter the L2TP connection password provided by your Service Provider.

Service Port

A Must filled setting

Enter the service port that the Internet service.
There are three options can be selected :
®  Auto: Port will be automatically assigned.
® 1701 (For Cisco): Set service port to port 1701 to connect to
CISCO server.
® User-defined: enter a service port provided by your Service
Provider.

MPPE

An optional setting

Select Enable to enable MPPE (Microsoft Point-to-Point Encryption)
security for PPTP connection.
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Ethernet Connection Common Configuration

Common Configure N
— » Connection Control

\L Select .

Connection
Control

Setu

“MTU
*NAT Enable?

Yes
1, Select

*DNS Query
*ICMP Checking

\lt Setup

» MTU Setup

» NAT

» IGMP

» WAN IP Alias

*Loading Check?
*Check Interval
*Check Timeout
*Latency Threshold
*Fail Threshold
*Target 1

*Target 2

Enable
¢ Enable

Disable v

Auto-reconnect

Enable (10.0.0.1

le

Enable
IGMP Enable?
WAN IP Alias?

S

Item Setting
B i
» Checking Method DNS Query v
» Loading Check #| Enable
» Query Interval 5 (seconds)
» Latency Threshold 3000 (ms)
» Fail Threshold 5 (Times)
» Target1 DNS1 v
» Target2 None v

There are some important parameters to be setup no matter which Ethernet WAN type is selected. You should
follow up the rule to configure.

Connection Control.

ISP-DSLAM ) pic connected teway Auto-reconnect: This gateway will establish
: — [ — Internet connection automatically once it has
G =0 v
been booted up, and try to reconnect once the
—1 ©Re-connecting connection is down. It’s recommended to choose
— Auto-reconnect this scheme if for mission critical applications to
—_ ensure full-time Internet connection.
g 9§
: Q & N
: Auto- (Alwayson)‘ % Q : .
SSR.DSIAM Connect-on-demand: This gateway won’t start to
© Start Connecting Gateway  ostablish Internet connection until local data is
R L O AR going to be sent to WAN side. After normal data

1 DI gl

znd D =

DHCP
Serverg, ]

(@ Disconnect when idle timeout;

Connect-on-demand

‘ Connection Control: Connect-on-demand ‘

040004104104

(D Request Coming

G

transferring between LAN and WAN sides, this
gateway will disconnect WAN connection if idle
time reaches value of Maximum Idle Time.
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ISP-DSLAM

(® start Connecting

xDSL

(@ Disconnect when idle timeout ;

Manually l

(D Connect Button

Gateway Manually: This gateway won’t start to establish
WAN connection until you press “Connect” button
on web Ul. After normal data transferring
between LAN and WAN sides, this gateway will
disconnect WAN connection if idle time reaches
value of Maximum Idle Time.

Please be noted, if the WAN interface serves as the primary one for another WAN interface in Failover role, the
Connection Control parameter will not be available to you to configure as the system must set it to “Auto-
reconnect (Always on)”.

Network Monitoring

Start

| 3

L€

Fail =0
2

“Check Loading”
Enable?

Yes

Loading Yes

Enough?

No Select One

5N

>
N

alive::hecking
*FQDN Query or
*ICMP Check

“Checking
Timeout”?

Wait for
“Check Interval”

Reply Time
> "Latency”

N

Fail = Fail +1

Exception Handing
System Re-initial

It is necessary to monitor connection status continuous. To
do it, "ICMP Check" and "FQDN Query" are used to check.
When there is trafiic of connection, checking packet will
waste bandwidth. Response time of replied packets may
also increase. To avoid "Network Monitoring" work
abnormally, enabling "Checking Loading" option will stop
connection check when there is traffic. It will wait for
another "Check Interval" and then check loading again.
When you do “Network Monitoring”, if reply time longer
than "Latency" or even no response longer than "Checking
Timeout", "Fail" count will be increased. If it is continuous
and "Fail" count is more than "Fail Threshold", gateway will
do exception handing process and re-initial this connection
again . Otherwise, network monitoring process will be start
again.
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Set up “Ethernet Common Configuration”

Connection Control

Maximum Idle Time

MTU Setup

MTU Setup

NAT

IGMP

WAN IP Alias

A Must filled setting

1. An Optional setting
2. By default 600
seconds is filled-in

1. An Optional setting
2. Uncheck by default

1. A Must filled setting

2. Auto (value zero) is
set by default

3. Manual set range
1200~1500

1. An optional setting

2. NAT is enabled by
default

1. A Must filled setting
2. Disable is set by
default

1. An optional setting
2. Uncheck by default

There are three connection modes.

° Auto-reconnect enables the router to always keep the Internet
connection on.

° Connect-on-demand enables the router to automatically re-
establish Internet connection as soon as user attempts to access
the Internet. Internet connection will be disconnected when it
has been inactive for a specified idle time.

° Connect Manually allows user to connect to Internet manually.
Internet connection will be inactive after it has been inactive for
specified idle time.

Specify the maximum Idle time setting to disconnect the internet
connection when the connection idle timed out.

Value Range: 300 ~ 86400.

Note: This field is available only when Connect-on-demand or Connect
Manually is selected as the connection control scheme.

Check the Enable box to enable the MTU (Maximum Transmission Unit)
limit, and specify the MTU for the 3G/4G connection.

MTU refers to Maximum Transmission Unit. It specifies the largest packet
size permitted for Internet transmission.

Value Range: 1200 ~ 1500.

MTU refers to Maximum Transmission Unit. It specifies the largest packet
size permitted for Internet transmission.

When set to Auto (value ‘0’), the router selects the best MTU for best
Internet connection performance.

Enable NAT to apply NAT on the WAN connection. Uncheck the box to
disable NAT function.

Enable IGMP (Internet Group Management Protocol) would enable the
router to listen to IGMP packets to discover which interfaces are
connected to which device. The router uses the interface information
generated by IGMP to reduce bandwidth consumption in a multi-access
network environment to avoid flooding the entire network.

Enable WAN IP Alias then enter the IP address provided by your service
provider.

WAN IP Alias is used by the device router and is treated as a second set
of WAN IP to provide dual WAN IP address to your LAN network.
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Item Setting
» Network Monitoring @ Enable
Configuration
» Checking Method lDNS Query v ‘
» Loading Check @ Enable

» Query Interval

(seconds)

» Latency Threshold

3000 (ms)

» Fail Threshold

(Tmes)

» Target1 DNS1 v
» Target2

Network Monitoring Configuration

Item

Network Monitoring
Configuration

Value setting

1. An optional setting
2. Box is checked by
default

Description
Check the Enable box to activate the network monitoring function.

Checking Method

1. An Optional setting
2. DNS Query is set by
default

Choose either DNS Query or ICMP Checking to detect WAN link.

With DNS Query, the system checks the connection by sending DNS
Query packets to the destination specified in Target 1 and Target 2.
With ICMP Checking, the system will check connection by sending ICMP
request packets to the destination specified in Target 1 and Target 2.

Loading Check

1. An optional setting
2. Box is checked by
default

Check the Enable box to activate the loading check function.

Enable Loading Check allows the gateway to ignore unreturned DNS
queries or ICMP requests when WAN bandwidth is fully occupied. This is
to prevent false link-down status.

Query Interval

1. An Optional setting
2.5 seconds is selected
by default.

Specify a time interval as the DNS Query Interval.

Query Interval defines the transmitting interval between two DNS Query
or ICMP checking packets.

With DNS Query, the system checks the connection by sending DNS
Query packets to the destination specified in Target 1 and Target 2.
Value Range: 2 ~ 14400.

Check Interval

1. An Optional setting
2.5 seconds is selected
by default.

Specify a time interval as the ICMP Checking Interval.

Query Interval defines the transmitting interval between two DNS Query
or ICMP checking packets.

With ICMP Checking, the system will check connection by sending ICMP
request packets to the destination specified in Target 1 and Target 2.
Value Range: 2 ~ 14400.

Latency Threshold

1. An Optional setting
2. 3000 ms is set by
default

Enter a number of detecting disconnection times to be the threshold
before disconnection is acknowledged.

Latency Threshold defines the tolerance threshold of responding time.
Value Range: 2000 ~ 3000 seconds.

Fail Threshold

1. An Optional setting
2. 5 times is set by
default

Enter a number of detecting disconnection times to be the threshold
before disconnection is acknowledged.

Fail Threshold specifies the detected disconnection before the router
recognize the WAN link down status.
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Target 1

Target 2

Save
Undo

1. An Optional filled
setting

2. DNS1 is selected by
default

1. An Optional filled
setting

2. None is selected by
default

N/A
N/A

Value Range: 1 ~ 10 times.

Targetl specifies the first target of sending DNS query/ICMP request.
DNS1: set the primary DNS to be the target.

DNS2: set the secondary DNS to be the target.

Gateway: set the Current gateway to be the target.

Other Host: enter an IP address to be the target.

Targetl specifies the second target of sending DNS query/ICMP request.

None: no second target is required.

DNS1: set the primary DNS to be the target.

DNS2: set the secondary DNS to be the target.
Gateway: set the Current gateway to be the target.
Other Host: enter an IP address to be the target.
Click Save to save the settings.

Click Undo to cancel the settings.
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Internet Connection — Cellular WAN

Edit

Internet Connect List

Internet Connect
Configure

WAN Type= >
Cellular

# Internet Connection Configuration { WAN-2 )

Item Setting

» WAN Type Cellular v

# Cellular WAN Type Configuration a
Item Setting

Cellular WAN Type
Configuration

L4 Setup
Configure
SIM-A/ SIM-B

L4 Setup
SIM-A/ SIM-B
APN Profile List

\I;aepeat Add/Edit

APN Profile-x

SIM-A/B APN
Profile Configuration

L4 Setup

Cellular Connection
Common Configure

Preferred SIM Card — Dual SIM Fail Over

» Preferred SIM Card

SIM-AFirst v| Failback: [] Enable

» Auto Flight Mode

(7] Enable

» SIM Switch Policy

# Connection with SIM-A Card

# Connection with SIM-B Card

# Cellular Connection Common Configuration

Il

Item

Setting

» Connection Control

|Auto-reconnect  v|

» Time Schedule

» MTU Setup (] Enable

» IP Passthrough (Cellular Bridge)| (] Enable Fixed MAC:
» NAT Enable

 IGMP

» WAN IP Alias (J Enable 10.0.0.1

For Cellular embedded device, one embedded cellular module can create only one WAN interface. This device
has featured by using dual SIM cards for one module with special fail-over mechanism. It is called Dual SIM
Failover. This feature is useful for ISP switch over when location is changed. Within “Dual SIM Failover”, there
are various usage scenarios, including "SIM-A First", "SIM-B First“ with “Failback” enabled or not, and “SIM-A

Only and “SIM-B Only”.
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SIM-A/SIM-B only: When “SIM-A Only” or “SIM-B Only” is used, the specified SIM slot card is the only one to be
used for negotiation parameters between gateway device and cellular ISP.

SIM-A / SIM-B first without enable Failback

By default, “SIM-A First” scenario is used to connect to cellular ISP for data
transfer. In the case of “SIM-A First” or “SIM-B First” scenario, the gateway
will try to connect to the Internet by using SIM-A or SIM-B card first. And
when the connection is broken, the gateway will switch to use the other
SIM card for an alternate automatically and will not switch back to use
original SIM card except current SIM connection is also broken. That is, SIM-
A and SIM-B are used iteratively, but either one will keep being used for
data transfer when current connection is still alive.

Disconnected S|M_A

g)\
ISP1G\ll ver
(( ) AN

Connected
ISP 2 Not back to SIM-A

SIM-A / SIM-B first with Failback enable
With Failback option enabled, “SIM-A First” scenario is used

isconnected SIMA
( ;)ISC SIM-A (( ») \ toconnect when the connection is broken, gateway system
. will switch to use SIM-B. And when SIM-A connection is
/f [SP% recovered, it will switch back to use original SIM-A card
ISP1
) ®
J¢Connected ;&
S 'B y
ISP2 ISP #2
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Configure Cellular WAN Setting

When Edit button is applied, Internet Connection Configuration, and Cellular WAN Configuration screens will

appear.

Item

» WAN Type

Item

» Preferred SIM Card
» Auto Flight Mode

» SIM Switch Policy

WAN Type

Preferred SIM Card

Auto Flight Mode

| Cellular v |

Setting

Setting

\SIM-A First v’ Failback : [_] Enable

] Enable

‘ Policy Setting ]

1.A Must filled setting
2.Cellular is set by
default.

1. A Must filled setting
2. By default SIM-A First
is selected

3. Failback is unchecked
by default

The box is unchecked by
default

From the dropdown box, select Internet connection method for Cellular
WAN Connection. Only Cellular is available.

Choose which SIM card you want to use for the connection.

When SIM-A First or SIM-B First is selected, it means the connection is
built first by using SIM A/SIM B. And if the connection is failed, it will
change to the other SIM card and try to dial again, until the connection is
up.

When SIM-A only or SIM-B only is selected, it will try to dial up only using
the SIM card you selected.

When Failback is checked, it means if the connection is dialed-up not
using the main SIM you selected, it will failback to the main SIM and try to
establish the connection periodically.

Note_1: For the product with single SIM design, only SIM-A Only option is
available.

Note_2: Failback is available only when SIM-A First or SIM-B First is
selected.

Check the Enable box to activate the function.

By default, if you disabled the Auto Flight Mode, the cellular module will
always occupy a physical channel with cellular tower. It can get data
connection instantly, and receive managing SMS all the time on required.
If you enabled the Auto Flight Mode, the gateway will pop up a message
“Flight mode will cause cellular function to be malfunctioned when the
data session is offline.”, and it will make the cellular module into flight
mode and disconnected with cellular tower phycially. In, addition,
whenever the cellular module is going to be used for data connection to
backup the failed primary connection, the cellular module will be active to
connect with cellular tower and get the data connection for use, It takes
few more seconds.
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Note: Keep it unchecked unless your cellular ISP asked the connected
gateway to enable the Auto Flight Mode.

SIM Switch Policy NA

Click the Policy Setting button to define the SIM Switch policy or browse
the current policy settings.

* Policy Setting

Item Setting
» Failed connection D (1-10) times
» RSSI Monitor (] Enable Threshold: - 0 (-90~-113 dBm)

» Network Service

[C] Enable Loss LTE signal: 0 (1~30 minutes)

» Roaming Service

(] Enable Timeout: 0 (1~30 minutes)

Configure SIM-A / SIM-B Card

Here you can set configurations for the cellular connection according to your situation or requirement.

Item Setting
» Network Type
» Dial-Up Profile | Manual-configuration v |
» APN I |
» PIN Code | | (Optional)
» Dial Number | | (Optional)
» Account | | (Optional)
» Password | QD] (Optional)
» Authentication
» IP Mode
» Primary DNS | | (Optional)
» Secondary DNS | | (Optional)
» Roaming (] Enable

Note_1: Configurations of SIM-B Card follows the same rule of Configurations of SIM-A Card, here we list SIM-
A as the example.

Note_2: Both Connection with SIM-A Card and Connection with SIM-B Card will pop up only when the SIM-A
First or SIM-B First is selected, otherwise it only pops out one of them.

Connection with SIM-A/-B Card

Item Value setting Description
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Network Type

Dial-Up Profile

APN

IP Type

PIN code

Dial Number,
Account,
Password

Authentication

IP Mode

Primary DNS

1. A Must filled setting
2. By default Auto is
selected

1. A Must filled setting
2. By default Manual-

configuration is selected

1. A Must filled setting
2. String format : any
text

1. A Must filled setting
2. By default IPv4 is
selected

1. An Optional setting
2. String format :
interger

1. An Optional setting
2. String format : any
text

1. A Must filled setting
2. By default Auto is
selected

1. A Must filled setting

2. By default Dynamic IP

is selected

1. An Optional setting
2. String format : IP

Select Auto to register a network automatically, regardless of the network
type.

Auto = 4G and NR 5G NSA all bands

NR 5G is only for NR 5G SA all bands

Note: Options may be different due to the specification of the module.
Specify the type of dial-up profile for your cellular network. It can be
Manual-configuration, APN Profile List, or Auto-detection.

Select Manual-configuration to set APN (Access Point Name), Dial
Number, Account, and Password to what your carrier provides.

Select APN Profile List to set more than one profile to dial up in turn, until
the connection is established. It will pop up a new filed, please go to Basic
Network > WAN & Uplink > Internet Setup > SIM-A APN Profile List for
details.

Select Auto-detection to automatically bring out all configurations
needed while dialing-up, by comparing the IMSI of the SIM card to the
record listed in the manufacturer’s database.

Note_1: You are highly recommended to select the Manual or APN
Profile List to specify the network for your subscription. Your ISP always
provides such network settings for the subscribers.

Note_2: If you select Auto-detection, it is likely to connect to improper
network, or failed to find a valid APN for your ISP.

Enter the APN you want to use to establish the connection.

This is a must-filled setting if you selected Manual-configuration as dial-
up profile scheme.

Specify the IP type of the network serveice provided by your cellular
network. It can be IPv4, IPv6, or IPv4/6.

Enter the PIN (Personal Identification Number) code if it needs to unlock
your SIM card.

Enter the optional Dial Number, Account, and Password settings if your ISP
provided such settings to you.

Note: These settings are only displayed when Manual-configuration is
selected.

Select PAP (Password Authentication Protocol) and use such protocol to
be authenticated with the carrier’s server.

Select CHAP (Challenge Handshake Authentication Protocol) and use such
protocol to be authenticated with the carrier’s server.

When Auto is selected, it means it will authenticate with the server either
PAP or CHAP.

When Dynamic IP is selected, it means it will get all IP configurations from
the carrier’s server and set to the device directly.

If you have specific application provided by the carrier, and want to set IP
configurations on your own, you can switch to Static IP mode and fill in all
parameters that required, such as IP address, subnet mask and gateway.

Note: IP Subnet Mask is a must filled setting, and make sure you have the
right configuration. Otherwise, the connection may get issues.

Enter the IP address to change the primary DNS (Domain Name Server)
setting. If it is not filled-in, the server address is given by the carrier while
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address (IPv4 type) dialing-up.

1. An Optional setting Enter the IP address to change the secondary DNS (Domain Name Server)
Secondary DNS 2. String format : IP setting. If it is not filled-in, the server address is given by the carrier while

address (IPv4 type) dialing-up.

Check the box to establish the connection even the registration status is
The box is unchecked by  roaming, not in home network.

Roaming default

Note: It may cost additional charges if the connection is under roaming.

Create/Edit SIM-A / SIM-B APN Profile List

You can add a new APN profile for the connection, or modify the content of the APN profile you added. It is
available only when you select Dial-Up Profile as APN Profile List.

= SIM-A APN Profile List

Account  Password Authentication Priority | Enable Actions

List all the APN profile you created, easily for you to check and modify. It is available only when you select Dial-
Up Profile as APN Profile List.

When Add button is applied, an APN Profile Configuration screen will appear.

* SIM-A APN Profile Configuration

Item Setting
» Profile Name |Profile-1 |
» APN | |
» IP Type
» Account | | (Optional)
» Password | @D | (Optional)
» Authentication
» Priority [ ]
» Profile [CJ Enable

SIM-A/-B APN Profile Configuration

Item Value setting Description
1. By default Profile-x is Enter the profile name you want to describe for this profile.
Profile Name listed
2. String format : any text
APN String format : any text Enter the APN you want to use to establish the connection.
1. A Must filled setting Specify the IP type of the network serveice provided by your cellular
IP Type 2. By default IPv4 is network. It can be IPv4, IPv6, or IPv4/6.
selected
Account String format : any text Enter the Account you want to use for the authentication.
Value Range: 0 ~ 53 characters.
Password String format : any text Enter the Password you want to use for the authentication.
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Authentication

Priority

Profile
Save

Undo

1. A Must filled setting
2. By default Auto is
selected

1. A Must filled setting
2. String format : integer

The box is checked by
default

N/A

N/A

Select the Authentication method for the cellular connection.
It can be Auto, PAP, CHAP, or None.

Enter the value for the dialing-up order. The valid value is from 1 to 16. It
will start to dial up with the profile that assigned with the smallest
number.

Value Range: 1 ~ 16.
Check the box to enable this profile.

Uncheck the box to disable this profile in dialing-up action.

Click the Save button to save the configuration.

Click the X button to restore what you just configured back to the
previous setting.

Setup Cellular Connection Common Configuration

Here you can change common configurations for Cellular WAN.

Item

» Connection Control

» Time Schedule [(0) Always v |

» MTU Setup (] Enable

» IP Passthrough (Cellular Bridge) (] Enable Fixed MA
» NAT Enable

» IGMP  Disable v |

» WAN IP Alias

Connection Control

Maximum Idle Time

Setting

| Auto-reconnect

v

(] Enable 10.0.0.1

By default Auto-
reconnect is selected

1. An Optional setting
2. By default 600
seconds is filled-in

When Auto-reconnect is selected, it means it will try to keep the Internet
connection on all the time whenever the physical link is connected.
When Connect-on-demand is selected, it means the Internet connection
will be established only when detecting data traffic.

When Connect Manually is selected, it means you need to click the
Connect button to dial up the connection manually. Please go to Status >
Basic Network > WAN & Uplink tab for details.

Note: If the WAN interface serves as the primary one for another WAN
interface in Failover role( and vice versa), the Connection Control
parameter will not be available on both WANSs as the system must set it
to “Auto-reconnect”

Specify the maximum Idle time setting to disconnect the internet
connection when the connection idle timed out.

Value Range: 300 ~ 86400.

Note: This field is available only when Connect-on-demand or Connect
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Time Schedule

MTU Setup

IP Pass-through
(Cellular Bridge)

NAT
IGMP

WAN IP Alias

Item

» Network Monitoring
Configuration

» Checking Method
» Loading Check

» Query Interval

v

Latency Threshold

v

Fail Threshold

v

Target1

v

Target2

Network Monitoring
Configuration

Checking Method

Loading Check

1. A Must filled setting
2. By default (0) Always
is selected

1. An Optional setting
2. Uncheck by default

1. The box is unchecked
by default

2. String format for
Fixed MAC:

MAC address, e.g.
00:50:18:aa:bb:cc

Check by default

By default Disable is
selected

1. Unchecked by default
2. String format: IP
address (IPv4 type)

Manually is selected as the connection control scheme.

When (0) Always is selected, it means this WAN is under operation all the
time. Once you have set other schedule rules, there will be other options
to select. Please go to Object Definition > Scheduling for details.

Check the Enable box to enable the MTU (Maximum Transmission Unit)
limit, and specify the MTU for the cellular connection.

MTU refers to Maximum Transmission Unit. It specifies the largest packet
size permitted for Internet transmission.

Value Range: 1200 ~ 1500.

When Enable box is checked, it means the device will directly assign the
WAN IP to the first connected local LAN client.

However, when an optional Fixed MAC is filled-in a non-zero value, it
means only the client with this MAC address can get the WAN IP address.

Note: When the IP Pass-through is on, NAT and WAN IP Alias will be
unavailable until the function is disabled again.

Uncheck the box to disable NAT (Network Address Translation) function.
Select Auto to enable IGMP function.

Check the Enable box to enable IGMP Proxy.

Check the box to enable WAN IP Alias, and fill in the IP address you want
to assign.

Setting
Enable
| DNS Query v |
Enable
5 | (seconds)
13000 | (ms)
5 | (Times)
| DNS1 v |
| None v |

1. An optional setting
2. Box is checked by
default

1. An Optional setting
2. DNS Query is set by
default

1. An optional setting

Check the Enable box to activate the network monitoring function.

Choose either DNS Query or ICMP Checking to detect WAN link.

With DNS Query, the system checks the connection by sending DNS
Query packets to the destination specified in Target 1 and Target 2.
With ICMP Checking, the system will check connection by sending ICMP
request packets to the destination specified in Target 1 and Target 2.
Check the Enable box to activate the loading check function.
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Query Interval

Check Interval

Latency Threshold

Fail Threshold

Target 1

Target 2

Save
Undo

2. Box is checked by
default

1. An Optional setting
2. 5 seconds is selected
by default.

1. An Optional setting
2. 5 seconds is selected
by default.

1. An Optional setting
2.3000 ms is set by
default

1. An Optional setting
2.5 times is set by
default

1. An Optional filled
setting

2. DNS1 is selected by
default

1. An Optional filled
setting

2. None is selected by
default

N/A
N/A

Enable Loading Check allows the gateway to ignore unreturned DNS
queries or ICMP requests when WAN bandwidth is fully occupied. This is
to prevent false link-down status.

Specify a time interval as the DNS Query Interval.

Query Interval defines the transmitting interval between two DNS Query
or ICMP checking packets.

With DNS Query, the system checks the connection by sending DNS
Query packets to the destination specified in Target 1 and Target 2.
Value Range: 2 ~ 14400.

Specify a time interval as the ICMP Checking Interval.

Query Interval defines the transmitting interval between two DNS Query
or ICMP checking packets.

With ICMP Checking, the system will check connection by sending ICMP
request packets to the destination specified in Target 1 and Target 2.
Value Range: 2 ~ 14400.

Enter a number of detecting disconnection times to be the threshold
before disconnection is acknowledged.

Latency Threshold defines the tolerance threshold of responding time.
Value Range: 2000 ~ 3000 seconds.

Enter a number of detecting disconnection times to be the threshold
before disconnection is acknowledged.

Fail Threshold specifies the detected disconnection before the router
recognize the WAN link down status.

Value Range: 1 ~ 10 times.

Targetl specifies the first target of sending DNS query/ICMP request.
DNS1: set the primary DNS to be the target.

DNS2: set the secondary DNS to be the target.

Gateway: set the Current gateway to be the target.

Other Host: enter an IP address to be the target.

Targetl specifies the second target of sending DNS query/ICMP request.
None: no second target is required.

DNS1: set the primary DNS to be the target.

DNS2: set the secondary DNS to be the target.

Gateway: set the Current gateway to be the target.

Other Host: enter an IP address to be the target.

Click Save to save the settings.

Click Undo to cancel the settings.
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Internet Connection — WFi Uplink WAN

If the device connects to Internet through WiFi Uplink, this section will help you to complete WiFi Uplink

connection setup.

Go to Basic Network > WAN & Uplink > Internet Setup tab.

WiFi Uplink interface: The Uplink network is a wireless network, and the gateway can connect to the Uplink
network through WiFi connection.

If you have the access permission to a certain wireless network, you can setup a WiFi Uplink connection by using

the gateway device. This gateway can support 802.11ac/n/g/b data connection, and it can connect to a wireless

network (access point) under the regular infrastrature mode.

# Internet Connection List

Interface Name Physical Interface Operation Mode WAN Type Action
WAN-1 Ethernet Always on Static IP
WAN-2 WiFi Module One Always on Uplink Edit
WAN-3 - Disable - Edit
WAN-4 - Disable - Edit

Configure WiFi Uplink Setting

When Edit button is applied, Internet Connection Configuration screen will appear. WAN-2 interface is used in

this example.

Item

% Internet Connection Configuration { WAN -2)

Setting

» WAN Type

Internet Connection Configuration

Item

Value setting

1. A Must filled setting.

WAN Type

default.

Description

From the dropdown box, select Internet connection method for WiFi

2. Uplink is selected by  Uplink Connection. Only Uplink is available.
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WiFi Uplink
Item Setting
» Connect to AP Only_For_Monkey-Ch#1-WPA2-PSK (AES)
» Network Type |NAT Mode v |
» IP Mode ' Dynamic IP v |
» Host Name J | (Optional)

» Connection Control

' Connect Manually v |

» Maximum Idle Time

(seconds)

» Fast Roaming

() Enable Signal Threshold %

» Fast Roaming Channels

NAv| NAv NAv|

WiFi Uplink WAN Type Configuration

Item

Connect to AP

Value setting Description

Display the information of AP for connecting.

You can Click the Scan button and select a AP for the uplink network.
N/A Besides, you can also create uplink profile(s) for ease of connecting to an

available Uplink network. Refer to Basic Network > WiFi > Uplink Profile

tab.

Network Type

Select the expected network type for the WiFi Uplink connection. It can
be NAT Mode, Bridge Mode, or NAT Disable.
When NAT Mode is selected, the NAT function is activated on the
Wireless Uplink connection;
1. A Must filled setting When Bridge Mode is selected, the bridge function is activated on the
2. NAT Mode is selected  Wireless Uplink connection; The supporting of bridge mode depends on
by default. the product specification, if the purchased device doesn’t support the
bridge mode, it will be greyed out from selection.
When NAT Disable is selected, the NAT function is deactivated on the
Wireless Uplink connection, and it can function as a router with manually
configured routing setting.

IP Mode

Specify the IP mode for the wireless uplink Interface. It can be Dynamic IP
or Static IP.

When Dynamic IP is selected, the device will request a IP from the Uplink
Network as the IP for the uplink interface ;

When Static IP is selected, you have to manually configure the IP address
settings for the uplink interface. The settings include IP address, subnet
mask, gateway, and primary/secondary DNS.

1. A Must filled setting
2. Dynamic IP is
selected by default.

Connection Control

There are three connection modes.

° Auto-reconnect (Always on) enables the router to always keep
the Internet connection on.

° Connect-on-demand enables the router to automatically re-
establish Internet connection as soon as user attempts to access
the Internet. Internet connection will be disconnected when it
has been inactive for a specified idle time.

° Connect Manually allows user to connect to Internet manually.

A Must filled setting
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Internet connection will be inactive after it has been inactive for
specified idle time.

Maximum Idle Time

1. An Optional setting
2. By default 600
seconds is filled-in

Specify the maximum Idle time setting to disconnect the internet
connection when the connection idle timed out.

Value Range: 300 ~ 86400.

Note: This field is available only when Connect-on-demand or Connect
Manually is selected as the connection control scheme.

Fast Roaming

1. An Optional setting
2. Unchecked is selected
by default.

Click the Enable checkbox to activate the fast roaming function.

In addition, you can also specify a threshold value for changing from one
AP to another near-by AP. The default threshold value is 40%.

Value Range: 30 ~ 60%.

Fast Roaming
Channels

1. An Optional setting
2. N/Ais selected by
default.

You can specify up to three channels for WiFi Uplink fast roaming
function. If you don’t specify any channel, the WiFi uplink will just operate
on original connection channel.

Network Minitoring

# Network Monitoring Configuration -

Item Setting
» Network Monitoring Enable
Configuration
» Checking Method 'DNS Query v
» Loading Check Enable

» Query Interval

(seconds)

» Latency Threshold

s

» Fail Threshold

(imes)

» Target1

' DNS1 v

» Target2

'None v

Network Monitoring Configuration

Item

Network Monitoring
Configuration

Value setting

1. An optional setting
2. Box is checked by
default

Description
Check the Enable box to activate the network monitoring function.

Checking Method

1. An Optional setting
2. DNS Query is set by
default

Choose either DNS Query or ICMP Checking to detect WAN link.

With DNS Query, the system checks the connection by sending DNS
Query packets to the destination specified in Target 1 and Target 2.
With ICMP Checking, the system will check connection by sending ICMP
request packets to the destination specified in Target 1 and Target 2.

Loading Check

1. An optional setting
2. Box is checked by
default

Check the Enable box to activate the loading check function.

Enable Loading Check allows the gateway to ignore unreturned DNS
queries or ICMP requests when WAN bandwidth is fully occupied. This is
to prevent false link-down status.

Query Interval

1. An Optional setting

Specify a time interval as the DNS Query Interval.
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Check Interval

Latency Threshold

Fail Threshold

Target 1

Target 2

Save
Undo

2. 5 seconds is selected
by default.

1. An Optional setting
2. 5 seconds is selected
by default.

1. An Optional setting
2.3000 ms is set by
default

1. An Optional setting
2.5 times is set by
default

1. An Optional filled
setting

2. DNS1 is selected by
default

1. An Optional filled
setting

2. None is selected by
default

N/A
N/A

Query Interval defines the transmitting interval between two DNS Query
or ICMP checking packets.

With DNS Query, the system checks the connection by sending DNS
Query packets to the destination specified in Target 1 and Target 2.
Value Range: 2 ~ 14400.

Specify a time interval as the ICMP Checking Interval.

Query Interval defines the transmitting interval between two DNS Query
or ICMP checking packets.

With ICMP Checking, the system will check connection by sending ICMP
request packets to the destination specified in Target 1 and Target 2.
Value Range: 2 ~ 14400.

Enter a number of detecting disconnection times to be the threshold
before disconnection is acknowledged.

Latency Threshold defines the tolerance threshold of responding time.
Value Range: 2000 ~ 3000 seconds.

Enter a number of detecting disconnection times to be the threshold
before disconnection is acknowledged.

Fail Threshold specifies the detected disconnection before the router
recognize the WAN link down status.

Value Range: 1 ~ 10 times.

Targetl specifies the first target of sending DNS query/ICMP request.
DNS1: set the primary DNS to be the target.

DNS2: set the secondary DNS to be the target.

Gateway: set the Current gateway to be the target.

Other Host: enter an IP address to be the target.

Targetl specifies the second target of sending DNS query/ICMP request.
None: no second target is required.

DNS1: set the primary DNS to be the target.

DNS2: set the secondary DNS to be the target.

Gateway: set the Current gateway to be the target.

Other Host: enter an IP address to be the target.

Click Save to save the settings.

Click Undo to cancel the settings.

52



5G WAN Extender

2.2 LAN & VLAN

This section provides the configuration of LAN and VLAN. VLAN is an optional feature, and it depends on the
product specification of the purchased gateway.

2.2.1 Ethernet LAN

Please follow the following instructions to do IPv4 Ethernet LAN Setup.

# Configuration

Item

xDSLand/or
4G Cellular

The Local Area Network (LAN) can be
used to share data or files among
computers attached to a network.
Following diagram illustrates the
network that wired and interconnects
computers.

EthernetLAN

Setting

» IP Mode

Static IP

» LAN IP Address

192.168.123.254 |

» Subnet Mask

1255.255.255.0 (/24) v |

Configuration

Item

Value setting

Description
It shows the LAN IP mode for the gateway according the related configuration.
Static IP: If there is at least one WAN interface activated, the LAN IP mode is

IP Mode N/A fixed in Static IP mode.
Dynamic IP: If all the available WAN inferfaces are disabled, the LAN IP mode
can be Dynamic IP mode.
Enter the local IP address of this device.
The network device(s) on your network must use the LAN IP address of this
LAN IP 1. A Must filled setti'ng device as their Default Gateway. You can change it if necessary.
Address 2.192.168.123.254 is set by

default

Note: /t’s also the IP address of web Ul. If you change it, you
need to type new IP address in the browser to see web Ul.

Subnet Mask

1. A Must filled setting
2.255.255.255.0 (/24) is set

Select the subnet mask for this gateway from the dropdown list.
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by default Subnet mask defines how many clients are allowed in one network or subnet.

The default subnet mask is 255.255.255.0 (/24), and it means maximum 254 |P
addresses are allowed in this subnet. However, one of them is occupied by
LAN IP address of this gateway, so there are maximum 253 clients allowed in
LAN network.
Value Range: 255.0.0.0 (/8) ~ 255.255.255.252 (/30).

Save N/A Click the Save button to save the configuration

Click the Undo button to restore what you just configured back to the

previous setting.

Undo N/A

Create / Edit Additional IP

This gateway provides the LAN IP alias function for some special management consideration. You can add
additional LAN IP for this gateway, and access to this gateway with the additional IP.

* Additional IP . ®

ID Name Interface IP Address Subnet Mask Enable

When Add button is applied, Additional IP Configuration screen will appear.

*] Additional IP Configuration

Item Setting
» Name I I
» Interface | o v
» IP Address | |
» Subnet Mask ‘ 2652552550 (/24) v ]
» Enahble o
Configuration
Item Value setting Description
Name .1 An Optional Setting Enter the name for the alias IP address.
1. A Must filled settin
Interface ) & Specify the Interface type. It can be lo or br0.
2. lo is set by default
1. An Optional setting
IP Address 2.192.168.123.254 is set by  Enter the addition IP address for this device.

default

. . Select the subnet mask for this gateway from the dropdown list.
1. A Must filled setting

Subnet Mask 2. 255.255.255.0 (/24) is set
by default

Subnet mask defines how many clients are allowed in one network or subnet.
The default subnet mask is 255.255.255.0 (/24), and it means maximum 254 |P
addresses are allowed in this subnet. However, one of them is occupied by
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Save NA

LAN IP address of this gateway, so there are maximum 253 clients allowed in

LAN network.
Value Range: 255.0.0.0 (/8) ~ 255.255.255.255 (/32).

Click the Save button to save the configuration
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2.2.2 VLAN

VLAN (Virtual LAN) is a logical network under a certain switch or router device to group client hosts with a
specific VLAN ID. This gateway supports both Port-based VLAN and Tag-based VLAN. These functions allow you
to divide local network into different “virtual LANs”. It is common requirement for some application scenario.
For example, there are various departments within SMB. All client hosts in the same department should own
common access privilege and QoS property. You can assign departments either by port-based VLAN or tag-
based VLAN as a group, and then configure it by your plan. In some cases, ISP may need router to support
“VLAN tag” for certain kinds of services (e.g. IPTV). You can group all devices required this service as one tag-
based VLAN.

If the gateway has only one physical Ethernet LAN port, only very limited configuration is available if you enable
the Port-based VLAN.

> Port-based VLAN

Port-based VLAN function can group Ethernet ports, Port-1 ~ Port-4, and WiFi Virtual Access Points, VAP-1 ~
VAP-8, together for differentiated services like Internet surfing, multimedia enjoyment, VolIP talking, and so on.
Two operation modes, NAT and Bridge, can be applied to each VLAN group. One DHCP server can be allocated
for a NAT VLAN group to let group host member get its IP address. Thus, each host can surf Internet via the NAT
mechanism of business access gateway. In bridge mode, Intranet packet flow is delivered out WAN trunk port
with VLAN tag to upper link for different services.

VLAN Group 1 NAT
= = Wireless Network P 4(
{ .‘\ [D ,a".\‘j‘ \. WiFi - «DSL Modem Q::;}‘
At A ,‘:\) wr Bridge =
. .// “ e

((«
\\

.. Wireless Network

% @ \Q @ VLAN Group 2

—
Wired Netwerk

I T T

S

Wired Netwerk

A port-based VLAN is a group of ports on an Ethernet or Virtual APs of Wired or Wireless Gateway that form a
logical LAN segment. Following is an example.

For example, in a company, administrator schemes out 3 network segments, Lobby/Meeting Room, Office, and
Data Center. In a Wireless Gateway, administrator can configure Lobby/Meeting Room segment with VLAN ID
3. The VLAN group includes Port-3 and VAP-8 (SSID: Guest) with NAT mode and DHCP-3 server equipped. He
also configure Office segment with VLAN ID 2. The VLAN group includes Port-2 and VAP-1 (SSID: Staff) with NAT

56



5G WAN Extender

mode and DHCP-2 server equipped. At last, administrator also configure Data Center segment with VLAN ID 1.
The VLAN group includes Port-1 with NAT mode to WAN interface as shown in following diagram.

Wireless Gateway ()

\ m@ xDSL and/or

4G Cellular
i 3
VLANID1 % %

A “
% ERP

'/:

m
@ Data Center 3
%
VID1: -
DHCP Server: DHCP-1
VID2:
DHCP Server: DHCP-2
VID3:
DHCP Server: DHCP-3 @ Office Network

VLANID 2

VLANID 2

Above is the general case for 3 Ethernet LAN ports in the gateway. But if the device just has one Ethernet LAN
port, there will be only one VLAN group for the device. Under such situation, it still supports both the NAT and
Bridge mode for the Port-based VLAN configuration.

» Tag-based VLAN

Tag-based VLAN function can group Ethernet ports, Port-1 ~ Port-4, and WiFi Virtual Access Points, VAP-1 ~ VAP-
8, together with different VLAN tags for deploying subnets in Intranet. All packet flows can carry with different
VLAN tags even at the same physical Ethernet port for Intranet. These flows can be directed to different
destination because they have differentiated tags. The approach is very useful to group some hosts at different
geographic location to be in the same workgroup.

Tag-based VLAN is also called a VLAN Trunk. The VLAN Trunk collects all packet flows with different VLAN IDs
from Router device and delivers them in the Intranet. VLAN membership in a tagged VLAN is determined by
VLAN ID information within the packet frames that are received on a port. Administrator can further use a VLAN
switch to separate the VLAN trunk to different groups based on VLAN ID. Following is an example.
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VLAN Group 1

= Wireless Network WiFi

a@»

i !
= Internet
xDSL Modem b

Wireless Network

Wired Netwerk:

For example, in a company, administrator schemes out 3 network segments, Lab, Meeting Rooms, and Office.
In a Security VPN Gateway, administrator can configure Office segment with VLAN ID 12. The VLAN group is
equipped with DHCP-3 server to construct a 192.168.12.x subnet. He also configure Meeting Rooms segment
with VLAN ID 11. The VLAN group is equipped with DHCP-2 server to construct a 192.168.11.x subnet for Intranet
only. That is, any client host in VLAN 11 group can’t access the Internet. At last, he configures Lab segment with
VLAN ID 10. The VLAN group is equipped with DHCP-1 server to construct a 192.168.10.x subnet.

Gateway

xDSL and/or
4G Cellular

VID10:
DHCP Server: DHCP-1(192.168.10.x)
VID11:

DHCP Server: DHCP-2(192.168.11.x)
VID12:

DHCP Server: DHCP-3(192.168.12.x)
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» VLAN Groups Access Control

Administrator can specify the Internet access permission for all VLAN groups. He can also configure which VLAN
groups are allowed to communicate with each other.

VLAN Group Internet Access

Administrator can specify members of one VLAN group to be able to access Internet or not. Following is an
example that VLAN groups of VID is 2 and 3 can access Internet but the one with VID is 1 cannot access Internet.
That is, visitors in meeting room and staffs in office network can access Internet. But the computers/servers in
data center cannot access Internet since security consideration. Servers in data center only for trusted staffs or
are accessed in secure tunnels.

Wireless Gateway )

HUy (8L

@ Office Network

VAP-1: Staf
VLANID 2

VLANID 2
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Inter VLAN Group Routing:

In Port-based tagging, administrator can specify member hosts of one VLAN group to be able to communicate
with the ones of another VLAN group or not. This is a communication pair, and one VLAN group can join many
communication pairs. But communication pair doesn’t have the transitive property. That is, A can communicate
with B, and B can communicate with C, it doesn’t imply that A can communicate with C. An example is shown
at following diagram. VLAN groups of VID is 1 and 2 can access each other but the ones between VID 1 and VID
3 and between VID 2 and VID 3 can’t.

Wireless Gateway )

xDSL and/or
4G Cellular

VLANID1

SEIVEIN |

x
-~

Q@ §@ S S

VLANID 2

VLANID 2
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VLAN Setting

Go to Basic Network > LAN & VLAN > VLAN Tab.

The VLAN function allows you to divide local network into different virtual LANs. There are Port-based and Tag-
based VLAN types. Select one that applies.

Item

» VLAN Types
» Systern Reserved VLAN 1D

VLAN Type Port-based is selected by
default
System
Reserved 1~ 5isreserved by default
VLAN ID
Save NA

Setting

Port-based v
Start 1D 1

(1-4081)~EndID 5

Select the VLAN type that you want to adopt for organizing you local subnets.
Port-based: Port-based VLAN allows you to add rule for each LAN port, and
you can do advanced control with its VLAN ID.

Tag-based: Tag-based VLAN allows you to add VLAN ID, and select member
and DHCP Server for this VLAN ID. Go to Tag-based VLAN List table.

Specify the VLAN ID range that is reserved for the system operation. For the
Port-based/Tag-based VLAN grouping, only use the ID outside the reserved
range.

Value Range: 1 ~ 4091.

Click the Save button to save the configuration

Port-based VLAN — Create/Edit VLAN Rules

The port-based VLAN allows you to custom each LAN port. There is a default rule shows the configuration of all
LAN ports. Also, if your device has a DMZ port, you will see DMZ configuration, too. The maxima rule numbers

is based on LAN port numbers.

J Add Delete
Name VLANID TXL‘SI:: g NAT /Bridge | Port Members LANIP Address Subnet Mask Joined WAN WANVID |Enable |Actions
DMZ 4094 X NAT DMZ Port 192.168.6.254 255.255.255.0 WWAN -1 0 Edit
LAN Native VLAN X NAT Detail 192.168.123.254 255.255.255.0 AllYWANS 0 Edit

Apply | Inter VLAN Group Routing

When Add button is applied, Port-based VLAN Configuration screen will appear, which is including 3 sections:
Port-based VLAN Configuration, IP Fixed Mapping Rule List, and Inter VLAN Group Routing (enter through a

button)
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Port-based VLAN - Configuration

» Name

» VLAN ID

» VLAN Tagging
» NAT / Bridge

» Port Members

» LAN to Join

Name

VLAN ID

VLAN Tagging

NAT / Bridge

Port Members

LAN to Join

Save

Undo

Item Setting
VLAN -1
Disable v
NAT v
Port Port-2 Port-3
2.4G: [) VAP-1 VAP-2 () VAP-3 [J VAP-4 [) VAP-5 () VAP-6 ] VAP-7 [] VAP-
5G VAP-1 VAP-2 () VAP-3 [ ] VAP-4 [ ] VAP-5 [ ] VAP-6 [ ] VAP-7 [ VAP-8
Enable (DHCP 1 v

1. A Must filled setting
2. String format: already
have default texts

A Must filled setting

Disable is selected by
default.

NAT is selected by default.
These boxes are unchecked
by default.

The box is unchecked by
default.

NA

NA

Define the Name of this rule. It has a default text and cannot be modified.

Define the VLAN ID number, range is 1~4094.
The rule is activated according to VLAN ID and Port Members configuration
when Enable is selected.

The rule is activated according Port Members configuration when Disable is
selected.

Select NAT mode or Bridge mode for the rule.

Select which LAN port(s) and VAP(s) that you want to add to the rule.

Note: The available member list can be different for the purchased product.
Check the Enable box and select one of the defined DHCP Server for the List to
define the DHCP server for the VLAN group.

If you enabled this function, all the rest settings will be greyed out, not
required to configured manually.

Click the Save button to save the configuration

Click the Undo button to restore what you just configured back to the
previous setting.

If you didn’t decide to bind the VLAN group to a pre-defined DHCP server, you have to further specify the
following settings.
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)

)

)

»

WAN & WAN VID to Join
LAN IP Address

Subnet Mask

DHCP Server / Relay

DHCP Server Name

Al WANS v
192.168.2.254
2552552550 ()24) v

None

Server v

192.168.2.100

Starting Address:

IP Pool
Ending Address:  (192.168.2.200
Lease Time 86400 seconds
Domain Name (Optional)
Primary DNS (Optional)
Secondary DNS (Optional)
Primary WINS (Optional)
Secondary WINS (Optional)
Gateway (Optional)
Enable
WAN & WAN  All WANS is selected by Select which WAN or All WANSs that allow accessing Internet.
VID to Join default. Note: If Bridge mode is selected, you need to select a WAN and enter a VID.
LAN IP . . Assign an IP Address for the DHCP Server that the rule used, this IP address is
A Must filled setting
Address a gateway IP.
Subnet Mask 255.255.255.0(/24) is Select a Subnet Mask for the DHCP Server.
selected by default.
Define the DHCP Server type.
There are three types you can select: Server, Relay, and Disable.
Relay: Select Relay to enable DHCP Relay function for the VLAN group, and
DHCP Server Server is selected by you only need to fill the DHCP Server IP Address field.
/Relay default. Server: Select Server to enable DHCP Server function for the VLAN group, and
you need to specify the DHCP Server settings.
Disable: Select Disable to disable the DHCP Server function for the VLAN
group.
DHCP Server If you select Relay type of DHCP Server, assign a DHCP Server IP Address that
IP Address A Must filled setting the gateway will relay the DHCP requests to the assigned DHCP server.
(for DHCP
Relay only)
DHCP Option If you select Relay type of DHCP Server, you can further enable the DHCP
82 . ) . Option 82 setting if the DHCP server support it.
(for DHCP An Optional filled setting
Relay only)
DHCP Server A Must filled setting Define name of the DHCP Server for the specified VLAN group.
Name
Define the IP Pool range.
P Pool A Must filled setting There are Starting Address and Ending Address fields. If a client requests an IP

address from this DHCP Server, it will assign an IP address in the range of IP
pool.
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Lease Time

Domain Name

Primary DNS
Secondary
DNS

Primary WINS

Secondary
WINS

Gateway
Enable

Save

Undo

A Must filled setting

String format can be any
text
IPv4 format

IPv4 format
IPv4 format
IPv4 format

IPv4 format
The box is unchecked by
default.

NA

NA

Define a period of time for an IP Address that the DHCP Server leases to a new
device. By default, the lease time is 86400 seconds.

The Domain Name of this DHCP Server.
Value Range: 0 ~ 31 characters.

The Primary DNS of this DHCP Server.
The Secondary DNS of this DHCP Server.
The Primary WINS of this DHCP Server.
The Secondary WINS of this DHCP Server.
The Gateway of this DHCP Server.

Click Enable box to activate this rule.

Click the Save button to save the configuration
Click the Undo button to restore what you just configured back to the
previous setting.
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Besides, you can add some IP rules in the IP Fixed Mapping Rule List if DHCP Server for the VLAN groups is
required.

= IP Fixed Mapping Rule List [[YT]
MAC Address IP Address Enable Actions

When Add button is applied, Mapping Rule Configuration screen will appear.

Mapping Rule Configuration

Item Value setting Description
MAC Address A Must filled setting Define the MAC Address target that the DHCP Server wants to match.
Define the IP Address that the DHCP Server will assign.
) . If there is a request from the MAC Address filled in the above field, the DHCP
IP Address A Must filled setting Server will assign this IP Address to the client whose MAC Address matched
the rule.
The box is unchecked by Click Enable box to activate this rule.
Enable
default.
Save NA Click the Save button to save the configuration

Note: ensure to always click on Apply button to apply the changes after the web browser refreshed taken you
back to the VLAN page.

= Portbased VLAN List [JX2] - f x

Name = VLANID TZ;‘;’:Q NAT /Bridge | phort LAN IP Address SubnetMask | Joined WAN | WANVID | Enable Actions
Native VLAN

LAN Tog 1 X NAT 192.168.66.1 2552552540 | Al WANs 0

| Apply | Inter VLAN Group Routing |
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Port-based VLAN - Inter VLAN Group Routing

Click VLAN Group Routing button, the VLAN Group Internet Access Definition and Inter VLAN Group Routing
screen will appear.
# VLAN Group Internet Access Definition

VLAN IDs Members Internet Access(WAN)
Port: 23

1 24GVAP: 123456738 Allow

5GVAP: 123456738

# Inter VLAN Group Routing

VLAN IDs Members Action

When Edit button is applied, a screen similar to this will appear.
# VLAN Group Internet Access Definition

VLAN IDs Members Internet Access(WAN)

Port:23

@ 1 24GVAP: 12345678 Allow

5GVAP: 123456738

# Inter VLAN Group Routing

VLAN IDs Members Action
o1

Inter VLAN Group Routing

Item Value setting Description

VALN Group By default, all boxes are checked means all VLAN ID members are allow to
Internet All boxes are checked by access WAN interface.

Access default. If uncheck a certain VLAN ID box, it means the VLAN ID member can’t access
Definition Internet anymore.
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Note: VLAN ID 1 is available always; it is the default VLAN ID of LAN rule. The
other VLAN IDs are available only when they are enabled.
Click the expected VLAN IDs box to enable the Inter VLAN access function.

Inter VLAN . By default, members in different VLAN IDs can’t access each other. The
The box is unchecked by .
Group default gateway supports up to 4 rules for Inter VLAN Group Routing.
Routing ' For example, if ID_1 and ID_2 are checked, it means members in VLAN ID_1
can access members of VLAN ID_2, and vice versa.
Save N/A Click the Save button to save the configuration

Tag-based VLAN - Create/Edit VLAN Rules

The Tag-based VLAN allows you to customize each LAN port according to VLAN ID. There is a default rule shows
the configuration of all LAN ports and all VAPs. Also, if your device has a DMZ port, you will see DMZ configuration,
too. The router supports up to a maximum of 128 tag-based VLAN rule sets.

Add Delete
VLAN ID | Internet Port Members Bridge Interface | IP Address Subnet Mask | Actions
Port Port-2 Port-3 -
Native Edit
‘-.’i A}\ 2.4G VAP-1 VAP-2 v VAP-3 v VAP-4 v VAP-5 v VAP-6 v VAP-7T v VAP-3 DHCP 1
Select
5G VAP-1 VAP-2 v VAP-3 v VAP-4 v VAP-5 v VAP-6 v VAP-7 v VAP-3

When Add button is applied, Tag-based VLAN Configuration screen will appear.

Item Setting
» VLAN ID 0
» Internet Access ¢/ Enable
Port Port-2 Port-3
» Port Members 2.4G VAP-1 VAP-2  VAP-3 | VAP-4 VAR5  VAP-6  VAP-7  VAP-3
5G VAP-1 VAP-2  VAP-3  VAP-4  VAP-5  VAP-6  VAP-7  VAP-3
DHCP 1 v

» Bridge Interface

Define the VLAN ID number, that is outside the system reserved range.

VALN ID A Must filled setting Value Range: 1 ~ 4095,
Internet The box is checked by Click Enable box to allow the members in the VLAN group access to internet.
Access default.

Port Members

The boxes are unchecked by
default.

Check the LAN port box(es) to join the VLAN group.
Check the VAP box(es) to join the VLAN group.
Note: Only the wireless gateway has the VAP list.

Bridge DHCP 1 is selected by Select a predefined DHCP Server , a New to defined a new DHCP server for
Interface default. these members of this VLAN group.
Save N/A Click Save button to save the configuration

Note: After clicking Save button, always click Apply button to apply the
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| settings. |

If you select New to create a new DHCP server setting for the VLAN group, you have to further specify the
following configuration.

» IP Address | |

» Subnet Mask [255.2552550 (124) v |
» DHCP Relay () Enable & Server IP : |

» WAN Interface WAN-1 v

» DHCP Relay Option 82 () Enable

Tag-based VLAN Configuration (part-Il)

Item Value setting Description
i he DHCP hat the rul his IP i
IP Address A Must filled setting Assign an IP Address for the DHCP Server that the rule used, this IP address is
a gateway IP.
. . . i Mask for the DHCP .
Subnet Mask 255.255.255.0(/24) is Select a Subnet Mask for the DHCP Server
selected by default.
DHCP Rela The box is unchecked by Check the box to enable the DHCP Relay function for the VLAN group, and you
4 default. only need to fill the DHCP Server IP Address field.
WAN WAN-1 is selected by Select which WAN interface that allow accessing Internet.
Interface default.
DHCP Option . ) . If you select Relay type of DHCP Server, you can further enable the DHCP
A I fill A
82 n Optional filled setting Option 82 setting if the DHCP server support it.
Save NA Click the Save button to save the configuration
Click the Undo button to restore what you just configured back to the
Undo NA . .
previous setting.

Tag-based VLAN Summary

The configured tag-based VLAN group information will be displayed in the following screen.

= Tag-based VLAN Summary ° ®
Port VLAN IDs
Port2 Native VLAN
Port3 Native VLAN
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2.2.3 DHCP Server

> DHCP Server

The gateway supports up to 4 DHCP servers to fulfill the DHCP requests from different VLAN groups (please
refer to VLAN section for getting more usage details). And there is one default setting for whose LAN IP Address
is the same one of gateway LAN interface, with its default Subnet Mask setting as “255.255.255.0”, and its
default IP Pool ranges is from “.100” to “.200” as shown at the DHCP Server List page on gateway’s WEB UI.

] o : w % L @ Meeting Room
EEES sooe
$8o¢

User can add more DHCP server configurations by clicking on the “Add” button behind “DHCP Server List”, or
clicking on the “Edit” button at the end of each DHCP Server on list to edit its current settings. Besides, user can
select a DHCP Server and delete it by clicking on the “Select” check-box and the “Delete” button.
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» Fixed Mapping

User can assign fixed IP address to map the specific client MAC address by select them then copy, when targets
were already existed in the DHCP Client List, or to add some other Mapping Rules by manually in advance, once
the target's MAC address was not ready to connect.

PC-A

2 88€

Q PC- @ Off ice Network
........... MACAddress ..
{ PC-A: 00-12-34-AB-CD-0A i _ i 192.168.123.150 :
: : Fixed Mapping : :
: PC-B: — :
! PC-C: 00-12-34-AB-CD-0C i ! 10.10.133.181

.
----------------------------------------------------------------------------------
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DHCP Server Setting

Go to Basic Network > LAN & VLAN > DHCP Server Tab.

The DHCP Server setting allows user to create and customize DHCP Server policies to assign IP Addresses to the
devices on the local area network (LAN).

Create / Edit DHCP Server Policy

The gateway allows you to custom your DHCP Server Policy. If multiple LAN ports are available, you can define
one policy for each LAN (or VLAN group), and it supports up to a maximum of 4 policy sets.

L o101 Add || Delete || DHCP Client List ' x

DHCP . . .

LANIP Lease  Domain Primary  Secondary Primary Secondary .
i‘ear'\'r;r Address Subnet Mask IP Pool Time = Name DNS DNS WINS WINS Gateway Enable Actions
DHCP 192.168.66.100- Edit

192.168.66.1 | 255.255.254.0 amo RA 900 0.0.00 0.0.0.0 0.0.00 0.000 0.0.00 v s 5

When Add button is applied, DHCP Server Configuration screen will appear.

# DHCP Server Configuration |

Item Setting
» DHCP Server Name IDHCP 2 ]
» LAN IP Address 1192.168.2.1 |
» Subnet Mask 12552552550 (/24) v |
Starting Address: | |
17 Podt Ending Address: | |
» Lease Time seconds
» Domain Name | | (Optional)
» Primary DNS | ] (Optional)
» Secondary DNS | | (Optional)
» Primary WINS | | (Optional)
» Secondary WINS | | (Optional)
» Gateway | | (Optional)

71



5G WAN Extender

DHCP Server .

Name text Enter a DHCP Server name. Enter a name that is easy for you to understand.
2. A Must filled setting

LAN IP 1. IPv4 format. .

. . The LAN IP Address of this DHCP Server.

Address 2. A Must filled setting
255.0.0.0 (/8) is set b

Subnet Mask /8) Y The Subnet Mask of this DHCP Server.
default

IP Pool 1. IPv4 format. The IP Pool of this DHCP Server. It composed of Starting Address entered in
2. A Must filled setting this field and Ending Address entered in this field.

. 1. Numberic string format. The Lease Time of this DHCP Server.
Lease Time

Domain Name

1. String format can be any

2. A Must filled setting
String format can be any

Value Range: 300 ~ 604800 seconds.

The Domain Name of this DHCP Server.

text
Primary DNS IPv4 format The Primary DNS of this DHCP Server.
Secondar
DNS v IPv4 format The Secondary DNS of this DHCP Server.
Primary WINS  |Pv4 format The Primary WINS of this DHCP Server.
Secondar
WINS v IPv4 format The Secondary WINS of this DHCP Server.
Gateway IPv4 format The Gateway of this DHCP Server.
The box is unchecked b
Server Y Click Enable box to activate this DHCP Server.
default.
Save N/A Click the Save button to save the configuration
Click the Undo button to restore what you just configured back to the
Undo N/A . .
previous setting.
When the Back button is clicked the screen will return to the DHCP Server
Back N/A

Configuration page.

Create / Edit Mapping Rule List on DHCP Server

The gateway allows you to custom your Mapping Rule List on DHCP Server. It supports up to a maximum of 64
rule sets. When Fix Mapping button is applied, the Mapping Rule List screen will appear.
Add || Delete

MAC Address IP Address Enable Actions

When Add button is applied, Mapping Rule Configuration screen will appear.
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Item Setting

» MAC Address | |
» |IP Address I l
» Rule [ ] Enable

Mapping Rule Configuration

Item Value setting Description
1. MAC Address string
MAC Address  format The MAC Address of this mapping rule.

2. A Must filled setting
1. IPv4 format.

IP Address . . The IP Address of this mapping rule.
2. A Must filled setting

The box is unchecked by

Rule Click Enable box to activate this rule.
default.
Save N/A Click the Save button to save the configuration
Click the Undo button to restore what you just configured back to the
Undo N/A

previous setting.

When the Back button is clicked the screen will return to the DHCP Server

Back N/A . .
Configuration page.

View / Copy DHCP Client List

When DHCP Client List button is applied, DHCP Client List screen will appear.

) 1. s e L Copy to Fixed Mapping |

LAN Interface IP Address Host Name MAC Address Remaining Lease Time | Actions
Ethernet Dynamic /192.168.123.100 James-P45V 74:D0:2B:62:8D:42 00:49:07 [ Select

DHCP Clie =4 Copy to Fixed Mapping -l x
LAN Interface IP Address Host Name MAC Address Remaining Lease Time | Actions

When the DHCP Client is selected and Copy to Fixed Mapping button is applied. The IP and MAC address of
DHCP Client will apply to the Mapping Rule List on specific DHCP Server automatically.

Enable / Disable DHCP Server Options
The DHCP Server Options setting allows user to set DHCP OPTIONS 66, 72, or 114. Click the Enable button to

activate the DHCP option function, and the DHCP Server will add the expected options in its sending out
DHCPOFFER DHCPACK packages.
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Option Meaning RFC
66 TFTP server name [RFC 2132
72 Default World Wide Web Server [RFC 2132]
114 URL [RFC 3679
= Configuration ’ x
Item Setting
» DHCP Server Options [[J Enable

Create / Edit DHCP Server Options

The gateway supports up to a maximum of 99 option settings.

« DHCP Server Option List [JXee

DHCP Sever Select

Option Select Enable Actions

Option Name

When Add/Edit button is applied, DHCP Server Option Configuration screen will appear.

» DHCP Server Option Configuration

Item Setting
» Option Name |Option 1 |
» DHCP Sever Select
» Option Select | DHCP OPTION 66 v |
» Type 'Single IP Address ¥ |
» Value |
» Enable () Enable

DHCP Server Option Configuration

Item Value setting Description
1. String format can be any
Option Name  text
2. A Must filled setting.

Enter a DHCP Server Option name. Enter a name that is easy for you to
understand.

DHCP Server Dropdown ~list of all Choose the DHCP server this option should apply to.

Select available DHCP servers.

1. A Must filled setting. Choose the specific option from the dropdown list. It can be Option 66, Option
Option Select 2. Option 66 is selected by 72, Option 144, Option 42, Option 150, or Option 160.

default. Option 42 for ntp server;
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Option 66 for tftp;
Option 72 for www;
Option 144 for url;

Each different options has different value types.

Single IP Address

Single FQDN

IP Addresses List, separated by “,”
Single URL

IP Addresses List, separated by “,”
IP Addresses List, separated by “,”
Single IP Address

Single FQDN

Should conform to Type :

66
72
Type Dropdown' list o'f DHCP 114
server option value’s type
42
150
160
1. IPv4 format
2. FQDN format
Value 3. 1P list 66
4. URL format
5. A Must filled setting 72
114
Enable The box is unchecked by
default.
Save NA
Undo NA

Type
Single IP Address
Single FQDN

“wn

IP Addresses List, separated by “,

Single URL

Click Enable box to activate this setting.

Click the Save button to save the setting.
When the Undo button is clicked the screen will return back with nothing

changed.

Create / Edit DHCP Relay

The gateway supports up to a maximum of 6 DHCP Relay configurations.

Add | Delete

ID Agent Name LAN interface

When Add/Edit button is applied, DHCP Relay Configuration screen will appear.

WAN interface

Server IP

DHCP Relay
Option 82

Value

IPv4 format
FQDN format

“wn

IPv4 format, separated by “,

URL format

Enable Actions
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Item Setting
» Agent Name I |
» LAN interface ‘E
» WAN interface (WAN -1 |
» Server IP l
» DHCP OPTION 82 O
» Enable O

DHCP Relay Configuration

Item Value setting Description

1. String format can be any Enter a DHCP Relay name. Enter a name that is easy for you to understand.

Agent Name text

2. A Must filled setting.
1. A Must filled setting. Choose a LAN Interface for the dropdown list to apply with the DHCP Relay
2. LAN is selected by default.  function.

1. A Must filled setting.

Value Range: 1~64 characters.

LAN Interface

WAN > WAN-1 is selected b Choose a WAN Interface for the dropdown list to apply with the DHCP Relay

Interface d;afault ¥ function. It can be the available WAN interface(s), and L2TP connection.

server IP 1. A Must filled setting. Assign a DHCP Server IP Address that the gateway will relay the DHCP requests
2. null by default. to the assigned DHCP server via specified WAN interface.

Click Enable box to activate DHCP OPTION 82 function.
DHCP OPTION The box is unchecked by Option 82 is organized as a single DHCP option that contains circuit-ID
82 default. information known by the relay agent. If the relayed DHCP server required the
such information, you have to enable it, otherwise, just leave it as unchecked.

The box is unchecked by

Enable Click Enable box to activate this setting.

default.
Save NA Click the Save button to save the setting.
When the Undo button is clicked the screen will return back with nothing
Undo NA changed
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2.3 WiFi

Wi-Fi Module 1

Configuration

La List Iltem Setting

Basic .
Configuration » Operation Band 2.4G Single Band ~
| .

Wi-Fi Module 2

Configuration ftem Setting
J'H Lt » WiFi Module ¥ Enable
» Channel Auto ~ @ By AP Numbers (" By Less Interference
Configuration -
» WiFi System 802.11b/g/n Mixed ~
Y » WiFi Operation Mode AP Router Mode  ~
Configuration » Green AP [~ Enable
| Select Each » VAP Isolation [v Enable
/" WiFiModule » Time Schedule (0) Always ~
Popup \rPupup J Add Delete I
Module 1 Module 2 o X i Broadcast i
ID VAP SSID Authentication Encryption STA Isolation SSID Enable Actions

Configuration | Configuration

|

The gateway provides WiFi interface for mobile devices or BYOD devices to connect for Internet/Intranet
accessing. WiFi function is usually modulized design in a gateway, and there can be single or dual modules within
a gateway. The WiFi system in the gateway complies with IEEE 802.11ac/11n/11g/11b standard in 2.4GHz or
5GHz single band or 2.4G/5GHz concurrent dual bands of operation. There are several wireless operation modes
provided by this device. They are: “AP Router Mode”, “WDS Only Mode”, and “WDS Hybrid Mode”. You can
choose the expected mode from the wireless operation mode list.

There are some sub-sections for you to configure the WiFi function, including “Basic Configuration” and
“Advanced Configuration”. In Basic Configuration section, you have to finish almost all the settings for using the
WiFi function. And the Advanced Configuration section provides more parameters for advanced user to fine
tune the connectivity performance for the WiFi function.
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2.3.1 WiFi Configuration

- ™
Item Setting
» WiFi Module [V Enable
» Channel Auto v (¢ By AP Numbers ¢ By Less Interference
» WiFi System 802.11b/g/n Mixed vl
Sem one » WiFi Operation Mode W
WiFi Operation » Green AP [ Enable
Mode » VAP Isolation v Enable
» Time Schedule (0) Always 'I
G’PDRSOOU tor m og: - Add Delete ~ 0l x
n y. o D VAP SSID Authentication Encryption STA Isolation Broadcast SSID Enable Actions
WDS Hylrid Mode .
1 | VAP1 Staff_2.4G WPA2-PSK AES = = 4 Edit | T Select
2 VAP 2 default Open None = 2 ~ Edit |~ Select
- - - x
Operation Mode
. Item Setting
Profile Configuration
» VAP VAP1 v
» SSID [staff_2.46
. » Max. STA 7 Enable
Multiple AP
ﬁ p . » Authentication WPA2-PSK >
Configuration + Encpton =e
» Preshared Key [1234567890
» STAlsolation 2
® » Broadcast SSID v
» Enable 3

Due to optional module(s) and frequency band, you need to setup module one by one. For each module, you
need to specify the operation mode, and then setup the virtual APs for wireless access.

In addition, if you configured the WiFi Uplink function in the Basic Network > WAN & Uplink > Physical Interface
tab, the WiFi uplink function is activated. However, for the wireless LAN function of the module worked under
WiFi uplink operation, it also provides AP Router function for local wireless clients to connect to wireless uplink
network via the gateway.

Hereunder are the scenarios for each wireless operation mode, you can get how it works, and what is the
difference among them. To connect your wireless devices with the wireless gateway, make sure your application
scenario for WiFi network and choose the most adequate operation mode.
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AP Router Mode

AP Routgx‘/Mode
/

This mode allows you to get your wired and wireless
devices connected to form the Intranet of the wireless
gateway, and the Intranet will link to the Internet with
NAT mechanism of the gateway. So, this gateway is

/ =1
() A \  working as a WiFi AP, but also a WiFi hotspot for Internet
Gatewa i i i iFi i
Y 10.0.75.0/24 accessing service. It means local WiFi clients can

Global IP: 118.18.8>
Local IP: 10.0.75.2 l\

associate to it, and go to Internet. With its NAT
mechanism, all of wireless clients don’t need to get
public IP addresses from ISP.

WiFi Operation Mode: AP Router
Multiple AP Names: VAP-1
Network ID: WAP1

Channel: Auto

WiFi System: 802.11b/g/n Mixed
Authentication: WPA2-PSK
Encryption: AES

Key: 1234567890

Wired Network

WDS Only Mode

Gateway 2 & 3 Settings:
[Configuration]-[WiFi Configuration]

WiFi Operation Mode: WDS Only
Lazy Mode: Enable

Channel: 3

Authentication: WPA2-PSK
Encryption: AES

Lazy Mode: Disable
Channel: 3
Authentication: WPA2-PSK
Encryption: AES

Key: 1234567890

[Configuration]-[Remote AP’s MAC]

Remote AP MAC1: MAC of Gateway 2
Remote AP MAC2: MAC of Gateway 3
Remote AP MAC3:

Wi-Fi Gateway 3
@ WDS Only Mode (( ))

Ethernet LAN N (( ))

i
WY I

\
\
\ /
i NAN /Ethernet LAN
/

WDS (Wireless Distributed System) Only mode
drives a WiFi gateway to be a bridge for its wired
Intranet and a repeater to extend distance. You
can use multiple WiFi gateways as a WiFi
repeater chain with all gateways setup as "WDS

Wi-Fi Gateway 2
@ WDS Only Mode

!
| wps

Key: 1234567890 ) ' Ethernet LAN Only" mode. All gateways can communicate
|' Ly with each other through WiFi. All wired client
2 I . .
Gateway 1 Settings: WDSOnly Mode &/ | hosts within each gateway can also
[Configuration]-[WiFi Configuration] 'y ! . . .
WiFi Operation Mode: WDS Only “‘ (@ ’,’ communicate each other in the scenario. Only
!

j one gateway within repeater chain can be DHCP
server to provide IP for all wired client hosts of
| every gateway which being disabled DHCP
& u 9 server. This gateway can be NAT router to
S et provide internet access
The diagram illustrates that there are two
wireless gateways 2, 3 running at "WDS Only"

Wi-Fi Gateway 1

@ WDS Only Mode
Globe IP:118.18.81.33
Local IP:10.0.75.2

mode. They both use channel 3 to link to local Gateway 1 through WDS. Both gateways connected by WDS need
to setup the remote AP MAC for each other. All client hosts under gateway 2, 3 can request IP address from the
DHCP server at gateway 1. Besides, wireless Gateway 1 also execute the NAT mechanism for all client hosts

Internet accessing.
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WDS Hybrid Mode

Gateway 2/ AP 1 Settings:
[Configuration]-[WiFi Configuration]

WiFi Operation Mode: WDS Hybrid
Lazy Mode: Enable

Multiple AP Names: VAP1
Network ID: Extended-WiFi
Channel: same as Router 1
Authentication: same as Router 1
Encryption: same as Router 1

Key: same as Router 1

/
/
!

Gateway 1 Settings:
[Configuration]-[WiFi Configuration]

|
[
|
|
|
\

\

WiFi Operation Mode: WDS Hybrid
Lazy Mode: Disable

Multiple AP Names: VAP1
Network ID: Extended-WiFi
Channel:3

Authentication: WPA2-PSK
Encryption: AES

Key: 1234567890

\
\

[Configuration]-[Remote AP’s MAC]

Remote AP MAC1: MAC of Router 2
Remote AP MAC2: MAC of AP 1
Remote AP MAC3:

Multiple VAPs

Gateway Settings:

WiFi Operation Mode: AP Route
VAP1

SSID: VAP-1

Authentication: WPA2-PSK
Encryption: TKIP

Key: 1234567890

VAP2

SSID: VAP-2
Authentication: WPA2-PSK
Encryption: TKIP

Key: 1234567890

VAP3

SSID: VAP-3

Authentication: WPA2
Encryption: TKIP

RADIUS Server IP: 192.168.168.
RADIUS Server Port: 1812
RADIUS Shared Key

\

Wi-F}G\ateway

@ WDSH\ybrid
N\

Wi-FiAP 1
(« ))/___@\wos Hybrid

~
~
N
N
\

N\
N\
. WDS Hybrid Mode\\

\ WDS:,

(9

Wi-Fi VAP-1
SSID: VAP-1

Authentication: WPA2-PSK

Encryption: TKIP

RADIUS Server

N

xDSL and/or
4G Cellular

L
AL

DS
)

Wi-Fi Gateway 2
\@ WDS Hybrid
\

Accessible if
VAP Isolation disabled

€ ———— >
WiFi Network
2.46/56 Wi-Fi VAP-2
Wi-i SSID: VAP-2

Authentication: WPA2-PSK
Encryption: TKIP

WiFi Network

Wi-Fi VAP-3
SSID: VAP-3
Authentication: WPA2
Encryption: TKIP

Wireless Gateway
@ AP Router Mode
Dynamic IP Address:
192.168.123.x/24

WDS hybrid mode includes both WDS and AP
Router mode. WDS Hybrid mode can act as
an access point for its WiFi Intranet and a
WiFi bridge for its wired and WiFi Intranets
at the same time. Users can thus use the
features to build up a large wireless network
in a large space like airports, hotels or
campus.

The diagram illustrates Gateway 1, Gateway
2 and AP 1 connected by WDS. Each gateway
has access point function for WiFi client
access. Gateway 1 has DHCP server to assign
IP to each client hosts. All gateways and AP
are under WDS hybrid mode. To setup WDS
hybrid mode, it need to fill all configuration
items similar to that of AP-router and WDS
modes.

VAP (Virtual Access Point) is function to
partition wireless network into multiple
broadcast domains. It can simulate
multiple APs in one physical AP. This
wireless gateway supports up to 8 VAPs.
For each VAP, you need to setup SSID,
authentication and encryption to control
Wi-Fi client access.

Besides, there is a VAP isolation option to
manage the access among VAPs. You can
allow or blocks communication for the
wireless clients connected to different
VAPs. As shown in the diagram, the clients
in VAP-1 and VAP-2 can communicate to
each other when VAP Isolation is disabled.
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Wi-Fi Security - Authentication & Encryption

Wi-Fi Gateway
@ AP Router Mode
Dynamic IP Address:
192.168.123.x/24

RADIUS
Server

Auto
1. None, WEP encryption
2. HEX/ASCIl Key

_________________________

1. WEP encryption
2. HEX/ASCIl Key

_________________________

_________________________

WPA-PSK and WPA2-PSK
1. WPA Personal
2. TKIP, AES, TKIP / AES encryption
WPA and WPA2
1. WPA Enterprise
2. TKIP, AES, TKIP / AES encryption

WPA-PSK / WPA2-PSK
1. Mixed WPA Personal
2. TKIP, AES, TKIP / AES encryption

_________________________

WPA / WPA2
Mixed WPA Enterprise
TKIP, AES, TKIP / AES encryption

Wi-Fi  security  provides complete
authentication and encryption
mechanisms to enhance the data security
while your data is transferred wirelessly
over the air. The wireless gateway
supports Shared, WPA-PSK / WPA2-PSK
and WPA / WPA2 authentication. You can
select one authentication scheme to
validate the wireless clients while they are
connecting to the AP. As to the data
encryption, the gateway supports WEP,
TKIP and AES. The selected encryption
algorithm will be applied to the data while
the wireless connection is established.
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WiFi Configuration Setting

The WiFi configuration allows user to configure 2.4GHz or 5GHz WiFi settings.

Go to Basic Network > WiFi > WiFi Module One Tab. If the gateway is equipped with two WiFi modules, there
will be another WiFi Module Two. You can do the similar configurations on both WiFi modules.

Basic Configuration

# Basic Configuration ' ®

Item Setting

» Operation Band | 2.4G Single Band j

Basic Configuration

Item Value setting \ Description
Specify the intended operation band for the WiFi module.
Basically, this setting is fixed and cannot be changed once the module is integrated
Operation Band A Must filled setting into the product. However, there is some module with selectable band or DBDC bands
for user to choose according to his network environment. Under such situation, you
can specify which operation band is suitable for the application.

Configure WiFi Setting

= 2.4G WiFi Configuration a x
Iltem Setting

» WiFi Module [ Enable

» Channel m @ By AP Numbers ¢ By Less Interference

» WiFi System | 802.11b/g/n Mixed ~|

» WiFi Operation Mode | AP Router Mode |

Configuring Wi-Fi Settings

Item Value setting Description
WiFi Module The box is checked by Check the Enable box to activate WiFi function.
default
Select a radio channel for the VAP. Each channel is corresponding to different radio
1. A Must filled setting. band. The permlss.lble chan'nels depend on t.he Regulatory Domain.
. There are two available options when Auto is selected:
Channel 2. Auto is selected be
default ® By AP Numbers
) The channel will be selected according to AP numbers (The less, the better).
® By Less Interference
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WIiFi System

WiFi Operation
Mode

The channel will be selected according to interference. (The lower, the better).
Specify the preferred WiFi System. The dropdown list of WiFi system is based on
IEEE 802.11 standard.
® 2.4G WiFi can select b, g and n only or mixed with each other.
® 5G WiFi can select a, n and ac only or mixed with each other.

Specify the WiFi Operation Mode according to your application.
Go to the following table for AP Router Mode, WDS Only Mode, and WDS Hybrid
Mode settings.

A Must filled setting

Note: The available operation modes depend on the product specification. For a
certain product, WDS related modes are only available in 2.4G WiFi system.

In the following, the specific configuration description for each WiFi operation mode is given.

Note: If you configured the WiFi Uplink function in the Basic Network > WAN & Uplink > Physical Interface tab,
the WiFi uplink function is activated. However, for the wireless LAN function of the module worked under WiFi
uplink operation, the WiFi Operation Mode is fixed to WiFi Uplink, and also provides AP Router function for
local wireless clients to connect to wireless uplink network via the gateway.

AP Router Mode [WiFi Uplink Mode] & VAPs Configuration

For the AP Router mode, or WiFi Uplink mode, the device not only supports stations connection but also the
router function. The WAN port and the NAT function are enabled.

» WiFi Operation Mode

»

»

»

Green AP
VAP Isolation

Time Schedule

Green AP

VAP Isolation

Profile

Time Schedule

| AP Router Mode  ~|
[ Enable

[v Enable

(0) Always ~ l

The box is unchecked Check the Enable box to activate Green AP function.

by default.

Check the Enable box to activate this function.

By default, the box is checked; it means that stations which associated to different
VAPs cannot communicate with each other.

Check the Enable box to enable the activate profile setting.

The box is checked by
default.

The box is unchecked
by default.

Note: This setting is only available in WiFi Uplink operation mode.

Apply a specific Time Schedule to this rule; otherwise leave it as (0) Always.

A Must filled setting If the dropdown list is empty ensure Time Schedule is pre-configured. Refer to Object
Definition > Scheduling > Configuration tab.
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% 2.4G VAP List m

= R
SSID Authentication Encryption STA Isolation Brosasdlgast Enable Actions
’ 1 ‘VAP1 ‘ Staff_2.4G ‘ WPA2-PSK AES = ~ ‘ M ‘ Edit | select

By default, VAP 1 is enabled and security key is required to connect to the gateway wirelessly to enhance the
security level and prevent unexpected access of un-authorized devices.

The default wifi key is printed on both the device label and the Security Card. It is created randomly and differs
from devices. So, you can connected to the VAP1 (SSID: Staff_2.4G) with the provided key.

However, it is strongly recommanded that you have to change the security key to a easy-to-remember one by
clicking the Edit button.

Click Add / Edit button in the VAP List screen to create or edit the settings for a VAP. A VAP Configuration screen
will appear.

For VAP 1:
« VAP Configuration ’ x
Iltem Setting
» VAP [var1 -]
» SSID [Staff_2.4G
» Max. STA [~ Enable

» Authentication I WPA2-PSK 'I

» Encryption I AES 'I

» Preshared Key |1234567890
» STA Isolation v
» Broadcast SSID v
» Enable =
For others:
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Iltem

» VAP

» SSID

» Max. STA

» Authentication

» Encryption

» STAlsolation

» Broadcast SSID

» Enable

SSID

Max. STA

Authentication

VAP2 ~ |

Setting

ldefault
[~ Enable
Open v |

None ~

777]

1. String format : Any
text

The box is unchecked
by default.

1. A Must filled setting
2. VAP1: WPA2-PSK is
selected be default;
Others: Open is
selected be default.

Enter the SSID for the VAP, and decide whether to broadcast the SSID or not.
The SSID is used for identifying from another AP, and client stations will associate
with AP according to SSID.
Check this box and enter a limitation to limit the maximum number of client
station.
The box is unchecked by default. It means no special limitation on the number of
connected STAs.
For security, there are several authentication methods supported. Client stations
should provide the key when associate with this device.
When Open is selected
The check box named 802.1x shows up next to the dropdown list.
® 802.1x (The box is unchecked by default)
When 802.1x is enabled, it means the client stations will be authenticated by
RADIUS server.
RADIUS Server IP (The default IP is 0.0.0.0)
RADIUS Server Port (The default value is 1812)
RADIUS Shared Key
When Shared is selected
The pre-shared WEP key should be set for authenticating.
When Auto is selected
The device will select Open or Shared by requesting of client automatically.
The check box named 802.1x shows up next to the dropdown list.
® 802.1x (The box is unchecked by default)
When 802.1x is enabled, it means the client stations will be authenticated by
RADIUS server.
RADIUS Server IP (The default IP is 0.0.0.0)
RADIUS Server Port (The default value is 1812)
RADIUS Shared Key
When WPA or WPA2 is selected
They are implementation of IEEE 802.11i. WPA only had implemented part of IEEE
802.11i, but owns the better compatibility.
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Encryption

STA Isolation

Broadcast SSID

Enable

Save
Undo

Apply

1. A Must filled setting.
2.VAP1: AES is
selected be default;
Others: None is
selected be default.

VAP1: The box is
checked by default;
Others: unchecked by
default.

VAP1: The box is
checked by default;
Others: unchecked by
default.

VAP1: The box is
checked by default;
Others: unchecked by
default.

N/A

N/A

N/A

WPA2 had fully implemented 802.11i standard, and owns the highest security.
® RADIUS Server

The client stations will be authenticated by RADIUS server.

RADIUS Server IP (The default IP is 0.0.0.0)

RADIUS Server Port (The default value is 1812)

RADIUS Shared Key
When WPA / WPA2 is selected
It owns the same setting as WPA or WPA2. The client stations can associate with
this device via WPA or WPA2.
When WPA-PSK or WPA2-PSK is selected
It owns the same encryption system as WPA or WPA2. The authentication uses
pre-shared key instead of RADIUS server.
When WPA-PSK / WPA2-PSK is selected
It owns the same setting as WPA-PSK or WPA2-PSK. The client stations can
associate with this device via WPA-PSK or WPA2-PSK.
Select a suitable encryption method and enter the required key(s).
The available method in the dropdown list depends on the Authentication you
selected.
None
It means that the device is open system without encrypting.
WEP
Up to 4 WEP keys can be set, and you have to select one as current key. The key
type can set to HEX or ASCII.
If HEX is selected, the key should consist of (0 to 9) and (A to F).
If ASCII is selected, the key should consist of ASCII table.
TKIP
TKIP was proposed instead of WEP without upgrading hardware. Enter a Pre-
shared Key for it. The length of key is from 8 to 63 characters.
AES
The newest encryption system in WiFi, it also designed for the fast 802.11n high
bitrates schemes. Enter a Pre-shared Key for it. The length of key is from 8 to 63
characters.
You are recommended to use AES encryption instead of any others for security.
TKIP / AES
TKIP / AES mixed mode. It means that the client stations can associate with this
device via TKIP or AES. Enter a Pre-shared Key for it. The length of key is from 8 to
63 characters.
Check the Enable box to activate this function.
By default, the box is checked; it means that stations which associated to the same
VAP cannot communicate with each other.

Check the Enable box to activate this function.
If the broadcast SSID option is enabled, it means the SSID will be broadcasted, and
the stations can associate with this device by scanning SSID.

Check the Enable box to activate this VAP.

Click the Save button to save the current configuration.
Click the Undo button to restore configuration to previous setting before saving.
Click the Apply button to apply the saved configuration.
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WDS Only Mode

For the WDS Only mode, the device only bridges the connected wired clients to another WDS-enabled WiFi
device which the device associated with. That is, it also means the no wireless clients stat can connect to this
device while WDS Only Mode is selected.

» WiFi Operation Mode IWDS Only Mode j
» Green AP [ Enable

» Time Schedule |(O) Always vl

»

Remote AP MAC 1

Remote AP MAC 2

Remote AP MAC 3

Remote AP MAC 4

Scan Remote AP's MAC List ﬂl
|
I
I
|

The box is Check the Enable box to activate Green AP function.
Green AP unchecked by
default.
A Must filled Apply a specific Time Schedule to this rule; otherwise leave it as (0) Always.
Time Schedule If the dropdown list is empty ensure Time Schedule is pre-configured. Refer to Object

setting Definition > Scheduling > Configuration tab.
, Press the Scan button to scan the spatial AP information, and then select one from
Scan Remote AP’s . . . - .
. N/A the AP list, the MAC of selected AP will be auto filled in the following Remote AP
MAC List
MAC table.
Remote AP MAC 1~4 A M'ust filled En.ter the remojce AP’s MAC manually, or via au.to-scan approach, The device will
setting bridge the traffic to the remote AP when associated successfully.
J Add | Delete |
ID VAP ssID Authentication Encryption sTalsolation =~ BrOgtt | Enable Actions
1 | VAP 1 Staff_2.4G WPA2-PSK AES - 2 2l Edit |~ select

By default, VAP 1 is enabled and security key is required to connect to the gateway wirelessly to enhance the
security level and prevent unexpected access of un-authorized devices.

The default wifi key is printed on both the device label and the Security Card. It is created randomly and differs
from devices. So, you can connected to the VAP1 (SSID: Staff_2.4G) with the provided key.

However, it is strongly recommanded that you have to change the security key to a easy-to-remember one by
clicking the Edit button.
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Under WDS Only mode, only VAP1 is available for further specifying the required authentication and Encryption
settings. Click Edit button in the VAP List screen and a VAP Configuration screen will appear for you to configure

the required settings

« VAP Configuration ’ %

Item Setting
» VAP [vap1 -]
» SSID [Staff_2.4G
» Max. STA [~ Enable

» Authentication

I WPA2-PSK ~ I

» Encryption IEEI

» Preshared Key |1234567890
» STAlsolation v

» Broadcast SSID v

» Enable 2

For the detail description about VAP configuration, please refer to the description stated in AP-Router section.
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WDS Hybrid Mode

For the WDS Hybrid mode, the device bridges all the wired LAN and WLAN clients to another WDS or WDS hybrid
enabled WiFi devices which the device associated with.

» WiFi Operation Mode

» Lazy Mode
» Green AP
» VAP Isolation

» Time Schedule

» Scan Remote AP's MAC List

Remote AP MAC 1
Remote AP MAC 2
Remote AP MAC 3
Remote AP MAC 4

Lazy Mode

Green AP

VAP Isolation

Time Schedule

Scan Remote AP’s
MAC List

[~ Enable
[~ Enable
[v Enable

| WDS Hybrid Mode ]

(0) Always vl

_Scan |
I
I
I
I

The box is checked by
default.

The box is unchecked
by default.

The box is checked by
default.

A Must filled setting

Available when Lazy
Mode disabled.

Check the Enable box to activate this function.

With the function been enabled, the device can auto-learn WDS peers without
manually entering other AP’s MAC address. But at least one of the APs has to fill
remote AP MAC addresses.

Check the Enable box to activate Green AP function.

Check the Enable box to activate this function.

By default, the box is checked; it means that stations which associated to different
VAPs cannot communicate with each other.

Apply a specific Time Schedule to this rule; otherwise leave it as (0) Always.

If the dropdown list is empty ensure Time Schedule is pre-configured. Refer to Object
Definition > Scheduling > Configuration tab.

Press the Scan button to scan the spatial AP information, and then select one from
the AP list, the MAC of selected AP will be auto filled in the following Remote AP
MAC table.

Remote AP MAC  Available when Lazy Enter the remote AP’s MAC manually, or via auto-scan approach, The device will
1~4 Mode disabled. bridge the traffic to the remote AP when associated successfully.
J Add | Delete

ID | VAP SSID Authentication Encryption | STA Isolation B‘%"’S‘:B"’S‘ Enable Actions

1 |VAP 1 Staff_2.4G WPA2-PSK AES Edit Select

By default, VAP 1 is enabled and security key is required to connect to the gateway wirelessly to enhance the
security level and prevent unexpected access of un-authorized devices.
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The default wifi key is printed on both the device label and the Security Card. It is created randomly and differs
from devices. So, you can connected to the VAP1 (SSID: Staff_2.4G) with the provided key.

However, it is strongly recommanded that you have to change the security key to a easy-to-remember one by
clicking the Edit button.

Under WDS Hybrid mode, the VAP function is available and you can further specifying the required VAP settings

for connecting with wireless client devices.

Click Add / Edit button in the VAP List screen to create or edit the settings for a VAP. A VAP Configuration screen
will appear.

For VAP 1:
) - X
ltem Setting
» VAP [vap1 -]
» SSID [Staff_2.4G
» Max. STA [~ Enable

» Authentication WPA2-PSK 'I
» Encryption AES 'I

» Preshared Key [1234567890
» STAIsolation v
» Broadcast SSID [v
» Enable 2
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For others:

* VAP Configuration

Item Setting

» VAP VAP2 ~

» SSID [default

» Max. STA [ Enable

» Authentication Open

» Encryption None ~

» STAlsolation -

» Broadcast SSID I

» Enable r

For the detail description about VAP configuration, please refer to the description stated in AP-Router section.
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2.3.2 Wireless Client List

The Wireless Client List page shows the information of wireless clients which are associated with this device.

Go to Basic Network > WiFi > Wireless Client List Tab.

Select Target WiFi

= Target WiFi a x

Item Setting

» Module Select

» Operation Band

N
>
@

<

» Multiple AP Names

Target Configuration

Item Value setting Description

Module Select A Must filled setting. Select the WiFi module to check the information of connected clients.
For those single WiFi module products, this option is hidden.
Specify the intended operation band for the WiFi module.
Basically, this setting is fixed and cannot be changed once the module is
Operation Band A Must filled setting. integrated into the product. quever, .there is some r.nodule with selectable
band for user to choose according to his network environment.
Under such situation, you can specify which operation band is suitable for the
application.
1. A Must filled Specify the VAP to show the associated clients information in the following
. setting. Client List. By default, All VAP is selected.
Multiple AP Names 2. All is selected by
default.

Show Client List

The following Client List shows the information for wireless clients that is associated with the selected VAP(s).

IP Address
Configuration &
Address

Host Name MAC Address Signal | Interface

Target Configuration

Item Value setting Description

IP Address It shows the Client’s IP address and the deriving method.

Configuration & N/A Dynamic means the IP address is derived from a DHCP server.

Address Static means the IP address is a fixed one that is self-filled by client.
Host Name N/A It shows the host name of client.

MAC Address N/A It shows the MAC address of client.

Mode N/A :es\zg:./s what kind of Wi-Fi system the client used to associate with this
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Rate

RSSIO, RSSI1
Signal
Interface
Refresh

N/A
N/A
N/A
N/A
N/A

It shows the data rate between client and this device.

It shows the RX sensitivity (RSSI) value for each radio path.
The signal strength between client and this device.

It shows the VAP ID that the client associated with.

Click the Refresh button to update the Client List immediately.
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2.3.3 Advanced Configuration

This device provides advanced wireless configuration for professional user to optimize the wireless performance
under the specific installation environment. Please note that if you are not familiar with the WiFi technology,
just leave the advanced configuration with its default values, or the connectivity and performance may get worse

with improper settings.

Go to Basic Network > WiFi > Advanced Configuration Tab.

Select Target WiFi
® Target WiFi

Item

Setting

» Module Select

» Operation Band

24G v

Target Configuration

Item Value setting Description

Module Select A Must filled setting.

Select the WiFi module to check the information of connected clients.
For those single WiFi module products, this option is hidden.

Operation Band A Must filled setting.

Specify the intended operation band for the WiFi module.

Basically, this setting is fixed and cannot be changed once the module is
integrated into the product. However, there is some module with selectable
band for user to choose according to his network environment.

Setup Advanced Configuration

#* Advanced Configuration

Item

Setting

» Regulatory Domain

(36, 40, 44, 48,52, 56, 60, 64, 149, 153, 157, 161, 165)

» Beacon Interval

Range: (1~1000 msec)

» DTIM Interval

Range: (1~255)

Ii

» RTS Threshold

Range: (1~2347)

» Fragmentation

2346 Range: (256~2346)

» WMM Enable

» Short GI

» TX Rate %
» RF Bandwidth

» Transmit Power
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» 5G Band Steering
» WIDS

» Dynamic Frequency Selection

» Associate RSSI Threshold

Regulatory Domain

Beacon Interval

DTIM Interval

RTS Threshold

Fragmentation

WMM

Short Gl

TX Rate
RF Bandwidth

Transmit Power

5G Band Steering

WIDS

Dynamic Frequency
Selection

(] Enable
(] Enable
Enable

-’o

The default setting is
according to where
the product sale to

1. A Must filled
setting.

2. 100 is set by default

1. A Must filled
setting.
2. 3 is set by default

1. A Must filled
setting.

2. 2347 is set by
default

1. A Must filled
setting.

2. 2346 is set by
default

The box is checked by
default

By default 400ns is
selected

By default Best is
selected

By default Auto is
selected

By default 100% is
selected

The box is unchecked
by default

The box is unchecked
by default

The box is checked by
default

Range: (0~-100 dBm)

It limits the available radio channel of this device.
The permissible channels depend on the Regulatory Domain.

It shows the time interval between each beacon packet broadcasted.
The beacon packet contains SSID, Channel ID and Security setting.

Value Range: 1 ~ 1000 msec.

A DTIM (Delivery Traffic Indication Message) is a countdown informing
clients of the next window for listening to broadcast message. When the
device has buffered broadcast message for associated client, it sends the
next DTIM with a DTIM value.

Value Range: 1 ~ 255.

RTS (Request to send) Threshold means when the packet size is over the
setting value, then active RTS technique.

RTS/CTS is a collision avoidance technique.

It means RTS never activated when the threshold is set to 2347.

Value Range: 1~ 2347.

Wireless frames can be divided into smaller units (fragments) to improve
performance in the presence of RF interference at the limits of RF coverage.
Value Range: 256 ~ 2346.

WMM (WiFi Multimedia) can help control latency and jitter when
transmitting multimedia content over a wireless connection.

Short Gl (Guard Interval) is defined to set the sending interval between
each packet. Note that lower Short Gl could increase not only the transition
rate but also error rate.

It means the data transition rate. When Best is selected, the device will
choose a proper data rate according to signal strength.

The setting of RF bandwidth limits the maximum data rate.

Normally the wireless transmitter operates at 100% power. By setting the
transmit power to control the WiFi coverage.

When the client station associate with 2.4G WiFi, the device will send the
client to 5G WiFi automatically if the client is available on accessing this 5G
WiFi band.

This option is only available on the module that supports 5GHz band.

The WIDS (Wireless Intrusion Detection System) will analyze all packets and
make a statistic table in WiFi status.

Go to Status > Basic Network > WiFi tab for detailed WIDS status.

Dynamic Frequency Selection (DFS) is a legally required feature for all WiFi
devices that share the 5 GHz band with radar.

DFS enables a gateway to detect radar signals and switch their operating
frequency to prevent interference. This process ensures that radar systems
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Associate RSSI
Threshold

Save

Undo

1. A Must filled
setting.
2.0is set by default

N/A
N/A

send and receive accurate information.

Note: Dynamic Frequency Selection (DFS) option is only available for the
WiFi module with 5GHz radio.

Specify a connection threshold for the RSSI value. If the RSSI of the WiFi
client is less than the threshold, it would be rejected to associate with the
AP. And if the average RSSI value while data transmission is less than the
threshold, the connection would be disconnected directly.

The default value 0 means disable the RSSI threshold checking function.
Value Range: 0 ~ -100 dBm.

Click the Save button to save the current configuration.

Click the Undo button to restore configuration to previous setting before
saving.
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2.3.4 Uplink Profile

This device provides WiFi Uplink function for connecting to a wireless access point just like connected to a wired
WAN or cellular WAN connection. It can operate as a NAT gateway and link the devices wirelessly to the uplink

network or hosts.

To connect to the wireless access point, user has to enable the wireless Uplink function for a certain WiFi Module
(refer to Basic Network > WAN & Uplink > Physical Interface, Internet Setup tabs) first, and then configure the
Uplink profile(s) for the access point to be connected to in the Uplink Profile page.

Go to Basic Network > WiFi > Uplink Profile tab for configuring the Uplink Profile page.

Uplink Profile Setting

"

’

i3

&

’

Item

Profile

Module Select
Operation Band
Priority

Current Profile

Profile

Module Select

Operation Band

Priority

Current Profile

Enable
One v

24G v

Setting

e By Signal Strength By User-defined

1. A Must filled
setting.

2. Unchecked by
default.

A Must filled setting.

A Must filled setting.

1. A Must filled
setting.

2. By Signal Strength
is selected by default.

N/A

Check the Enable box to activate the profile function.
It is available only when the selected WiFi module is configured at WiFi Uplink
mode.

Select the WiFi module to check or configure the expected uplink profile(s).
For those single WiFi module products, this option is hidden.

Specify the intended operation band for the WiFi module.

Basically, this setting is fixed and cannot be changed once the module is
integrated into the gateway product. However, there are some module with
selectable band for user to choose according to his network environment.
Under such situation, you can specify which operation band is suitable for the
application.

Specify the network selection methodology for connectin to an available wireless
uplink network. It can be By Signal Strength or By User-defined priority.

When By Signal Strength is selected, the gateway will try to connect to the available
uplink network whose wireless signal strength is the strongest.

When By User-defined is selected, the gateway will try to connect to the available
uplink network whose priority is the highest (1 is the highest priority, and 16 is the
lowest priority).

After enabling Profile and connecting by a certain uplink profile, the profile name will
be displayed.
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Note: to apply the defined Uplink profile(s) for the gateway to find a best fit profile for connecting to a certain
uplink network, user has to Enable the Profile auto-connect function (Refer to Basic Network > WiFi >
(Module 1/ Module 2) WiFi Configuration tab.

Create/Edit Uplink Profile

ID

Add

Profile
Name

Delete

SSID

Channel Authentication Encryption MAC Address

Get Signal Strength

Signal

Strength Actions

Priority Enable

The Profile List shows the settings for the created uplink profiles. The information includes Profile Name, SSID,
Channel, Authentication, Encryption, MAC Address, Signal Strength, Priority, and Enable.

When Add button is applied, Profile Configuration screen will appear.

Item

Prafile Name
Network 1D (SSID)
Channel
Authentication
Encryption

MAC Address
Priority

Enahle

Profile Name

Network ID (SSID)

Channel

Auto v
Open

None v

1. String format can
be any text
2. A Must filled setting

1. String format : Any
text

2. The box is checked
by default.

1. A Must filled
setting.

2. Auto is selected by
default.

Setting

Scan

Enter a profile name for the uplink network specified below. It is a name that

is easy for you to understand.
Value Range: 1 ~ 64 characters.
Enter the SSID for the VAP, and decide whether to broadcast the SSID or not.
The SSID is used for identifying from another AP, and client stations will
associate with AP according to SSID. If the broadcast SSID option is enabled, it
means the SSID will be broadcasted, and the stations can associate with this
device by scanning SSID.
Select a radio channel for the VAP. Each channel is corresponding to different
radio band. The permissible channels depend on the Regulatory Domain.
There are two available options when Auto is selected:
() By AP Numbers

The channel will be selected according to AP numbers (The less, the
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Authentication

Encryption

MAC Address

Priority

Enable
Save

Undo

Back

Instead of manually enter the information for the uplink network, you can alslo click the Scan button to get the

1. A Must filled setting
2. Open is selected by
default.

1. A Must filled
setting.

2. None is selected by
default.

1. MAC Address string
Format

2. A Must fill setting
1. An Optional filled
setting.

2. 16 is set by default.

The box is checked by
default.
N/A

N/A

N/A

better).
( By Less Interference
The channel will be selected according to interference. (The lower, the
better).
Specify the authentication method for connecting with the uplink network. It
can be Open, Shared, WPA-SPK, or WPA2-PSK.
When Open is selected, the preshared WEP key could be set for
authentication;
When Shared is selected, the preshared WEP key should be set for
authentication;
When WPA-PSK or WPA2-PSK is selected, The the TKIP or AES preshared key
should be set for authentication;
Select a suitable encryption method and enter the required key(s).
The available method in the dropdown list depends on the Authentication you
selected.
None
It means that the device is open system without encrypting.
WEP
Up to 4 WEP keys can be set, and you have to select one as current key. The
key type can set to HEX or ASCII.
If HEX is selected, the key should consist of (0 to 9) and (A to F).
If ASCII is selected, the key should consist of ASCII table.
TKIP
TKIP was proposed instead of WEP without upgrading hardware. Enter a
Preshared Key for it. The length of key is from 8 to 63 characters.
AES
The newest encryption system in WiFi, it also designed for the fast 802.11n
high bitrates schemes. Enter a Preshared Key for it. The length of key is from 8
to 63 characters.
You are recommended to use AES encryption instead of any others for
security.

Specify the MAC Address of the access point (with the Network ID) to be
connected to.

Specify a priority setting for the uplink profile when the By User-defined
methodology is selected. The priority value can be 1 ~ 16. 1 is the highest
priority, and 16 is the lowest priority).

Click the Enable box to activate this profile.

Click the Save button to save the configuration.

Click the Undo button to restore what you just configured back to the
previous setting.

When the Back button is clicked, the screen will return to the Profile List
page.

available wireless networks around the device, and select one as the uplink network.

When the Scan button is applied, Wireless AP List will appear after few seconds.
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= Wireless AP List

SSID Channel Quality Authentication Encryption MAC Address Select
Guest_2.4G 1 86% None 02:50:78:56:79:15 @)
WIN 1 100% WPA2-PSK AES 00:60:64:cb:f5:f6 Q
amit02 1 63% WPA2-PSK AES 00:50:18:21:e2:17 @)
Guest_2.4G 1 5% None 1a:50:18:33:55:66 @)
lan test_24 1 1 86% WPA2-PSK AES 00:50:18:56:79:15 @)
lan test_24 3 1 89% WPA2-PSK AES 02:50:28:56:79:15 @)
lan test_24 5 1 86% WPA2-PSK AES 02:50:48:56:79:15 Q
lan test_24 7 1 86% WPA2-PSK AES 02:50:68:56:79:15 Q

Once you selected an AP from the AP list, the channel, SSID, Authentication, Encryption, and MAC address will
be automatically filled into the profile, you just have to enter a key for the uplink connection, if required.
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2.4 IPv6

The growth of the Internet has created a need for more addresses than are possible with IPv4. IPv6 (Internet
Protocol version 6) is a version of the Internet Protocol (IP) intended to succeed IPv4, which is the protocol
currently used to direct almost all Internet traffic. IPv6 also implements additional features not present in IPv4.
It simplifies aspects of address assignment (stateless address auto-configuration), network renumbering and
router announcements when changing Internet connectivity providers.

2.4.1 IPv6 Configuration

Pve « Main IPv6 Configuration -
Configuration tem Setting

» Main IPv6 Enable

» WAN Connection Type DHCPv6 v

* Main DHCPv6 WAN Type Configuration

Item Setting

» DNS @® From Server () Specific DNS

» Primary DNS

» Secondary DNS

xxx WAN Type
Configuration

» MLD Snooping [T Enable

* Main Address Auto-configuration vix

WAN Connection

Option * Failover IPv6 Configuration lx
Item Setting
» Failover IPv6 Enable
Configuration
» WAN Connection Type DHCPv6 v

Address Auto-
Configuration

* Failover DHCPv6 WAN Type Configuration

* Failover Address Auto-configuration viIx

The IPv6 Configuration setting allows user to set the IPv6 connection type to access the IPv6 network. This
gateway supports various types of IPv6 connection, including Static IPv6, DHCPv6, and PPPoEv6

Note: The available WAN connection types can be different, depending on the Interface type of WAN.
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IPv6 WAN Connection Type

Static IPv6

Static IPv6 does the same function as static IPv4. The static IPv6 provides manual setting of IPv6 address, IPv6
default gateway address, and IPv6 DNS.

ISP IP:2001:470:871¢::100 /64
DNS 1: 2001:470:20::2 Gateway
M DNS 2: 209A.4860:4860€B888
.
—————— e, .— — \\\
2
2001:470:871c=5 xDSL Modem \-\
Primary D) 10.0.75.2)8
Server — 2001:470§871:50ff::75:2 /64
2001:470:207
Secondary @ |
Server Q
2001:470:20:6 ‘ : : NI

o1 Intranet

Above diagram depicts the IPv6 IP addressing, type in the information provided by your ISP to setup the IPv6
network.

DHCPv6

DHCP in IPv6 does the same function as DHCP in IPv4. The DHCP server sends IP address, DNS server addresses
and other possible data to the DHCP client to configure automatically. The server also sends a lease time of the
address and time to re-contact the server for IPv6 address renewal. The client has then to resend a request to
renew the IPv6 address.

DNS 1:2001:470:20::2

ISP DNS 2:2001:4860:4860::8888
2001:47p:871c::5 xDSL Modem

PrimaryD 10.0.75.2/8
Serve s 2001:470:871c:50QLd:250:18ff:fe21:deea/6

T BQE

Carvar

Above diagram depicts DHCP IPv6 IP addressing, the DHCPv6 server on the ISP side assigns IPv6 address, IPv6
default gateway address, and IPv6 DNS to client host’s automatically.
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PPPoEv6

PPPOEV6 in IPv6 does the same function as PPPoE in IPv4. The PPPoEV6 server provides configuration parameters
based on PPPoEV6 client request. When PPPoEV6 server gets client request and successfully authenticates it, the
server sends IP address, DNS server addresses and other required parameters to automatically configure the
client.

GOt IFV Jul.4/U.0/4C L4

DNS 1:2001:470:20::2

ISP DNS 2:2001:4860:4860::8888
M
—_— [ ._ @ . ateway
- 2001:479:871c::5 xDSL Modem

PrimaryD 10.0.75.2 /8
Serve i ' 2001:470:871c:500d:250:18ff:fe21:deea/6

= B

Coarver

The diagram above depicts the IPv6 addressing through PPPoE, PPPoEV6 server (DSLAM) on the ISP side provides
IPv6 configuration upon receiving PPPoEv6 client request. When PPPoEv6 server gets client request and
successfully authenticates it, the server sends IP address, DNS server addresses and other required parameters
to automatically configure the client.
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IPv6 Configuration Setting

Go to Basic Network > IPv6 > Configuration Tab.
The IPv6 Configuration setting allows user to set the IPv6 connection type to access the IPv6 WAN network.

The device provides two types of IPv6 connections, one is for the Main IPv6 connection through the main
(always-on) WAN, and the other is for Failover IPv6 connection through the Failover WAN. You have to configure
the Main IPv6 related configurations first, and then configure the Failover parts if required.

Item Setting
» Main IPv6 (] Enable

» WAN Connection Type

IPv6 The box is unchecked Check the Enable box to activate the Main IPv6 function.
by default,
Define the selected IPv6 WAN Connection Type to establish the IPv6
connectivity via Main / Failover WAN Interface.
The available WAN connection type are Static IPvé, DHCPv6, PPPoOEV6, or just

IPv6.

1. A Must filled setting
WAN Connection 2. DHCPv6 is selected
Type by default

Select Static IPv6 when your ISP provides you with a set IPv6 addresses.
Select DHCPv6 when your ISP provides you with DHCPV6 services.

Select PPPoEv6 when your ISP provides you with PPPoEv6 account settings.
Select IPv6 when your ISP provides you with IPv6 (DHCPv6) services.

Note: The available WAN connection types can be different, depending on the
Interface type of corresponding WAN.

Static IPv6 WAN Type Configuration

105



5G WAN Extender

* Main Static IPv6 WAN Type Configuration -

Item

Setting

» |Pv6 Address

» Subnet Prefix Length

» Default Gateway

» Primary DNS

» Secondary DNS

» MLD Snooping

I
I
I
[C] Enable

Static IPv6 WAN Type Configuration

Item

Value setting

Description

IPv6 Address A Must filled setting Enter the WAN IPv6 Address for the router.
f::;;‘t Prefix A Must filled setting Enter the WAN Subnet Prefix Length for the router.
Default Gateway A Must filled setting Enter the WAN Default Gateway IPv6 address.
Primary DNS An optional setting Enter the WAN primary DNS Server.
Secondary DNS An optional setting Enter the WAN secondary DNS Server.

. The box is unchecked . . .
MLD Snooping by default Enable/Disable the MLD Snooping function

DHCPv6 WAN Type Configuration

* Main DHCPv6 WAN Type Configuration -

Item Setting
» DNS (@ From Server () Specific DNS
» Primary DNS
» Secondary DNS
» MLD Snooping (] Enable
DHCPv6 WAN Type Configuration
Item Value setting Description
The optIon [From Select the [Specific DNS] option to active Primary DNS and Secondary DNS.
DNS Server] is selected by ) . h
Then fill the DNS information.
default
Primary DNS Can not modified by Enter the WAN primary DNS Server.
default
Secondary DNS s:?a:?ct modified by Enter the WAN secondary DNS Server.
The box is unchecked . . .
MLD by default Enable/Disable the MLD Snooping function
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PPPoEv6 WAN Type Configuration

Item Setting
» Account | I
» Password | |

» Service Name

» Connection Control

Auto-reconnect (Always on)

» MTU

LI

» MLD Snooping

[C] Enable

PPPoEv6 WAN Type Configuration

Item Value setting Description
Enter the Account for setting up PPPoEv6 connection. If you want more
Account A Must filled setting information, please contact your ISP.
Value Range: 0 ~ 45 characters.
i PPPoE ion. If
Password A Must filled setting Enter the Password for setting up PPPoEv6 connection. If you want more

information, please contact your ISP.

Enter the Service Name for setting up PPPoEv6 connection. If you want more

A Must fill . -
Service Name settil:1$t/(l) et(ijon information, please contact your ISP.
&/op Value Range: 0 ~ 45 characters.
Connection Control  Fixed value The value is Auto-reconnect(Always on).

Enter the MTU for setting up PPPoEv6 connection. If you want more

MTU A Must filled setting information, please contact your ISP.
Value Range: 1280 ~ 1492.
Th i heck . .
MLD Snooping e boxis unchecked Enable/Disable the MLD Snooping function

by default

Address Auto-configuration

« Main Address Auto-configuration ’ ®
Item Setting
» Auto-configuration Enable

» Auto-configuration Type

» Router Advertisement Lifetime

(seconds)

_Address Auto-configuration
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X . The box is unchecked . .
Auto-configuration Check to enable the Auto configuration feature.
by default
Define the selected IPv6 WAN Connection Type to establish the IPv6
connectivity.
Select Stateless to manage the Local Area Network to be SLAAC + RDNSS
Router Advertisement Lifetime (A Must filled setting): Enter the Router
Advertisement Lifetime (in seconds). 200 is set by default.

Value Range: 0 ~ 65535.

1. Only can be Select Stateful to manage the Local Area Network to be Stateful (DHCPv6).
selected when Auto- IPv6 Address Range (Start) (A Must filled setting): Enter the start IPv6 Address

Auto-configuration
& configuration enabled for the DHCPv6 range for your local computers. 0100 is set by default.

Type
2. Stateless is selected  Value Range: 0001 ~ FFFF.

by default
IPv6 Address Range (End) (A Must filled setting): Enter the end IPv6 Address
for the DHCPv6 range for your local computers. 0200 is set by default.
Value Range: 0001 ~ FFFF.

IPv6 Address Lifetime (A Must filled setting): Enter the DHCPv6 lifetime for

your local computers. 36000 is set by default.
Value Range: 0 ~ 65535.

If above settings are configured, click the save button to save the configuration.
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2.5 Port Forwarding

Network address translation (NAT) is a methodology of remapping one IP address space into another by
modifying network address information in Internet Protocol (IP) datagram packet headers while they are in
transit across a traffic routing device. The technique was originally used for ease of rerouting traffic in IP
networks without renumbering every host. It has become a popular and essential tool in conserving global
address space allocations in face of IPv4 address exhaustion. The product you purchased embeds and activates
the NAT function. You also can disable the NAT function in [Basic Network]-[WAN & Uplink]-[Internet Setup]-
[WAN Type Configuration] page.

W Virtual Server & Virtual Computer Special AP & ALG DMZ & Pass Through Midgek

- WAN & Uplink Item Setting
- LAN & VLAN » NAT Loophack ) Enable

Wil | Save | Lo |

- IPv6

© Port Forwarding

- Routing

- DNS & DDNS A
Usually all local hosts or servers behind corporate gateway are protected by NAT firewall. NAT firewall will filter
out unrecognized packets to protect your Intranet. So, all local hosts are invisible to the outside world. Port
forwarding or port mapping is function that redirects a communication request from one address and port
number combination to assigned one. This technique is most commonly used to make services on a host residing
on a protected or masqueraded (internal) network available to hosts on the opposite side of the gateway
(external network), by remapping the destination IP address and port number
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2.5.1 Configuration

NAT Loopback

This feature allows you to access the WAN global IP address from your inside NAT local network. It is useful
when you run a server inside your network. For example, if you set a mail server at LAN side, your local devices
can access this mail server through gateway’s global IP address when enable NAT loopback feature. On either
side are you in accessing the email server, at the LAN side or at the WAN side, you don’t need to change the IP
address of the mail server.

Configuration Setting

Go to Basic Network > Port Forwarding > Configuration tab.

The NAT Loopback allows user to access the WAN IP address from inside your local network.

Enable NAT Loopback

= NAT Loopback .

Item Setting

» NAT Loopback Enahle

Configuration

Item \ Value setting Description

NAT Loopback The box is checked by default ~ Check the Enable box to activate this NAT function
Save N/A Click the Save button to save the settings.

Undo N/A Click the Undo button to cancel the settings
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2.5.2 Virtual Server & Virtual Computer

« Configuration a =
ltem Setting

» Virtual Server () Enable

» Virtual Computer (¥ Enable

OR'THESPITEY Add [l Delete |

Server IP

Private
Port

Source IP Protocol | Public Port Time Schedule | Enable

Global IP

There are some important Pot Forwarding functions implemented within the gateway, including "Virtual Server",
"NAT loopback" and "Virtual Computer".

It is necessary for cooperate staffs who travel outside and want to access various servers behind office gateway.
You can set up those servers by using "Virtual Server" feature. After trip, if want to access those servers from
LAN side by global IP, without change original setting, NAT Loopback can achieve it.

"Virtual computer" is a host behind NAT gateway whose IP address is a global one and is visible to the outside
world. Since it is behind NAT, it is protected by gateway firewall. To configure Virtual Computer, you just have to
map the local IP of the virtual computer to a global IP.
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Virtual Server & NAT Loopback

Network-A

" Gateway
Global IP:118.18.81.33

a”@

Remote User

1.Configure E-mail Server (10.0.75.101) |

as a Virtual Server. ‘
2.Remote User access E-mail Server

with Gateway Global IP (118.18.81.33). Garaivsefver
3.With NAT Loopback enabled, Local

User can access local E-mail Server

with Global IP (118.18.81.33) as well.

Local User
10.0.75.100

File Server
Global IP: 118.18.81.44
Local IP: 10.0.75.102

"Virtual Server" allows you to access servers with the
global IP address or FQDN of the gateway as if they are
servers existed in the Internet. But in fact, these servers
are located in the Intranet and are physically behind the
gateway. The gateway serves the service requests by port
forwarding the requests to the LAN servers and transfers
the replies from LAN servers to the requester on the WAN
side. As shown in example, an E-mail virtual server is
defined to be located at a server with IP address
10.0.75.101 in the Intranet of Network-A, including SMTP
service port 25 and POP3 service port 110. So, the remote
user can access the E-mail server with the gateway’s global

IP 118.18.81.33 from its WAN side. But the real E-mail server is located at LAN side and the gateway is the port

forwarder for E-mail service.

NAT Loopback allows you to access the WAN global IP address from your inside NAT local network. It is useful
when you run a server inside your network. For example, if you set a mail server at LAN side, your local devices
can access this mail server through gateway’s global IP address when enable NAT loopback feature. On either
side are you in accessing the email server, at the LAN side or at the WAN side, you don’t need to change the IP

address of the mail server.

Virtual Computer

Network-A" .
Gateway
Global IP:118.18.81.33
ocal IP:10.0.75.2

=

Local User
10.0.75.100

Remote User

1. Configure File Server as a Virtual
Computer by Global IP (118.18.81.44). |
2. Remote User access File Serverasby !

global IP (118.18.81.44) directly

E-mail Server |3
10.0.75.101 |°

File Server
Global IP: 118.18.81.44
Local IP: 10.0.75.102

"Virtual Computer" allows you to assign LAN hosts to
global IP addresses, so that they can be visible to outside
world. While so, they are also protected by the gateway
firewall as being client hosts in the Intranet. For example,
if you set a FTP file server at LAN side with local IP address
10.0.75.102 and global IP address 118.18.82.44, a remote
user can access the file server while it is hidden behind the
NAT gateway. That is because the gateway takes care of
all accessing to the IP address 118.18.82.44, including to
forward the access requests to the file server and to send
the replies from the server to outside world.
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Virtual Server & Virtual Computer Setting

Go to Basic Network > Port Forwarding > Virtual Server & Virtual Computer tab.

Enable Virtual Server and Virtual Computer

« Configuration ’ =
Item Setting

» Virtual Server [CJ Enable

» Virtual Computer [ Enable

Configuration

Item Value setting Description
. The box is unchecked b
Virtual Server default Y Check the Enable box to activate this port forwarding function
efau
. The box is checked b
Virtual Computer default Y Check the Enable box to activate this port forwarding function
efau
Save N/A Click the Save button to save the settings.
Undo N/A Click the Undo button to cancel the settings.

Create / Edit Virtual Server

The gateway allows you to custom your Virtual Server rules. It supports up to a maximum of 20 rule-based Virtual
Server sets.

« Virtual Server List [[X10 [RECCY

WAN Interface

Private
Port

Server IP Source IP Protocol | Public Port Time Schedule | Enable

When Add button is applied, Virtual Server Rule Configuration screen will appear.
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v

WAN Interface

v

Server IP

v

Source IP

» Protocol

v

Public Port

v

Private Port

v

Time Schedule

» Rule

Item

Setting

v Al WAN-1 WAN-2 WAN-3

Any v
TCP(6) & UDP(17) v
Single Port v
Single Port v
(0) Always v

Enable

WAN Interface

Server IP

Source IP

Protocol

Define the selected interface to be the packet-entering interface of the

gateway.

If the packets to be filtered are coming from WAN-x then select WAN-x for
1. A Must filled setting this field.
2. Default is ALL. Select ALL for packets coming into the gateway from any interface.

It can be selected WAN-x box when WAN-x enabled.

Note: The available check boxes (WAN-1 ~ WAN-4) depend on the number of

WAN interfaces for the product.

. . This field is to specify the IP address of the interface selected in the WAN

A Must filled setting .
Interface setting above.

This field is to specify the Source IP address.

1. A Must filled setting Select Any to allow the access coming from any IP addresses.

2. By default Any is Select Specific IP Address to allow the access coming from an IP address.

selected Select IP Range to allow the access coming from a specified range of IP
address.

When “ICMPv4” is selected

It means the option “Protocol” of packet filter rule is ICMPv4.

Apply Time Schedule to this rule, otherwise leave it as Always. (refer to
Scheduling setting under Object Definition)

Then check Enable box to enable this rule.

1. A Must filled setting When “TCP” is selected
2. TCP & UDP is selected It means the option “Protocol” of packet filter rule is TCP.
by default. Public Port selected a predefined port from Well-known Service, and Private

Port is the same with Public Port number.

Public Port is selected Single Port and specify a port number, and Private Port
can be set a Single Port number.

Public Port is selected Port Range and specify a port range, and Private Port
can be selected Single Port or Port Range.

Value Range: 1 ~ 65535 for Public Port, Private Port.
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When “UDP” is selected

It means the option “Protocol” of packet filter rule is UDP.

Public Port selected a predefined port from Well-known Service, and Private
Port is the same with Public Port number.

Public Port is selected Single Port and specify a port number, and Private Port
can be set a Single Port number.

Public Port is selected Port Range and specify a port range, and Private Port
can be selected Single Port or Port Range.

Value Range: 1 ~ 65535 for Public Port, Private Port.

When “TCP & UDP” is selected

It means the option “Protocol” of packet filter rule is TCP and UDP.

Public Port selected a predefined port from Well-known Service, and Private
Port is the same with Public Port number.

Public Port is selected Single Port and specify a port number, and Private Port
can be set a Single Port number.

Public Port is selected Port Range and specify a port range, and Private Port
can be selected Single Port or Port Range.

Value Range: 1 ~ 65535 for Public Port, Private Port.

When “GRE” is selected
It means the option “Protocol” of packet filter rule is GRE.

When “ESP” is selected
It means the option “Protocol” of packet filter rule is ESP.

When “SCTP” is selected
It means the option “Protocol” of packet filter rule is SCTP.

When “User-defined” is selected
It means the option “Protocol” of packet filter rule is User-defined.
For Protocol Number, enter a port number.

1. An optional filled
i P Apply Time Schedule to this rule; otherwise leave it as (0) Always. (refer to
setting

Time Schedule Scheduling setting under Object Definition)
2. (0) Always Is selected

by default.
1. An optional filled

setting

Rule Check the Enable box to activate the rule.

2.The box is unchecked by
default.
Save N/A Click the Save button to save the settings.
Undo N/A Click the X button to cancel the settings and return to previous page.
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Create / Edit Virtual Computer

The gateway allows you to custom your Virtual Computer rules. It supports up to a maximum of 20 rule-based
Virtual Computer sets.

« Virtual Computer List [EX2)

Global IP

Local IP

Enable

Actions

When Add button is applied, Virtual Computer Rule Configuration screen will appear.

Global IP Local IP Enable
| | | | =
Virtual Computer Rule Configuration
Item Value setting Description
Global IP A Must filled setting This field is to specify the IP address of the WAN IP.
Local IP A Must filled setting This field is to specify the IP address of the LAN IP.
Enable N/A Then check Enable box to enable this rule.
Save N/A Click the Save button to save the settings.
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2.5.3 DMZ & Pass Through

DMZ (De Militarized Zone) Host is a host that is exposed to the Internet cyberspace but still within the protection
of firewall by gateway device. So, the function allows a computer to execute 2-way communication for Internet
games, Video conferencing, Internet telephony and other special applications. In some cases when a specific
application is blocked by NAT mechanism, you can indicate that LAN computer as a DMZ host to solve this

problem.

The DMZ function allows you to ask the gateway pass through all normal packets to the DMZ host behind the
NAT gateway only when these packets are not expected to receive by applications in the gateway or by other
client hosts in the Intranet. Certainly, the DMZ host is also protected by the gateway firewall. Activate the
feature and specify the DMZ host with a host in the Intranet when needed.

Item

¢ Enahle

+ DMz DMZ Host :

» Pass Through Enahle v IPSec
DMZ Scenario

Global IP:118.18.81.33

Local IP:10.0.75.2
/ Gateway
& —

Remote User 2

1.Set X Server as DMZ Host

2.Request X server service by Gateway Global IP
3.Gateway redirect service request to DMZ host:
10.0.75.100

v Al

10.0.75.100
¢ PPTP @ L2TP

X Server

Setting
AN-2 WWAN-3 WAN-4

When the network administrator wants to set up
some service daemons in a host behind NAT
gateway to allow remote users request for services
from server actively, you just have to configure this
host as DMZ Host. As shown in the diagram, there is
an X server installed as DMZ host, whose IP address
is 10.0.75.100. Then, remote user can request
services from X server just as it is provided by the
gateway whose global IP address is 118.18.81.33.
The gateway will forward those packets, not
belonging to any configured virtual server or
applications, directly to the DMZ host.
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VPN Pass through Scenario

Network-A @ HQ Data Center Gateway without
VPN Pass Through
l%\‘ Rs
N R ACS
E,\‘ & server
N Fail to establish VPN tunnel
Application —— -
Server N fDatabase | e mm =TT
W server 4+ = 7
’
l L.
\ “
| 5
PR VPN Tunnel
SecurityGatewayl = = = = = = = = = = = = = = = = = = =
Establish VPN tunnel Gateway with

with a “StaticIP”
successfully

Global IP: 203.95.80.22
Local IP: 10.0.76.2

DMZ & Pass Through Setting

Since VPN traffic is different from that of TCP or
UDP connection, it will be blocked by NAT gateway.
To support the pass through function for the VPN
connections initiating from VPN clients behind NAT
gateway, the gateway must implement some kind
of VPN pass through function for such application.
The gateway support the pass through function for
IPSec, PPTP, and L2TP connections, you just have to
check the corresponding checkbox to activate it.

VPN Pass Through behind NAT Gateway

Go to Basic Network > Port Forwarding > DMZ & Pass Through tab.

The DMZ host is a host that is exposed to the Internet cyberspace but still within the protection of firewall by

gateway device.

Enable DMZ and Pass Through

Item

Enable All

> DMZ DMZ Host -

» Pass Through Enable v IPSec

DMZ 1. A Must filled setting

2. Default is ALL.

Setting

WWAN-1 WVWAN-2 WVWAN-3 AN-4

¥ PPTP @ L2TP

Check the Enable box to activate the DMZ function
Define the selected interface to be the packet-entering interface of the
gateway, and fill in the IP address of Host LAN IP in DMZ Host field

If the packets to be filtered are coming from WAN-x then select WAN-x
for this field.

Select ALL for packets coming into the router from any interfaces.

It can be selected WAN-x box when WAN-x enabled.
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Pass Through Enable

Save
Undo

The boxes are checked by
default

N/A
N/A

Note: The available check boxes (WAN-1 ~ WAN-4) depend on the
number of WAN interfaces for the product.

Check the box to enable the pass through function for the IPSec, PPTP,
and L2TP.

With the pass through function enabled, the VPN hosts behind the
gateway still can connect to remote VPN servers.

Click the Save button to save the settings.

Click the Undo button to cancel the settings
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2.5.4 Special AP & ALG (not supported)

Not supported feature for the purchased product, leave it as blank.
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2.5.5 IP Translation

IP Translation is slimier to One-to-One NAT. it is a feature where you can configure the gateway with multiple
IP addresses issued by your Internet Service Provider (ISP) and map them to individual intranet devices with
specific IP addresses. That is, configuring the IP Translation feature creates a one-to-one mapping between a
public IP address and a private IP address of a local host. In addition, admin users also map a private IP address

range to a public IP address range of equal instances.

This feature offers another way to make systems behind a firewall and configured with private IP addresses

appear to have public IP addresses.

- | Add | | Delete |
. Mapping
ID IMP?SP::gi::IU’;e Mask Destination Mask Physical interface Description Enable Actions
omain Name IP/Domain Name
1 1118 255.255.255.255 8888 255.255.255.255 DNS Server v | Edit | () Select
2 1.1.1.201 255265255255 | 192168123201 | 255255255255 Remote IPCam-1 | | Edit | () Select
3 1.1.1.202 255.255.255.255 192.168.123.202 | 255.255.255.255 Remote IPCam-2 v | Edit | Select
[ NetworkA @ Control Center | P [ NetworkB @Remotessite | As shown in above configuration settings
oA for the VPN gateway at Control Center, the
ONSServer 1 oo 92:168123.201 Admin user can access the DNS Server with
§£L‘ cat 8.;.8.8f nt .
. pplication nterne IPCAM-2 . .
8 T pecessihe | HINEES o 102268123202 mapped IP 1.1.1.8, instead of its real IP
e ./ 8.8.8.8; and he can also access (or manage)
ety dr 8 the remote IPCams with mapped IP
IPSec VPN Tunnel ¥ . .
VPNGateway o [T e | M2WHeTGateway i 1.1.1.201 and 1.1.1.202, instead of their
with a “Static IP” or “I " DAcess 192168125 | with a “Publicor Private IP”
Dynamic VPN 2. Access 192.168.100.x | Siteto Site real IP 192.168.123.xxx.

GW Global IP: 60.249.211.108
FQDN : amitacs.ddns.net
Local IP: 192.168.100.100

WAN IP: 192.168.168.111
Local IP: 192.168.123.254

From Control Center to Remote Site From Remote Site to Control Center

1. Admin user can ping DNS Server by mapped IP 1. Remote User can manage remote VPN
Address 1.1.1.8 instead of 8.8.8.8 Gateway, GUI,SSH directly by mapped

2. Admin User in Control Center also can manage specific IP Address 1.1.1.1 instead of FQDN
remote IPCam via VPN Tunnel directly by mapped amitacs.ddns.net

IP Address 1.1.1.201 instead of 192.168.123.201
IP Address 1.1.1.202 instead of 192.168.123.202

122



5G WAN Extender

IP Translation Setting

Go to Basic Network > Port Forwarding > IP Translation tab.

Enable IP Translation

#* Configuration

Item

Setting

» IP Translation (] Enable

Configuration
Item
IP Translation

\ Value setting
The box is unchecked by
default

Description
Check the Enable box to activate the IP translation function

Save

N/A

Click the Save button to save the settings.

Create / Edit IP Translation Rule

When Add button is applied, IP Translation

Configuration screen will appear.

# |IP Translation Configuration

ltem Setting
» Mapping Source IP/Domain P v |
Name
» Mask | 255.255.255 255 (/32) v |

» Mapping Destination | P

v |

|P/Domain Name

» Mask | 255255 255 255 (/32) v |

» Physical Interface Al v

» Description | |
» Enable (]

IP Translation Configuration

\ Value setting
1. A Must filled setting
2.IP is selected by default.

Item
Mapping Source
IP/Domain Name

Description

Specify the mapped IP / Domain Name that will be issued from the hosts
behind the NAT gateway.

The NAT gateway will translate the specified source IP/Domain Name into
other real IP / Domain Name that might be in the Internet or Intranet.

Mask 1. A Must filled setting

2.255.255.255.255(/32) is

Enter the required subnet mask if Source IP is specified above.
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Mapping
Destination
IP/Domain Name

Mask

Physical Interface

Description
Enable

Save
Undo

selected by default.

1. A Must filled setting
2.IP is selected by default.

1. A Must filled setting
2.255.255.255.255(/32) is
selected by default.

1. A Must filled setting
2.All is selected by
default.

An optional setting.

The box is unchecked by
default

N/A

N/A

It can be a single IP with 255.255.255.255 (/32) subnet mask, or an IP
group limited with proper subnet setting.

Specify the expected real target IP / Domain Name that will be used to
replace the original one that is issued by the hosts behind the NAT
gateway.

Enter the required subnet mask if Destination IP is specified above.

It can be a single IP with 255.255.255.255 (/32) subnet mask, or an IP
group limited with proper subnet setting.

Specify the interface to apply the translation rule. The enabled WAN
Interface will be available in the dropdown list.

By default, All is selected, and the translation rule will be applied to the
traffics passing through all WAN interfaces.

Specify a brief description or rule name for this IP Translation rule.
Check the Enable box to activate the translation rule.

Click the Save button to save the settings.

Click the Undo button to cancel the settings

124



5G WAN Extender

2.6 Routing
' @ Status W Dynamic Routing Routing Information Widget

N

Basic Network

- WAN & Uplink

Item Setting

— » Static Routing Enable

- WiFi e —

=) IPv4 Static Routing Rule List [ERE] [EEEDY = K.
- IPv6 S —

D Destination IP Subnet Mask Gateway IP Interface Metric Enable Actions

- Port Forwarding

| Save | Undo |

- DNS & DDNS

If you have more than one router and subnet, you will need to enable routing function to allow packets to find
proper routing path and allow different subnets to communicate with each other. Routing is the process of
selecting best paths in a network. It is performed for many kinds of networks, like electronic data networks (such
as the Internet), by using packet switching technology. The routing process usually directs forwarding on the
basis of routing tables which maintain a record of the routes to various network destinations. Thus, constructing
routing tables, which are held in the router's memory, is very important for efficient routing. Most routing
algorithms use only one network path at a time.

The routing tables record your pre-defined routing paths for some specific destination subnets. It is static routing.
However, if the contents of routing tables record the obtained routing paths from neighbor routers by using
some protocols, such as RIP, OSPF and BGP. It is dynamic routing. These both routing approaches will be
illustrated one after one. In addition, the gateway also built in one advanced configurable routing software
Quagga for more complex routing applications, you can configure it if required via Telnet CLI.
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2.6.1 Static Routing

Static Routing

Item Setting
Conﬁgflratlon > Stadc Rout 2 Ensble
Add §| Delete N E
|v] Destination IP Subnet Mask Gateway IP Interface Metric  Enable Actions
Static Routing Item Setting
Rulelist
. » Destination IP
» Subnet Mask 255250 2550(/24) v
» Gateway P
Static-Routing » Interface Auto v

| Rule Configuration

» Metnc

» Rule Enable

"Static Routing" function lets you define the routing paths for some dedicated hosts/servers or subnets to store
in the routing table of the gateway. The gateway routes incoming packets to different peer gateways based on
the routing table. You need to define the static routing information in gateway routing rule list.

(1) Google(173.194.72.94): -> WAN-1
Yahoo(188.125.73.108): -> WAN-2
ISP-DSLAM (( ))Gateway

' (?Google

192.168.121.253

9

WAN-2: 3G/4
Yah
Cellular ((( ))) O¥ehoo LAN
({1&.92.16&22.1
. )
| Static Routing: Enable | @ @ g
[Static Routing]-[Static Routing Rule List] ntrane

ID1: ID2:

Destination IP: 173.194.72.94
Subnet Mask: 255.255.255.255
Gateway: 192.168.121.253
Metric: 255

Rule: Enable

Destination IP: 188.125.73.108
Subnet Mask: 255.255.255.255
Gateway: 192.168.22.1

Metric: 255

Rule: Enable

When the administrator of the gateway wants to specify
what kinds of packets to be transferred via which
gateway interface and which peer gateway to their
destination. It can be carried out by the "Static Routing"
feature. Dedicated packet flows from the Intranet will
be routed to their destination via the pre-defined peer
gateway and corresponding gateway interface that are
defined in the system routing table by manual.

As shown in the diagram, when the destination is Google
access, rule 1 set interface as ADSL, routing gateway as
IP-DSLAM gateway 192.168.121.253. All the packets to
Google will go through WAN-1. And the same way
applied to rule 2 of access Yahoo. Rule 2 sets 3G/4G as
interface.
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Static Routing Setting

Go to Basic Network > Routing > Static Routing Tab.

There are three configuration windows for static routing feature, including "Configuration", "Static Routing Rule
List" and "Static Routing Rule Configuration" windows. "Configuration" window lets you activate the global static
routing feature. Even there are already routing rules, if you want to disable routing temporarily, just uncheck
the Enable box to disable it. "Static Routing Rule List" window lists all your defined static routing rule entries.
Using "Add" or "Edit" button to add and create one new static routing rule or to modify an existed one.

When "Add" or "Edit" button is applied, the "Static Routing Rule Configuration" window will appear to let you
define a static routing rule.

Enable Static Routing

Just check the Enable box to activate the "Static Routing" feature.

Item Setting

» Static Routing ¢ Enahle

The box is unchecked by

Check the Enable box to activate this function
default

Static Routing

Create / Edit Static Routing Rules

The Static Routing Rule List shows the setup parameters of all static routing rule entries. To configure a static
routing rule, you must specify related parameters including the destination IP address and subnet mask of
dedicated host/server or subnet, the IP address of peer gateway, the metric and the rule activation.

Add | Delete

1D Destination IP Subnet Mask Gateway IP Interface Metric Enable Actions

The gateway allows you to custom your static routing rules. It supports up to a maximum of 64 rule sets. When
Add button is applied, Static Routing Rule Configuration screen will appear, while the Edit button at the end of
each static routing rule can let you modify the rule.
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# |IPv4 Static Routing Rule Configuration

Item

Setting

» Destination IP

|

|

» Subnet Mask ‘255.255.255.0 {724y v |
» Gateway P | |

» Interface

» Metric I:]

» Rule () Enahle

IPv4 Static Routing

Item

Value setting

Description

L. 1. IPv4 Format . L . . .
Destination IP ) ) Specify the Destination IP of this static routing rule.
2. A Must filled setting
255.255.255.0 (/24) is set
Subnet Mask (/24) Specify the Subnet Mask of this static routing rule.
by default
1. IPv4 Format
Gateway IP . ) Specify the Gateway IP of this static routing rule.
2. A Must filled setting
. Select the Interface of this static routing rule. It can be Auto, or the available
Interface Auto is set by default .
WAN / LAN interfaces.
Metric 1. Numberic String Format The Metric of this static routing rule.
2. A Must filled setting Value Range: 0 ~ 255.
The box is unchecked b
Rule Y Click Enable box to activate this rule.
default.
Save NA Click the Save button to save the configuration
Click the Undo button to restore what you just configured back to the
Undo NA . .
previous setting.
Back NA When the Back button is clicked the screen will return to the Static Routing
Configuration page.
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2.6.2 Dynamic Routing

RIP
Configuration

OSPF Area List?

OFPF Area
Configuration

BGP Network
Configuration

BGP
Network List?

BGP Neighbor
Configuration

——

= RIP Configuration

Item Setting

» RIP Enable Disable 'I

*) OSPF Configuration ’ n
Item Setting

» OSPF [ Enable

» Router ID |

» Authentication INone 'I

» Backbone Subnet |

« OSPF Area List L1 a

ID Area Subnet Area ID Enable Actions

=] OSPF Area Configuration [+ ] x]
Item Setting

» Area Subnet |

» Area ID |

» Area [~ Enable

Save |

* BGP Configuration a n
Item Setting

» BGP [~ Enable

» ASN |

» Router ID |

« BGP Network List [0 .

ID Network Subnet Enable Actions
* BGP Neighbor List m m .
D ‘ Neighbor IP Remote ASN Enable Actions

Dynamic Routing, also called adaptive routing, describes the capability of a system, through which routes are
characterized by their destination, to alter the path that the route takes through the system in response to a

change in network conditions.

This gateway supports dynamic routing protocols, including RIPv1/RIPv2 (Routing Information Protocol), OSPF
(Open Shortest Path First), and BGP (Border Gateway Protocol), for you to establish routing table automatically.
The feature of dynamic routing will be very useful when there are lots of subnets in your network. Generally
speaking, RIP is suitable for small network. OSPF is more suitable for medium network. BGP is more used for big

network infrastructure.
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The supported dynamic routing protocols are described as follows.

RIP Scenario

©Routing Table#1 |

ISP-DSLAM

R

@ Basic Network-Routin

[DynamicRouting]-[RIPF onfiguration]

RIP:RIPv1 or RIPv2 \
|:I_ '& 203.95.80,1 a a
SN

Cellular Network

118.18.81.1

©)

|

\

y
/
{
fWAN 1: ADSL
118.18.81.33

Network-A

~
N
\

.
) \
RIP Enabled "ﬁ\

Gateway \

1

(9)

WAN-2: 36/
203.95.80.22

® Routing Table #1 +#2

LAN

AN T

N\
N

QRoutingTable#2  ~ < _

GatewaySettings:

[Dynamic Routing]-[OSPF Configurati

OSPF: Enable
Backbone Subnet: 192.168.0.0/16

[Dynamic Routing]-[OSPF Area List]

D1
AreaSubnet: 192.168.101.0/24
ArealD: 192.168.101.254
Area: Enable

D2:
AreaSubnet: 192.168.102.0/24
AreaD: 192.168.102.254
Area; Enable

o/

O
Intranet ) /

(X D)
: ;Areao: Backbong area

&7 AreaSubnet: 192,168.0.0/16

The Routing Information Protocol (RIP) is one of the
oldest distance-vector routing protocols, which
employs the hop count as a routing metric. RIP prevents
routing loops by implementing a limit on the number of
hops allowed in a path from the source to a destination.
The maximum number of hops allowed for RIP is 15.
This hop limit, however, also limits the size of networks
that RIP can support. A hop count of 16 is considered an
infinite distance, in other words the route is considered
unreachable. RIP implements the split horizon, route
poisoning and hold-down mechanisms to prevent
incorrect routing information from being propagated.

OSPF Scenario

Open Shortest Path First (OSPF) is a routing protocol
that uses link state routing algorithm. It is the most
widely used interior gateway protocol (IGP) in large
enterprise networks. It gathers link state information
from available routers and constructs a topology map
of the network. The topology is presented as a routing
table which routes datagrams based solely on the
destination IP address.

Network administrator can deploy OSPF gateway in
large enterprise network to get its routing table from
the enterprise backbone, and forward routing
information to other routers, which are no linked to the
enterprise backbone. Usually, an OSPF network is
subdivided into routing areas to simplify administration
and optimize traffic and resource utilization.

As shown in the diagram, OSPF gateway gathers

routing information from the backbone gateways in area 0, and will forward its routing information to the
routers in area 1 and area 2 which are not in the backbone.
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BGP Scenario

Border Gateway Protocol (BGP) is a standard exterior
gateway protocol designed to exchange routing and
reachability information between autonomous systems
(AS) on the Internet. It usually makes routing decisions
based on paths, network policies, or rule-sets.

Most ISPs use BGP to establish routing between one
another (especially for multi-homed). Very large private
IP networks also use BGP internally. The major BGP
gateway within one AS will links with some other border
gateways for exchanging routing information. It will
distribute the collected data in AS to all routers in other
AS.

As shown in the diagram, BGP 0 is gateway to dominate

ASO (self IP is 10.100.0.1 and self ID is 100). It links with other BGP gateways in the Internet. The scenario is like
Subnet in one ISP to be linked with the ones in other ISPs. By operating with BGP protocol, BGP 0 can gather
routing information from other BGP gateways in the Internet. And then it forwards the routing data to the
routers in its dominated AS. Finally, the routers resided in AS 0 know how to route packets to other AS.
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Dynamic Routing Setting

Go to Basic Network > Routing > Dynamic Routing Tab.

The dynamic routing setting allows user to customize RIP, OSPF, and BGP protocol through the router based on
their office setting.

In the "Dynamic Routing" page, there are several configuration windows for dynamic routing feature. They are
the "RIP Configuration" window, "OSPF Configuration" window, "OSPF Area List", "OSPF Area Configuration",
"BGP Configuration", "BGP Neighbor List" and "BGP Neighbor Configuration" window. RIP, OSPF and BGP
protocols can be configured individually.

The "RIP Configuration" window lets you choose which version of RIP protocol to be activated or disable it. The
"OSPF Configuration" window can let you activate the OSPF dynamic routing protocol and specify its backbone
subnet. Moreover, the "OSPF Area List" window lists all defined areas in the OSPF network. However, the "BGP
Configuration" window can let you activate the BGP dynamic routing protocol and specify its self ID. The "BGP
Neighbor List" window lists all defined neighbors in the BGP network.

RIP Configuration

The RIP configuration setting allows user to customize RIP protocol through the router based on their office
setting.

Item Setting

» RIP Enable Disable .|

Select Disable will disable RIP protocol.
RIP Enable Disable is set by default Select RIP v1 will enable RIPv1 protocol.
Select RIP v2 will enable RIPv2 protocol.

OSPF Configuration

The OSPF configuration setting allows user to customize OSPF protocol through the router based on their office
setting.
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= OSPF Configuration . %
Item Setting

» OSPF [ Enable

» Router ID |

» Authentication None ~

» Backbone Subnet |

OSPF Configuration

Item Value setting Description

OSPF Disable is set by default Click Enable box to activate the OSPF protocol.
1. IPv4 Format

Router ID The Router ID of this router on OSPF protocol

2. A Must filled setting

The Authentication method of this router on OSPF protocol.

Select None will disable Authentication on OSPF protocol.

Select Text will enable Text Authentication with entered the Key in this field
on OSPF protocol.

Select MD5 will enable MD5 Authentication with entered the ID and Key in
these fields on OSPF protocol.

Authentication  None is set by default

1. Classless Inter Domain

Routing (CIDR) Subnet

Mask Notation. (Ex: The Backbone Subnet of this router on OSPF protocol.
192.168.1.0/24)

2. A Must filled setting

Backbone
Subnet

Create / Edit OSPF Area Rules

The gateway allows you to custom your OSPF Area List rules. It supports up to a maximum of 32 rule sets.

% OSPF Area List

Actions

Area ID

Area Subnet

When Add button is applied, OSPF Area Rule Configuration screen will appear.
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# OSPF Area Configuration

Item

Setting

» Area Subnet

» Area ID

» Area

[T Enable

_save |

OSPF Area Configuration

Item

Area Subnet

Value setting

1. Classless Inter Domain
Routing (CIDR) Subnet
Mask Notation. (Ex:
192.168.1.0/24)

2. A Must filled setting

Description

The Area Subnet of this router on OSPF Area List.

1. IPv4 Format

Area ID . . The Area ID of this router on OSPF Area List.
2. A Must filled setting
The box is unchecked b
Area Y Click Enable box to activate this rule.
default.
Save N/A Click the Save button to save the configuration
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BGP Configuration

The BGP configuration setting allows user to customize BGP protocol through the router setting.

! BGP Configuration

Setting

» BGP

[~ Enable

» ASN

» Router ID

BGP Network Configuration

Item

Value setting

Description

BGP The box is unchecked by ~ Check the Enable box to activate the BGP protocol.
default

ASN 1. Numberic String The ASN Number of this router on BGP protocol.
Format Value Range: 1 ~ 4294967295.
2. A Must filled setting

Router ID 1. IPv4 Format The Router ID of this router on BGP protocol.
2. A Must filled setting

Create / Edit BGP Network Rules

The gateway allows you to custom your BGP Network rules. It supports up to a maximum of 32 rule sets.

« BGP Network List

Network Subnet

When Add button is applied, BGP Network Configuration screen will appear.

* BGP Network Configuration

Item Setting
» Network Subnet P: | | 255.255.255.0 (/24) -]
» Network [~ Enable
_Save |
Item Value setting Description
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Network Subnet 1. IPv4 Format The Network Subnet of this router on BGP Network List. It composes of
2. A Must filled setting entered the IP address in this field and the selected subnet mask.
The box is unchecked b

Network Y Click Enable box to activate this rule.
default.

Save N/A Click the Save button to save the configuration

Create / Edit BGP Neighbor Rules

The gateway allows you to custom your BGP Neighbor rules. It supports up to a maximum of 32 rule sets.
# BGP Neighbor List

Neighbor IP Remote ASN Actions

When Add button is applied, BGP Neighbor Configuration screen will appear.

# BGP Neighbor Configuration a X
Item Setting

» Neighbor IP I

» Remote ASN |

» Neighbor [~ Enable

BGP Neighbor Configuration

Item Value setting Description
. 1. IPv4 Format
Neighbor IP . . The Neighbor IP of this router on BGP Neighbor List.
2. A Must filled setting
1. Numberic String Format The Remote ASN of this router on BGP Neighbor List.
Remote ASN
2. A Must filled setting Value Range: 1 ~ 4294967295.
. The box is unchecked b
Neighbor Y Click Enable box to activate this rule.
default.
Save N/A Click the Save button to save the configuration
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2.6.3 Routing Information

The routing information allows user to view the routing table and policy routing information. Policy Routing
Information is only available when the Load Balance function is enabled and the Load Balance Strategy is By

User Policy.

Go to Basic Network > Routing > Routing Information Tab.

* Routing Table ’ x

Destination IP Subnet Mask Gateway IP Metric  Interface
100.105.167.72 255.255.255.252 0.0.00 0 WAN-2
192.168.66.0 255.255.255.0 0.0.0.0 0 LAN
192.168.127.0 255.255.255.0 0.0.00 0 WAN-1
169.254.0.0 255.255.0.0 0.0.00 0 LAN
127.0.0.0 255.0.0.0 0.0.0.0 0 lo

Routing Table

Item Value setting Description

Destination IP N/A Routing record of Destination IP. IPv4 Format.
Subnet Mask N/A Routing record of Subnet Mask. IPv4 Format.
Gateway IP N/A Routing record of Gateway IP. IPv4 Format.
Metric N/A Routing record of Metric. Numeric String Format.
Interface N/A Routing record of Interface Type. String Format.

= Policy Routing Information ' x

Policy Routing Source

Source IP

Destination IP

Destination Port

WAN Interface

Load Balance

Policy Routing Information

Item Value setting Description

Policy Routing Source  N/A Policy Routing of Source. String Format.

Source IP N/A Policy Routing of Source IP. IPv4 Format.
Destination IP N/A Policy Routing of Destination IP. IPv4 Format.
Destination Port N/A Policy Routing of Destination Port. String Format.
WAN Interface N/A Policy Routing of WAN Interface. String Format.
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2.7 DNS & DDNS

How does user access your server if your WAN IP address changes all the time? One way is to register a new
domain name, and maintain your own DNS server. Another simpler way is to apply a domain name to a third-
party DDNS service provider. The service can be free or charged. If you want to understand the basic concepts
of DNS and Dynamic DNS, you can refer to Wikipedia website”2.

2.7.1 DNS & DDNS Configuration

Dynamic DNS

Inform
@ DN Server Network-A

——————————— Global IP: 118.18.81.33 > .44 (L WAN IP
" =4 - _FQDN: mygw.no-ip.org Changed

Gateway

Local IP: 10.0.75.2

No-IP
DDNS Server

N
E-mail Server $

Local IP: 10.0.75.101 |\s
File Server

Local IP: 10.0.75.102
Global IP: 118.18.81.44.

Remote User

Access E-mail Server
(mygw.no-ip.org) from Internet

To host your server on a changing IP address, you
have to use dynamic domain name service (DDNS).
Therefore, anyone wishing to reach your host only
needs to know the domain name. Dynamic DNS will
map the name of your host to your current IP address,
which changes each time you connect your Internet
service provider.

The Dynamic DNS service allows the gateway to alias
a public dynamic IP address to a static domain name,
allowing the gateway to be more easily accessed from
various locations on the Internet. As shown in the
diagram, user registered a domain name to a third-

party DDNS service provider (NO-IP) to use DDNS function. Once the IP address of designated WAN interface
has changed, the dynamic DNS agent in the gateway will inform the DDNS server with the new IP address. The
server automatically re-maps your domain name with the changed IP address. So, other hosts or remote users
in the Internet world are able to link to your gateway by using your domain name regardless of the changing

global IP address.

7 http://en.wikipedia.org/wiki/Domain_Name_System
8 http://en.wikipedia.org/wiki/Dynamic_DNS
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DNS & DDNS Setting

Go to Basic Network > DNS & DDNS > Configuration Tab.

The DNS & DDNS setting allows user to setup Dynamic DNS feature and DNS redirect rules.

Setup Dynamic

DNS

The gateway allows you to custom your Dynamic DNS settings.

# Dynamic DNS

Item

Setting

» DDNS

[~ Enable

» WAN Interface

IWAN-l - I

» Provider

I DynDNS.org(Dynamic) j

» Host Name

» User Name / E-Mail

» Password / Key

DDNS (Dynamic DNS) Configuration

Item Value setting Description
DDNS The box is unchecked by Check the Enable box to activate this function.
default
WAN Interface WAN 1 is set by default Select the WAN Interface IP Address of the gateway.
Provider DynDNS.org (Dynamic) is  Select your DDNS provider of Dynamic DNS. It can be DynDNS.org(Dynamic),
set by default DynDNS.org(Custom), NO-IP.com, etc...
Host Name ;njt:;r:f format can be Your registered host name of Dynamic DNS.
2. A Must filled setting Value Range: 0 ~ 63 characters.
1. String format can be
User Name / E- . .
Mail any text Enter your User name or E-mail addresss of Dynamic DNS.
2. A Must filled setting
1. String format can be
Password / Key  any text Enter your Password or Key of Dynamic DNS.
2. A Must filled setting
Save N/A Click Save to save the settings
Undo N/A Click Undo to cancel the settings
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Setup DNS Redirect
DNS redirect is a special function to redirect certain traffics to a specified host. Administator can manage the

internet / intranet traffics that are going to access some restricted DNS and force those traffics to be redirected
to a specified host.

* DNS Redirect ’ x

Item Setting

» DNS Redirect [ Enable

DNS Redirect Configuration

Item Value setting Description
The box i hecked b

DNS Redirect & boxs unhchecked by Check the Enable box to activate this function.
default

Save N/A Click Save to save the settings

Undo N/A Click Undo to cancel the settings

If you enabled the DNS Redirect function, you have to further specify the redirect rules. According to the rules,
the gateway can redirect the traffic that matched the DNS to corresponding pre-defined IP address.

« Redirect Rule

Mapping Rule

Condition Description

When Add button is applied, Redirect Rule screen will appear.

« Redirect Rule ’ x

ltem Setting
Domain Name IP
Mapping Rule
| (* for Any)
Condition Always -
Description |
Enable [T Enable

Redirect Rule Configuration

Item Value setting Description
. 1. String format can be Enter a domain name to be redirect. The traffic to specified domain name will
Domain Name . .
any text be redirect to the following IP address.
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Condition

Description

Enable

Save
Undo

2. A Must filled setting
1. IPv4 format
2. A Must filled setting

1. A Must filled setting
2. Always is selected by
default.

1. String format can be
any text

2. A Must filled setting
The box is unchecked by
default

N/A

N/A

Value Range: at least 1 character is required; “*’ for any.
Enter an IP Address as the target for the DNS redirect.

Specify when will the DNS redirect action can be applied.

It can be Always, or WAN Block.

Always: The DNS redirect function can be applied to matched DNS all the
time.

WAN Block: The DNS redirect function can be applied to matched DNS only
when the WAN connection is disconneced, or un-reachable.

Enter a brief description for this rule.
Value Range: 0 ~ 63 characters.
Click the Enable button to activate this rule.

Click Save to save the settings
Click Undo to cancel the settings
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Chapter 3 Object Definition

3.1 Scheduling

Scheduling provides ability of adding/deleting time schedule rules, which can be applied to other functionality.

3.1.1 Scheduling Configuration

Go to Object Definition > Scheduling > Configuration tab.

= Time Schedule List [ /:G[| Delete

Button description

Item Value setting Description
Add N/A Click the Add button to configure time schedule rule
Delete N/A Click the Delete button to delete selected rule(s)

When Add button is applied, Time Schedule Configuration and Time Period Definition screens will appear.

« Time Schedule Configuration

Item

Setting

» Rule Name |

» Rule Policy

I Inactivate 'vl the Selected Days and Hours Below.

Time Schedule Configuration

Item Value Setting Description
Rule Name String: any text Set rule name
Rule Policy Default Inactivate Inactivate/activate the function been applied to in the time period below
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%1 Time Period Definition

ID Week Day Start Time (hh:mm) End Time (hh:mm)
1 | -- choose one -- »| [ [
2 | -- choose one - ~| [ [
3 | -- choose one -- »| [ [
4 | -- choose one -- j |_ |_
5 | - choose one -- »| [ [
6 | - choose one -- »| [ [
7 | - choose one - ~| [ [
8 | -- choose one -- ~| [ [

Time Period Definition

Item Value Setting Description

Week Day Select from menu Select everyday or one of weekday

Start Time Time format (hh :mm) Start time in selected weekday

End Time Time format (hh :mm) End time in selected weekday

Save N/A Click Save to save the settings

Undo N/A Click Undo to cancel the settings

Refresh N/A Click the Refresh button to refresh the time schedule list.
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3.2 User (not supported)

Not supported feature for the purchased product, leave it as blank.
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3.3 Grouping

The Grouping function allows user to make group for some services.

3.3.1 Host Grouping

Go to Object Definition > Grouping > Host Grouping tab.

The Host Grouping function allows user to make host group for some services, such as QoS, Firewall, and
Communication Bus. The supported service types could be different for the purchased product.

= Host Group List [ /7] Delete -
ID Group Name Group Type Member List Bound Services Enable Actions

When Add button is applied, Host Group Configuration screen will appear.

*1 Host Group Configuration

Item Setting
» Group Name [
» Group Type IIP Address-based EI
» Member to Join [ Join |
» Member List
» Bound Services [ Firewall [~ QoS
» Group [~ Enable

Host Group Configuration

Item Value setting Description
1. String format can
Group Name be any text Enter a group name for the rule. It is a name that is easy for you to understand.

2. A Must filled setting

Select the group type for the host group. It can be IP Address-based, MAC
Address-based, or Host Name-based.

When IP Address-based is selected, only IP address can be added in Member to
Join.

When MAC Address-based is selected, only MAC address can be added in
Member to Join.

1. IP Address-based is
Group Type selected by default.
2. A Must filled setting
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Member to Join

Member List

Bound Services

Group

Save
Undo

N/A

NA

The boxes are
unchecked by default

The box is unchecked
by default

N/A

N/A

When Host Name-based is selected, only host name can be added in Member
to Join.

Note: The available Group Type can be different for the purchased model.

Add the members to the group in this field.

You can enter the member information as specified in the Member Type above,
and press the Join button to add.

Only one member can be add at a time, so you have to add the members to the
group one by one.

This field will indicate the hosts (members) contained in the group.

Binding the services that the host group can be applied. If you enable the
Firewall, the produced group can be used in firewall service. Same as by enable
QoS, or other available service types.

Note: The supported service type can be different for the purchased product.
Check the Enable checkbox to activate the host group rule. So that the group
can be bound to selected service(s) for further configuration.

Click Save to save the settings

Click Undo to cancel the settings
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3.4 External Server

Go to Object Definition > External Server > External Server tab.

The External Server setting allows user to add external server.

Create External Server

= External Server List | /:0[;| Delete

Server Name Server Type Server IPIFQDN Actions

Server Port

When Add button is applied, External Server Configuration screen will appear.
# External Server Configuration

- 1=

ltem Setting

» Server Name I

| Email Server j

» Server Type User Name: I

Password: |

» Server IP/FQDN |

» Server Port |25

» Server [V Enable

Save | Undo
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Sever Name

1. String format can be
any text
2. A Must filled setting

Enter a server name. Enter a name that is easy for you to understand.

Server Type

A Must filled setting

Specify the Server Type of the external server, and enter the required settings

for the accessing the server.

Email Server (A Must filled setting) :

When Email Server is selected, User Name, and Password are also required.

User Name (String format: any text)
Password (String format: any text)

RADIUS Server (A Must filled setting) :

When RADIUS Server is selected, the following settings are also required.
Primary :

Shared Key (String format: any text)

Authentication Protocol (By default CHAP is selected)
Session Timeout (By default 1)

The values must be between 1 and 60.

Idle Timeout: (By default 1)

The values must be between 1 and 15.

Secondary :

Shared Key (String format: any text)

Authentication Protocol (By default CHAP is selected)
Session Timeout (By default 1)

The values must be between 1 and 60.

Idle Timeout: (By default 1)

The values must be between 1 and 15.

Active Directory Server (A Must filled setting) :

When Active Directory Server is selected, Domain setting is also required.

Domain (String format: any text)

LDAP Server (A Must filled setting) :

When LDAP Server is selected, the following settings are also required.
Base DN (String format: any text)

Identity (String format: any text)

Password (String format: any text)

UAM Server (A Must filled setting) :

When UAM Server is selected, the following settings are also required.
Login URL (String format: any text)

Shared Secret (String format: any text)

NAS/Gateway ID (String format: any text)

Location ID (String format: any text)

Location Name (String format: any text)
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TACACS+ Server (A Must filled setting) :

When TACACS+ Server is selected, the following settings are also required.
Shared Key (String format: any text)

Session Timeout (String format: any number)

The values must be between 1 and 60.

SCEP Server (A Must filled setting) :

When SCEP Server is selected, the following settings are also required.
Path (String format: any text, By default cgi-bin is filled)

Application (String format: any text, By default pkiclient.exe is filled)

FTP(SFTP) Server (A Must filled setting) :

When FTP(SFTP) Server is selected, the following settings are also required.
User Name (String format: any text)

Password (String format: any text)

Protocol (Select FTP or SFTP)

Encryprion (Select Plain, Explicit FTPS or Implicit FTPS)

Transfer mode (Select Passive or Active)

Server IP/FQDN

A Must filled setting

Specify the IP address or FQDN used for the external server.

Server Port

A Must filled setting

Specify the Port used for the external server. If you selected a certain server
type, the default server port number will be set.

For Email Server 25 will be set by default;

For Syslog Server, port 514 will be set by default;

For RADIUS Server, port 1812, 1823 will be set by default;
For Active Directory Server, port 389 will be set by default;
For LDAP Server, port 389 will be set by default;

For UAM Server, port 3990, 4990 will be set by default;
For TACACS+ Server, port 49 will be set by default;

For SCEP Server, port 80 will be set by default;

For FTP(SFTP) Server, port 21 will be set by default;

Value Range: 1 ~ 65535.

Account Port

1. A Must filled setting
2. 1813 is set by default

Specify the accounting port used if you selected external RADIUS server.
Value Range: 1 ~ 65535.

The box is checked by

Server Click Enable to activate this External Server.
default
Save N/A Click Save to save the settings
Undo N/A Click Undo to cancel the settings
Refresh N/A Click the Refresh button to refresh the external server list.
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3.5 Certificate

In cryptography, a public key certificate (also known as a digital certificate or identity certificate) is an electronic
document used to prove ownership of a public key. The certificate includes information about the key,
information about its owner's identity, and the digital signature of an entity that has verified the certificate's
contents are genuine. If the signature is valid, and the person examining the certificate trusts the signer, then
they know they can use that key to communicate with its owner®.

In a typical public-key infrastructure (PKI) scheme, the signer is a certificate authority (CA), usually a company
such as VeriSign which charges customers to issue certificates for them. In a web of trust scheme, the signer is
either the key's owner (a self-signed certificate) or other users ("endorsements") whom the person examining
the certificate might know and trust. The device also plays as a CA role.

Certificates are an important component of Transport Layer Security (TLS, sometimes called by its older name
SSL), where they prevent an attacker from impersonating a secure website or other server. They are also used
in other important applications, such as email encryption and code signing. Here, it can be used in IPSec
tunneling for user authentication.

3.5.1 Configuration

The configuration setting allows user to create Root Certificate Authority (CA) certificate and configure to set
enable of SCEP. Root CA is the top-most certificate of the tree, the private key of which is used to "sign" other
certificates.

Go to Object Definition > Certificate > Configuration tab.

Create Root CA

Generate |

ID Name Subject Issuer Vaild To Action

When Generate button is applied, Root CA Certificate Configuration screen will appear. The required
information to be filled for the root CA includes the name, key, subject name and validity.

9 http:/en.wikipedia.org/wiki/Public_key_certificate.
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% Root CA Certificate Configuration

Item Setting
» Name I
e Key Type : m Key Length: | 517 pits +| Digest Algorithm : I MD5 vI

» Subject Name

Country(C): | State(ST) - | Location(L) - |
Organization(O) : | Organization Unit(OU) - |
Common Name(CN) : | E-mail - |

» Validity Period

| 20-years v|

Root CA Certificate Configuration

Item

Value setting

Description

1. String format can be

Name any text Enter a Root CA Certificate name. It will be a certificate file name
2. A Must filled setting
This field is to specify the key attribute of certificate.
Key Type to set public-key cryptosystems. It only supports RSA now.
! ) Key Length to set s the size measured in bits of the key used in a
Key A Must filled setting

cryptographic algorithm.
Digest Algorithm to set identifier in the signature algorithm identifier of
certificates

Subject Name

This field is to specify the information of certificate.

Country(C) is the two-letter ISO code for the country where your organization
is located.

State(ST) is the state where your organization is located.

A Must filled setting Location(L) is the location where your organization is located.

Organization(O) is the name of your organization.

Organization Unit(OU) is the name of your organization unit.

Common Name(CN) is the name of your organization.

Email is the email of your organization. It has to be email address style.

Validity Period

A Must filled setting This field is to specify the validity period of certificate.
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Setup SCEP
% SCEP Configuration a x

Iltem Setting

» SCEP [~ Enable

» Automatically re-enroll aging [~ Enable
certificates

SCEP Configuration
Item Value setting Description
The box i hecked b
SCEP € boxs unhchecked by Check the Enable box to activate SCEP function.
default
Automatically . When SCEP is activated, check the Enable box to activate this function.

X The box is unchecked by ) . ) . . . N
re-enroll aging default It will be automatically check which certificate is aging. If certificate is aging, it
certificates erad will activate SCEP function to re-enroll automatically.

Save N/A Click Save to save the settings
Undo N/A Click Undo to cancel the settings
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3.5.2 My Certificate

My Certificate includes a Local Certificate List. Local Certificate List shows all generated certificates by the root
CA for the gateway. And it also stores the generated Certificate Signing Requests (CSR) which will be signed by
other external CAs. The signed certificates can be imported as the local ones of the gateway.

Self-signed Certificate Usage Scenario

Network-A @ HQ Data Center Network-B @ Branch Office

Shs Rs
LU N | Acs
EI‘.\- J ‘?g‘ Server
g
Application s ‘Database \
Server w[7] server -

(D Creatg HQ Root ( VPN Tunnel (IPSec IKE+X.509) O

@ Create Loca RootCA
©@Import SLapthCRTZ ® Create IPSec (IKE + X.509) CRT
- — X VPN Tunnel .
Security Gateway 1 Security Gateway 2
with Root CA and Trusted with Trusted CA &
Client Certificates Client Certificates
Global IP: 203.95.80.22 Global IP: 118.18.81.33
Local IP: 10.0.76.2 Local IP: 10.0.75.2

Scenario Application Timing

When the enterprise gateway owns the root CA and VPN tunneling function, it can generate its own local
certificates by being signed by itself or import any local certificates that are signed by other external CAs.
Also import the trusted certificates for other CAs and Clients. In addition, since it has the root CA, it also
can sign Certificate Signing Requests (CSR) to form corresponding certificates for others. These
certificates can be used for two remote peers to make sure their identity during establishing a VPN
tunnel.

Scenario Description

Gateway 1 generates the root CA and a local certificate (HQCRT) signed by itself. Import a trusted
certificate (BranchCRT) —a BranchCSR certificate of Gateway 2 signed by root CA of Gateway 1.

Gateway 2 creates a CSR (BranchCSR) to let the root CA of the Gateway 1 sign it to be the BranchCRT
certificate. Import the certificate into the Gateway 2 as a local certificate. In addition, also import the
certificates of the root CA of the Gateway 1 into the Gateway 2 as the trusted ones. (Please also refer to
following two sub-sections)

Establish an IPSec VPN tunnel with IKE and X.509 protocols by starting from either peer, so that all client
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hosts in these both subnets can communicate with each other.

Parameter Setup Example

For Network-A at HQ

Following tables list the parameter configuration as an example for the "My Certificate" function used
in the user authentication of IPSec VPN tunnel establishing, as shown in above diagram. The
configuration example must be combined with the ones in following two sections to complete the whole

user scenario.

Use default value for those parameters that are not mentioned in the tables.

Configuration Path

[My Certificate]-[Root CA Certificate Configuration]

Name

HQRootCA

Key

Key Type: RSA Key Length: 1024-bits

Subject Name

Country(C): TW State(ST): Taiwan Location(L): Tainan
Organization(O): TELEWELLHQ Organization Unit(OU): HQRD
Common Name(CN): HQRootCA E-mail: hqrootca@TeleWell.com.tw

Configuration Path

[My Certificate]-[Local Certificate Configuration]

Name

HQCRT Self-signed: m

Key

Key Type: RSA Key Length: 1024-bits

Subject Name

Country(C): TW State(ST): Taiwan Location(L): Tainan
Organization(O): TELEWELLHQ Organization Unit(OU): HQRD
Common Name(CN): HQCRT E-mail: hgcrt@TeleWell.com.tw

Configuration Path

[IPSec]-[Configuration]

IPSec

m Enable

Configuration Path

[IPSec]-[Tunnel Configuration]

Tunnel m Enable
Tunnel Name s2s-101
Interface WAN 1
Tunnel Scenario Site to Site
Operation Mode Always on

Configuration Path

[IPSec]-[Local & Remote Configuration]

Local Subnet 10.0.76.0
Local Netmask 255.255.255.0
Full Tunnel Disable
Remote Subnet 10.0.75.0
Remote Netmask 255.255.255.0
118.18.81.33

Remote Gateway
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Configuration Path

[IPSec]-[Authentication]

Key Management

IKE+X.509 Local Certificate: HQCRT Remote Certificate: BranchCRT

Local ID

User Name Network-A

Remote ID

User Name Network-B

Configuration Path

[IPSec]-[IKE Phase]

Negotiation Mode

Main Mode

X-Auth

None

For Network-B at Branch Office

Following tables list the parameter configuration as an example for the "My Certificate" function used
in the user authentication of IPSec VPN tunnel establishing, as shown in above diagram. The
configuration example must be combined with the ones in following two sections to complete the whole

user scenario.

Use default value for those parameters that are not mentioned in the tables.

Configuration Path

[My Certificate]-[Local Certificate Configuration]

Name

BranchCRT Self-signed: o

Key

Key Type: RSA Key Length: 1024-bits

Subject Name

Country(C): TW State(ST): Taiwan Location(L): Tainan
Organization(O): TELEWELLBranch Organization Unit(OU): BranchRD
Common Name(CN): BranchCRT E-mail: branchcrt@TeleWell.com.tw

Configuration Path

[IPSec]-[Configuration]

IPSec

m Enable

Configuration Path

[IPSec]-[Tunnel Configuration]

Tunnel m Enable
Tunnel Name s2s-102
Interface WAN 1
Tunnel Scenario Site to Site
Operation Mode Always on

Configuration Path

[IPSec]-[Local & Remote Configuration]

Local Subnet 10.0.75.0
Local Netmask 255.255.255.0
Full Tunnel Disable
Remote Subnet 10.0.76.0
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Remote Netmask

255.255.255.0

Remote Gateway

203.95.80.22

Configuration Path

[IPSec]-[Authentication]

Key Management

IKE+X.509 Local Certificate: BranchCRT Remote Certificate: HQCRT

Local ID

User Name Network-B

Remote ID

User Name Network-A

Configuration Path

[IPSec]-[IKE Phase]

Negotiation Mode

Main Mode

X-Auth

None

Scenario Operation Procedure

In above diagram, "Gateway 1" is the gateway of Network-A in headquarters and the subnet of its
Intranet is 10.0.76.0/24. It has the IP address of 10.0.76.2 for LAN interface and 203.95.80.22 for WAN-
1 interface. "Gateway 2" is the gateway of Network-B in branch office and the subnet of its Intranet is
10.0.75.0/24. It has the IP address of 10.0.75.2 for LAN interface and 118.18.81.33 for WAN-1 interface.
They both serve as the NAT security gateways.

Gateway 1 generates the root CA and a local certificate (HQCRT) that is signed by itself. Import the
certificates of the root CA and HQCRT into the "Trusted CA Certificate List" and "Trusted Client Certificate
List" of Gateway 2.

Gateway 2 generates a Certificate Signing Request (BranchCSR) for its own certificate (BranchCRT)
(Please generate one not self-signed certificate in the Gateway 2, and click on the "View" button for that
CSR. Just downloads it). Take the CSR to be signed by the root CA of Gateway 1 and obtain the BranchCRT
certificate (you need rename it). Import the certificate into the "Trusted Client Certificate List" of the
Gateway 1 and the "Local Certificate List" of Gateway 2.

Gateway 2 can establish an IPSec VPN tunnel with "Site to Site" scenario and IKE and X.509 protocols to
Gateway 1.

Finally, the client hosts in two subnets of 10.0.75.0/24 and 10.0.76.0/24 can communicate with each
other.
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My Certificate Setting

Go to Object Definition > Certificate > My Certificate tab.

The My Certificate setting allows user to create local certificates. In "My Certificate" page, there are two
configuration windows for the "My Certificate" function. The "Local Certificate List" window shows the stored
certificates or CSRs for representing the gateway. The "Local Certificate Configuration" window can let you fill
required information necessary for corresponding certificate to be generated by itself, or corresponding CSR to
be signed by other CAs.

Create Local Certificate

J Add | Import | Delete =

ID Name Subject Issuer Vaild To Actions

When Add button is applied, Local Certificate Configuration screen will appear. The required information to
be filled for the certificate or CSR includes the name, key and subject name. It is a certificate if the "Self-
signed" box is checked; otherwise, it is a CSR.

Item Setting

» Name | Self-signed : [~

b Key Key Type : I RSA vl Key Length : I 1024-bits vI Digest Algorithm : ISHA‘]. vI

Country(C) - | State(ST) - | Location(L) : |
» Subject Name Organization(O) - | Organization Unit(OU) - |
Common Name(CN) : | E-mail - |

Challenge Password: | Unstructured Name:
» Extra Attributes I

Enable: [ SCEP Server: I___ Option — j Add Object I
» SCEP Enroliment CA Certificate: I amit-IDG761AM-JH.crt j CA Encryption Certificate:
| Option --- '] (Optional) CA identifier: | (Optional)
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Name 1. String format can be Enter a certificate name. It will be a certificate file name
any text If Self-signed is checked, it will be signed by root CA. If Self-signed is not
2. A Must filled setting checked, it will generate a certificate signing request (CSR).

Key A Must filled setting This field is to specify the key attributes of certificate.

Key Type to set public-key cryptosystems. Currently, only RSA is supported.
Key Length to set the length in bits of the key used in a cryptographic
algorithm. It can be 512/768/1024/1536/2048.
Digest Algorithm to set identifier in the signature algorithm identifier of
certificates. It can be MD5/SHA-1.
Subject Name A Must filled setting This field is to specify the information of certificate.
Country(C) is the two-letter ISO code for the country where your organization
is located.
State(ST) is the state where your organization is located.
Location(L) is the location where your organization is located.
Organization(0) is the name of your organization.
Organization Unit(OU) is the name of your organization unit.
Common Name(CN) is the name of your organization.
Email is the email of your organization. It has to be email address setting only.
Extra Attributes A Must filled setting This field is to specify the extra information for generating a certificate.
Challenge Password for the password you can use to request certificate
revocation in the future.
Unstructured Name for additional information.
SCEP A Must filled setting This field is to specify the information of SCEP.
Enrollment If user wants to generate a certificate signing request (CSR) and then signed by
SCEP server online, user can check the Enable box.

Select a SCEP Server to identify the SCEP server for use. The server detailed
information could be specified in External Servers. Refer to Object Definition
> External Server > External Server. You may click Add Object button to
generate, and the settings are the same as those defined in Section 3.4
External Server.

Select a CA Certificate to identify which certificate could be accepted by SCEP
server for authentication. It could be generated in Trusted Certificates.

Select an optional CA Encryption Certificate, if it is required, to identify which
certificate could be accepted by SCEP server for encryption data information.
It could be generated in Trusted Certificates.

Fill in optional CA Identifier to identify which CA could be used for signing
certificates.

Save N/A Click the Save button to save the configuration.
Back N/A When the Back button is clicked, the screen will return to previous page.
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When Import button is applied, an Import screen will appear. You can import a certificate from an existed
certificate file, or directly paste a PEM encoded string as the certificate.

A Cancel
HE... | FIEIEEE -

Import
Item Value setting Description
Import A Must filled setting Select a certificate file from user’s computer, and click the Apply button to
import the specified certificate file to the gateway.
PEM Encoded 1. String format can be This is an alternative approach to import a certificate.
any text You can directly fill in (Copy and Paste) the PEM encoded certificate string,
2. A Must filled setting and click the Apply button to import the specified certificate to the gateway.
Apply N/A Click the Apply button to import the certificate.
Cancel N/A Click the Cancel button to discard the import operation and the screen will
return to the My Certificates page.
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3.5.3 Trusted Certificate

Trusted Certificate includes Trusted CA Certificate List, Trusted Client Certificate List, and Trusted Client Key List.
The Trusted CA Certificate List places the certificates of external trusted CAs. The Trusted Client Certificate List
places the others' certificates what you trust. And the Trusted Client Key List places the others’ keys what you
trusted.

Self-signed Certificate Usage Scenario

Network-A @ HQ Data Center Network-B @ Branch Office

> .
JJ N ACS

A
N
5y T—
EL k"?@ Server
g
Application ks ‘Database \

Server bz'_[.} Server
Create HQ Root QAN
% Create Loca (VPN Tunnel (IPSec IKE+X.509) 0 Root CA
©@Import SLapghCRT 5 | ® Create IPSec (IKE + X.509) CRT
- — " VPN Tunnel .
Security Gateway 1 Security Gateway 2
with Root CA and Trusted with Trusted CA &
Client Certificates Client Certificates
Global IP: 203.95.80.22 Global IP: 118.18.81.33
Local IP: 10.0.76.2 Local IP:10.0.75.2

Scenario Application Timing (same as the one described in "My Certificate" section)

When the enterprise gateway owns the root CA and VPN tunneling function, it can generate its own local
certificates by being signed by itself. Also imports the trusted certificates for other CAs and Clients. These
certificates can be used for two remote peers to make sure their identity during establishing a VPN
tunnel.

Scenario Description (same as the one described in "My Certificate" section)

Gateway 1 generates the root CA and a local certificate (HQCRT) signed by itself. Import a trusted
certificate (BranchCRT) —a BranchCSR certificate of Gateway 2 signed by root CA of Gateway 1.

Gateway 2 creates a CSR (BranchCSR) to let the root CA of the Gateway 1 sign it to be the BranchCRT
certificate. Import the certificate into the Gateway 2 as a local certificate. In addition, also imports the
certificates of the root CA of Gateway 1 into the Gateway 2 as the trusted ones. (Please also refer to "My
Certificate" and "Issue Certificate" sections).

Establish an IPSec VPN tunnel with IKE and X.509 protocols by starting from either peer, so that all client
hosts in these both subnets can communicate with each other.

Parameter Setup Example (same as the one described in "My Certificate" section)
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For Network-A at HQ

Following tables list the parameter configuration as an example for the "Trusted Certificate" function
used in the user authentication of IPSec VPN tunnel establishing, as shown in above diagram. The
configuration example must be combined with the ones in "My Certificate" and "Issue Certificate"
sections to complete the setup for the whole user scenario.

Configuration Path [Trusted Certificate]-[Trusted Client Certificate List]

Command Button Import

Configuration Path [Trusted Certificate]-[Trusted Client Certificate Import from a File]
File BranchCRT.crt

For Network-B at Branch Office

Following tables list the parameter configuration as an example for the "Trusted Certificate" function
used in the user authentication of IPSec VPN tunnel establishing, as shown in above diagram. The
configuration example must be combined with the ones in "My Certificate" and "Issued Certificate"
sections to complete the setup for the whole user scenario.

Configuration Path [Trusted Certificate]-[Trusted CA Certificate List]

Command Button Import

Configuration Path [Trusted Certificate]-[Trusted CA Certificate Import from a File]
File HQRootCA.crt

Configuration Path [Trusted Certificate]-[Trusted Client Certificate List]

Command Button Import

Configuration Path [Trusted Certificate]-[Trusted Client Certificate Import from a File]
File HQCRT.crt

Scenario Operation Procedure (same as the one described in "My Certificate" section)

In above diagram, the "Gateway 1" is the gateway of Network-A in headquarters and the subnet of its
Intranet is 10.0.76.0/24. It has the IP address of 10.0.76.2 for LAN interface and 203.95.80.22 for WAN-
1 interface. The "Gateway 2" is the gateway of Network-B in branch office and the subnet of its Intranet
is 10.0.75.0/24. It has the IP address of 10.0.75.2 for LAN interface and 118.18.81.33 for WAN-1 interface.
They both serve as the NAT security gateways.

In Gateway 2 import the certificates of the root CA and HQCRT that were generated and signed by

Gateway 1 into the "Trusted CA Certificate List" and "Trusted Client Certificate List" of Gateway 2.
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Import the obtained BranchCRT certificate (the derived BranchCSR certificate after Gateway 1’s root CA
signature) into the "Trusted Client Certificate List" of the Gateway 1 and the "Local Certificate List" of
the Gateway 2. For more details, refer to the Network-B operation procedure in "My Certificate" section
of this manual.

Gateway 2 can establish an IPSec VPN tunnel with "Site to Site" scenario and IKE and X.509 protocols to
Gateway 1.

Finally, the client hosts in two subnets of 10.0.75.0/24 and 10.0.76.0/24 can communicate with each
other.
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Trusted Certificate Setting

Go to Object Definition > Certificate > Trusted Certificate tab.

The Trusted Certificate setting allows user to import trusted certificates and keys.

Import Trusted CA Certificate

= Trusted CA Certificate List |/ 1[jj:/fs Delete | Get CA

Issuer Vaild To Actions

When Import button is applied, a Trusted CA import screen will appear. You can import a Trusted CA certificate
from an existed certificate file, or directly paste a PEM encoded string as the certificate.

# Trusted CA Certificate Import from a File Appl ) Cancel
- MES TR
* Trusted CA Certificate Import froma PEM | .10 [ & (¢:)

Trusted CA Certificate List

Item Value setting Description

Import from a A Must filled setting Select a CA certificate file from user’s computer, and click the Apply button to

File import the specified CA certificate file to the gateway.

Import from a 1. String format can be This is an alternative approach to import a CA certificate.

PEM any text You can directly fill in (Copy and Paste) the PEM encoded CA certificate string,

2. A Must filled setting and click the Apply button to import the specified CA certificate to the

gateway.

Apply N/A Click the Apply button to import the certificate.

Cancel N/A Click the Cancel button to discard the import operation and the screen will
return to the Trusted Certificates page.
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Instead of importing a Trusted CA certificate with mentioned approaches, you can also get the CA certificate
from the SECP server.

If SCEP is enabled (Refer to Object Definition > Certificate > Configuration), you can click Get CA button, a Get
CA Configuration screen will appear.

#» Get CA Configuration

Item Setting
» SCEP Server | — Option — v | | Add Object |
» CA Identifier | | (Optional)

Get CA Configuration

Item Value setting Description

SCEP Server A Must filled setting Select a SCEP Server to identify the SCEP server for use. The server detailed
information could be specified in External Servers. Refer to Object Definition
> External Server > External Server. You may click Add Object button to

generate.
CA Ildentifier 1. String format can be Fill in optional CA Identifier to identify which CA could be used for signing
any text certificates.
Save N/A Click Save to save the settings.
Close N/A Click the Close button to return to the Trusted Certificates page.

Import Trusted Client Certificate

# Trusted Client Certificate List

Vaild To

Actions

Subject Issuer

When Import button is applied, a Trusted Client Certificate Import screen will appear. You can import a Trusted
Client Certificate from an existed certificate file, or directly paste a PEM encoded string as the certificate.
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! Trusted Client Certificate Import from a File

Trusted Client Certificate List

Item Value setting

Import from a A Must filled setting
File

Description
Select a certificate file from user’s computer, and click the Apply button to import the
specified certificate file to the gateway.

Import from a 1. String format can be This is an alternative approach to import a certificate.

PEM any text You can directly fill in (Copy and Paste) the PEM encoded certificate string, and click
2. A Must filled setting the Apply button to import the specified certificate to the gateway.

Apply N/A Click the Apply button to import certificate.

Cancel N/A Click the Cancel button to discard the import operation and the screen will return to

the Trusted Certificates page.

Import Trusted Client Key

e i Import | Delete

Actions

When Import button is applied, a Trusted Client Key Import screen will appear. You can import a Trusted Client
Key from an existed file, or directly paste a PEM encoded string as the key.
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R | FIEIFERE -

) Trusted Client Key Import from a PEM | /.1+0), 4 [11&: (e

Trusted Client Key List

Item Value setting Description
Import from a A Must filled setting Select a certificate key file from user’s computer, and click the Apply button to import
File the specified key file to the gateway.
Import from a 1. String format can be This is an alternative approach to import a certificate key.
PEM any text You can directly fill in (Copy and Paste) the PEM encoded certificate key string, and
2. A Must filled setting click the Apply button to import the specified certificate key to the gateway.
Apply N/A Click the Apply button to import the certificate key.
Cancel N/A Click the Cancel button to discard the import operation and the screen will return to
the Trusted Certificates page.
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3.5.4 Issue Certificate

When you have a Certificate Signing Request (CSR) that needs to be certificated by the root CA of the device,
you can issue the request here and let Root CA sign it. There are two approaches to issue a certificate. One is
from a CSR file importing from the managing PC and another is copy-paste the CSR codes in gateway’s web-

based utility, and then click on the "Sign" button.

If the gateway signs a CSR successfully, the "Signed Certificate View" window will show the resulted certificate
contents. In addition, a "Download" button is available for you to download the certificate to a file in the

managing PC.

Self-signed Certificate Usage Scenario

Network-A @ HQ Data Center

Sk .
Lt/ N | Acs
g ¥ s

erver

Application s Database
Server w[7] server

(D Create HQ Root

®Impor‘§Pranh ,};_/

Security Gateway 1
with Root CA and Trusted
Client Certificates

Global IP: 203.95.80.22
Local IP: 10.0.76.2

<3

(VPN Tunnel (IPSec IKE+X.509) O

® Create IPSec (IKE + X.509)
VPN Tunnel

Network-B @ Branch Office

Security Gateway 2
with Trusted CA &
Client Certificates

Global IP: 118.18.81.33
Local IP: 10.0.75.2

Scenario Application Timing (same as the one described in "My Certificate" section)

When the enterprise gateway owns the root CA and VPN tunneling function, it can generate its own local
certificates by being signed by itself. Also imports the trusted certificates for other CAs and Clients. These
certificates can be used for two remote peers to make sure their identity during establishing a VPN

tunnel.

Scenario Description (same as the one described in "My Certificate" section)

Gateway 1 generates the root CA and a local certificate (HQCRT) signed by itself. Also imports a trusted

RootCA
CRT

certificate (BranchCRT) —a BranchCSR certificate of Gateway 2 signed by root CA of Gateway 1.

Gateway 2 creates a CSR (BranchCSR) to let the root CA of the Gateway 1 sign it to be the BranchCRT
certificate. Import the certificate into the Gateway 2 as a local certificate. In addition, also imports the
certificates of the root CA of the Gateway 1 into the Gateway 2 as the trusted ones. (Please also refer to



5G WAN Extender

"My Certificate" and "Trusted Certificate" sections).

Establish an IPSec VPN tunnel with IKE and X.509 protocols by starting from either peer, so that all client
hosts in these both subnets can communicate with each other.

Parameter Setup Example (same as the one described in "My Certificate" section)
For Network-A at HQ

Following tables list the parameter configuration as an example for the "Issue Certificate" function used
in the user authentication of IPSec VPN tunnel establishing, as shown in above diagram. The
configuration example must be combined with the ones in "My Certificate" and "Trusted Certificate"
sections to complete the setup for whole user scenario.

Configuration Path [Issue Certificate]-[Certificate Signing Request Import from a File]
Browse C:/BranchCSR

Command Button Sign

Configuration Path [Issue Certificate]-[Signed Certificate View]

Command Button Download (default name is "issued.crt")

Scenario Operation Procedure (same as the one described in "My Certificate" section)

In above diagram, the "Gateway 1" is the gateway of Network-A in headquarters and the subnet of its
Intranet is 10.0.76.0/24. It has the IP address of 10.0.76.2 for LAN interface and 203.95.80.22 for WAN-
1 interface. The "Gateway 2" is the gateway of Network-B in branch office and the subnet of its Intranet
is 10.0.75.0/24. It has the IP address of 10.0.75.2 for LAN interface and 118.18.81.33 for WAN-1 interface.
They both serve as the NAT security gateways.

Gateway 1 generates the root CA and a local certificate (HQCRT) that is signed by itself. Import the
certificates of the root CA and HQCRT into the "Trusted CA Certificate List" and "Trusted Client Certificate
List" of Gateway 2.

Gateway 2 generates a Certificate Signing Request (BranchCSR) for its own certificate BranchCRT to be
signed by root CA (Please generate one not self-signed certificate in the Gateway 2, and click on the
"View" button for that CSR. Just downloads it). Take the CSR to be signed by the root CA of the Gateway
1 and obtain the BranchCRT certificate (you need rename it). Import the certificate into the "Trusted
Client Certificate List" of the Gateway 1 and the "Local Certificate List" of the Gateway 2.

Gateway 2 can establish an IPSec VPN tunnel with "Site to Site" scenario and IKE and X.509 protocols to
Gateway 1.

Finally, the client hosts in two subnets of 10.0.75.0/24 and 10.0.76.0/24 can communicate with each
other.
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Issue Certificate Setting

Go to Object Definition > Certificate > Issue Certificate tab.

The Issue Certificate setting allows user to import Certificate Signing Request (CSR) to be signed by root CA.

Import and Issue Certificate

X Certificate Signing Request (CSR) Import from a File ’ %

Choose File | No file chosen

= Certificate Signing Request (CSR) Import from a PEM [

Certificate Signing Request (CSR) Import from a File

Item Value setting Description
Certificate Signing . - )
Select a certificate signing request file you're your

Request (CSR) Import A Must filled setting fori g 8 hq Y Y
from a File computer for importing to the gateway.
:::tle:;:t(i:gnlmiort 1. String fo'rmat can. be any text Enter (copy-p.a.ste) the certificate signing request PEM
from a PEM 2. A Must filled setting encoded certificate to the gateway.

. When root CA is exist, click the Sign button sign and
Sign N/A

issue the imported certificate by root CA.
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Chapter 4 Field Communication (not supported)

Not supported feature for the purchased product, leave it as blank.

170



5G WAN Extender

Chapter 5 Security

5.1 VPN

A virtual private network (VPN) extends a private network across a public network, such as the Internet. It
enables a computer to send and receive data across shared or public networks as if it were directly connected
to the private network, while benefitting from the functionality, security and management policies of the private
network. This is done by establishing a virtual point-to-point connection through the use of dedicated
connections, encryption, or a combination of the two. The tunnel technology supports data confidentiality, data
origin authentication and data integrity of network information by utilizing encapsulation protocols, encryption
algorithms, and hashing algorithms.
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1
i 1
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: Digital ;
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N Ethernet Cable : e :
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—_—____ W™ 4
Access & Control Ethernet-based devices

The product series supports different tunneling technologies to establish secure tunnels between multiple sites
for data transferring, such as IPSec, OpenVPN, L2TP (over IPSec), PPTP and GRE. Besides, some advanced
functions, like Full Tunnel, Tunnel Failover, Tunnel Load Balance, NetBIOS over IPSec, NAT Traversal and Dynamic
VPN, are also supported.
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5.1.1 IPSec

Internet Protocol Security (IPSec) is a protocol suite for securing Internet Protocol (IP) communications by
authenticating and encrypting each IP packet of a communication session. IPSec includes protocols for
establishing mutual authentication between agents at the beginning of the session and negotiation of
cryptographic keys to be used during the session.

An IPSec VPN tunnel is established between IPSec client and server. Sometimes, we call the IPSec VPN client as
the initiator and the IPSec VPN server as the responder. This gateway can be configured as different roles and
establish number of tunnels with various remote devices. Before going to setup the VPN connections, you may
need to decide the scenario type for the tunneling.

IPSec Tunnel Scenarios

To build IPSec tunnel, you need to fill in
remote gateway global IP, and optional
subnet if the hosts behind IPSec peer

Network-A @
Control Center Network-B @

N IPSec VPN Tunnel Scenario | Remote Site ‘&
Host -DC

I bret: 10.0.76.x ﬁ M2M s.;!me:mz.zss.z.x can access to remote site or hosts.
- \ Securi t Gat : . .
% ; B £S5 . 7 TN Under such configuration, there are four
2.SitetoHost | | |~ g s .
k-s—'Hpﬂt-"ﬂt?—-—- | - scenarios:
- 4. Host to Host — . .
Global1P:203.95.80.27 | T T T~ Gebaeiiiaassiss ote|  Site to Site: You need to setup remote

:10.0.76. Responder Initiator :192.168.1.
Local IP:10.0.76.253 (ser’;,er) (Client) Local IP: 192.168.1.253 gateway IP and Subnet Of both gateways,
After the IPSec tunnel established, hosts
€-==== > Site to Site: Tunnel between M2M gateway /w 192.168.1.x subnetand UTM /w 10.0.76.x subnet A
D SRREEEEEE > Siteto Host: Tunnel between M2M gateway /w 192.168.1.x subnet and Host-DC under UTM behlnd bOth gateways can

€~ - —> Host to Site: Tunnel between Host-Re under M2M Gateway and UTM /w 10.0.76.x subnet communication eaCh Other thrOUgh the

<€— — > Hostto Host: Tunnel between Host-Re under M2M Gateway and Host-DC under UTM tun nel‘

Site to Host: Site to Host is suitable for tunneling between clients in a subnet and an application server (host).
As in the diagram, the clients behind the M2M gateway can access to the host "Host-DC" located in the control
center through Site to Host VPN tunnel.

Host to Site: On the contrast, for a single host (or mobile user to) to access the resources located in an intranet,
the Host to Site scenario can be applied.

Host to Host: Host to Host is a special configuration for building a VPN tunnel between two single hosts.
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IPSec

Setting

Go to Security > VPN > IPSec tab.

The IPSec Setting allows user to create and configure IPSec tunnels.

Enable IPSec

= Configuration

Item

Setting

» IPSec

() Enable

» Max. Concurrent IPSec Tunnels

16

Configuration Window

Item
IPsec

Value setting

Unchecked by default

Description
Click the Enable box to enable IPSec function.

Max. Concurrent
IPSec Tunnels

Depends on Product
specification.

The specified value will limit the maximum number of simultaneous IPSec
tunnel connection. The default value can be different for the purchased

model.
Save N/A Click Save to save the settings
Undo N/A Click Undo to cancel the settings

Create/Edit IPSec tunnel

Ensure that the IPSec enable box is checked to enable before further configuring the IPSec tunnel settings.

Tunnel Name | Interface

Remote Gateway

Remote Subnet Enable Actions

When Add/Edit button is applied, a series of configuration screens will appear. They are Tunnel Configuration,
Local & Remote Configuration, Authentication, IKE Phase, IKE Proposal Definition, IPSec Phase, and IPSec
Proposal Definition. You have to configure the tunnel details for both local and remote VPN devices.
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Item

» Tunnel

» Tunnel Name

» Interface

» Tunnel Scenario
» Tunnel TCP MSS

» ICMP Keep alive

» Encapsulation Protocol
» IKE Version

Tunnel

Tunnel Name

Interface

Tunnel Scenario

Tunel TCP MSS

ICMP Keep Alive

Encapsulation
Protocol

IKE Version

Setting
Enable
IPSec #1
WAN-1 ¥
Site-to-Site(Tunnel mode) v
Auto v | |0 (64~1500 Bytes)

Enable Max. fail times |3 Interval |20 (secs.) Source Addr

Destination Addr.

ESP v

viy

Unchecked by default
1. A Must fill setting
2. String format can
be any text

1. A Must fill setting
2. WAN 1 is selected
by default

1. A Must fill setting
2. Site to site is

selected by default

1. An optional setting
2. Auto is set by
default

1. An optional setting
2. Unchecked by
default

1. A Must fill setting
2. ESP is selected by
default

1. A Must fill setting
2. vl is selected by
default

Check the Enable box to activate the IPSec tunnel

Enter a tunnel name. Enter a name that is easy for you to identify.
Value Range: 1 ~ 19 characters.

Select the interface on which IPSec tunnel is to be established. It can be the
available WAN and LAN interfaces.

Select an IPSec tunneling scenario from the dropdown box for your
application. Select Site-to-Site, Site-to-Host, Host-to-Site, or Host-to-Host. If
LAN interface is selected, only Host-to-Host scenario is available.

With Site-to-Site or Site-to-Host or Host-to-Site, IPSec operates in tunnel
mode. The difference among them is the number of subnets. With Host-to-
Host, IPSec operates in transport mode.

Select from the dropdown box to define the size of Tunel TCP MSS.

Select Auto, and all devices will adjust this parameter automatically.

Select Manual, and specify an expected vaule for Tunel TCP MSS.

Value Range: 64 ~ 1500 bytes.

Check the Enable box to activate the ICMP keep alive function for the tunnel.

If the keep alive function is enabled, you have to define the numner of fail

trials, check interval, and source/destination IP address for the ICMP packets.

Value Range: 1~999 for fail trials and time interval.

Select the Encapsulation Protocol from the dropdown box for this IPSec
tunnel. Available encapsulations are ESP and AH.

Specify the IKE version for this IPSec tunnel. Select v1 or v2.
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= Local & Remote Configuration

Item Setting
D Subnet IP Address Subnet Mask Actions
» Local Subnet List 1 192.168.66.0 255255.255.0(24) v
Add
D Subnet IP Address Subnet Mask Actions
» Remote Subnet List 1 ] 255255.255.0(24) v
Add
» Remote Gateway [ | (IP Address/FQDN)

Local & Remote Configuration Window

Item

Local Subnet List

Value setting

A Must fill setting

Description
Specify the Local Subnet IP address and Subnet Mask.
Click the Add or Delete button to add or delete a Local Subnet.

Note_1: When Dynamic VPN option in Tunnel Scenario is selected, there will
be only one subnet available.

Note_2: When Host-to-Site or Host-to-Host option in Tunnel Scenario is
selected, Local Subnet will not be available.

Note_3: When Hub and Spoke option in Hub and Spoke is selected, there will
be only one subnet available.

Remote Subnet List

A Must fill setting

Specify the Remote Subnet IP address and Subnet Mask.
Click the Add or Delete button to add or delete Remote Subnet setting.

Remote Gateway

1. A Must fill setting.
2. Format can be a
ipv4 address or FQDN

Specify the Remote Gateway.

Item

Setting

» Key Management

| IKE+Pre-shared Key v | | | (Min. 8 characters)

» Local ID Type: |User Name v | ID: (Optional)
» Remote ID Type: [UserName v| ID: | |

Authentication Configuration Window

Item

Key Management

Value setting

1. A Must fill setting
2. Pre-shared Key 8
to 32 characters.

Description

Select Key Management from the dropdown box for this IPSec tunnel.
IKE+Pre-shared Key: user needs to set a key (8 ~ 32 characters).

IKE+X.509: user needs Certificate to authenticate. IKE+X.509 will be available
only when Certificate has been configured properly. Refer to Certificate
section of this manual and also Object Definition > Certificate in web-based
utility.

Local ID

An optional setting

Specify the Local ID for this IPSec tunnel to authenticate.

Select User Name for Local ID and enter the username. The username may
include but can’t be all numbers.

Select FQDN for Local ID and enter the FQDN.
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Select User@FQDN for Local ID and enter the User@FQDN.
Select Key ID for Local ID and enter the Key ID (English alphabet or number).

Specify the Remote ID for this IPSec tunnel to authenticate.
Select User Name for Remote ID and enter the username. The username may
include but can’t be all numbers.
Select FQDN for Local ID and enter the FQDN.

Remote ID An optional setting Select User@FQDN for Remote ID and enter the User@FQDN.
Select Key ID for Remote ID and enter the Key ID (English alphabet or
number).
Note: Remote ID will be not available when Dynamic VPN option in Tunnel
Scenario is selected.

« IKE Phase
Item Setting
» Negotiation Mode
» X-Auth [ X-Auth Account |(Optional)
UserName: [ | Password: [ |
» Dead Peer Detection (DPD) @ Enable
Timeout : (seconds) Delay : (seconds)
» Phase1 Key Life Time [3600 | (seconds) (Max. 86400)

IKE Phase Window
Item Value setting Description

Main Mode is set by Specify the Negotiation Mode for this IPSec tunnel. Select Main Mode or

Negotiation Mode
default default Aggressive Mode.

Specify the X-Auth role for this IPSec tunnel. Select Server, Client, or None.
Selected None no X-Auth authentication is required.
Selected Server this gateway will be an X-Auth server. Click on the X-Auth

X-Auth None is selected by Account button to create remote X-Auth client account.
default Selected Client this gateway will be an X-Auth client. Enter User name and
Password to be authenticated by the X-Auth server gateway.
Note: X-Auth Client will not be available for Dynamic VPN option selected in
Tunnel Scenario.
Dead Peer 1. Checked by default  Click Enable box to enable DPD function. Specify the Timeout and Delay time

2. Default Timeout in seconds.
180s and Delay 30s Value Range: 0 ~ 999 seconds for Timeout and Delay.

1. A Must fill settin
Phasel Key Life & Specify the Phasel Key Life Time.

Time 2. Default 36005 Value Range: 30 ~ 86400
3. Max. 86400s ’ ]

e

Detection (DPD)

D Encryption Authentication DH Group Definition
1 @ Enable
2 @ Enable
3 @ Enable
4 [3DES v [SHAT v [Group2 v| ¥ Enable
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IKE Proposal Definition Window

Item Value setting Description
Specify the Phase 1 Encryption method. It can be DES / 3DES / AES-128 / AES-
192 / AES-256.

Specify the Authentication method. It can be None / MD5 / SHA1 / SHA2-256.
IKE Proposal

Definition A Must fill setting

Specify the DH Group. It can be None / Groupl / Group2 / Group5 / Group14 /
Group15 / Groupl6 / Groupl7 / Groupl8.

Check Enable box to enable this setting

» Phase2 Key Life Time 28300 (seconds) (Max. 86400)

IPSec Phase Window

Item Value setting Description

1. A Must fill setting
Phase2 Key Life 2. 28800s is set by Specify the Phase2 Key Life Time in second.
Time default Value Range: 30 ~ 86400.

3. Max. 86400s

« IPSec Proposal Definition

ID Encryption Authentication PFS Group Definition

1 AES-128 v SHA1 v ¥ Enable

2 AES-128 v MD5 v ¥/ Enable
Group2 v

3 (Group2 » @ Enatle

4 [3DES  v| [SHAT | Enable

IPSec Proposal Definition Window

Item Value setting Description
Specify the Encryption method. It can be DES / 3DES / AES-128 / AES-192 /
AES-256.
Note: None is available when Encapsulation Protocol is set as AH.

Specify the Authentication method. It can be None / MD5 / SHA1 / SHA2-256.
IPSec Proposal . . Note: None and SHA2-256 are available only when Encapsulation Protocol is
- A Must fill setting . .
Definition set as ESP; they are not available for AH Encapsulation.

Specify the PFS Group. It can be None / Groupl / Group2 / Group5 / Groupl14
/ Group15 / Group16 / Groupl7 / Groupl8.

Click Enable to enable this setting
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Save N/A Click Save to save the settings
Undo N/A Click Undo to cancel the settings
Back N/A Click Back to return to the previous page.

Create/Edit Dynamic VPN Server List

* Dynamic VPN List %0

Delete || Refresh

Similar to create an IPSec VPN Tunnel for site/host to site/host scenario, when Add / Edit button is applied a
series of configuration screen will appear. They are Tunnel Configuration, Local & Remote Configuration,
Authentication, IKE Phase, IKE Proposal Definition, IPSec Phase, and IPSec Proposal Definition. You have to
configure the tunnel details for the gateway as a Dynamic VPN server.

Note: For the purchased gateway, you can configure one Dynamic VPN server for each WAN interface.

« Tunnel Configuration

Item Setting
» Tunnel [ Enable
» Tunnel Name
» Interface
» Tunnel Scenario
» Encapsulation Protocol
» IKE Version [viv]

Tunnel Configuration Window

Item
Tunnel

Value setting
Unchecked by default

Description
Check the Enable box to activate the Dynamic IPSec VPN tunnel.

Tunnel Name

1. A Must fill setting
2. String format can
be any text

Enter a tunnel name. Enter a name that is easy for you to identify.
Value Range: 1 ~ 19 characters.

Interface

1. A Must fill setting
2. WAN 1 is selected
by default

Select WAN interface on which IPSec tunnel is to be established.

Tunnel Scenario

1. A Must fill setting
2. Tunnel Mode is
selected by default

Select the Dynamic IPSec tunneling scenario. It can be Tunnel Mode or
Transport Mode.

Encapsulation

1. A Must fill setting
2. ESP is selected by

Select the Encapsulation Protocol from the dropdown box for this IPSec

default

Protocol tunnel. Available encapsulations are ESP and AH.
default
1. A Must fill setting

IKE Version 2.vlis selected by Specify the IKE version for this IPSec tunnel.
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« Local & Remote Configuration

Item Setting
» Local Subnet 192.168.66.0
» Local Netmask | 255.255.255.0(/24) v |

Local & Remote Configuration Window

Item Value setting Description
Local Subnet A Must fill setting Specify the Local Subnet IP address.
Local Netmask A Must fill setting Specify the Local Subnet Mask.

Item Setting
» Key Management | IKE+Pre-shared Key v | | | (Min. 8 characters)
» Local ID Type: |UserName ¥ | ID: (Optional)
» Remote ID Type: [User Name ¥ | ID: | |

Authentication Configuration Window

Item Value setting Description

1. A Must fill setting
Key Management 2. Pre-shared Key 8
to 32 characters.

Select Key Management from the dropdown box for this IPSec tunnel.
IKE+Pre-shared Key: user needs to set a key (8 ~ 32 characters).

Specify the Local ID for this IPSec tunnel to authenticate.

Select User Name for Local ID and enter the username. The username may
include but can’t be all numbers.

Select FQDN for Local ID and enter the FQDN.

Select User@FQDN for Local ID and enter the User@FQDN.

Select Key ID for Local ID and enter the Key ID (English alphabet or number).

Local ID An optional setting

Specify the Remote ID for this IPSec tunnel to authenticate.
Select User Name for Remote ID and enter the username. The username may
include but can’t be all numbers.
Select FQDN for Local ID and enter the FQDN.

Remote ID An optional setting Select User@FQDN for Remote ID and enter the User@FQDN.
Select Key ID for Remote ID and enter the Key ID (English alphabet or
number).
Note: Remote ID will be not available when Dynamic VPN option in Tunnel
Scenario is selected.

For the rest IKE Phase, IKE Proposal Definition, IPSec Phase, and IPSec Proposal Definition settings, they are the
same as that of creating an IPSec Tunnel described in previous section. Please refer to the related description.
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5.1.2 OpenVPN

OpenVPN is an application that implements virtual private network (VPN) techniques for creating secure point-
to-point or site-to-site connections in routed or bridged configurations and remote access facilities. It uses a
custom security protocol that utilizes SSL/TLS for key exchange. It is capable of traversing network address
translators (NATs) and firewalls.

OpenVPN allows peers to authenticate each other using a Static Key (pre-shared key) or certificates. When used
in a multi-client-server configuration, it allows the server to release an authentication certificate for every client,
using signature and certificate authority. It uses the OpenSSL encryption library extensively, as well as the
SSLv3/TLSv1 protocol, and contains many security and control features.

OpenVPN Tunneling is a Client and Server based tunneling technology. The OpenVPN Server must have a Static
IP or a FQDN, and maintain a Client list. The OpenVPN Client may be a mobile user or mobile site with public IP
or private IP, and requesting the OpenVPN tunnel connection. The product supports both OpenVPN Server and
OpenVPN Client features to meet different application requirements.

There are two OpenVPN connection scenarios. They are the TAP and TUN scenarios. The product can create
either a layer-3 based IP tunnel (TUN), or a layer-2 based Ethernet TAP that can carry any type of Ethernet traffic.
In addition to configuring the device as a Server or Client, you have to specify which type of OpenVPN connection
scenario is to be adopted.

OpenVPN TUN Scenario

[NetworkcA @ cantrolcanter | — The term "TUN" mode is referred to routing mode and
> ‘..mgﬁg operates with layer 3 packets. In routing mode, the VPN
Eg R =L B client is given an IP address on a different subnet than the

.
scabA Application Enabled __-="
-

Servers -

local LAN under the OpenVPN server. This virtual subnet

JopC 3
8 & is created for connecting to any remote VPN computers.
ramn et {-__ OpenVPNTUN '\\ In routing mode, the OpenVPN server creates a "TUN"
VPN Gateway/Concentrator . . . . . .
Witha “StaticIP" or FQDN" |  oocess from M2M 40T Gateway interface with its own IP address pool which is different to
and RootCA. with “Public/Private IP” H I :
OpenvPN TUN Server OpenVPNTUN Cltent the local LAN. Remote hosts that dial-in will get an IP
GW  Global IP: 60.249.211.108 GW: WAN IP: 192.168.168.111 address inside the virtual network and will have access
FQDN : main-gw.ddns.net LAN IP: 192.168.123.254 VPN IP: 10.8.0.2 .
Local IP: 192.168.100.100 NB: 1P:192.168.123.21 VPN IP:10.8.0.22 only to the server where OpenVPN resides.
1. M2M-loT Gateway (as OpenVPN TUN Client) connects to peer VPN
Gateway/Concentrator (as OpenVPN TUN Server).
2. M2M-loT Gateway will be assigned 10.8.0.2 IP Address after OpenVPN TUN If you want to Offer remote access to a VPN server from
Connection estabilshed. (10.8.0.xis a virtual subnet) client(s), and inhibit the access to remote LAN resources

3. Local networked device will get a virtual IP 10.8.0.x if its trafficgoes through the

OpenVPN TUN connection (when NAT disabled & Redirect Internet Trafficenabled). under VPN server, OpenVPN TUN mode is the simplest

4. SCADA Serverin Control Center can access remote attached device(s) with the .
assigned IP Address 10.8.0.2. solution.

As shown in the diagram, the M2M-loT Gateway is configured as an OpenVPN TUN Client, and connects to an
OpenVPN UN Server. Once the OpenVPN TUN connection is established, the connected TUN client will be

assigned a virtual IP (10.8.0.2) which is belong to a virtual subnet that is different to the local subnet in Control
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Center. With such connection, the local networked devices will get a virtual IP 10.8.0.x if its traffic goes through
the OpenVPN TUN connection when Redirect Internet Traffic settings is enabled; Besides, the SCADA Server in
Control Center can access remote attached serial device(s) with the virtual IP address (10.8.0.2).

OpenVPN TAP Scenario

Application
Servers

\
SCADA

inne

8.

D

7 Serial Cable

(D)

Admin User
e

D

VPN Gateway/Concentrator
with a “Static IP” or “FQDN”
and RootCA.

OpenVPN TAP Server

GW Global IP: 60.249.211.108
FQDN : main-gw.ddns.net

Local IP: 192.168.100.100

M2M-loT Gateway
with a “Public or
Private IP”
OpenVPN TAP Client

WAN IP: 192.168.168.111
Local IP: 192.168.123.254

1. M2M-loT Gateway (as OpenVPN TAP Client) connects to peer VPN
Gateway/Concentrator (as OpenVPN TAP Server).

2. M2M-loT Gateway will be assigned 192.168.100.210 IP Address after
OpenVPN TAP Connection estabilshed. (same subnetasin Control Center)

3. SCADA Serverin Control Center can access remote attached device(s) with
the assigned IP Address 192.168.100.210.

The term "TAP" is referred to bridge mode and operates
with layer 2 packets. In bridge mode, the VPN client is
given an IP address on the same subnet as the LAN resided
under the OpenVPN server. Under such configuration, the
OpenVPN client can directly access to the resources in LAN.
If you want to offer remote access to the entire remote
LAN for VPN client(s), you have to setup OpenVPN in “TAP”
bridge mode.

As shown in the diagram, the M2M-loT Gateway is
configured as an OpenVPN TAP Client, and connects to an
OpenVPN TAP Server. Once the OpenVPN TAP connection
is established, the connected TAP client will be assigned a
virtual IP (192.168.100.210) which is the same subnet as

that of local subnet in Control Center. With such connection, the SCADA Server in Control Center can access
remote attached serial device(s) with the virtual IP address (192.168.100.210).
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Open VPN Setting

Go to Security > VPN > OpenVPN tab.

The OpenVPN setting allows user to create and configure OpenVPN tunnels.

Enable OpenVPN

Enable OpenVPN and select an expected configuration, either server or client, for the gateway to operate.

= Configuration -~ Ix
Item Setting

» OpenVPN ¥ Enable

» Server / Client

Configuration

Item Value setting Description
OpenVPN The box is unchecked by Check the Enable box to activate the OpenVPN function.
default
Server/ Server Configuration is When Server is selected, as the name indicated, server configuration will be
Client selected by default. displayed below for further setup.
When Client is selected, you can specify the client settings in another client
configuration window.
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As an OpenVPN Server

If Server is selected, an OpenVPN Server Configuration screen will appear. OpenVPN Server Configuration
window can let you enable the OpenVPN server function, specify the virtual IP address of OpenVPN server, when
remote OpenVPN clients dial in, and the authentication protocol.

3C
Item Setting
» OpenVPN ¥ Enable
» Server / Client
» OpenVPN Configuration file Enable; Export | client.ovpn

Configuration

Description

Item Value setting
OpenVPN 1. An Optional setting.
Configuration 2. The box is unchecked
File by default.

Click the Enable box to activate the export feature of OpenVPN Client
configuration to a .ovpn file. You have to further click the Export button to get
the configuration file.

The OpenVPN Server supports up to 4 TUN / TAP tunnels at the same time.
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[ (] M
#= OpenVPN Server Configuration ’ °
Item Setting
» OpenVPN Server () Enable
» Protocol
» Port 4430 |
» Tunnel Scenario
TLS v
» Authorization Mode CA Cert.: I 761AM-JH.crt v | Server Cert.: [@l
» Server Virtual IP [10.8.0.0 I
» DHCP-Proxy Mode v Enable
EJ » IP Pool Starting Address: | ~ Ending Address: | "
» Gateway l |
» Netmask | 255255255 0(/24) v |
» Redirect Default Gateway () Enable
» Encryption Cipher
» Hash Algorithm SHA-1 v
» LZO Compression
» Persist Key « Enable
» Persist Tun Enable
& » Advanced Configuration - B

OpenVPN Server Configuration

Item Value setting Description
OpenVPN The box is unchecked by Click the Enable to activate OpenVPN Server functions.
Server default.
Protocol 1. A Must filled setting Define the selected Protocol for connecting to the OpenVPN Server.
2. Bydefault TCPis e Select TCP, or UDP
selected. ->The TCP protocol will be used to access the OpenVPN Server, and Port will
be set as 4430 automatically.
e Select UDP
->The UDP protocol will be used to access the OpenVPN Server, and Port will
be set as 1194 automatically.
Port 1. A Must filled setting Specify the Port for connecting to the OpenVPN Server.
2. Bydefault 4430 is set. | Value Range: 1 ~ 65535.
Tunnel Scenario | 1. A Must filled setting Specify the type of Tunnel Scenario for connecting to the OpenVPN Server. It
2. Bydefault TUN is can be TUN for TUN tunnel scenario, or TAP for TAP tunnel scenario.
selected.
Authorization 1. A Must filled setting Specify the authorization mode for the OpenVPN Server.
Mode 2. Bydefault TLSis e TLS
selected. ->The OpenVPN will use TLS authorization mode, and the following items CA
Cert., Server Cert. and DH PEM will be displayed.
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Local Endpoint
IP Address

Remote
Endpoint IP
Address

Static Key

Server Virtual IP

DHCP-Proxy
Mode

IP Pool

Gateway

Netmask

Redirect Default
Gateway

Encryption
Cipher

Hash Algorithm

A Must filled setting

A Must filled setting

A Must filled setting

A Must filled setting

1. A Must filled setting
2. The box is checked by
default.

A Must filled setting

A Must filled setting

By default - select one - is
selected.

1. An Optional setting.
2. The box is unchecked
by default.

1. A Must filled setting.
2. By default Blowfish is
selected.

By default SHA-1 is
selected.

CA Cert. could be generated in Certificate. Refer to Object Definition >
Certificate > Trusted Certificate.

Server Cert. could be generated in Certificate. Refer to Object Definition >
Certificate > My Certificate.

e Static Key

->The OpenVPN will use static key (pre-shared) authorization mode, and the
following items Local Endpoint IP Address, Remote Endpoint IP Address and
Static Key will be displayed.

Note: Static Key will be available only when TUN is chosen in Tunnel Scenario.
Specify the virtual Local Endpoint IP Address of this OpenVPN gateway.

Value Range: The IP format is 10.8.0.x, the range of x is 1~254.

Note: Local Endpoint IP Address will be available only when Static Key is
chosen in Authorization Mode.

Specify the virtual Remote Endpoint IP Address of the peer OpenVPN
gateway.

Value Range: The IP format is 10.8.0.x, the range of x is 1~254.

Note: Remote Endpoint IP Address will be available only when Static Key is
chosen in Authorization Mode.

Specify the Static Key.

Note: Static Key will be available only when Static Key is chosen in Authorization
Mode.

Specify the Server Virtual IP.

Value Range: The IP format is 10.y.0.0, the range of y is 1~254.

Note: Server Virtual IP will be available only when TLS is chosen in Authorization
Mode.

Check the Enable box to activate the DHCP-Proxy Mode.

Note: DHCP-Proxy Mode will be available only when TAP is chosen in Tunnel
Device.

Specify the virtual IP pool setting for the OpenVPN server. You have to specify
the Starting Address and Ending Address as the IP address pool for the
OpenVPN clients.

Note: IP Pool will be available only when TAP is chosen in Tunnel Device, and
DHCP-Proxy Mode is unchecked (disabled).

Specify the Gateway setting for the OpenVPN server. It will be assigned to the
connected OpenVPN clients.

Note: Gateway will be available only when TAP is chosen in Tunnel Device, and
DHCP-Proxy Mode is unchecked (disabled).

Specify the Netmask setting for the OpenVPN server. It will be assigned to the
connected OpenVPN clients.

Value Range: 255.255.255.0/24 (only support class C)

Note_1: Netmask will be available when TAP is chosen in Tunnel Device, and
DHCP-Proxy Mode is unchecked (disabled).

Note_2: Netmask will also be available when TUN is chosen in Tunnel Device.
Check the Enable box to activate the Redirect Default Gateway function.

Specify the Encryption Cipher from the dropdown list.
It can be Blowfish/AES-256/AES-192/AES-128/None.

Specify the Hash Algorithm from the dropdown list.
It can be SHA-1/MD5/MD4/SHA2-256/SHA2-512/None/Disable.
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LzO
Compression
Multicast

Persis Key

Persis Tun

Advanced

Configuration

Save
Undo

By default Adaptive is
selected.

1. An Optional setting.
2. The box is checked by
default.

1. An Optional setting.
2. The box is checked by
default.

1. An Optional setting.
2. The box is checked by
default.

N/A

N/A
N/A

Specify the LZO Compression scheme.
It can be Adaptive/YES/NO/Default.
Check the Enable box to activate the Multicast function.

Note: Multicast function is only available for TAP tunnel scenario.
Check the Enable box to activate the Persis Key function.

Check the Enable box to activate the Persis Tun function.

Click the Edit button to specify the Advanced Configuration setting for the
OpenVPN server.

If the button is clicked, Advanced Configuration will be displayed below.

Click Save to save the settings.

Click X to cancel the changes and return to last page.
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When Advanced Configuration is selected, an OpenVPN Server Advanced Configuration screen will appear.

*1 OpenVPN Server Advanced Configuration ®

Item Setting
» TLS Cipher 'None v |
» TLS Auth. Key )
(Optional)
» Client to Client Enable
» Duplicate CN Enable
» Tunnel MTU |1500 ]
» Tunnel UDP Fragment ‘0 |
» Tunnel UDP MSS-Fix Enable

» CCD-Dir Default File

» Client Connection Script

» Additional Configuration

OpenVPN Server Advanced Configuration

Item Value setting Description
TLS Cipher 1. A Must filled setting. Specify the TLS Cipher from the dropdown list.
2. TLS-RSA-WITH-AES128- It can be None / TLS-RSA-WITH-RC4-MD5 / TLS-RSA-WITH-AES128-SHA / TLS-
SHA is selected by default  RSA-WITH-AES256-SHA / TLS-DHE-DSS-AES128-SHA / TLS-DHE-DSS-AES256-
SHA.
Note: TLS Cipher will be available only when TLS is chosen in Authorization
Mode.
TLS Auth. Key 1. An Optional setting. Specify the TLS Auth. Key.
2. String format: any text ~ Note: TLS Auth. Key will be available only when TLS is chosen in Authorization
Mode.
Client to Client  The box is checked by Check the Enable box to enable the traffics among different OpenVPN Clients.
default Note: Client to Client will be available only when TLS is chosen in
Authorization Mode
Duplicate CN The box is checked by Check the Enable box to activate the Duplicate CN function.
default Note: Duplicate CN will be available only when TLS is chosen in Authorization
Mode
Tunnel MTU 1. A Must filled setting Specify the Tunnel MTU.
2. The value is 1500 by Value Range: 0 ~ 1500.
default
Tunnel UDP 1. A Must filled setting Specify the Tunnel UDP Fragment. By default, it is equal to Tunnel MTU.
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Fragment

Tunnel UDP
MSS-Fix

CCD-Dir Default
File

Client
Connection
Script
Additional
Configuration

2. The value is 1500 by
default

1. An Optional setting.

2. The box is unchecked
by default.

1. An Optional setting.

2. String format: any text
1. An Optional setting.

2. String format: any text

1. An Optional setting.
2. String format: any text

Value Range: 0 ~ 1500.

Note: Tunnel UDP Fragment will be available only when UDP is chosen in
Protocol.

Check the Enable box to activate the Tunnel UDP MSS-Fix Function.

Note: Tunnel UDP MSS-Fix will be available only when UDP is chosen in
Protocol.

Specify the CCD-Dir Default File.

Value Range: 0 ~ 256 characters.

Specify the Client Connection Script.

Value Range: 0 ~ 256 characters.

Specify the Additional Configuration.
Value Range: 0 ~ 256 characters.
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As an OpenVPN Client

If Client is selected, the configuration screen will be changed as below and an OpenVPN Client List screen appear.

« Configuration ’ "

Item Setting
» OpenVPN ("] Enable
» Server / Client Client v
» OpenVPN Configuration file Enable Upgrade | Interface  WAN-1 v

OpenVPN Configuration

Item Value setting Description
OpenVPN The box is unchecked  Check the Enable box to activate the OpenVPN function.
by default
Server/ Server Configurationis When Server is selected, as the name indicated, server configuration will be
Client selected by default. displayed below for further setup.

When Client is selected, you can specify the client settings in another client
configuration window.

OpenVPN 1. An Optional setting.  Click the Enable box to activate the OpenVPN Client configuration via a pre-
Configuration file 2. The box is defined configuration file. You have to further specify the Interface to be
unchecked by default. applied, and click the Upgrade button to upload the configuration from
a .ovpn file.

If you enabled this function, you can’t add any OpenVPN clients manually.

= OpenVPN Client List

Client
ID Name Interface Protocol Port

Redirect
Internet | NAT
Traffic

Remote Remote
Scenario IP/FQDN | Subnet

Authorization | Encryption
Mode Cipher

Algorithm Enable Actions

When Add button is applied, OpenVPN Client Configuration screen will appear. OpenVPN Client Configuration
window let you specify the required parameters for an OpenVPN VPN client, such as "OpenVPN Client Name",
"Interface", "Protocol", "Tunnel Scenario", "Remote IP/FQDN", "Remote Subnet", "Authorization Mode",
"Encryption Cipher", "Hash Algorithm" and tunnel activation.
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Item

Setting

» OpenVPN Client Name

|OpenVPN Client#1 |

» Authorization Mode

» Interface
» Protocol TCP v | Port (443 |
» Tunnel Scenario
» Remote IP/FQDN | |
» Remote Subnet () Enable | | [255.256.255.0(24) v |
» Redirect Internet Traffic [0 Enable
» NAT [ Enable
TLS v

CA Cert. E] Client Cert.: EI Client Key.: E Please set the Certificate.

» Encryption Cipher Blowfish v
» Hash Algorithm SHA- v

» LZO Compression

» Persist Key

» Persist Tun

» Advanced Configuration

E@ EI

m m

- | S

(U]
S|z
@ @

» Tunnel

O

Enable

OpenVPN Client Configuration

Item
OpenVPN Client
Name

Value setting
A Must filled setting

Description
The OpenVPN Client Name will be used to identify the client in the tunnel list.
Value Range: 1 ~ 32 characters.

Interface 1. A Must filled setting  Define the physical interface to be used for this OpenVPN Client tunnel.
2. By default WAN-1
is selected.
Protocol 1. A Must filled setting  Define the Protocol for the OpenVPN Client.
2. By default TCP is e Select TCP
selected. ->The OpenVPN will use TCP protocol, and Port will be set as 443
automatically.
e Select UDP
->The OpenVPN will use UDP protocol, and Port will be set as 1194
automatically.
Port 1. A Must filled setting  Specify the Port for the OpenVPN Client to use.

2. By default 443 is
set.

Value Range: 1 ~ 65535.

Tunnel Scenario

1. A Must filled setting
2. By default TUN is
selected.

Specify the type of Tunnel Scenario for the OpenVPN Client to use. It can be
TUN for TUN tunnel scenario, or TAP for TAP tunnel scenario.

Remote IP/FQDN

A Must filled setting

Specify the Remote IP/FQDN of the peer OpenVPN Server for this OpenVPN
Client tunnel.
Fill in the IP address or FQDN.

Remote Subnet

1. An Optional setting.
2. The box is
unchecked by default.

Check the Enable box to activate remote subnet function, and specify Remote
Subnet of the peer OpenVPN Server for this OpenVPN Client tunnel.
Fill in the remote subnet address and remote subnet mask.

Redirect Internet
Traffic

1. An Optional setting.
2. The box is
unchecked by default.

Check the Enable box to activate the Redirect Internet Traffic function.
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NAT

Authorization
Mode

Local Endpoint IP
Address

Remote Endpoint IP
Address

Static Key

Encryption Cipher
Hash Algorithm
LZO Compression

Multicast

Persis Key

Persis Tun

Advanced
Configuration

Tunnel

Save
Undo

1. An Optional setting.
2. The box is checked
by default.

1. A Must filled setting
2. By default TLS is
selected.

A Must filled setting

A Must filled setting

A Must filled setting

By default Blowfish is
selected.

By default SHA-1 is
selected.

By default Adaptive is
selected.

1. An Optional setting.
2. The box is checked
by default.

1. An Optional setting.
2. The box is checked
by default.

1. An Optional setting.
2. The box is checked
by default.

N/A

The box is unchecked
by default

N/A

N/A

Check the Enable box to activate the NAT function.

Specify the authorization mode for the OpenVPN Server.

o TLS

->The OpenVPN will use TLS authorization mode, and the following items CA
Cert., Client Cert. and Client Key will be displayed.

CA Cert. could be selected in Trusted CA Certificate List. Refer to Object
Definition > Certificate > Trusted Certificate.

Client Cert. could be selected in Local Certificate List. Refer to Object Definition
> Certificate > My Certificate.

Client Key could be selected in Trusted Client key List. Refer to Object Definition
> Certificate > Trusted Certificate.

e Static Key

->The OpenVPN will use static key authorization mode, and the following
items Local Endpoint IP Address, Remote Endpoint IP Address and Static Key
will be displayed.

Specify the virtual Local Endpoint IP Address of this OpenVPN gateway.

Value Range: The IP format is 10.8.0.x, the range of x is 1~254.

Note: Local Endpoint IP Address will be available only when Static Key is
chosen in Authorization Mode.

Specify the virtual Remote Endpoint IP Address of the peer OpenVPN
gateway.

Value Range: The IP format is 10.8.0.x, the range of x is 1~254.

Note: Remote Endpoint IP Address will be available only when Static Key is
chosen in Authorization Mode.

Specify the Static Key.

Note: Static Key will be available only when Static Key is chosen in Authorization
Mode.

Specify the Encryption Cipher.

It can be Blowfish/AES-256/AES-192/AES-128/None.

Specify the Hash Algorithm.

It can be SHA-1/MD5/MD4/SHA2-256/SHA2-512/None/Disable.

Specify the LZO Compression scheme.

It can be Adaptive/YES/NO/Default.

Check the Enable box to activate the Multicast function.

Note: Multicast function is only available for TAP tunnel scenario.
Check the Enable box to activate the Persis Key function.

Check the Enable box to activate the Persis Tun function.

Click the Edit button to specify the Advanced Configuration setting for the
OpenVPN server.

If the button is clicked, Advanced Configuration will be displayed below.
Check the Enable box to activate this OpenVPN tunnel.

Click Save to save the settings.
Click X to cancel the changes and return to last page.
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When Advanced Configuration is selected, an OpenVPN Client Advanced Configuration screen will appear.

ltem

» TLS Cipher

» TLS Auth. Key(Optional)

» User Name(Optional)

» Password(Optional)

None

» Bridge TAP to
» Firewall Protection

» Client IP Address

VLAN

Setting

|(Optional)
(Optional)
(Optional)

1v

Enable

DynamicIP v

» Tunnel MTU

» Tunnel UDP Fragment

» Tunnel UDP MSS-Fix

» nsCeriType Verification

» Connection Retry(seconds)

» DNS

» Additional Configuration

» TLS Renegotiation Time(seconds)

1500
1500

Enable

Enable

3600
-1

(seconds)

(seconds)

Automatically v

TLS Cipher

TLS Auth. Key

User Name

Password

Bridge TAP to

1. A Must filled setting.
2. TLS-RSA-WITH-
AES128-SHA is selected
by default

1. An Optional setting.
2. String format: any
text

An Optional setting.

An Optional setting.

By default VLAN 1 is
selected

Specify the TLS Cipher from the dropdown list.

It can be None / TLS-RSA-WITH-RC4-MDS5 / TLS-RSA-WITH-AES128-SHA / TLS-
RSA-WITH-AES256-SHA / TLS-DHE-DSS-AES128-SHA / TLS-DHE-DSS-AES256-
SHA.

Note: TLS Cipher will be available only when TLS is chosen in Authorization
Mode.

Specify the TLS Auth. Key for connecting to an OpenVPN server, if the server
required it.

Note: TLS Auth. Key will be available only when TLS is chosen in Authorization
Mode.

Enter the User account for connecting to an OpenVPN server, if the server
required it.

Note: User Name will be available only when TLS is chosen in Authorization
Mode.

Enter the Password for connecting to an OpenVPN server, if the server
required it.

Note: User Name will be available only when TLS is chosen in Authorization
Mode.

Specify the setting of “Bridge TAP to” to bridge the TAP interface to a certain
local network interface or VLAN.

Note: Bridge TAP to will be available only when TAP is chosen in Tunnel
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Firewall Protection
Client IP Address

Tunnel MTU

Tunnel UDP
Fragment

Tunnel UDP MSS-
Fix

nsCerType
Verification

TLS Renegotiation
Time (seconds)
Connection
Retry(seconds)

DNS

Additional
Configuration
Save

Undo

The box is unchecked by
default.

By default Dynamic IP is
selected

1.A Must filled setting
2.The value is 1500 by
default

The value is 1500 by
default

The box is unchecked by
default.

The box is unchecked by
default.

The value is 3600 by
default

The value is -1 by
default

By default
Automatically is
selected

An Optional setting.

N/A
N/A

Scenario and NAT is unchecked.

Check the box to activate the Firewall Protection function.

Note: Firewall Protection will be available only when NAT is enabled.
Specify the virtual IP Address for the OpenVPN Client.

It can be Dynamic IP/Static IP.

Specify the value of Tunnel MTU.

Value Range: 0 ~ 1500.

Specify the value of Tunnel UDP Fragment.
Value Range: 0 ~ 1500.

Note: Tunnel UDP Fragment will be available only when UDP is chosen in

Protocol.
Check the Enable box to activate the Tunnel UDP MSS-Fix function.

Note: Tunnel UDP MSS-Fix will be available only when UDP is chosen in

Protocol.
Check the Enable box to activate the nsCerType Verification function.

Note: nsCerType Verification will be available only when TLS is chosen in

Authorization Mode.

Specify the time interval of TLS Renegotiation Time.

Value Range: -1 ~ 86400.

Specify the time interval of Connection Retry.

The default -1 means that it is no need to execute connection retry.
Value Range: -1 ~ 86400, and -1 means no retry is required.
Specify the setting of DNS.

It can be Automatically/Manually.

Enter optional configuration string here. Up to 256 characters is allowable.
Value Range: 0 ~ 256 characters.

Click Save to save the settings.

Click X to cancel the changes and return to last page.
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5.1.3 L2TP
« Configuration ’ x
Item Setting

» L2TP [C] Enable

» Client/Server Server v

« L2TP Server Configuration a %

Item Setting

» L2TP Server Enable

» Interface WAN-1 v

» L2TP over IPsec Enable Preshared Key {Min. 2 characters) | Advanced setlings

» Server Virtual IP 192.168.10.1

» IP Pool Starting Address 10

» IP Pool Ending Address 17

» Authentication Protocol PAP | | CHAP | A MS-CHAP  MS-CHAP V2

» MPPE Encryption Enable | 40 bits v

» Service Port 1701

= L2TP Server Status : a x

User Name Remote IP Remote Virtual IP Remote Call ID Actions

No connection from remote

« User Account List ’ x
1D User Name Password Enable Actions

Layer 2 Tunneling Protocol (L2TP) is a tunneling protocol used to support virtual private networks (VPNs) or as
part of the delivery of services by ISPs. It does not provide any encryption or confidentiality by itself. Rather, it
relies on an encryption protocol that it passes within the tunnel to provide privacy. This Gateway can behave as
a L2TP server and a L2TP client both at the same time.

L2TP Server: It must have a static IP or a FQDN for clients to create L2TP tunnels. It also maintains “User Account
list” (user name/ password) for client login authentication; There is a virtual IP pool to assign virtual IP to each
connected L2TP client.

L2TP Client: It can be mobile users or gateways in remote offices with dynamic IP. To setup tunnel, it should get
“user name”, “password” and server’s global IP. In addition, it is required to identify the operation mode for
each tunnel as main connection, failover for another tunnel, or load balance tunnel to increase overall
bandwidth. It needs to decide “Default Gateway” or “Remote Subnet” for packet flow. Moreover, you can also
define what kind of traffics will pass through the L2TP tunnel in the “Default Gateway / Remote Subnet”

parameter.
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Network-A @ HQ Data Center

Network-B @ Remote Office
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Application ) Tickr ¥
Server vt
Database e B
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2 | 10.0.76.0/24 J e
@ ; ' 4 ”’
S

\ ,/' \
Security = 0L = = e h e e = = = — —
Gateway

“StaticIP” [

M2mM
Gateway
“Dynamic IP”

AN
Global IP: 203.95.80.22
Local IP: 10.0.76.2

[L2TP]-[L2TP Server Configuration] 1
L2TP over IPSec:

Enable Preshare Key, 12345678
Server Virtual IP: 192.168.101.253 | 2
IP Pool Starting Address: 10
IP Pool Ending Address: 50 3
Authentication Protocol: MS-CHAP
MPPE Encryption: Enable, 128 bits
Service Port: 1701 4

Create tunnel by Client,
Authentication by Server.

Server assign Virtual IP,
Tunnel created.

Client subnet can access
HQ servervia tunnel.

Internet packets go through
Tunnel if “Default Gateway”
option Is enabled.

ID1:
User Name: Client-1
Password: 1234

1~ Global IP: 118.18.81.33

Local IP: 10.0.75.2

[L2TP]-[L2TP Client Configuration]

Operation Mode: Always on
L2TP over IPSec: Enable
Preshare Key: 12345678
Remote LNS IP/FQDN: 203.95.80.22
Remote LNS Port: 1701

User Name: Client-1

Password: 1234

Remote Subnet: 10.0.76.0/24
Authentication Protocol: MS-CHAP
MPPE Encryption: Enable,128 bits
Service Port: Auto

Besides, for the L2TP client peer, a Remote
Subnet item is required. It is for the Intranet of
L2TP server peer. So, at L2TP client peer, the
packets whose destination is in the dedicated
subnet will be transferred via the L2TP tunnel.
Others will be transferred based on current
routing policy of the gateway at L2TP client
peer. But, if you entered 0.0.0.0/0 in the
Remote Subnet field, it will be treated as a
"Default Gateway" setting for the L2TP client
peer, all packets, including the Internet
accessing of L2TP client peer, will go through
the established L2TP tunnel. That means the
remote L2TP server peer controls the flow of
any packets from the L2TP client peer.
Certainly, those packets come through the
L2TP tunnel.
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L2TP Setting

Go to Security > VPN > L2TP tab.

The L2TP setting allows user to create and configure L2TP tunnels.

Enable L2TP
*| Configuration

Item Setting
» L2TP () Enable
» Client/Server

Enable L2TP Window

Item Value setting Description
L2TP Unchecked by default  Click the Enable box to activate L2TP function.

. Specify the role of L2TP. Select Server or Client role your gateway will take.
Client/Server A Must filled setting pedly yours v

Below are the configuration windows for L2TP Server and for L2TP Client.

Save N/A

Click Save button to save the settings

As a L2TP Server

When select Server in Client/Server, the L2TP server Configuration will appear.

* L2TP Server Configuration

Item Setting
» L2TP Server Enable
» Interface All WANs v
» L2TP over IPsec Enable Preshared Key (Min. 2 characters) | Advanced settings
» Server Virtual IP 192.168.10.1
» IP Pool Starting Address 10
» IP Pool Ending Address 17

» Authentication Protocol

PAP | | CHAP | MS-CHAP | | MS-CHAP v2

» MPPE Encryption

Enable 40 pits v

» Service Port

1701
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» L2TP over IPsec

Enable Preshared Key | | (Min. 2 characters) [ Advanced setﬁngs&

IKE Proposal Definition
Encryption: |3DES v’ Authentication: |SHA1 v| DH Group |Group 2 v‘
|PSec proposal Definition:

v| PFS Group: [None v|

Encryption: ‘3[)55 v’ Authentication: |SHA1

L2TP Server

Interface

L2TP over IPSec

Server Virtual IP

IP Pool Starting
Address

IP Pool Ending
Address

Authentication
Protocol

MPPE Encryption

Service Port

Save
Undo

The box is unchecked
by default

1. A Must fill setting
2. All WANS is
selected by default

The box is unchecked
by default

A Must filled setting

1. A Must filled setting
2. 10 s set by default.

1. A Must filled setting
2. 17 is set by default.

A Must filled setting

A Must filled setting

A Must filled setting

N/A
N/A

When click the Enable box
It will active L2TP server

Select the interface on which L2TP tunnel is to be established. It can be the
available WAN interfaces.

When click the Enable box.

It will enable L2TP over IPSec and need to fill in the Pre-shared Key (2~31
characters).

Furthermore, you can also click the Advanced Settings button to specify
required settings for IKE Proposal and IPSec Proposal definitions:

Encryption method: It can be DES / 3DES / AES-128 / AES-192 / AES-256.
Authentication method: It can be None / MD5 / SHA1 / SHA2-256.

DH Group: It can be None / Groupl / Group2 / Group5 / Group14 / Group15 /
Groupl6 / Groupl7 / Groupl8.

Note: If the Interface setting is ALL WANSs, the L2TP over IPSec function won't
be available, and all settings are been greyed out.

Specify the L2TP server Virtual IP

It will set as this L2TP server local virtual IP

Specify the L2TP server starting IP of virtual IP pool

It will set as the starting IP which assign to L2TP client

Value Range: 1~ 254.

Specify the L2TP server ending IP of virtual IP pool

It will set as the ending IP which assign to L2TP client

Value Range: >= Starting Address, and < (Starting Address + 8) or 254,
Select single or multiple Authentication Protocols for the L2TP server with
which to authenticate L2TP clients. Available authentication protocols are PAP
/ CHAP / MS-CHAP / MS-CHAP v2.

Specify whether to support MPPE Protocol. Click the Enable box to enable
MPPE and from dropdown box to select 40 bits / 56 bits / 128 bits.

Note: when MPPE Encryption is enabled, the Authentication Protocol PAP /
CHAP options will not be available.

Specify the Service Port which L2TP server use.

Value Range: 1 ~ 65535.

Click the Save button to save the configuration.

Click the Undo button to recovery the configuration.
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« L2TP Server Status

User Name Remote IP Remote Virtual IP Remote Call ID Actions

No connection from remote

L2TP Server Status
Item Value setting Description

It displays the User Name, Remote IP, Remote Virtual IP, and Remote Call ID of
L2TP Server Status N/A the connected L2TP clients.

Click the Refresh button to renew the L2TP client information.

« User Account List [[¥1]

ID User Name Password Enable Actions

User Name Password Account
| | [ | ©J Enable
Save

Account List Window

Value setting Description
This is the L2TP authentication user account entry. You can create and add
accounts for remote clients to establish L2TP VPN connection to the gateway
device.

Max.of 10 Click Add button to add user account. Enter User name and password. Then
. ax.o user
User Account List check the enable box to enable the user.
accounts .
Click Save button to save new user account.
The selected user account can permanently be deleted by clicking the Delete
button.

Value Range: 1 ~ 32 characters.
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As a L2TP Client

When select Client in Client/Server, a series L2TP Client Configuration will appear.
*] L2TP Client Configuration ° b4

Item Setting

» L2TP Client Enable

L2TP Client Configuration

Item Setting Value setting Description
L2TP Client The box is unchecked )
Check the Enable box to enable L2TP client role of the gateway.
by default
Save N/A Click Save button to save the settings.
Undo N/A Click Undo button to cancel the settings.

Create/Edit L2TP Client

« L2TP Client List & Status [[X2) ° x

ID Tunnel Name Interface Virtual IP |§7|?‘ch:| Remote Subnet Status Enable Actions
- L2TP #1 WAN 1 0000 |192168127.72 ) Select

When Add/Edit button is applied, a series of configuration screen will appear. You can add up to 8 L2TP Clients.

# L2TP Client Configuration

Item Setting
» Tunnel Name |L2TP #1 |
» Interface
» L2TP over IPsec [J) Enable Preshared Key (Min. 2 characters) | Advanced seftings
» Remote LNS IP/FQDN 1]
» MTU [1500 ]
» Remote LNS Port [1701
» User Name :|
» Password ]
» Tunneling Password (Optional) | |
» Remote Subnet |
» Authentication Protocol [ PAP [J CHAP [] MS-CHAP (] MS-CHAP v2
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» MPPE Encryption (] Enable
» NAT before Tunneling (] Enable
| Auto v
» LCP Echo Type
! Interval 30 seconds Max. Failure Time 6 times
» Service Port | Auto v| o
» Tunnel (] Enable
. . Enter a tunnel name. Enter a name that is easy for you to identify.
Tunnel Name A Must filled setting

Value Range: 1 ~ 32 characters.
Define the selected interface to be the used for this L2TP tunnel
Interface A Must filled setting (WAN-1 is available only when WAN-1 interface is enabled)
The same applies to other WAN interfaces (e.g. WAN-2).
When click the Enable box.
It will enable L2TP over IPSec and need to fill in the Pre-shared Key (2~31
characters).
. Furthermore, you can also click the Advanced Settings button to specify
The box is unchecked . . oo
L2TP over IPSec by default required settings for IKE Proposal and IPSec Proposal definitions:
Encryption method: It can be DES / 3DES / AES-128 / AES-192 / AES-256.
Authentication method: It can be None / MD5 / SHA1 / SHA2-256.
DH Group: It can be None / Groupl / Group2 / Group5 / Group14 / Group15 /
Groupl6 / Groupl7 / Groupl8.

Remote LNS

A Must filled setting Enter the public IP address or the FQDN of the L2TP server.
IP/FQDN

1.A Must filled setting .

. Specify the MTU.
MTU 2.The value is 1500 by
Value Range: 0 ~ 1500.

default

1. A Must filled
Remote LNS Port setting Enter the Remote LNS Port for this L2TP tunnel.

2.1701 is set by Value Range: 1 ~ 65535.

default

Enter the User Name for this L2TP tunnel to be authenticated when connect
User Name A Must filled setting to L2TP server.
Value Range: 1 ~ 32 characters.
. . Enter the Password for this L2TP tunnel to be authenticated when connect to
Password A Must filled setting L2TP server.

Tunneling An Optional filled

. . Enter the Tunneling Password for this L2TP tunnel to authenticate.
Password(Optional)  setting

Specify the remote subnet for this L2TP tunnel to reach L2TP server.
The Remote Subnet format must be IP address/netmask (e.g. 10.0.0.2/24).

It is for the Intranet of L2TP VPN server. So, at L2TP client peer, the packets
whose destination is in the dedicated subnet will be transferred via the L2TP

Remote Subnet A Must filled setting
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Authentication
Protocol

MPPE Encryption

NAT before
Tunneling

LCP Echo Type

Service Port

Tunnel
Save
Undo

1. A Must filled
setting

2. Unchecked by
default

1. Unchecked by
default

2. an optional setting

1. A Must filled
setting

2. Unchecked by
default

1. Auto is set by
default

A Must filled setting

Unchecked by default
N/A
N/A

VPN tunnel. Others will be transferred based on current routing policy of the
security gateway at L2TP client peer.

If you entered 0.0.0.0/0 in the Remote Subnet field, it will be treated as a
default gateway setting for the L2TP client peer, all packets, including the
Internet accessing of L2TP Client peer, will go through the established L2TP
VPN tunnel. That means the remote L2TP VPN server controls the flow of any
packets from the L2TP client peer. Certainly, those packets come through the
L2TP VPN tunnel.

Specify one ore multiple Authentication Protocol for this L2TP tunnel.
Available authentication methods are PAP / CHAP / MS-CHAP / MS-CHAP v2.

Specify whether L2TP server supports MPPE Protocol. Click the Enable box to
enable MPPE.

Note: when MPPE Encryption is enabled, the Authentication Protocol PAP /
CHAP options will not be available.

Specify whether NAT is required or not for this L2TP tunnel.

Specify the LCP Echo Type for this L2TP tunnel. It can be Auto, User-defined,
or Disable.

Auto: the system sets the Interval and Max. Failure Time.

User-defined: enter the Interval and Max. Failure Time. The default value for
Interval is 30 seconds, and Maximum Failure Times is 6 Times.

Disable: disable the LCP Echo.

Value Range: 1 ~ 99999 for Interval Time, 1~999 for Failure Time.

Specify the Service Port for this L2TP tunnel to use. It can be Auto, (1701) for
Cisco), or User-defined.

Auto: The system determines the service port.

1701 (for Cisco): The system use port 1701 for connecting with CISCO L2TP
Server.

User-defined: Enter the service port. The default value is 0.

Value Range: 0 ~ 65535.

Check the Enable box to enable this L2TP tunnel.

Click Save button to save the settings.

Click X button to cancel the settings and back to last page.
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5.1.4 PPTP

« Configuration an
Item Setting

» PPTP [ Enable

» Client/Server

= PPTP Server Configuration an
Item Setting

» PPTP Server Enable

» Interface

» Server Virtual IP

» IP Pool Starting Address

» IP Pool Ending Address

» Authentication Protocol PAP ' CHAP ' MS-CHAP ' MS-CHAP v2

» MPPE Encryption Enable

« PPTP Server Status [[Eo0 an

User Name Remote IP Remote Virtual IP Remote Call ID Actions
No connection from remote
« User Account List [~ | %]
ID User Name Password Enable Actions

Point-to-Point Tunneling Protocol (PPTP) is a method for implementing virtual private networks. PPTP uses a
control channel over TCP and a GRE tunnel operating to encapsulate PPP packets. It is a client-server based
technology. There are various levels of authentication and encryption for PPTP tunneling, usually natively as
standard features of the Windows PPTP stack. The security gateway can play either "PPTP Server" role or "PPTP
Client" role for a PPTP VPN tunnel, or both at the same time for different tunnels. PPTP tunnel process is nearly
the same as L2TP.

PPTP Server: It must have a static IP or a FQDN for clients to create PPTP tunnels. It also maintains “User Account
list” (user name / password) for client login authentication; There is a virtual IP pool to assign virtual IP to each
connected PPTP client. u

PPTP Client: It can be mobile users or gateways in remote offices with dynamic IP. To setup tunnel, it should get
“user name”, “password” and server’s global IP. In addition, it is required to identify the operation mode for
each tunnel as main connection, failover for another tunnel, or load balance tunnel to increase overall
bandwidth. It needs to decide “Default Gateway” or “Remote Subnet” for packet flow. Moreover, you can also
define what kind of traffics will pass through the PPTP tunnel in the “Default Gateway / Remote Subnet”
parameter.
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Network-A @ HQ Data Center

=2Ae

= o

W iy

Application N,
Server %

\ Databa-se o= %
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Gateway

Security —A === ——— —
Gateway 2 ~-.PPTPTunnel___
“StaticIP” &) -
) . server Cl
Global IP: 203.95.80.22

““““““ 1

Local IP: 10.0.76.2

Create tunnel by Client,
Authentication by Server.

[PPTP]-[PPTP Server Configuration] 1

Server Virtual IP: 192.168.101.253
IP Pool Starting Address: 10
IP Pool Ending Address: 50
Authentication Protocol: MS-CHAP
MPPE Encryption: Enable, 128 bits 3

2 Server assign Virtual IP,
Tunnel created.

Client subnet can access
HQservervia tunnel.

ID1:
User Name: Client-1 4
Password: 1234

Internet packets go through

option Is

“Dynamic IP”

Tunnel if “Default Gateway”
lod

= = Global IP:118.18.81.33
Local IP: 10.0.75.2

[PPTP]-[PPTP Client Configuration]

Operation Mode: Always on
Remote IP/FQDN: 203.95.80.22
User Name: Client-1

Password: 1234

Remote Subnet: 10.0.76.0/24
Authentication: MS-CHAP

MPPE Encryption: Enable, 128 bits

"

Certainly, those packets come through the PPTP tunnel.

Besides, for the PPTP client peer, a Remote
Subnet item is required. It is for the Intranet of
PPTP server peer. So, at PPTP client peer, the
packets whose destination is in the dedicated
subnet will be transferred via the PPTP tunnel.
Others will be transferred based on current
routing policy of the gateway at PPTP client
peer. But, if you entered 0.0.0.0/0 in the
Remote Subnet field, it will be treated as a
"Default Gateway" setting for the PPTP client
peer, all packets, including the Internet
accessing of PPTP client peer, will go through
the established PPTP tunnel. That means the
remote PPTP server peer controls the flow of
any packets from the PPTP client peer.
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PPTP Setting

Go to Security > VPN > PPTP tab.

The PPTP setting allows user to create and configure PPTP tunnels.

Enable PPTP
*| Configuration

Item Setting
» PPTP () Enable
» Client/Server

Enable PPTP Window
Value setting
Unchecked by default

Item
PPTP

Description
Click the Enable box to activate PPTP function.

Client/Server

A Must fill setting

Specify the role of PPTP. Select Server or Client role your gateway will take.
Below are the configuration windows for PPTP Server and for Client.

Save

N/A

Click Save button to save the settings.

As a PPTP Server

The gateway supports up to a maximum of 10 PPTP user accounts.
When Server in the Client/Server field is selected, the PPTP server configuration window will appear.

* PPTP Server Configuration

Item Setting
» PPTP Server Enable
» Interface
» Server Virtual IP 1192.168.12.1 |

» IP Pool Starting Address

» IP Pool Ending Address

—
N

» Authentication Protocol

PAP | CHAP v MS-CHAP v MS-CHAP v2

» MPPE Encryption

v Enable
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PPTP Server Configuration Window

Item Value setting Description
PPTP Server Unchecked by default ~ Check the Enable box to enable PPTP server role of the gateway.
1. A Must fill setting

. Select the interface on which PPTP tunnel is to be established. It can be the
Interface 2. All WANSs is

available WAN interfaces.
selected by default

1. A Must fill setting Specify the PPTP server Virtual IP address. The virtual IP address will serve as

Server Virtual IP 2. Default is the virtual DHCP server for the PPTP clients. Clients will be assigned a virtual IP
192.168.0.1 address from it after the PPTP tunnel has been established.
This is the PPTP server’s Virtual IP DHCP server. User can specify the first IP
IP Pool Starting 1. A Must fill setting address for the subnet from which the PPTP client’s IP address will be
Address 2. Default is 10 assigned.

Value Range: 1 ~ 254.
This is the PPTP server’s Virtual IP DHCP server. User can specify the last IP

IP Pool Ending 1. A Must fill setting address for the subnet from which the PPTP client’s IP address will be
Address 2. Default is 17 assigned.
Value Range: >= Starting Address, and < (Starting Address + 8) or 254.
Authentication 1. A Must fill setting Select single or multiple Authentication Protocols for the PPTP server with
Protocol 2. Unchecked by which to authenticate PPTP clients. Available authentication protocols are PAP
default / CHAP / MS-CHAP / MS-CHAP v2.

Specify whether to support MPPE Protocol. Click the Enable box to enable
MPPE and from dropdown box to select 40 bits / 56 bits / 128 bits.
Note: when MPPE Encryption is enabled, the Authentication Protocol PAP /

1. A Must fill setting
MPPE Encryption 2. Unchecked by

default
CHAP options will not be available.
Save N/A Click Save button to save the settings.
Undo N/A Click Undo button to cancel the settings.
= PPTP Server Status

User Name Remote IP Remote Virtual IP Remote Call ID Actions

No connection from remote

PPTP Server Status Window

Item Value setting Description
It displays the User Name, Remote IP, Remote Virtual IP, and Remote Call ID of
PPTP Server Status  N/A the connected PPTP clients.

Click the Refresh button to renew the PPTP client information.

« User Account List [[XT] [- ] ]
ID User Name Password Enable Actions
User Name Password Account
[ | [ | i1 Enable
Save
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User Account List Window

Item Value setting Description
This is the PPTP authentication user account entry. You can create and add
accounts for remote clients to establish PPTP VPN connection to the gateway

device.
Click Add button to add user account. Enter User name and password. Then
. Max.of 10 user
User Account List check the enable box to enable the user.
accounts

Click Save button to save new user account.

The selected user account can permanently be deleted by clicking the Delete
button.

Value Range: 1 ~ 32 characters.

As a PPTP Client

When select Client in Client/Server, a series PPTP Client Configuration will appear.

« PPTP Client Configuration ’ a

Item Setting

» PPTP Client Enable

PPTP Client Configuration

Item Value setting Description

PPTP Client Unchecked by default  Check the Enable box to enable PPTP client role of the gateway.
Save N/A Click Save button to save the settings.

Undo N/A Click Undo button to cancel the settings.

Create/Edit PPTP Client

« PPTP Client List & Status W.%0| I Delete | Refresh
D Tunnel Name Interface Virtual IP Ils%?)%ﬁ Remote Subnet Status Enable Actions

When Add/Edit button is applied, a series PPTP Client Configuration will appear.
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Item

» Tunnel Name

» Interface

» Remote IP/FQDN

» MTU

» User Name

» Password

» Remote Subnet

» Authentication Protocol
» MPPE Encryption

» NAT before Tunneling

» LCP Echo Type

» Tunnel

PPTP #1
WAN1 v

1500

PAP

Enable

Enable
Auto

Interval |30

Enable

Setting

CHAP [[] MS-CHAP [] MS-CHAP v2

seconds Max. Failure Time |6 times

Tunnel Name

Interface

Remote IP/FQDN

MTU

User Name

Password

Remote Subnet

A Must fill setting

1. A Must fill setting
2. WAN1 is selected
by default

1. A Must fill setting.
2. Format can be a
ipv4 address or FQDN
1.A Must filled setting
2.The value is 1500 by
default

A Must fill setting

A Must fill setting

A Must fill setting

Enter a tunnel name. Enter a name that is easy for you to identify.
Value Range: 1 ~ 32 characters.

Define the selected interface to be the used for this PPTP tunnel
(WAN-1 is available only when WAN-1 interface is enabled)

The same applies to other WAN interfaces (e.g. WAN-2).

Enter the public IP address or the FQDN of the PPTP server.

Specify the MTU.
Value Range: 0 ~ 1500.

Enter the User Name for this PPTP tunnel to be authenticated when connect
to PPTP server.

Value Range: 1 ~ 32 characters.

Enter the Password for this PPTP tunnel to be authenticated when connect to
PPTP server.

Specify the remote subnet for this PPTP tunnel to reach PPTP server.

The Remote Subnet format must be IP address/netmask (e.g. 10.0.0.2/24).

It is for the Intranet of PPTP VPN server. So, at PPTP client peer, the packets
whose destination is in the dedicated subnet will be transferred via the PPTP
VPN tunnel. Others will be transferred based on current routing policy of the
security gateway at PPTP client peer.

If you entered 0.0.0.0/0 in the Remote Subnet field, it will be treated as a
default gateway setting for the PPTP client peer, all packets, including the
Internet accessing of PPTP Client peer, will go through the established PPTP
VPN tunnel. That means the remote PPTP VPN server controls the flow of any
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Authentication
Protocol

MPPE Encryption

NAT before
Tunneling

LCP Echo Type

Tunnel
Save
Undo

1. A Must fill setting
2. Unchecked by
default

1. Unchecked by
default

2. an optional setting

1. A Must filled setting
2. Unchecked by
default

Auto is set by default

Unchecked by default
N/A
N/A

packets from the PPTP client peer. Certainly, those packets come through the
PPTP VPN tunnel.

Specify one ore multiple Authentication Protocol for this PPTP tunnel.
Available authentication methods are PAP / CHAP / MS-CHAP / MS-CHAP v2.

Specify whether PPTP server supports MPPE Protocol. Click the Enable box to
enable MPPE.

Note: when MPPE Encryption is enabled, the Authentication Protocol PAP /
CHAP options will not be available.

Specify whether NAT is required or not for this PPTP tunnel.

Specify the LCP Echo Type for this PPTP tunnel. It can be Auto, User-defined,
or Disable.

Auto: the system sets the Interval and Max. Failure Time.

User-defined: enter the Interval and Max. Failure Time. The default value for
Interval is 30 seconds, and Maximum Failure Times is 6 Times.

Disable: disable the LCP Echo.

Value Range: 1 ~ 99999 for Interval Time, 1~999 for Failure Time.

Check the Enable box to enable this PPTP tunnel.

Click Save button to save the settings.

Click X button to cancel the settings and back to last page.
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5.1.5 GRE

Generic Routing Encapsulation (GRE) is a tunneling protocol developed by Cisco Systems that encapsulates a
wide variety of network layer protocols inside virtual point-to-point links over an Internet Protocol internetwork.

Deploy a M2M gateway for remote site and establish a virtual private network with control center by using GRE
tunneling. So, all client hosts behind M2M gateway can make data communication with server hosts behind
control center gateway.

GRE Tunneling is similar to IPSec Tunneling, client requesting the tunnel establishment with the server. Both the
client and the server must have a Static IP or a FQDN. Any peer gateway can be worked as either a client or a
server, even using the same set of configuration rule.

GRE Tunnel Scenario

Network.B @ Remote Office To setup a GRE tunnel, each peer needs to setup
B iy its global IP as tunnel IP and fill in the other's

Application Go 5| fickr P

Server Database =L T global IP as remote IP.

s

oS | 10.0.76.0/24

N d
>3

RS
A

Network-A @ HQ Data Center

Besides, each peer must further specify the

Security
Gateway
“StaticIP” |

Global IP: 203.95.
Local IP: 10.0.76.2

[GRE]-[GRE Rule Configuration]

M2M
Gateway

“Static IP”

Tunnel Name: GRE_A_B
Interface: WAN-1

Operation Mode: Always on
Tunnel IP: 203.95.80.22
Remote IP: 118.18.81.33

Key: 1234

TTL: 255

Remote Subnet: 10.0.75.0/24
DMVPN Spoke: Disable
Tunnel: Enable

-------- 1

4 Create tunnel by Client,
Authentication by Server.

2 Any peer gateway can be
both Client & Server, and

= = Global IP: 118.18.81.33
Local IP: 10.0.75.2

[GRE]-[GRE Rule Configuration]

Tunnel Name: GRE_A_B
Interface: WAN-1
Operation Mode: Always on

must have Static IP or FQDN. | Tunnel IP: 118.18.81.33

Client subnet can access
3 Serversubnetvia tunnel.

Internet packets go through

option Is enabled.

”

4 Tunnel if “Default Gateway”

Remote IP: 203.95.80.22

Key: 1234

TTL: 255

Remote Subnet: 10.0.76.0/24
DMVPN Spoke: Disable
Tunnel: Enable

Remote Subnet item. It is for the Intranet of GRE
server peer. So, at GRE client peer, the packets
whose destination is in the dedicated subnet will
be transferred via the GRE tunnel. Others will be
transferred based on current routing policy of
the gateway at GRE client peer. But, if you
entered 0.0.0.0/0 in the Remote Subnet field, it
will be treated as a "Default Gateway" setting for
the GRE client peer, all packets, including the
Internet accessing of GRE client peer, will go
through the established GRE tunnel. That means

the remote GRE server peer controls the flow of any packets from the GRE client peer. Certainly, those packets
come through the GRE tunnel.

If the GRE server supports DMVPN Hub function, like Cisco router as the VPN concentrator, the GRE client can
active the DMVPN spoke function here since it is implemented by GRE over IPSec tunneling.
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GRE Setting

Go to Security > VPN > GRE tab.

The GRE setting allows user to create and configure GRE tunnels.

Enable GRE
# Configuration a 2
Item Setting
» GRE Tunnel () Enable
» Max. Concurrent GRE 32
Tunnels

Enable GRE Window

Item Value setting Description
GRE Tunnel Unchecked by default  Click the Enable box to enable GRE function.
The specified value will limit the maximum number of simultaneous GRE
Max. Concurrent Depends on Product . .
. tunnel connection. The default value can be different for the purchased
GRE Tunnels specification.
model.
Save N/A Click Save button to save the settings
Undo N/A Click Undo button to cancel the settings
Create/Edit GRE tunnel
« GRE Tunnel List 80
ID Tunnel Name Interface Tunnel IP Remote IP MTU Key TTL Remote Subnet Enable Actions

When Add/Edit button is applied, a GRE Rule Configuration screen will appear.
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Item Setting
» Tunnel Name IGRE #1 ]
» Interface
» Tunnel IP IP: | | MASK: | -- select one — v | (Option
» Remote IP | |
» MTU [ ]
> Key | | (Optional)
» TTL [ ]
» Remote Subnet | l
» Tunnel () Enable

GRE Rule Configuration Window
Item Value setting Description
Enter a tunnel name. Enter a name that is easy for you to identify.

Tunnel Name A Must fill setting
Value Range: 1 ~ 9 characters.

1. A Must fill settin
& Select the interface on which GRE tunnel is to be established. It can be the

Interface 2. WAN 1 is selected ] .
available WAN and LAN interfaces.
by default
Tunnel IP An Optional setting Enter the Tunnel IP address and corresponding subnet mask.
. . Enter the Remote IP address of remote GRE tunnel gateway. Normally this is
Remote IP A Must fill setting

the public IP address of the remote GRE gateway.
MTU refers to Maximum Transmission Unit. It specifies the largest packet size
1. A Must filled setting Permitted for Internet transmission.
MTU 2. Auto (value zeroor  When set to Auto (value ‘0’ or blank), the router selects the best MTU for best
blank) is set by default  Internet connection performance.
Value Range: 0 ~ 1500.
Enter the Key for the GRE connection.
Value Range: 0 ~ 9999999999.
1. A Must fill setting Specify TTL hop-count value for this GRE tunnel.
2.1to 255 range Value Range: 1~ 255.
Specify the remote subnet for this GRE tunnel.
The Remote Subnet format must be IP address/netmask (e.g. 10.0.0.2/24).
It is for the Intranet of GRE server peer. So, at GRE client peer, the packets
whose destination is in the dedicated subnet will be transferred via the GRE
Remote Subnet A Must fill setting tunnel. Others will be transferred based on current routing policy of the
security gateway at GRE client peer.

Key An Optional setting

TTL

If you entered 0.0.0.0/0 in the Remote Subnet field, it will be treated as a
default gateway setting for the GRE client peer, all packets, including the
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Tunnel
Save
Undo

Unchecked by default
N/A
N/A

Internet accessing of GRE client peer, will go through the established GRE
tunnel. That means the remote GRE server peer controls the flow of any
packets from the GRE client peer. Certainly, those packets come through the
GRE tunnel.

Check Enable box to enable this GRE tunnel.

Click Save button to save the settings.

Click X button to cancel the settings and back to last page.
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5.2 Firewall

Internet

|Sessions e
M2M-loT <J——— Allow/ specific destination port TCP/UDP & @

Gateway i _’_.: Deny  Specific Destination IP Address

Host Computer

(« ))*_

———

Control Center

S

Application Filter
e (T S S e i e Applicati
=3, Block Lotsof TCP/UDP/ICMP e
oo attackpackets _ _________
okl Local

Access & Control

The firewall functions include Packet Filter, URL Blocking, Content Filter, MAC Control, Application Filter, IPS and
some firewall options. The supported function can be different for the purchased gateway.

5.2.1 Packet Filter

) - x
Item Setting

» Packet Filters v Enable

» Black List / White List Deny those match the following rules. v

» Log Alert Log Alert

- Add | Delete \ - %
Rule From To Destination = Source Source Destination Time .

ID Source IP P MAC Protocol Port Port Schedule Enable Actions

Name Interface Interface
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"Packet Filter" function can let you define some filtering rules for incoming and outgoing packets. So the
gateway can control what packets are allowed or blocked to pass through it. A packet filter rule should indicate
from and to which interface the packet enters and leaves the gateway, the source and destination IP addresses,
and destination service port type and port number. In addition, the time schedule to which the rule will be

active.

Packet Filter with White List Scenario

Denied to pass for non-http packets.
(packets not dest. to TCP port 80 / 443)

X‘_ — — — Access “ftp://ftp.abc.com/pub/”

B0 5 50

Allowed to Pass *~._
{packets with TCP PO;{BU')"‘&S).._ User Group 192.168.123.2007250

Access “http://www.abc.com/”

Black List / White List: Allow those || Rule Name : Allow HTTP_HTTPS || Destination IP: Any

match the following rules From Interface : Any Destination Port :
To Interface : Any HTTP (TCP:80) for Rule-1,
Source IP: 192.168.123.200 ~ HTTPs (TCP:443) for Rule-2

192.168.123.250 Protocol : TCP

Packet Filter Setting

As shown in the diagram, specify "Packet Filter Rule
List" as white list (Allow those match the following rules)
and define the rules. Rule-1 is to allow HTTP packets to
pass, and Rule-2 is to allow HTTPS packets to pass.

Under such configuration, the gateway will allow only
HTTP and HTTPS packets, issued from the IP range
192.168.123.200 to 250, which are targeted to TCP
port 80 or 443 to pass the WAN interface.

Go to Security > Firewall > Packet Filter Tab.

The packet filter setting allows user to create and customize packet filter policies to allow or reject specific
inbound/outbound packets through the router based on their office setting.

Enable Packet Filter

Item Setting
» Packet Filters Enable
» Black List / White List Deny those match the following rules. v
B ng Alert LUQ Alert
. The box is unchecked b
Packet Filter 4 Check the Enable box to activate Packet Filter function

default
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When Deny those match the following rules is selected, as the name suggest,
. Deny those match the e . . .
Black List / . . packets specified in the rules will be blocked —black listed. In contrast, with
White Li following rules is set by . . N
ite List default Allow those match the following rules, you can specifically white list the
efau
packets to pass and the rest will be blocked.
The box is unchecked b
Log Alert Y Check the Enable box to activate Event Log.
default
Save N/A Click Save to save the settings
Undo N/A Click Undo to cancel the settings

Create/Edit Packet Filter Rules

The gateway allows you to customize your packet filtering rules. It supports up to a maximum of 20 filter rule
sets.

= Packet Filter List "

Source IP

Destination Source Destination

Enable Actions

Protocol Schedule

When Add button is applied, Packet Filter Rule Configuration screen will appear.

# Packet Filter Rule Configuration

Item Setting
» Rule Name |Ru|e1 |
» From Interface Any—v
» To Interface Any v
» Source IP ‘Any v |
» Destination IP Any v
» Source MAC |Any v |
» Protocol
» Source Port  User-defined Service v | | - |
» Destination Port User-defined Service v | | -] |
» Time Schedule W
» Rule [ Enable

Packet Filter Rule Configuration

Item Name Value setting Description

1. String format can be Enter a packet filter rule name. Enter a name that is easy for you to
Rule Name any text remember.

2. A Must filled setting Value Range: 1 ~ 30 characters.
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From Interface

To Interface

Source IP

Destination IP

Source MAC

Protocol

1. A Must filled setting
2. By default Any is
selected

1. A Must filled setting
2. By default Any is
selected

1. A Must filled setting
2. By default Any is
selected

1. A Must filled setting
2. By default Any is
selected

1. A Must filled setting
2. By default Any is
selected

1. A Must filled setting
2. By default Any(0) is
selected

Define the selected interface to be the packet-entering interface of the router.
If the packets to be filtered are coming from LAN to WAN then select LAN for
this field. Or VLAN-1 to WAN then select VLAN-1 for this field. Other examples
are VLAN-1 to VLAN-2. VLAN-1 to WAN.

Select Any to filter packets coming into the router from any interfaces.

Please note that two identical interfaces are not accepted by the router. e.g.,
VLAN-1 to VLAN-1.

Define the selected interface to be the packet-leaving interface of the router.
If the packets to be filtered are entering from LAN to WAN then select WAN
for this field. Or VLAN-1 to WAN then select WAN for this field. Other
examples are VLAN-1 to VLAN-2. VLAN-1 to WAN.

Select Any to filter packets leaving the router from any interfaces.

Please note that two identical interfaces are not accepted by the router. e.g.,
VLAN-1 to VLAN-1.

This field is to specify the Source IP address.

Select Any to filter packets coming from any IP addresses.

Select Specific IP Address to filter packets coming from an IP address.

Select IP Range to filter packets coming from a specified range of IP address.
Select IP Address-based Group to filter packets coming from a pre-defined
group. Note: group must be pre-defined before this option become available.
Refer to Object Definition > Grouping > Host grouping. You may also access
to create a group by the Add Rule shortcut button.

This field is to specify the Destination IP address.

Select Any to filter packets that are entering to any IP addresses.

Select Specific IP Address to filter packets entering to an IP address entered in
this field.

Select IP Range to filter packets entering to a specified range of IP address
entered in this field.

Select IP Address-based Group to filter packets entering to a pre-defined
group selected. Note: group must be pre-defined before this selection become
available. Refer to Object Definition > Grouping > Host grouping. You may
also access to create a group by the Add Rule shortcut button. Setting done
through the Add Rule button will also appear in the Host grouping setting
screen.

This field is to specify the Source MAC address.

Select Any to filter packets coming from any MAC addresses.

Select Specific MAC Address to filter packets coming from a MAC address.
Select MAC Address-based Group to filter packets coming from a pre-defined
group selected. Note: group must be pre-defined before this selection become
available. Refer to Object Definition > Grouping > Host grouping. You may
also access to create a group by the Add Rule shortcut button.

For Protocol, select Any to filter any protocol packets

Then for Source Port, select a predefined port dropdown box when Well-
known Service is selected, otherwise select User-defined Service and specify
a port range.
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Then for Destination Port, select a predefined port dropdown box when Well-
known Service is selected, otherwise select User-defined Service and specify
a port range.
Value Range: 1 ~ 65535 for Source Port, Destination Port.
For Protocol, select ICMPv4 to filter ICMPv4 packets
For Protocol, select TCP to filter TCP packets
Then for Source Port, select a predefined port dropdown box when Well-
known Service is selected, otherwise select User-defined Service and specify
a port range.
Then for Destination Port, select a predefined port dropdown box when Well-
known Service is selected, otherwise select User-defined Service and specify
a port range.
Value Range: 1 ~ 65535 for Source Port, Destination Port.
For Protocol, select UDP to filter UDP packets
Then for Source Port, select a predefined port dropdown box when Well-
known Service is selected, otherwise select User-defined Service and specify
a port range.
Then for Destination Port, select a predefined port dropdown box when Well-
known Service is selected, otherwise select User-defined Service and specify
a port range.
Value Range: 1 ~ 65535 for Source Port, Destination Port.
For Protocol, select GRE to filter GRE packets
For Protocol, select ESP to filter ESP packets
For Protocol, select SCTP to filter SCTP packets
For Protocol, select User-defined to filter packets with specified port number.
Then enter a pot number in Protocol Number box.
Apply Time Schedule to this rule, otherwise leave it as Always.

Time Schedule A Must filled setting If the dropdown list is empty ensure Time Schedule is pre-configured. Refer to

Object Definition > Scheduling > Configuration tab.
The box is unchecked by

Rule Click Enable box to activate this rule then save the settings.
default.

Save N/A Click Save to save the settings.

Undo N/A Click X to cancel the settings and back to last page.
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5.2.2 URL Blocking

"URL Blocking" function can let you define blocking or allowing rules for incoming and outgoing Web request
packets. With defined rules, gateway can control the Web requests containing the complete URL, partial domain
name, or pre-defined keywords. For example, one can filter out or allow only the Web requests based on domain
input suffixes like .com or .org or keywords like “bct” or “mpe”.

An URL blocking rule should specify the URL, partial domain name, or included keywords in the Web requests
from and to the gateway and also the destination service port. Besides, a certain time schedule can be applied
to activate the URL Blocking rules during pre-defined time interval(s).

The gateway will logs and displays the disallowed web accessing requests that matched the defined URL blocking
rule in the black-list or in the exclusion of the white-list.

When you choose "Allow all to pass except those match the following rules" for the "URL Blocking Rule List",
you are setting the defined URL blocking rules to belong to the black list. The packets, listed in the rule list, will
be blocked if one pattern in the requests matches to one rule. Other Web requests can pass through the
gateway. In contrast, when you choose "Deny all to pass except those match the following rules" for the "URL
Blocking Rule List", you are setting the defined packet filtering rules to belong to the white list. The Web requests,
listed in the rule, will be allowed if one pattern in the requests matches to one rule. Other Web requests will be
blocked.

URL Blocking Rule with Black List

",

Denied to access those URLs with “sex”, “girl” or “playboy” , like
http://www.sex.com; www.girl.com, www.playboy.com”

When the administrator of the gateway wants to
block the Web requests with some dedicated
patterns, he can use the "URL Blocking" function

4m=—m———- -X- - Gatewa . p .
- WAN ’ Y to block specific Web requests by defining the
A\ ~.o L 10.0.75.2 Network-A black list as shown in above diagram. Certainly,
o= when the administrator wants to allow only the
Allowto Pass for URL Access : ’ Web requests with some dedicated patterns to
without “sex”, “girl “or “playboy | \ \ "
. O o go through the gateway, he can also use the "URL
rane . . .. . .
: _ : Blocking" function by defining the white list to
S REE L ooy meet the requirement
Black List / White List: Deny those ;JRL/ I?Tmfln:lame/ Keyword: a )
: ex; girl; playboy . .
match the following rules Pl As shown in the diagram, enable the URL
Rule : Enable blocking function and create the first rule to

deny the Web requests with "sex" or "sexygirl" patterns and the other to deny the Web requests with "playboy"

pattern to go through the gateway. System will block the Web requests with "sex", "sexygirl" or "playboy"
patterns to pass through the gateway.
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URL Blocking Setting

Go to Security > Firewall > URL Blocking Tab.

In "URL Blocking" page, there are three configuration windows. They are the "Configuration" window, "URL
Blocking Rule List" window, and "URL Blocking Rule Configuration" window.

The "Configuration" window can let you activate the URL blocking function and specify to black listing or to
white listing the packets defined in the "URL Blocking Rule List" entry. In addition, log alerting can be enabled
to record on-going events for any disallowed Web request packets. Refer to "System Status" in "6.1.1 System
Related" section in this user manual for how to view recorded log.

The "URL Blocking Rule List" window lists all your defined URL blocking rule entry. And finally, the "URL Blocking
Rule Configuration" window can let you define URL blocking rules. The parameters in a rule include the rule
name, the Source IP or MAC, the URL/Domain Name/Keyword, the destination service ports, the integrated
time schedule rule and the rule activation.

Enable URL Blocking

Item Setting
» URL Blocking v Enable
» Black List / White List Deny those match the following rules. v
» Log Alert Enable

The box is unchecked Check the Enable box to activate URL Blocking function.

URL Blocking by default
Specify the URL Blocking Policy, either Black List or White List.
Black List: When Deny those match the following rules is selected, as the name
. Deny those match the .
Black List / following rules is set suggest, the matched Web request packets will be blocked.
White List b defau?t White List: When Allow those match the following rules is selected, the matched
y Web request packets can pass through the Gateway, and the others that don’t match
the rules will be blocked.
The box is unchecked Check the Enable box to activate Event Log.
Log Alert
by default
Save NA Click Save button to save the settings
Undo NA Click Undo button to cancel the settings

Create/Edit URL Blocking Rules

The Gateway supports up to a maximum of 20 URL blocking rule sets. Ensure that the URL Blocking is enabled before we
can create blocking rules.
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Add Delete

Destination Time

D Rule Name Port Schedule

Source IP Source MAC URL / Domain Name / Keyword Enable Actions

When Add button is applied, the URL Blocking Rule Configuration screen will appear.

J
ltem Setting
» Rule Name Rule1
» Source IP Any M
» Source MAC Any v
» URL / Domain Name / Keyword
» Destination Port Any M
» Time Schedule Rule (0) Always v
» Rule Enable
1. String format can be any  Specify an URL Blocking rule name. Enter a name that is easy for you to
Rule Name text understand.
2. A Must filled setting

This field is to specify the Source IP address.

e Select Any to filter packets coming from any IP addresses.

o Select Specific IP Address to filter packets coming from an IP address entered in

' . this field.
Source IP LA ML.JSt filled setting o Select IP Range to filter packets coming from a specified range of IP address
2. Anyis set by default D
entered in this field.

o Select IP Address-based Group to filter packets coming from a pre-defined
group selected. Note: group must be pre-defined before this option become
available. Refer to Object Definition > Grouping > Host grouping.

This field is to specify the Source MAC address.

e Select Any to filter packets coming from any MAC addresses.

Source MAC 1. AMust filled setting e Select Sp.ecifi'c MAC Address to filter packets coming from a MAC address
2. Anyis set by default entered in this field. . . .

o Select MAC Address-based Group to filter packets coming from a pre-defined
group selected. Note: group must be pre-defined before this selection become
available. Refer to Object Definition > Grouping > Host grouping.

1. A Must filled setting Specify URL, Domain Name, or Keyword list for URL checking.
URL / Domain 2. Supports up to a ¢ In the Black List mode, if a matched rule is found, the packets will be dropped.
Name / maximum of 10 Keywords e In the White List mode, if a matched rule is found, the packets will be accepted
Keyword in a rule by using the and the others which don’t match any rule will be dropped.

delimiter “;”.

This field is to specify the Destination Port number.

Destination 1. A Must filled setting e Select Any to filter packets going to any Port.
Port 2. Anyis set by default o Select Specific Service Port to filter packets going to a specific Port entered in this field.

o Select Port Range to filter packets going to a specific range of Ports entered in this field.

Time Apply a specific Time Schedule to this rule; otherwise leave it as (0) Always.

Schedule Rule

A Must filled setting

If the dropdown list is empty ensure Time Schedule is pre-configured. Refer to Object
Definition > Scheduling > Configuration tab.
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Rule

Save
Undo

The box is unchecked by
default.

NA

NA

Click the Enable box to activate this rule.

Click the Save button to save the settings.
Click the X button to cancel the changes and back to last page.
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5.2.3 MAC Control

Item

» MAC Control v Enahle

» Black List / White List

» Log Alert Enable

» Known MAC from LAN PC List v | | Copyto
J ‘ Add | | Delete

1D Rule Name MAC Address

Setting

Deny MAC Address Below. v

Time Schedule Rule Enable Actions

"MAC Control" function allows you to assign the accessibility to the gateway for different users based on device’s
MAC address. When the administrator wants to reject the traffics from some client hosts with specific
MAC addresses, he can use the "MAC Control" function to reject with the black list configuration.

MAC Control with Black List Scenario

MACAddress : “20:6A:6A:6A:6A:6B”
Denied to access Internet.

WAN X
\ A Gateway \_\

MAC Address : “00:50:18:99:99:01"
Allowed to access Internet. |

JPNB

jPuLylj

Black List / White List:

Deny MAC Address Below.

Rule Name : Deny_JP
MAC Address : 20:6A:6A:6A:6A:6B

&

\ 00:50:18:99:99:01

As shown in the diagram, enable the MAC control
function and specify the "MAC Control Rule List" is a
black list, and configure one MAC control rule for
the gateway to deny the connection request from
the "JP NB" with its own MAC address
20:6A:6A:6A:6A:6B.

System will block the connecting from the "JP NB"
to the gateway but allow others.
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MAC Control Setting

Go to Security > Firewall > MAC Control Tab.

The MAC control setting allows user to create and customize MAC address policies to allow or reject packets
with specific source MAC address.

Enable MAC Control

# Configuration ' ®

Item Setting
» MAC Control [ Enahle
» Black List / White List | Deny MAC Address Below. v
» Log Alert Enahle
» Known MAC fram LAN PC List ]

Configuration Window

Item Value setting Description
The box is unchecked b
MAC Control g ? it Y Check the Enable box to activate the MAC filter function
efau
When Deny MAC Address Below is selected, as the name suggest, packets
Black List / Deny MAC Address Below  specified in the rules will be blocked —black listed. In contrast, with Allow MAC
White List is set by default Address Below, you can specifically white list the packets to pass and the rest
will be blocked.
The box is unchecked b
Log Alert default Y Check the Enable box to activate to activate Event Log.
Known MAC Select a MAC Address from LAN Client List. Click the Copy to to copy the
from LAN PC N/A .
List selected MAC Address to the filter rule.
Save N/A Click Save to save the settings
Undo N/A Click Undo to cancel the settings

223



5G WAN Extender

Create/Edit MAC Control Rules

The gateway supports up to a maximum of 20 filter rule sets. Ensure that the MAC Control is enabled before
we can create control rules.

= MAC Control Rule List

MAC Address

Rule Name Time Schedule Rule Enable Actions

When Add button is applied, Filter Rule Configuration screen will appear.

# MAC Control Rule Configuration X

Rule Name MAC Address (Use : to Compose) Time Schedule | Enable

Rule1 ||| - [(0)Aways v | | ()

MAC Control Rule Configuration

Item Value setting Description

1. String format can be any .
Enter a MAC Control rule name. Enter a name that is easy for you to
Rule Name text
) . remember.

2. A Must fill setting
MAC Address 1. MAC Address string
(Use: to Format Specify the Source MAC Address to filter rule.
Compose) 2. A Must fill setting
Time Apply Time Schedule to this rule; otherwise leave it as (0) Always.

Schedule A Must fill setting If the dropdown list is empty, ensure Time Schedule is pre-configured. Refer
to Object Definition > Scheduling > Configuration tab

The box is unchecked by

Enable default Click Enable box to activate this rule, and then save the settings.
Save N/A Click Save to save the settings
Undo N/A Click Undo to cancel the settings
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5.2.4 Content Filter (not supported)

Not supported feature for the purchased product, leave it as blank.
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5.2.5 Application Filter (not supported)

Not supported feature for the purchased product, leave it as blank.
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5.2.6 IPS

Item Setting
» IPS Enable
» Log Alert Enable

Item Setting
» SYN Flood Defense Enable 300 Packets/second (10~10000)
» UDP Flood Defense Enable 300 Packets/second (10~10000)
» ICMP Flood Defense Enable |300 Packets/second (10~10000)
» Port Scan Defense Enable |200 Packets/second (10~10000)

To provide application servers in the Internet, administrator may need to open specific ports for the services.
However, there are some risks to always open service ports in the Internet. In order to avoid such attack risks,
it is important to enable IPS functions.

Intrusion Prevention System (IPS) is network security appliances that monitor network and/or system activities
for malicious activity. The main functions of IPS are to identify malicious activity, log information about this
activity, attempt to block/stop it and report it. You can enable the IPS function and check the listed intrusion
activities when needed. You can also enable the log alerting so that system will record Intrusion events when
corresponding intrusions are detected.

IPS Scenario

As shown in the diagram, the gateway serves as
Block lots of TCP attack packets to . .
Remote administration port: 8080 X Gateway an E'mall Server, Web Server and a|SO prOVIdES
Global IP: 118.18.81.200 TCP port 8080 for remote administration. So,
Local IP: 192.168.1.253
remote users or unknown users can request
Black lots of TCP attack packets to LNOSE services from Internet. With IPS enabled,
Web Server : HTTP 80, HTTPS 443 the gateway can detect incoming attack
packets, including the TCP ports (25, 80, 110,

%
]

Attackers Block lots of TCP attack packets to
Mail Server :SMTP 25, POP3 110

[IPS]-[Configuration]

IPS: Enable ‘

Intrusion Prevention \ 443 and 8080) with services. It will block the
SYN Flood Defense Mail S :25,110) Wed Server (port: 80, 443)

Port Scan Detection Locs! ||e:ar:v:;¥_,::3_1.2 ) Local 1P 192.168.0.3 attack packets and let the normal access to
Block IP Spoof pass through the gateway

Block TCP Flag Scan
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IPS Setting

Go to Security > Firewall > IPS Tab.

The Intrusion Prevention System (IPS) setting allows user to customize intrusion prevention rules to prevent
malicious packets.

Enable IPS Firewall
= Configuration ° ®
Item Setting
» IPS (| Enable
» Log Alert Enable

Configuration Window

Item Value setting Description
The box is unchecked b
IPS Y Check the Enable box to activate IPS function
default
The box is unchecked by . .
Log Alert Check the Enable box to activate to activate Event Log.
default
Save N/A Click Save to save the settings
Undo N/A Click Undo to cancel the settings

Setup Intrusion Prevention Rules

The router allows you to select intrusion prevention rules you may want to enable. Ensure that the IPS is
enabled before we can enable the defense function.
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# Intrusion Prevention

Item

8c

Setting

» SYN Flood Defense

Enable Packets/second (10~10000)

» UDP Flood Defense

Enable Packets/second (10~10000)

» ICMP Flood Defense

Enable Packets/second (10~10000)

» Port Scan Defense

Enable Packets/second (10~10000)

» Block Fraggle Attack

» Block Land Attack Enable
» Block Ping of Death Enable
» Block IP Spoof Enable
» Block TCP Flag Scan Enable
» Block Smurf Enable
» Block Traceroute Enable

Enable

» ARP Spoofing Defense

Enable Packets/second (10~10000)

Setup Intrusion Prevention Rules

Item Name Value setting Description
SYN Flood 1 A Must filled setti Click Enable box to activate this intrusion prevention rule and
Defense ) us I ed setting enter the traffic threshold in this field.
2. The box is unchecked by default. . . L . )
UDP Flood . . Click Enable box to activate this intrusion prevention rule and
3. Traffic threshold is set to 300 by . .
Defense default enter the traffic threshold in this field.
efau
ICMP Flood 4. The value range can be from 10 to Click Enable bc.)x to activat? this' in'trusion prevention rule and
enter the traffic threshold in this field.
Defense 10000.
Value Range: 10 ~ 10000.
1. A Must filled setting
2. The box is unchecked by default. . . L . )
Port Scan i . Click Enable box to activate this intrusion prevention rule and
R 3. Traffic threshold is set to 200 by . .
Defection default enter the traffic threshold in this field.
efau
Value Range: 10 ~ 10000.
4. The value range can be from 10 to
10000.
Block Land
Attack
Block Ping of
Death
Block IP Spoof —_,  hox is unchecked by defaul Click Enable b ivate this intrusi ion rul
Block TCP Flag e box is unchecked by default. ick Enable box to activate this intrusion prevention rule.
Scan
Block Smurf
Block
Traceroute
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Block Fraggle
Attack

1. A Must filled setting

2. The box is unchecked by default.
ARP Spoofing 3. Traffic threshold is set to 300 by
Defence default

Click Enable box to activate this intrusion prevention rule and
enter the traffic threshold in this field.

Value Range: 10 ~ 10000.
4. The value range can be from 10 to LAe ange

10000.
Save NA Click Save to save the settings
Undo NA Click Undo to cancel the settings
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5.2.7 Options

Item Setting

» Stealth Mode Enable

» SPI #| Enable

» Discard Ping from WAI Enable

Service
ID | Interface Protocol P Subnet Mask Enable | Action
Port

1 All WAN HTTPS Any IP N/A 443 Edit
2 All WAN HTTPS Any IP N/A 443 Edit
3 All WAN HTTPS Any IP N/A 443 Edit
4 All WAN HTTPS Any IP N/A 443 Edit
5 All WAN HTTPS Any IP N/A 443 Edit

There are some additional useful firewall options in this page.

“Stealth Mode” lets gateway not to respond to port scans from the WAN so that makes it less susceptible to
discovery and attacks on the Internet. ”SPI” enables gateway to record the packet information like IP address,
port address, ACK, SEQ number and so on while they pass through the gateway, and the gateway checks every
incoming packet to detect if this packet is valid.

“Discard Ping from WAN” makes any host on the WAN side can't ping this gateway. And finally, “Remote
Administrator Hosts” enables you to perform administration task from a remote host. If this feature is enabled,
only specified IP address(es) can perform remote administration.
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Enable SPI Scenario

Dst IP and Port Network-A
118.18.81.200: 1999 DstIPand Port

SrcIP and Port 203.95.80.22: 80

200.10.10.10: 80 SrcIPand Port Gateway

118.18.81.200: 1999

Unknown User
With Portscan Utility
Global IP: 200.10.10.10

Cloud Server
Global IP: 203.95.80.22

DstIP and Port
118.18.81.200: 1999
SrcIPand Port
203.95.80.22 : 80

. Global IP: 118.18.81.200 |

As shown in the diagram, Gateway has the IP
address of 118.18.81.200 for WAN interface and
192.168.1.253 for LAN interface. It serves as a NAT
gateway. Users in Network-A initiate to access
cloud server through the gateway. Sometimes,
unknown users will simulate the packets but use
different source IP to masquerade. With the SPI
feature been enabled at the gateway, it will block
such packets from unknown users.

Discard Ping from WAN & Remote Administrator Hosts Scenario

Use “Ping tool” to detect if Global IP is existed,

- The gateway doesn’t reply such requests.

S~
-~
NN
‘N
-~

Unknown User -
=~ ~o Global IP: 118.18.81.200
~ \Local 1P: 192.168.1.253

Remote Admin. Remote Admin. can access Gateway GUI
via Browser “Http:// 118.18.81.200:8080"

“Discard Ping from WAN” makes any host on the
WAN side can't ping this gateway reply any ICMP
packets. Enable the Discard Ping from WAN function
to prevent security leak when local users surf the
internet.

Remote administrator knows the gateway’s global IP,
and he can access the Gateway GUI via TCP port 8080.
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Firewall Options Setting

Go to Security > Firewall > Options Tab.

The firewall options setting allows network administrator to modify the behavior of the firewall and to enable
Remote Router Access Control.

Enable Firewall Options

« Firewall Options ' x
Item Setting

» Stealth Mode () Enable

» SPI Enable

» Discard Ping from WAN [ Enable

Firewall Options

Item Value setting Description

The box is unchecked b
Stealth Mode default Y Check the Enable box to activate the Stealth Mode function

The box is checked b
SPI @ Doxs checked by Check the Enable box to activate the SPI function

default
Discard Pin The box is unchecked b

& Y Check the Enable box to activate the Discard Ping from WAN function

from WAN default

Define Remote Administrator Host

The router allows network administrator to manage router remotely. The network administrator can assign
specific IP address and service port to allow accessing the router via designated WAN interface.
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= Remote Administrator Host Definition I x
Service
ID |Interface Protocol P Subnet Mask Enable | Action
Port

1 | AlWAN HTTPS Any IP N/A 443 O
2 | AIWAN HTTPS Any IP N/A 443 O
3 | AIWAN HTTPS Any IP N/A 443 O
4 | AIWAN HTTPS Any IP N/A 443 O
5 | AWAN HTTPS Any IP N/A 443 O

Remote Administrator Host Definition

Item Value setting Description

Protocol HTTPS is set by default Select HTTP or HTTPS method for remote administration.
This field is to specify the remote host to assign access right for remote
access.
Select Any IP to allow any remote hosts

P A Must filled setting v Y

Select Specific IP to allow the remote host coming from a specific subnet. An
IP address entered in this field and a selected Subnet Mask to compose the
subnet.

1. 80 for HTTP by default
Y This field is to specify a Service Port to HTTP or HTTPS connection.

Service Port 2. 443 for HTTPS by
Value Range: 1 ~ 65535.

default

Enabling th The box i hecked b
nabling the € boxs unhchecked by Click Enable box to activate this rule.

rule default.
Save N/A Click Enable box to activate this rule then save the settings.
Undo N/A Click Undo to cancel the settings
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Chapter 6 Administration
6.1 Configure & Manage

M2M-loT § :

Gateway

Ccntrcl Center
Manage via Internet

N

Management
‘Server / Tools

Access & Control

|
|
|
1
Managernenl )
Host Computer Server / Tools : @I
v

Teinet / Console with CLI

Local Access & Control

Configure & Manage refers to enterprise-wide administration of distributed systems including (and commonly
in practice) computer systems. Centralized management has a time and effort trade-off that is related to the size
of the company, the expertise of the IT staff, and the amount of technology being used. This device supports
many system management protocols, such as Command Script, TR-069, SNMP, and Telnet with CLI. You can setup
those configurations in the "Configure & Manage" section.
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6.1.1 Command Script

Command script configuration is the application that allows administrator to setup the pre-defined
configuration in plain text style and apply configuration on startup.

Go to Administration > Command Script > Configuration Tab.

Enable Command Script Configuration

Item

» Command Script

» Backup Script
» Upload Script
» Script Name

» Version

» Description

» Update time

Command
Script

Backup Script

Upload Script

Script Name

Version

Description

Update time

Enable
Via Web Ul
Via Web Ul

Setting

2019-04-08T18:05:31

The box is unchecked by
default

N/A

N/A

1.An Optional setting
2.Any valid file name

1.An Optional setting
2.Any string

1.An Optional setting
2.Any string

N/A

Check the Enable box to activate the Command Script function.

Click the Via Web Ul or Via Storage button to backup the existed command
script in a .txt file. You can specify the script file name in Script Name below.
Click the Via Web Ul or Via Storage button to Upload the existed command
script from a specified .txt file.

Specify a script file name for script backup, or display the selected upload
script file name.

Value Range: 0 ~ 32 characters.

Specify the version number for the applied Command script.

Value Range: 0 ~ 32 characters.

Enter a short description for the applied Command script.

It records the upload time for last commad script upload.
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Edit/Backup Plain Text Command Script

« Command Script Editor

0/65280

You can edit the plain text configuration settings in the configuration screen as above.
Plain Text Configuration

Item Value setting Description

Clean NA Clean text area. (You should click Save button to further clean the
configuration already saved in the system.)

Backup NA Backup and download configuration.

Save NA Save configuration

The supported plain text configuration items are shown in the following list. For the settings that can be executed
with standard Linux commands, you can put them in a script file, and apply to the system configure with
STARTUP command. For those configurations without corresponding Linux command set to configure, you can
configure them with proprietary command set.

Configuration Content

Key Value setting \ Description
OPENVPN_ENABLED 1:enable Enable or disable OpenVPN Client function.
0 : disable
OPENVPN_DESCRIPTION A Must filled Specify the tunnel name for the OpenVPN Client connection.
Setting
OPENVPN_PROTO udp Define the Protocol for the OpenVPN Client.
tcp e Select TCP or TCP /UDP
->The OpenVPN will use TCP protocol, and Port will be set as 443
automatically.
e Select UDP
->The OpenVPN will use UDP protocol, and Port will be set as 1194
automatically.
OPENVPN_PORT A Must filled Specify the Port for the OpenVPN Client to use.
Setting
OPENVPN_REMOTE_IPADDR IP or FQDN Specify the Remote IP/FQDN of the peer OpenVPN Server for this
OpenVPN Client tunnel.
Fill in the IP address or FQDN.
OPENVPN_PING_INTVL seconds Specify the time interval for OpenVPN keep-alive checking.
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OPENVPN_PING_TOUT
OPENVPN_COMP
OPENVPN_AUTH

seconds
Adaptive
Static Key/TLS

Specify the timeout value for OpenVPN Client keep-alive checking.
Specify the LZO Compression algorithm for OpenVPN client.
Specify the authorization mode for the OpenVPN tunnel.

o TLS

->The OpenVPN will use TLS authorization mode, and the following
items CA Cert., Client Cert. and Client Key need to specify as well.

OPENVPN_CA_CERT A Must filled Specify the Trusted CA certificate for the OpenVPN client. It will go
Setting through Base64 Conversion.
OPENVPN_LOCAL_CERT A Must filled Specify the local certificate for OpenVPN client. It will go through
Setting Base64 Conversion.
OPENVPN_LOCAL_KEY A Must filled Specify the local key for the OpenVPN client. It will go through
Setting Base64 Conversion.
OPENVPN_EXTRA_OPTS Options Specify the extra options setting for the OpenVPN client.
IP_ADDR1 Ip Ethernet LAN IP
IP_NETM1 Net mask Ethernet LAN MASK
PPP_MONITORING 1:enable When the Network Monitoring feature is enabled, the router will
0 : disable use DNS Query or ICMP to periodically check Internet connection —
connected or disconnected.
PPP_PING 0 : DNS Query With DNS Query, the system checks the connection by sending DNS
1:ICMP Query  Query packets to the destination specified in PPP_PING_IPADDR.
With ICMP Query, the system will check connection by sending
ICMP request packets to the destination specified in
PPP_PING_IPADDR.
PPP_PING_IPADDR IP Specify an IP address as the target for sending DNS query/ICMP
request.
PPP_PING_INTVL seconds Specify the time interval for between two DNS Query or ICMP
checking packets.
STARTUP Script file For the configurations that can be configured with standard Linux

commands, you can put them in a script file, and apply the script file
with STARTUP command.

For example,

STARTUP=#!/bin/sh

STARTUP=echo “startup done” > /tmp/demo

Plain Text System Configuration with Telnet

In addition to the web-style plain text configuration as mentioned above, the gateway system also allow the
configuration via Telnet CLI. Administrator can use the proprietary telnet command “txtConfig” and related
action items to perform the plain system configuration.

The command format is: txtConfig (action) [option]

clone Output file Duplicate the configuration content from database and stored as a
configuration file.

(ex: txtConfig clone /tmp/config)

The contents in the configuration file are the same as the plain text

commands mentioned above. This action is exactly the same as performing
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commit

enable

disable
run_immediately

run_immediately

a existing file
NA
NA
NA

a existing file

the “Backup” plain text configuration.

Commit the configuration content to database.
(ex: txtConfig commit /tmp/config)

Enable plain text system config.

(ex: txtConfig enable)

Disable plain text system config.

(ex: txtConfig disable)

Apply the configuration content that has been committed in database.

(ex: txtConfig run_immediately)
Assign a configuration file to apply.
(ex: txtConfig run_immediately /tmp/config)
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6.1.2 TR-069

TR-069 (Technical Report 069) is a Broadband Forum technical specification entitled CPE WAN Management
Protocol (CWMP). It defines an application layer protocol for remote management of end-user devices, like this
gateway device. As a bidirectional SOAP/HTTP-based protocol, it provides the communication between
customer-premises equipment (CPE) and Auto Configuration Servers (ACS). The Security Gateway is such CPE.

TR-069 is a customized feature for ISP. It is not recommend that you change the configuration for this. If you
have any problem in using this feature for device management, please contact with your ISP or the ACS provider
for help. At the right upper corner of TR-069 Setting screen, one “[Help]” command let you see the same
message about that.

Scenario - Managing deployed gateways through an ACS Server

Gatewayn
Gateway 2
/ ]
S
o
< — Gateway 1
Global IP:
ACS 118.18.81.33
Server

Scenario Application Timing

When the enterprise data center wants to use an ACS server to manage remote gateways geographically
distributed elsewhere in the world, the gateways in all branch offices must have an embedded TR-069
agent to communicate with the ACS server. So that the ACS server can configure, FW upgrade and
monitor these gateways and their corresponding Intranets.

Scenario Description
The ACS server can configure, upgrade with latest FW and monitor these gateways.
Remote gateways inquire the ACS server for jobs to do in each time period.

The ACS server can ask the gateways to execute some urgent jobs.

240



5G WAN Extender

Parameter Setup Example

Following tables list the parameter configuration as an example for the Gateway 1 in above diagram with
"TR-069" enabling.

Use default value for those parameters that are not mentioned in the tables.

Configuration Path [TR-069]-[Configuration]
TR-069 m Enable

ACS URL http://ga.acslite.com/cpe.php
ACS User Name ACSUserName

ACS Password ACSPassword
ConnectionRequest Port 8099

ConnectionRequest User Name ConnReqUserName
ConnectionRequest Password ConnReqPassword

Inform m Enable Interval 900

Scenario Operation Procedure

In above diagram, the ACS server can manage multiple gateways in the Internet. The "Gateway 1" is one
of them and has 118.18.81.33 IP address for its WAN-1 interface.

When all remote gateways have booted up, they will try to connect to the ACS server.

Once the connections are established successfully, the ACS server can configure, upgrade with latest FW
and monitor these gateways.

Remote gateways inquire the ACS server for jobs to do in each time period.

If the ACS server needs some urgent jobs to be done by the gateways, it will issue the "Connection
Request" command to those gateways. And those gateways make immediate connections in response
to the ACS server’s immediate connection request for executing the urgent jobs.
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TR-069 Setting

Go to Administration > Configure & Manage > TR-069 tab.

In "TR-069" page, there is only one configuration window for TR-069 function. In the window, you must specify
the related information for your security gateway to connect to the ACS. Drive the function to work by specifying
the URL of the ACS server, the account information to login the ACS server, the service port and the account
information for connection requesting from the ACS server, and the time interval for job inquiry. Except the
inquiry time, there are no activities between the ACS server and the gateways until the next inquiry cycle. But
if the ACS server has new jobs that are expected to do by the gateways urgently, it will ask these gateways by
using connection request related information for immediate connection for inquiring jobs and executing.

Enable TR-069

= Configuration

Item Setting
» TR-069 Enable
» Interface
» Data model |ACS Cloud Data Model |
» ACS URL |

» ACS UserName

» ACS Password

» Connection Request Port

» Connection Request UserName

» Connection Request Password

» Inform

#/ Enable Interval

» Certification Setup

o default

Select from Certificate List

Certificate:

Value setting

Description

TR-069
default

The box is unchecked by

Check the Enable box to activate TR-069 function.
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Interface

Data Model

ACS URL
ACS Username
ACS Password

ConnectionRequest
Port

ConnectionRequest
UserName

ConnectionRequest
Password

Inform

Certification Setup

Save
Undo

WAN-1 is selected by
default.

ACS Cloud Data Model
is selected by default.

A Must filled setting
A Must filled setting
A Must filled setting

1. A Must filled setting.

2. By default 8099 is set.

A Must filled setting

A Must filled setting

1. The box is checked by

default.
2. The Interval value is
300 by default.

The default box is
selected by default

N/A
N/A

When you finish set basic network WAN-1 ~ WAN-n, you can choose WAN-1
~ WAN-n

When you finish set Security > VPN > IPSec/OpenVPN/PPTP/L2TP/GRE, you
can choose IPSec/OpenVPN/PPTP/L2TP/GRE tunnel, the interface just like
“IPSec #1”

Select the TR-069 dat model for the remote management.

Standard : the ACS Server is a standard one, which is fully comply with TR-
069.

ACS Cloud Data Model : Select this data model if you intend to use Cloud
ACS Server to managing the deployed gateways.

You can ask ACS manager provide ACS URL and manually set

You can ask ACS manager provide ACS username and manually set

You can ask ACS manager provide ACS password and manually set

You can ask ACS manager provide ACS ConnectionRequest Port and
manually set

Value Range: 0 ~ 65535.

You can ask ACS manager provide ACS ConnectionRequest Username and
manually set

You can ask ACS manager provide ACS ConnectionRequest Password and
manually set

When the Enable box is checked, the gateway (CPE) will periodicly send
inform message to ACS Server according to the Interval setting.
Value Range: 0 ~ 86400 for Inform Interval.

You can leave it as default or select an expected certificate and key from the
drop down list.

Refer to Object Definition > Certificate Section for the Certificate
configuration.

Click Save to save the settings.

Click Undo to cancel the modifications.

When you finish set ACS URL ACS Username ACS Password, your gateway (CPE, Client Premium Equipment) can
send inform to ACS Server.
When you finish set ConnectionRequest Port ConnectionRequest Username ConnectionRequest Password,
ACS Server can ask the gateway (CPE) to send inform to ACS Server.

Enable STUN Server
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# STUN Settings

Item

Setting

» STUN

+ Enable

» Server Address

» Server Port

(1~65535)

» Keep Alive Period

0 | (0~65535)second(s)

STUN Settings Configuration

Item

Value setting

The box is checked by

Description

2.3478 is set by default

STUN Check the Enable box to activate STUN function.
default
1. String format: any
ify the IP for th TUN .
Server Address IPva address Specify the IP address for the expected STUN Server
2. It is an optional item.
. . Specify the port number for the expected STUN Server.
1. An optional setting
Server Port

Value Range: 1~ 65535.

Keep Alive Period

1. An optional setting
2.0 is set by default

Specify the keep alive time period for the connection with STUN Server.

Value Range: 0 ~ 65535.

Save

N/A

Click Save to save the settings.

Undo

N/A

Click Undo to cancel the modifications.
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6.1.3 SNMP

In brief, SNMP, the Simple Network Management Protocol, is a protocol designed to give a user the capability to
remotely manage a computer network by polling and setting terminal values and monitoring network events.

In typical SNMP uses, one or more administrative computers, called managers, have the task of monitoring or
managing a group of hosts or devices on a computer network. Each managed system executes, at all times, a
software component called an agent which reports information via SNMP to the manager.

SNMP agents expose management data on the managed systems as variables. The protocol also permits active
management tasks, such as modifying and applying a new configuration through remote modification of these
variables. The variables accessible via SNMP are organized in hierarchies. These hierarchies, and other metadata
(such as type and description of the variable), are described by Management Information Bases (MIBs).

The device supports several public MIBs and one private MIB for the SNMP agent. The supported MIBs are as
follow: MIB-1I (RFC 1213, Include IPvé), IF-MIB, IP-MIB, TCP-MIB, UDP-MIB, SMIvl and SMIv2,
SNMPv2-TM and SNMPv2-MIB, and AMIB (a Proprietary MIB)

SNMP Management Scenario

a3

Remote NMS Gateway 2
118.18.81.22
8 Q/ Gateway 1
/.
Remote NMS LAN IP: 10.0.75.2
118.18.81.11 et: 10.0.75.0/24

ooTe

10.0.75.100

Intranet

Scenario Application Timing

There are two application scenarios of SNMP Network Management Systems (NMS). Local NMS is in the
Intranet and manage all devices that support SNMP protocol in the Intranet. Another one is the Remote
NMS to manage some devices whose WAN interfaces are connected together by using a switch or a
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router with UDP forwarding. If you want to manage some devices and they all have supported SNMP
protocol, use either one application scenario, especially the management of devices in the Intranet. In
managing devices in the Internet, the TR-069 is the better solution. Please refer to last sub-section.

Scenario Description

The NMS server can monitor and configure the managed devices by using SNMP protocol, and those
devices are located at where UDP packets can reach from NMS.

The managed devices report urgent trap events to the NMS servers.

Use SNMPv3 version of protocol can protected the transmitting of SNMP commands and responses.
The remote NMS with privilege IP address can manage the devices, but other remote NMS can't.
Parameter Setup Example

Following tables list the parameter configuration as an example for the Gateway 1 in above diagram with
"SNMP" enabling at LAN and WAN interfaces.

Use default value for those parameters that are not mentioned in the tables.

[SNMP]-[Configuration]
m LAN = WAN

mvl mv2c mv3

Configuration Path
SNMP Enable
Supported Versions
Get / Set Community

ReadCommunity / WriteCommunity

Trap Event Receiver 1 118.18.81.11

WAN Access IP Address 118.18.81.11

Configuration Path [SNMP]-[User Privacy Definition]

ID 1 2 3

User Name UserNamel UserName2 UserName3
Password Password1 Password2 Disable
Authentication MD5 SHA-1 Disable
Encryption DES Disable Disable
Privacy Mode authPriv authNoPriv noAuthNoPriv
Privacy Key 12345678 Disable Disable
Authority Read/Write Read Read
Enable m Enable m Enable m Enable

Scenario Operation Procedure

In above diagram, the NMS server can manage multiple devices in the Intranet or a UDP-reachable
network. The "Gateway 1" is one of the managed devices, and it has the IP address of 10.0.75.2 for LAN
interface and 118.18.81.33 for WAN-1 interface. It serves as a NAT router.

At first stage, the NMS manager prepares related information for all managed devices and records them
in the NMS system. Then NMS system gets the status of all managed devices by using SNMP get
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commands.

When the manager wants to configure the managed devices, the NMS system allows him to do that by
using SNMP set commands. The "UserNamel" account is used if the manager uses SNMPv3 protocol for
configuring the "Gateway 1". Only the "UserNamel" account can let the "Gateway 1" accept the
configuration from the NMS since the authority of the account is "Read/Write".

Once a managed device has an urgent event to send, the device will issue a trap to the Trap Event
Receivers. The NMS itself could be one among them.

If you want to secure the transmitted SNMP commands and responses between the NMS and the
managed devices, use SNMPv3 version of protocol.

The remote NMS without privilege IP address can't manage the "Gateway 1", since "Gateway 1" allows
only the NMS with privilege IP address can manage it via its WAN interface.
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SNMP Setting

Go to Administration > Configure & Manage > SNMP tab.

The SNMP allows user to configure SNMP relevant setting which includes interface, version, access control and
trap receiver.

Enable SNMP
» Configuration ° %
Item Setting

» SNMP Enable @ LAN (] WAN

» WAN Interface All WANSs v

» Supported Versions @ vi@ v2c[J v3

» SNMP Port
'IP Range v
| - | [ Enable
| I - | ] (] Enable

» Limited Remote Access IP | | _ | | = Endbie
| | - | | [} Enable
| | - | | () Enable

SNMP

Item Value setting Description

Select the interface for the SNMP and enable SNMP functions.
When Check the LAN box, it will activate SNMP functions and you can access
1.The boxes are

SNMP Enable hecked by default SNMP from LAN side;
unchecke efau
Y When Check the WAN box, it will activate SNMP functions and you can access

SNMP from WAN side.
1.A Must filled setting ~ Specify the WAN interface that a remote SNMP host can access to the device.
WAN Interface 2. ALL WANs is By default, All WANSs is selected, and there is no limitation for the WAN
selected by default inferface.

Select the version for the SNMP
When Check the v1 box.
1.A Must filled setting It means you can access SNMP by version 1.
Supported Versions  2.The boxes are When Check the v2c box.
unchecked by default It means you can access SNMP by version 2c.
When Check the v3 box.
It means you can access SNMP by version 3.
SNMP Port 1. String format: any Specify the SNMP Port.
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port number You can fill in any port number. But you must ensure the port number is not
2. The default SNMP to be used.
port is 161. Value Range: 1~ 65535.

3. A Must filled setting

Specify the Remote Access IP for WAN and check the box to enable it as well.
Select Specific IP Address, and fill in a certain IP address. It means only this IP
1. String format: any address can access SNMP from LAN/WAN side.

Limited Remote IPv4 address Select IP Range, and fill in a range of IP addresses. It means the IP address
Aceess IP 2. It is an optional within specified range can access SNMP from LAN/WAN side.
item.

If you left it as blank, it means any IP address can access SNMP from WAN

side.
Save N/A Click Save to save the settings
Undo N/A Click Undo to cancel the settings

Create/Edit Multiple Community

The SNMP allows you to custom your access control for version 1 and version 2 user. The router supports up to
a maximum of 10 community sets.

« Multiple Community List %20

Community

Actions

When Add button is applied, Multiple Community Rule Configuration screen will appear.

Item Setting

» Community 'Read Only v | | |

» Enable ¢/ Enable

Multiple Community Rule Configuration

Item Value setting Description
1. Read Only is
selected b ‘;efault Specify this version 1 or version v2c user’s community that will be allowed
. y . Read Only (GET and GETNEXT) or Read-Write (GET, GETNEXT and SET) access
Community 2. A Must filled setting

respectively.

3. String format: an
& Y The maximum length of the community is 32.

text
1.The box is checked
Enable Click Enable to enable this version 1 or version v2c user.
by default
Click the Save button to save the configuration. But it does not apply to SNMP
Save N/A

functions. When you return to the SNMP main page. It will show “Click on
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save button to apply your changes” remind user to click main page Save

button.
Undo N/A Click the Undo button to cancel the settings.
Back N/A Click the Back button to return to last page.

Create/Edit User Privacy

The SNMP allows you to custom your access control for version 3 user. The router supports up to a maximum of
128 User Privacy sets.

« User Privacy List [E¥0

Password | Authentication | Encryption

OID Filter
Prefix

Privacy
Key

Authority Actions

When Add button is applied, User Privacy Rule Configuration screen will appear.

®] User Privacy Rule Configuration

» Privacy Key

Item Setting
» User Name | |
» Password |
» Authentication
» Encryption
» Privacy Mode
|

» Authority Read v
1 |

» QID Filter Prefix

» Enable Enahle

User Privacy Rule Configuration

Item Value setting Description
User Name 1. A Must filled setting  Specify the User Name for this version 3 user.
2. String format: any Value Range: 1 ~ 32 characters.
text
Password 1. String format: any When your Privacy Mode is authNoPriv or authPriv, you must specify the
text Password for this version 3 user.
Value Range: 8 ~ 64 characters.
Authentication 1. None is selected by  When your Privacy Mode is authNoPriv or authPriv, you must specify the
default Authentication types for this version 3 user.
Selected the authentication types MD5/ SHA-1 to use.
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Encryption

Privacy Mode

Privacy Key

Authority

OID Filter Prefix

Enable

Save

Undo
Back

1. None is selected by
default

1. noAuthNoPriv is
selected by default

1. String format: any
text

1. Read is selected by
default

1. The default value is
1

2. A Must filled setting
3. String format: any
legal OID

1.The box is checked
by default

N/A

N/A
N/A

Create/Edit Trap Event Receiver

The SNMP allows you to custom your trap event receiver. The router supports up to a maximum of 4 Trap Event

Receiver sets.

D Server Server| SNMP | Community | User
IP Port |Version

When Add button is applied, Trap Event Receiver Rule Configuration screen will appear. The default SNMP

When your Privacy Mode is authPriv, you must specify the Encryption
protocols for this version 3 user.

Selected the encryption protocols DES / AES to use.

Specify the Privacy Mode for this version 3 user.

Selected the noAuthNoPriv.

You do not use any authentication types and encryption protocols.

Selected the authNoPriv.

You must specify the Authentication and Password.

Selected the authPriv.

You must specify the Authentication, Password, Encryption and Privacy Key.
When your Privacy Mode is authPriv, you must specify the Privacy Key (8 ~ 64
characters) for this version 3 user.

Specify this version 3 user’s Authority that will be allowed Read Only (GET
and GETNEXT) or Read-Write (GET, GETNEXT and SET) access respectively.
The OID Filter Prefix restricts access for this version 3 user to the sub-tree
rooted at the given OID.

Value Range: 1 ~2080768.

Click Enable to enable this version 3 user.

Click the Save button to save the configuration. But it does not apply to SNMP
functions. When you return to the SNMP main page. It will show “Click on
save button to apply your changes” remind user to click main page Save
button.

Click the Undo button to cancel the settings

Click the X button to return the last page.

Add Delete

Name

Name

Privacy

P i
assword “pa- 00

Authentication Encryption Pr}i(vee;cy Enable Actions

Version is v1. The configuration screen will provide the version 1 must filled items.
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# Trap Event Receiver Rule Configuration

Item Setting
» Server IP | | (IP Address/FQDN)
» Server Port 1162
» SNMP Version vl v
» Community Name I l
» Enable Enable

When you selected v2c, the configuration screen is exactly the same as that of v1, except the version.

When you selected v3, the configuration screen will provide more setting items for the version 3 Trap.

« Trap Event Receiver Rule Configuration

Item Setting
» Server IP | | (IP Address/FQDN)
» Server Port 1162
» SNMP Version v3 v

» Community Name |

» User Name l

» Password |

» Privacy Mode

' noAuthNoPriv v |

» Authentication

» Encryption

» Privacy Key

» Enable

Enable

Trap Event Receiver Rule Configuration

Item Value setting

Description

1. A Must flled setting Specify the trap Server IP or FQDN

Server IP 2. String format: any Ti DST o P 4 trap to th ' IP/FQDN
e will send trap to the server .
IPv4 address or FQDN P
1. String format: any .
Specify the trap Server Port.

port number You can fill t number. But t the port number is not t

Server Port 5 The default SNMP I:)ou ca; ill in any port number. But you must ensure the port number is not to
e used.

trap port s 162 Value Range: 1~ 65535

3. A Must filled setting Lae mange: '
SNMP Version 1. vlis selected by Select the version for the trap

default Selected the v1.

252



5G WAN Extender

Community Name

User Name

Password

Privacy Mode

Authentication

Encryption

Privacy Key

Enable

Save

Undo
Back

1. Avl and v2c Must
filled setting

2. String format: any
text

1. Av3 Must filled
setting

2. String format: any
text

1. Av3 Must filled
setting

2. String format: any
text

1. Av3 Must filled
setting

2. noAuthNoPriv is
selected by default

1. Av3 Must filled
setting

2. None is selected by
default

1. Av3 Must filled
setting

2. None is selected by
default

1. Av3 Must filled
setting

2. String format: any
text

1.The box is checked
by default

N/A

N/A
N/A

The configuration screen will provide the version 1 must filled items.
Selected the v2c.

The configuration screen will provide the version 2c must filled items.
Selected the v3.

The configuration screen will provide the version 3 must filled items.

Specify the Community Name for this version 1 or version v2c trap.
Value Range: 1 ~ 32 characters.

Specify the User Name for this version 3 trap.
Value Range: 1 ~ 32 characters.

When your Privacy Mode is authNoPriv or authPriv, you must specify the
Password for this version 3 trap.
Value Range: 8 ~ 64 characters.

Specify the Privacy Mode for this version 3 trap.

Selected the noAuthNoPriv.

You do not use any authentication types and encryption protocols.

Selected the authNoPriv.

You must specify the Authentication and Password.

Selected the authPriv.

You must specify the Authentication, Password, Encryption and Privacy Key.

When your Privacy Mode is authNoPriv or authPriv, you must specify the
Authentication types for this version 3 trap.
Selected the authentication types MD5/ SHA-1 to use.

When your Privacy Mode is authPriv, you must specify the Encryption
protocols for this version 3 trap.
Selected the encryption protocols DES / AES to use.

When your Privacy Mode is authPriv, you must specify the Privacy Key (8 ~ 64

characters) for this version 3 trap.

Click Enable to enable this trap receiver.

Click the Save button to save the configuration. But it does not apply to SNMP

functions. When you return to the SNMP main page. It will show “Click on
save button to apply your changes” remind user to click main page Save
button.

Click the Undo button to cancel the settings.

Click the X button to return to last page.
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Specify SNMP MIB-2 System
If required, you can also specify the required information for the MIB-2 System.

« SNMP MIB-2 System ’ x

Item Setting

» sysContact | |

» syslocation | |

SNMP MIB-2 System Configuration

Item Value setting Description

sysContact 1. An Optional filled Specify the contact information for MIB-2 system.
setting Value Range: 0 ~ 64 characters.
2. String format: any
text

sysLocation 1. An Optional filled Specify the location information for MIB-2 system.
setting Value Range: 0 ~ 64 characters.
2. String format: any
text

Edit SNMP Options

If you use some particular private MIB, you must fill the enterprise name, number and OID.

= Options ° x
Item Setting
» Enterprise Name
» Enterprise Number |12823 |
Options
Item Value setting Description
1. The default value is
Default

Specify the Enterprise Name for the particular private MIB.

Enterprise Name 2. A Must filled setting . . ' i
Value Range: 1 ~ 10 characters, and only string with A~Z, a~z, 0~9, ', “_".

3. String format: any
text

The default value is

Enterprise Number 12823 Specify the Enterprise Number for the particular private MIB.

Value Range: 1 ~2080768.

(Default Enterprise

254



5G WAN Extender

Enterprise OID

Save

Undo

Number)

2. A Must filled setting
3. String format: any
number

1. The default value is
1.3.6.1.4.1.12823.4.4.9
(Default Enterprise OID)
2. A Must filled setting
3. String format: any
legal OID

N/A

N/A

Specify the Enterprise OID for the particular private MIB.

The range of the each OID number is 1-2080768.

The maximum length of the enterprise OID is 31.

The seventh number must be identical with the enterprise number.

Click the Save button to save the configuration and apply your changes to
SNMP functions.
Click the Undo button to cancel the settings.
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6.1.4 Telnet & SSH

A command-line interface (CLI), also known as command-line user interface, and console user interface are
means of interacting with a computer program where the user (or client) issues commands to the program in
the form of successive lines of text (command lines). The interface is usually implemented with a command line
shell, which is a program that accepts commands as text input and converts commands to appropriate operating
system functions. Programs with command-line interfaces are generally easier to automate via scripting. The
device supports both Telnet and SSH (Secure Shell) CLI with default service port 23 and 22, respectively.

Telnet & SSH Scenario

Network-A

Gateway

8 et

Remote Admin
140.116.82.98

Global IP: 118.18.81.33
Local IP: 10.0.75.2

CllviaTelnet

Local Admin
10.0.75.100

Scenario Application Timing

When the administrator of the gateway wants to manage it from remote site in the Intranet or
Internet, he may use "Telnet with CLI" function to do that by using "Telnet" or "SSH" utility.

Scenario Description

The Local Admin or the Remote Admin can manage the Gateway by using "Telnet" or "SSH" utility
with privileged user name and password.

The data packets between the Local Admin and the Gateway or between the Remote Admin and the
Gateway can be plain texts or encrypted texts. Suggest they are plain texts in the Intranet for Local
Admin to use "Telnet" utility, and encrypted texts in the Internet for Remote Admin to use "SSH"
utility.
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Parameter Setup Example

Following table lists the parameter configuration as an example for the Gateway in above diagram
with "Telnet with CLI" enabling at LAN and WAN interfaces.

Use default value for those parameters that are not mentioned in the table.

Configuration Path

[Telnet & SSH]-[Configuration]

Telnet

LAN: m Enable WAN: (1 Enable
Service Port: 23

SSH

LAN: m Enable \WAN: m Enable
Service Port: 22

Scenario Operation Procedure

In above diagram, "Local Admin" or "Remote Admin" can manage the "Gateway" in the Intranet or
Internet. The "Gateway" is the gateway of Network-A, and the subnet of its Intranet is 10.0.75.0/24.
It has the IP address of 10.0.75.2 for LAN interface and 118.18.81.33 for WAN-1 interface. It serves as

a NAT gateway.

The "Local Admin" in the Intranet uses "Telnet" utility with privileged account to login the Gateway.

Or the "Remote Admin" in the Internet uses "SSH" utility with privileged account to login the Gateway.

The administrator of the gateway can control the device as like he is in front of the gateway.
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Telnet & SSH Setting

Go to Administration > Configure & Manage > Telnet & SSH tab.

The Telnet & SSH setting allows administrator to access this device through the traditional Telnet or SSH Telnet
program. Before you can telnet (login) to the device, please configure the related settings with care.

PR — -] *

Item Setting
LAN @ Enable
WAN (] Enable ( WAN-1 v WAN-4 )
» Telnet I - I
Service Port 23 |
LAN @ Enable
WAN (] Enable ( WAN-1 v WAN-4 )
» SSH I - |
Service Port 22 |
Configuration
Item Value setting Description
Telnet 1. The LAN Enable box Check the Enable box to activate the Telnet function for connecting from LAN or WAN
is checked by interfaces.
default. You can set which number of Service Port you want to provide for the corresponding
2. By default Service Service.
Port is 23. Value Range: 1 ~65535.
SSH 3. The LAN Enable box Check the Enable box to activate the SSH Telnet function for connecting from LAN or
is checked by WAN interfaces.
default. You can set which number of Service Port you want to provide for the corresponding
4. By default Service Service.
Port is 22. Value Range: 1 ~65535.
Save N/A Click Save to save the settings
Undo N/A Click Undo to cancel the settings

Note: The Telnet/SSH login password is the same one as the administrator’s login password for the device web

GUI.
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6.2 System Operation

System Operation allows the network administrator to manage system, settings such as web-based utility access
password change, system information, system time, system log, firmware/configuration backup & restore, and
reset & reboot.

6.2.1 Password & MMI

Go to Administration > System Operation > Password & MMI tab.

Setup Host Name

Host Name screen allows network administrator to setup / change the host name of the gateway. Click the
Modify button and provide the new username setting.

= Host Name ‘ x

Item Setting

» Host Name |:]

Username Configuration

Item Value setting Description
1. An Optional setting

Host Name 2. It is blanked by Enter the host name of the gateway.
default

Save N/A Click Save button to save the settings

Undo N/A Click Undo button to cancel the settings

Change UserName

Username screen allows network administrator to change the web-based MMI login account to access gateway.
Click the Modify button and provide the new username setting.

Item Setting
» Username admin | Modify
» New Username :
» Password :]
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Username Configuration

Item Value setting Description

1. The default Username
Username for web-based MMl is Display the current MMI login account (Username).

‘admin’.
New Username String: any text Enter new Username to replace the current setting.

. Enter current password to verify if you have the permission to change the
Password String: any text .
username setting.

Save N/A Click Save button to save the settings
Undo N/A Click Undo button to cancel the settings

Change Password

Change password screen allows network administrator to change the web-based MMI login password to access

gateway.

Item

= Password ’ x

Setting

» Old Password

I

» New Password

(NOTE: The password must be at least 10 characters long.
and must contain at least 1 English letter and 1 number.
The password cannot be the same as the login account.)

» New Password Confirmation

L]

Password Configuration

Item Value setting

1. String: any text
2. The default password
for web-based MMl is

Old Password

Description

Enter the current password to enable you unlock to change password.

‘admin’.
Enter new password
NOTE: There are some limitation on setting the new password for
New Password String: any text enhancing the security. The password length must be at least 10

characters, and there must be at least one English character and one
numeric character. Beside, the new password must be different to the
existing one.

New Password
Confirmation

String: any text

Enter new password again to confirm

Save N/A

Click Save button to save the settings

Undo N/A

Click Undo button to cancel the settings
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Change MIMI Setting for Accessing

This is the gateway’s web-based MMl access which allows administrator to access the gateway for management.
The gateway’s web-based MMI will automatically logout when the idle time has elapsed. The setting allows
administrator to enable automatic logout and set the logout idle time. When the login timeout is disabled, the

system won’t logout the administrator automatically.

Item

» Login

» Login Timeout

» GUI Access Protocol | hitp/https v |
(] Enable Type
» External Authentication
@ default

» HTTPs Certificate Setup

Certificate: Key:
» HTTP Compression (] gzip [] deflate
DHCP 1

» HTTP Binding

» System Boot Mode | Normal Mode V\

Login 3 times is set by default

The Enable box is

Login Timeout checked, and 300 is set

by default.
GUI Access Protocol http/https is selected by
default.
HTTPs Certificate The default box is
Setup selected by default

Password-Guessing Attack & MAX: |3

Enable (300

Setting
(times)

| (seconds)

Primary Server Secondary Server

Select from Certificate List

Enter the login trial counting value.
Value Range: 3 ~ 10.

If someone tried to login the web GUI with incorrect password for more
than the counting value, an warning message “Already reaching
maximum Password-Guessing times, please wait a few seconds!” will be
displayed and ignore the following login trials.

Check the Enable box to activate the auto logout function, and specify the
maximum idle time as well.

Value Range: 30 ~ 65535.

Select the protocol that will be used for GUI access. It can be http/https,
http only, or https only.

If the https Access Protocol is selected, the HTTPs Certificate Setup option
will be available for further configuration.
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You can leave it as default or select a expected certificate and key from
the drop down list.
Refer to Object Definition > Certificate Section for the Certificate
configuration.
The box is unchecked by  Check the box (gzip, or deflate) if any comprerssion method is preferred.
default.
1. An Optional setting
HTTP Binding 2. DHCP-1is checked by  Select the DHCP Server to bind with http access.
default

HTTP Compression

Select the system boot mode that will be adopted to boot up the device.
Normal Mode: It takes longer boot up time, with complete firmware
image check during the device booting.
Fast Mode: It takes shorter boot up time, without checking the firmware
) image during the device booting.
Normal Mode is . . . .
System Boot Mode Quick Mode: It takes the shortest boot up time, without checking the

selected by default. . . . .

firmware image and creating the internal database for

User/Group/Captive Portal functions.

Note: Use Quick Mode with care, once selected, the User/Group/Captive
Portal function will become non-functional.

Save N/A Click Save button to save the settings

Undo N/A Click Undo button to cancel the settings
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6.2.2 System Information

System Information screen gives network administrator a quick look up on the device information for the
purchades gateway.

Go to Administration > System Operation > System Information tab.

= System Information . x

Item Setting

» Model Name VHG87BAM_0T001

» Device Serial Number

» Kernel Version 2.6.36

» FW Version 0000Y90.J31_e32.BETA_04021700
» System Time Thu, 18 Apr 2019 16:18:16 +0800

» Device Up-Time 15day 22hr 30min 35sec

System Information

Item Value Setting Description

Model Name N/A It displays the model name of this product.

zz\;feferlal N/A It displays the serial number of this product.

Kernel Version N/A It displays the Linux kernel version of the product

FW Version N/A It displays the firmware version of the product

Memory Usage N/A It displays the percentage of device memory utilization.

System Time N/A It displays the current system time that you browsed this web page.
Device Up-Time N/A It displays the statistics for the device up-time since last boot up.
Refresh N/A Click the Refresh button to update the system Information immediately.
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6.2.3 System Time

The gateway provides manually setup and auto-synchronized approaches for the administrator to setup the
system time for the gateway. The time supported synchronization methods can be Time Server, Manual, PC,
Cellular Module, or GPS Signal. Select the method first, and then configure rest settings.

Instead of manually configuring the system time for the gateway, there are two simple and quick solutions for
you to set the correct time information and set it as the system time for the gateway.

The first one is “Sync with Timer Server”. Based on your selection of time zone and time server in above time
information configuration window, system will communicate with time server by NTP Protocol to get system
date and time after you click on the Synchronize immediately button.

The second one is “Sync with my PC”. Select the method and the system will synchronize its date and time to
the time of the administration PC.

Go to Administration > System Operation > System Time tab.

Synchronize with Time Server

Item Setting
» Synchronization method |@|
» Time Zone (GMT+00:00) Greenwich Mean Time: Dublin, Edinburgh, Lisbon, London v |
» Auto-synchronization Time Server: | ‘

Available Time Servers (RFC-868): [ Auto v|

» Auto Daylight Saving Time (] Enable
» NTP Service (] Enable
» Synchronize immediately | Active |

1. A Must-filled item.
2. Time Server is Select the Time Server as the synchronization method for the system time.
selected by default.

1. A Must-filled item.
Time Zone 2. GMT+00 :00 is Select a time zone where this device locates.
selected by default.

Synchronization
method
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Auto-
synchronization

Auto Daylight
Saving Time

NTP Service

Synchronize
immediately

Save
Refresh

1. A Must-filled item.
2. Auto is selected by
default.

1. It is an optional item.

2. Un-checked by
default

1. It is an optional item.

2. Un-checked by
default

N/A

N/A
N/A

Enter the IP or FQDN for the NTP time server you expected, or leave it as auto
mode so that the available server will be used for time synchronization one by
one.

Check the Enable button to activate the auto daylight saving function.

Check the Enable button to activate the NTP Service function.

When you enabled this function, the gateway can provide NTP server service
for its local connected devices.

Click the Active button to synchronize the system time with specified time
server immediately.

Click the Save button to save the settings.

Click the Refresh button to update the system time immediately.

Note: Remember to select a correct time zone for the device, otherwise, you will just get the UTC (Coordinated
Universal Time) time, not the local time for the device.

Synchronize with Manually Setting

4

4

Item

Synchronization method
Time Zone

Auto Daylight Saving Time

Set Date & Time Manually

Setting

| Manual v |

| (GMT+00:00) Greenwich Mean Time: Dublin, Edinburgh, Lishon, London v |

» NTP Service

Synchronization

method

Time Zone

Auto Daylight
Saving Time

(] Enable
|2021 v| \June v| y24v| (Year/Month/Day)
‘ |13v| : |47 v| : |31 v| (Hour:Minute:Second)

C E n a‘b‘I e,

1. A Must-filled item.
2. Time Server is
selected by default.

1. A Must-filled item.
2. GMT+00 :00 is
selected by default.

1. It is an optional item.

2. Un-checked by
default

Select the Manual as the synchronization method for the system time. It
means administrator has to set the Date & Time manually.

Select a time zone where this device locates.

Check the Enable button to activate the auto daylight saving function.
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Set Date & Time . . . Manually set the date (Year/Month/Day) and time (Hour:Minute:Second) as
1. It is an optional item. .

Manually the system time.
1. Itis an optional item.  Check the Enable button to activate the NTP Service function.

NTP Service 2. Un-checked by When you enabled this function, the gateway can provide NTP server service
default for its local connected devices.

Save N/A Click the Save button to save the settings.

Synchronize with PC

= System Time Configuration

-] =

Item Setting
» Synchronization method |PC v
» NTP Service (1) Enable
» Synchronize immediately Active

System Time Information

Item

Synchronization

Value Setting

1. A Must-filled item.
2. Time Server is

Description

Select PC as the synchronization method for the system time to let system

method synchronize its date and time to the time of the administration PC.
selected by default.
1. Itis an optional item. ~ Check the Enable button to activate the NTP Service function.
NTP Service 2. Un-checked by When you enabled this function, the gateway can provide NTP server service
default for its local connected devices.
Synchronize N/A Click the Active button to synchronize the system time with specified time
immediately server immediately.
Save N/A Click the Save button to save the settings.
Refresh N/A Click the Refresh button to update the system time immediately.
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Synchronize with Cellular Time Service

= System Time Configuration

Item

Setting

» Synchronization method

' Cellular Module v |

» Time Zone |(GMT+00:00) Greenwich Mean Time: Dublin, Edinburgh, Lisbon, London v |
» NTP Service () Enable
» Synchronize immediately Active

System Time Information

Item

Synchronization
method

Value Setting

1. A Must-filled item.
2. Time Server is
selected by default.

Description

Select Cellular Module as the synchronization method for the system time to
let system synchronize its date and time to the time provided from the
connected mobile ISP.

Note: this option is only available for the product with Cellular WAN interface.

1. A Must-filled item.

Time Zone 2. GMT+00 :00 is Select a time zone where this device locates.
selected by default.
1. Itis an optional item. ~ Check the Enable button to activate the NTP Service function.
NTP Service 2. Un-checked by When you enabled this function, the gateway can provide NTP server service

default

for its local connected devices.

Synchronize

Click the Active button to synchronize the system time with specified time

. . N/A

immediately / server immediately.

Save N/A Click the Save button to save the settings.

Refresh N/A Click the Refresh button to update the system time immediately.
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Synchronize with GPS Time Service

= System Time Configuration

Item

Setting

» Synchronization method

| GPS Signal

d

» Time Zone |(GMT+00:00) Greenwich Mean Time: Dublin, Edinburgh, Lisbon, London v |
— Enable

» Daylight Saving Time O el

» NTP Service [} Enable

» Synchronize immediately

System Time Information

Item

Synchronization
method

Value Setting

1. A Must-filled item.
2. Time Server is
selected by default.

Description

Select GPS Signal as the synchronization method for the system time to let
system synchronize its date and time to the time provided from the GNSS
service.

Note: this option is only available for the product with GNSS interface.

Time Zone

1. A Must-filled item.
2. GMT+00 :00 is
selected by default.

Select a time zone where this device locates.

Daylight Saving
Time

1. It is an optional item.

2. Un-checked by
default

Check the Enable button to activate the daylight saving function.
When you enabled this function, you have to specify the start date and end
date for the daylight saving time duration.

NTP Service

1. It is an optional item.

2. Un-checked by
default

Check the Enable button to activate the NTP Service function.
When you enabled this function, the gateway can provide NTP server service
for its local connected devices.

Synchronize

Click the Active button to synchronize the system time with specified time

. . N/A

immediately / server immediately.

Save N/A Click the Save button to save the settings.

Refresh N/A Click the Refresh button to update the system time immediately.
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6.2.4 System Log

System Log screen contains various event log tools facilitating network administrator to perform local event

logging and remote reporting.

Go to Administration > System Operation > System Log tab.

PP e | Emainow |

Item Setting

» Web Log Type Category System Attacks Drop Login message [) Debug

[ Enable

Server: Add Object

» Email Alert E-mail Addresses:

Subject: | |

Log type Category: [) System [ Attacks [ ) Drop [ Login message [ ) Debug

» Syslogd

[ Enable Server: Add Object

Log type Category: [) System [ Attacks [ ) Drop [ Login message [ ) Debug

Enable

Select Device: [ nternal v |

Log file name: |syslog |

Split file: () Enable Size: [200

» Log to St
0g 10 Storage Interval: [ ) Enable 1440 (1~10080 Minutes)

Download log file | clear logs |

Max Records: [3000 | (5~10000)

Log type Category: System Attacks Drop Login message Debug

View & Email Log History

View button is provided for network administrator to view log history on the gateway. Email Now button

enables administrator to send instant Email for analysis.

View & Email Log History

Item Value setting Description

View button N/A Click the View button to view Log History in Web Log List Window.
Email Now . . . . -

button N/A Click the Email Now button to send Log History via Email instantly.
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s [ [ o [ oo | o T

Time Log
Apr 1 06:01:36 dnsmasg-dhcp[6016]: Ignoring domain amit.com.tw for DHCP host name NB-msnb
Apr 1 06:08:31 dnsmasg-dhcp[6016]: Ignoring domain amit.com.tw for DHCP host name NB-msnb
Apr 1 06:15:30 dnsmasg-dhcp[6016]: Ignoring domain amit.com.tw for DHCP host name NB-msnb
Apr 1 06:22:06 dnsmasg-dhcp[6016]: Ignoring domain amit.com.tw for DHCP host name NB-msnb
Apr 106:28:42 dnsmasg-dhcp[6016]: Ignoring domain amit.com.tw for DHCP host name NB-msnb
Apr 1 06:35:42 dnsmasg-dhcp[6016]: Ignoring domain amit.com.tw for DHCP host name NB-msnb
Apr 106:42:20 dnsmasg-dhcp[6016]: Ignoring domain amit.com.tw for DHCP host name NB-msnb

Web Log List Window

Item Value Setting Description
Time column N/A It displays event time stamps
Log column N/A It displays Log messages

Web Log List Button Description

Item Value setting Description
Previous N/A Click the Previous button to move to the previous page.
Next N/A Click the Next button to move to the next page.
First N/A Click the First button to jump to the first page.
Last N/A Click the Last button to jump to the last page.
Download N/A Click the Download button to download log to your PCin tar file format.
Clear N/A Click the Clear button to clear all log.
Back N/A Click the Back button to return to the previous page.
Web Log Type Category

Web Log Type Category screen allows network administrator to select the type of events to log and be displayed
in the Web Log List Window as described in the previous section. Click on the View button to view Log History
in the Web Log List window.

» Web Log Type Category System ¥ Attacks Drop Login message [] Debug

Web Log Type Category Setting Window

Item Value Setting Description

System Checked by default Check to log system events and to display in the Web Log List window.
Attacks Checked by default Check to log attack events and to display in the Web Log List window.

Drop Checked by default Check to log packet drop events and to display in the Web Log List window.
Login message Checked by default Check to log system login events and to display in the Web Log List window.
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Debug

Email Alert

Un-checked by default

Check to log debug events and to display in the Web Log List window.

Email Alert screen allows network administrator to select the type of event to log and be sent to the destined

Email account.

» Email Alert

Enable

Server

E-mail address

Subject

Log type category

Enable

Server: | —- Option --- v || Add Object

E-mail Addresses:

Subject

Log type Category: System Attacks Drop Login message Debug

Un-checked by default

N/A

String : email format

String : any text

Default unchecked

Check Enable box to enable sending event log messages to destined Email
account defined in the E-mail Addresses blank space.

Select one email server from the Server dropdown box to send Email. If none
has been available, click the Add Object button to create an outgoing Email
server.

You may also add an outgoing Email server from Object Definition >
External Server > External Server tab.

Enter the recipient’s Email address. Separate Email addresses with comma ¢’
or semicolon “;’

Enter the Email address in the format of ‘myemail@domain.com’

Enter an Email subject that is easy for you to identify on the Email client.
Select the type of events to log and be sent to the designated Email
account. Available events are System, Attacks, Drop, Login message, and
Debug.
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Syslogd

Syslogd screen allows network administrator to select the type of event to log and be sent to the designated

Syslog server.

» Syslogd

() Enable Server: | — Option — v || Add Object

Log type Category: [ System [) Attacks

() Drop [) Login message [ ) Debug

Syslogd Setting Window

Item Value Setting Description
Un-checked by . .

Enable default Check Enable box to activate the Syslogd function, and send event logs to a syslog server
Select one syslog server from the Server dropdown box to sent event log to.

Server N/A If none has been available, click the Add Object button to create a system log server.
You may also add an system log server from the Object Definition > External
Server > External Server tab.

Log type Un-checked by Select the type of event to log and be sent to the destined syslog server. Available

category default events are System, Attacks, Drop, Login message, and Debug.

Log to Storage

Log to Storage screen allows network administrator to select the type of events to log and be stored at an
internal or an external storage.

» Log to Storage

# Enable

Select Device: [|nternal v

Log file name: lsyslog ‘
Split file: () Enable Size: |200

Interval: [ ) Enable |1440 (1~10080 Minutes)

| [KB |

Max Records: |3000 | (5~10000)
| Download log file | clear logs |
Log type Category: @ System (¢ Attacks # Drop ¢ Login message ¢ Debug

Log to Storage Setting Window

Item
Enable

Value Setting
Un-checked by default

Description
Check to enable sending log to storage.

Select Device

Internal is selected by
default

Select internal or external storage.

Log file name

Un-checked by default

Enter log file name to save logs in designated storage.

Split file Enable

Un-checked by default

Check enable box to split file whenever log file reaching the specified limit.

Split file Size

200 KB is set by default

Enter the file size limit for each split log file.
Value Range: 10 ~ 1000.

Interval Enable

Un-checked by default

Check enable box to enable the log interval setting.

Log Interval

1440 is set by default

Enter the log interval setting.
Value Range: 1 ~ 10080 Minute.

Max Records

3000 is set by default

Enter the maximum number of records to be stored in the log storage.
Value Range: 5 ~ 10000.
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Log type category

Un-checked by default

Check which type of logs to send: System, Attacks, Drop, Login message,
Debug

Log to Storage Button Description

Item

Value setting

Description

Download log N/A Click the Download log file button to download log files to a log.tar file.
file
Clear Logs N/A Click the Clear logs button to delete the log files from the storage.
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6.2.5 Backup & Restore

In the Backup & Restore window, you can upgrade the device firmware when new firmware is available and also

backup / restore the device configuration.

In addition to the factory default settings, you can also customize a special configuration setting as a customized
default value. With this customized default value, you can reset the device to the expected default setting if

needed.

Go to Administration > System Operation > Backup & Restore tab.

Item

-

FW Upgrade Via Web Ul v

Download v

-

Backup Configuration Settings

v

Auto Restore Configuration

» Self-defined Logo Download v
» Self-defined CSS Edit
Download v

Via Web Ul is selected

FW Upgrade
Pe by default
Back.up . Download is selected by
Configuration
Settings default

The Enable box is
unchecked by default

Auto Restore
Configuration

Enable | Save Conf

Setting
FW Upgrade
Via Web Ul
. Clean Conf J Conf. Info
Via Web Ul || Reset
Via Web Ul || Reset

If new firmware is available, click the FW Upgrade button to upgrade the
device firmware via Web Ul, or Via Storage.

After clicking on the “FW Upgrade” command button, you need to specify the
file name of new firmware by using “Browse” button, and then click
“Upgrade” button to start the FW upgrading process on this device. If you
want to upgrade a firmware which is from GPL policy, please check “Accept
unofficial firmware”

You can backup or restore the device configuration settings by clicking the Via
Web Ul button.

Download: for backup the device configuration to a config.bin file.

Upload: for restore a designated configuration file to the device.

Via Web Ul: to retrieve the configuration file via Web GUI.

Chick the Enable button to activate the customized default setting function.
Once the function is activated, you can save the expected setting as a
customized default setting by clicking the Save Conf. button, or clicking the
Clean Conf. button to erase the stored customized configuration.
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6.2.6 Reboot & Reset

For some special reason or situation, you may need to reboot the gateway or reset the device configuration to
its default value. In addition to perform these operations through the Power ON/OFF, or pressing the reset
button on the device panel, you can do it through the web GUI too.

Go to Administration > System Operation > Reboot & Reset tab.

In the Reboot & Reset window, you can reboot this device by clicking the “Reboot” button, and reset this device
to default settings by clicking the “Reset” button.

Item Setting
» Reboot Now v | | Reboot

» Reset to Default Reset

Chick the Reboot button to reboot the gateway immediately or on a pre-
defined time schedule.

Reboot Now is selected by Now: Reboot immediately
default Time Schedule: Select a pre-defined auto-reboot time schedule rule to reboot
the auto device on a designated tim. To define a time schedule rule, go to
Object Definition > Scheduling > Configuration tab.
Reset to Default N/A Click the Reset button to reset the device configuration to its default value.
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6.3 FTP

The File Transfer Protocol (FTP) is a standard network protocol used to transfer computer files between a client
and server on a computer network. FTP is built on a client-server model architecture and uses separate control
and data connections between the client and the server. FTP users may authenticate themselves with a clear-
text sign-in protocol, normally in the form of a username and password, but can connect anonymously if the
server is configured to allow it.

For secure transmission that protects the username and password, and encrypts the content, FTP is
often secured with SSL/TLS (FTPS). Besides, SSH File Transfer Protocol (SFTP) is sometimes also used instead,
but is technologically different.

This gateway embedded FTP / SFTP server for administrator to download the log files to his computer or
database. In the following two sections, you can configure the FTP server and create the user accounts that can
login to the server. After login to the FTP server, you can browse the log directory and have the permission to
download the stored log files and delete the files you have downloaded to make more storage space for further
data logs.

The available log files can be system logs (refer to Administration > System Operation > System Log), Network
Packets (refer to Administrator > Diagnostic > Packet Analyzer), Data Log (refer to Field Communication > Data
Logging > Log File Management), and GNSS Log (refer to Service > Location Tracking > GNSS). With proper
configuration for the various log functions that supported on your purchased product, you can download the
log via FTP / SFTP connections.
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6.3.1 Server Configuration

This section allows user to setup the embedded FTP and SFTP server for retrieving the interested log files.
Go to Administration > FTP > Server Configuration tab.

Enable FTP Server

Save
Item Setting
» FTP ¢! Enable
» FTP Port 21
» Timeout 300 second(s)(60-7200)
» Max. Connections per IP 2 v
» Max. FTP Clients 3 v
» PASV Mode Enable
» Port Range of PASV Mode 20000 ~ 150031
» Auto Report External IP in Enable
PASV Mode
» ASCII Transfer Mode Enable
» FTPS(FTP over SSL/TLS) Enable
Check Enable box to activate the embedded FTP Server function.
The box is unchecked by With the FTI? Server enabled, you can retrieve or delete the stored log files via
FTP default FTP connection.
' Note: The embedded FTP Server is only for log downloading, so no any write
permission is implemented for user file upload to the storage.
Specify a port number for FTP connection. The gateway will listen for
FTP Port Port 21 is set by default incoming FTP connections on the specified port.
Value Range: 1 ~ 65535.
Timeout 300 seconds is set by Specify the maximum timeout interval for the FTP connection. Supported
default. range is 60 to 7200 seconds.
Max. . Specify the maximum number of clients from the same IP address for the FTP
. 2 Clients are set by . . .
Connections per connection. Up to 5 clients from the same IP address is supported.
P default.
Max. ETP Clients 5 Clients are set by Specify.the maximum number of clients for the FTP connection. Up to 32
default. clients is supported.
PASV Mode Optional setting Check the Enable box to activate the support of PASV mode for a FTP

connection from FTP clients.
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Port Range of
PASV Mode
Auto Report
External IP in

by default.

Optional setting

Port 50000 ~ 50031 is set

Specify the port range to allocate for PASV style data connection.

Value Range: 1024 ~ 65535.

Check the Enable box to activate the support of overriding the IP address
advertising in response to the PASV command.

PASV Mode

ASCII Transfer Ootional settin Check the Enable box to activate the support of ASCIl mode data transfers.

Mode P & Binary mode is supported by default.

FTPS (FTP over Ootional settin Check the Enable box to activate the support of secure connections via

SSL/TLS) P & SSL/TLS.

Enable SFTP Server
- Save
Item Setting
Enable
ia LAN

> SFTP via || WAN (WAN-1 | WAN-2

» SFTP Port 22

SFTP Check Enable box to activate the embedded SFTP Server function.
Furthermore, you can check the granted interface(s) for the SFTP connection,
via LAN, WAN, or both.

The box is unchecked by Besides, if any WAN interface is selected, you can further limit the hosts that
default. can access to the WAN port via SFTP. The available options are: any, Specific

IP Address, or IP Range.
With the SFTP Server enabled, you can retrieve or delete the stored log files
via secure SFTP connection.

SFTP Port Default 22 Specify a port number for SFTP connection. The gateway will listen for

incoming SFTP connections on the specified port.
Value Range: 1 ~ 65535.
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6.3.2 User Account

This section allows user to setup user accounts for logging to the embedded FTP and SFTP server to retrieve the
interested fog files.

Go to Administration > FTP > User Account tab.

Create/Edit FTP User Accounts

# User Account List

User Name Password Directory Permission Enable Actions

When Add button is applied, User Account Configuration screen will appear.
# User Account Configuration Be%:\':)

Item Setting
» User Name jadmin
» Password |'""
» Directory
» Permission Read/Write v
» Enable

Configuration

Item Value setting Description
User Name String : non-blank string Enter the user account for login to the FTP server.
Value Range: 1 ~ 15 characters.
Password String : no blank Enter the user password for login to the FTP server.
Directory N/A Select a root directory after user login.
Permission Read/Write is selected Select the Read/write permission.
by default. Note: The embedded FTP Server is only for log downloading, so no any write

permission is implemented for user file upload to the storage, even
Read/Write option is selected.
Enable The box is checked by Check the box to activate the FTP user account.
default.
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6.4 Diagnostic

This gateway supports simple network diagnosis tools for the administrator to troubleshoot and find the root
cause of the abnormal behavior or traffics passing through the gateway. There can be a Packet Analyzer to help
record the packets for a designated interface or specific source/destination host, and another Ping and Tracert
tools for testing the network connectivity issues.

6.4.1 Diagnostic Tools

The Diagnostic Tools provide some frequently used network connectivity diagnostic tools (approaches) for the
network administrator to check the device connectivity.

Go to Administration > Diagnostic > Diagnostic Tools tab.

Item Setting

» Ping Test Host IP Outer Interface: [Ayto v | LAN Source
Default v Ping

» Tracert Test Host IP Interface: |Auto v UDP v Tracert
» Speed Test Interface: |Auto v mode: | DL+UL v SSL | Test
» Wake on LAN Wake up

This allows you to specify an IP / FQDN, the Outer interface (auto, WAN,

) . ) LAN, or VLAN), and LAN source (default, LAN, or VLAN) as well, so system will
Ping Test Optional Setting . . . s .
try to ping the specified device to test whether it is alive after clicking on the
Ping button. A test result window will appear beneath it.

Trace route (tracert) command is a network diagnostic tool for displaying the
route (path) and measuring transit delays of packets across an IP network.
Trace route proceeds until all (three) sent packets are lost for more than
twice, then the connection is lost and the route cannot be evaluated.

First, you need to specify an IP / FQDN, the test interface (LAN, WAN, or
Auto) and the protocol (UDP or ICMP), and by default, it is UDP.

Then, system will try to trace the specified host to test whether it is alive

Tracert Test Optional setting

after clicking on Tracert button. A test result window will appear beneath it.
This allow you to do q quick speed test for verifying the connectivity on
Speed Test Optional setting o y a9 P ying y
specific interface.
Wake on LAN (WOL) is an Ethernet networking standard that allows a
computer to be turned on or awakened by a network message. You can
Wake on LAN Optional setting p y. 8
specify the MAC address of the computer, in your LAN network, to be

remotely turned on by clicking on the Wake up command button.
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Save N/A Click the Save button to save the configuration.
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6.4.2 Packet Analyzer

The Packet Analyzer can capture packets depend on user settings. User can specify interfaces to capture packets
and filter by setting rule. Ensure the log storage is available (either embedded SD-Card or external USB Storage),

otherwise Packet Analyzer cannot be enabled.

Go to Administration > Diagnostic > Packet Analyzer tab.

Item
» Packet Analyzer Enable
» File Name
» Split Files Enable File Size :
WAN-1 WAN-
ASY | |Binary Mode
» Packet Interfaces 2.4G VAP-1
VAP-8
5G VAP-1
VAP-8

The box is unchecked by
Packet Analyzer default.
1. An optional setting

2. Blank is set by default, and

File Name the default file name is
<Interface>_<Date>_<index>.
1. An optional setting
_— 2. The default value of File
Split Files Size is 200 KB.
Packet Interfaces An optional setting

Setting

200 KB v
2 [ WAN-3 [J WAN-4

e v |,

VAP-2 VAP-3 VAP-4 VAP-5 VAP-6 VAP-7

VAP-2 VAP-3 VAP-4 || VAP-5 VAP-6 || VAP-7

Check Enable box to activate the Packet Analyzer function.
If you cannot enable the checkbox, please check if the storage is available
or not. Plug in the USB storage and then enable the Package Analyzer
function.
Enter the file name to save the captured packets in log storage.
If Split Files option is also enabled, the file name will be appended with
an index code “_<index>".
The extension file name is .pcap.
Check enable box to split file whenever log file reaching the specified
limit.
If the Split Files option is enabled, you can further specify the File Size
and Unit for the split files.
Value Range: 10 ~ 99999.
NOTE: File Size cannot be less than 10 KB
Define the interface(s) that Packet Analyzer should work on.
At least, one interface is required, but multiple selections are also
accepted.
The supported interfaces can be:

[ ) WAN: When the WAN is enabled at Physical Interface, it can be

selected here.
®  ASY: This means the serial communication interface. It is used to
capture packets appearing in the Field Communication.
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Therefore, it can only be selected when specific field
communication protocol, like Modbus, is enabled.
Select Binary mode or String mode for the serial interface.

[ ] VAP: This means the virtual AP. When WiFi and VAP are enabled,

it can be selected here.

Save

N/A

Click the Save button to save the configuration.

Undo

N/A

Click the Undo button to restore what you just configured back to the
previous setting.

Once you enabled the Packet Analyzer function on specific Interface(s), you can further specify some filter rules
to capture the packets which matched the rules.

= Capture Filters . ®

Item

Setting

» Filter

[J Enable

» Source MACs

» Source IPs

» Source Ports

» Destination MACs

» Destination IPs

» Destination Ports

Capture Fitters

Item
Filter

Value setting
Optional setting

Description
Check Enable box to activate the Capture Filter function.

Source MACs

Optional setting

Define the filter rule with Source MACs, which means the source MAC address of

packets.

Packets which match the rule will be captured.

Up to 10 MACs are supported, but they must be separated with “;”,
e.g. AA:BB:CC:DD:EE:FF; 11:22:33:44:55:66

The packets will be captured when match any one MAC in the rule.

Source IPs

Optional setting

Define the filter rule with Source IPs, which means the source IP address of
packets.
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Packets which match the rule will be captured.
Up to 10 IPs are supported, but they must be separated with “;”,
e.g. 192.168.1.1; 192.168.1.2
The packets will be captured when match any one IP in the rule.
Source Ports Optional setting Define the filter rule with Source Ports, which means the source port of packets.
The packets will be captured when match any port in the rule.
Up to 10 ports are supported, but they must be separated with “;”,
e.g. 80; 53
Value Range: 1 ~ 65535.
Destination MACs Optional setting Define the filter rule with Destination MACs, which means the destination MAC
address of packets.
Packets which match the rule will be captured.
Up to 10 MACs are supported, but they must be separated with “;”,
e.g. AA:BB:CC:DD:EE:FF; 11:22:33:44:55:66
The packets will be captured when match any one MAC in the rule.
Destination IPs Optional setting Define the filter rule with Destination IPs, which means the destination IP address
of packets.
Packets which match the rule will be captured.
Up to 10 IPs are supported, but they must be separated with “;”,
e.g. 192.168.1.1; 192.168.1.2
The packets will be captured when match any one IP in the rule.
Destination Ports Optional setting Define the filter rule with Destination Ports, which means the destination port of
packets.
The packets will be captured when match any port in the rule.
Up to 10 ports are supported, but they must be separated with “;”,
e.g. 80; 53
Value Range: 1 ~ 65535.
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Chapter 7 Service

7.1 Cellular Toolkit

>
=

A ———

Data Usage Monitoring
1. Statisticsofdata usage thru3G/LTE
2. SIMswitchor drop if reach quota limit

------------------------------------

,_______

SMS (Short Message Service)
1. Compose SMSmessage ongateway
2. Receive SMSmessage from remote

Céllular
Tower \ (t9)
_ ) SIMPIN Management 5 |
Mol():;le N;lwork k SIM card PIN lock or PIN unlock ! -
rator '
PEERE Cellular C Sl =
, Tower
(-(‘,g\) Mobile Network Scan | Cellular Gateway
I ol Actively mobile network search ]
Cellular Manually select mobile network I
Tower N d
USSD Communication

1. Instant communication with MNO E
2. Subscriberinquiryor setting change |

_________ T ——— 1
Besides cellular data connection, you may also like to monitor data usage of cellular WAN, sending text message
through SMS, changing PIN code of SIM card, communicating with carrier/ISP by USSD command, or doing a
cellular network scan for diagnostic purpose.

In Cellular Toolkit section, it includes several useful features that are related to cellular configuration or
application. You can configure settings of Data Usage, SMS, SIM PIN, USSD, and Network Scan here. Please note
at least a valid SIM card is required to be inserted to device before you continue settings in this section.

7.1.1 Data Usage

Most of data plan for cellular connection is with a limited amount of data usage. If data usage has been over
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limited quota, either you will get much lower data throughput that may affect your daily operation, or you will
get a ‘bill shock’ in the next month because carrier/ISP charges a lot for the over-quota data usage.

With help from Data Usage feature, device will monitor cellular data usage continuously and take actions. If data
usage reaches limited quota, device can be set to drop the cellular data connection right away. Otherwise, if
secondary SIM card is inserted, device will switch to secondary SIM and establish another cellular data

connection with secondary SIM automatically.

If Data Usage feature is enabled, all history of cellular data usage can be viewed at Status > Statistics & Reports

> Cellular Usage tab.

J | Add || Delete |
ID SIM info Carrier Name | Cycle Period Start Date
1 3G/4G SIM A ISP A 1 Monthly Mon Apr 01 2019

3G/4G Data Usage

SIMA
ISPA Bill Start: every 20t (« ))

(((g)j_g Data limit: 1Gb
(« ))>..$---.>__
é\ SIMB Gateway

ISPB

SIM A Settings
-Cycle Period: monthly

-Start Date: 2017 / Feb / 20
-Data Limitation: 1Gb
-Connection Restrict: Enable

00:00:00 GMT+0800

Connection
Data Limitation Enable Action
Restrict

1GB s ¢ | Edit | (] Select

Data Usage feature enabling gateway device to
continuously monitor cellular data usage and take
actions. In the diagram, quota limit of SIM A is 1Gb
per month and bill start date is 20*" of every month.
The device is smart to start a new calculation of data
usage on every 20" of month. Enable Connection
Restrict will force gateway device to drop cellular
connection of SIM A when data usage reaches quota
limit (1Gb in this case). If SIM failover feature is
configured in Internet Setup, then gateway will
switch to SIM B and establish a new cellular data
connection automatically.
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Data Usage Setting

Go to Service > Cellular Toolkit > Data Usage tab.

Before finished settings for Data Usage, you need to know bill start date, bill period, and quota limit of data
usage according to your data plan. You can ask this information from your carrier or ISP.

Create / Edit Cellular Data Usage Profile

SIM info

« Cellular Data Usage Profile List [[XI]]

Cycle Connection

Start Date Data Limitation Action

Period Restrict

When Add button is applied, Cellular Data Usage Profile Configuration screen will appear. You can create up to
four data usage profiles, one profile for each SIM card used in the Gateway.

# Cellular Data Usage Profile Configuration

Item

Setting

» SIM Select

| Cellular v| [SIMA v |

» Carrier Name

» Cycle Period |Days  v| | |

> Start Date (2021 v| / |January v|/ [19v|
» Data Limitation | | [KB v|
» Connection Restrict (] Enable

» Enable Enable

Cellular Data Usage Profile Configuration

Item Setting  Value setting Description
SIM Select Cellular-1 and SIM A Choose a cellular interface (Cellular-1 or Cellular-2), and a SIM card bound to the
by default. selected cellular interface to configure its data usage profile.
Note: Cellular-2 is only available for for the product with dual cellular module.

Carrier Name It is an optional item. Fill in the Carrier Name for the selected SIM card for identification.

Cycle Period Days by default The first box has three types for cycle period. They are Days, Weekly and Monthly.
Days: For per Days cycle periods, you have to further specify the number of days in
the second box.

Value Range: 1 ~ 90 days.
Weekly, Monthly: The cycle period is one week or one month.

Start Date N/A Specify the date to start measure network traffic.

Please don’t select the day before now, otherwise, the traffic statistics will be
incorrect.

Data Limitation N/A Specify the allowable data limitation for the defined cycle period.
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Connection Un-Checked by default. Check the Enable box to activate the connection restriction function.

Restrict During the specified cycle period, if the actual data usage exceeds the allowable data
limitation, the cellular connection will be forced to disconnect.

Enable Checked by default. Check the Enable box to activate the data usage profile.
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7.1.2 SMS

Short Message Service (SMS) is a text messaging service, which is used to be widely-used on mobile phones. It
uses standardized communications protocols to allow mobile phones or cellular devices to exchange short text
messages in an instant and convenient way.

SMS Setting

Go to Service > Cellular Toolkit > SMS tab

With this gateway device, you can send SMS text messages or browse received SMS messages as you usually do
on a cellular phone.

Setup SMS Configuration

# Configuration ‘ "
Item Setting

» Physical Interface Cellular-1 v

» SMS Enable SIM Status: SIM_A

» SMS Storage | SIM Card Only |

» SMS Space "] Enable & Keep Available Space (1-10)

Configuration

Item Value setting Description
Choose a cellular interface (Cellular-1 or Cellular-2) for the following SMS
Physical The box is Cellular-1 by functi i i ( ) &
Interface default unction configuration.
Note: Cellular-2 is only available for for the product with dual cellular module.
SMS The box is checked by This is the SMS switch. If the box checked that the SMS function enable, if the
default box unchecked that the SMS function disable.
SIM Status N/A Depend on currently SIM status. The possible value will be SIM_A or SIM_B.
The box is SIM Card Onl
SMS Storage by default v This is the SMS storage location. Currently the option only SIM Card Only.
Check the Enable box and specify a number (1-10) for message count to
The box is unchecked by . pectly ( ). 8
SMS Space default reserve some available storage space and prevent it from run out of storage.
The oldest message(s) will be deleted when the SMS storage is going to full.
Save N/A Click the Save button to save the settings
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SMS Summary

Show Unread SMS, Received SMS, Sent SMS, Remaining SMS, and edit SMS context to send, read SMS from

SIM card.
ST New SMS | sMS Inbox J| SMS Sent Folder ° x
Item Setting
» Unread SMS 0
» Received SMS 10
» Sent SMS 0
» Remaining SMS 0
SMS Summary
Item Value setting Description
If SIM card insert to router first time, unread SMS value is zero. When received the
Unread SMS N/A . .
new SMS but didn’t read, this value plus one.
. This value record the existing SMS numbers from SIM card, When received the new
Received SMS N/A .
SMS, this value plus one.
. . his val
Sent SMS N/A This value record the number of out going SMS, When sent one SMS, this value
plus one.
Remaining SMS  N/A This Va|l:le is SMS capacity minus received SMS, When received the new SMS, this
value minus one.
New SMS N/A Click Ne'w SMS button, a New SMS s.creen appears. User can set the SMS setting
from this screen. Refer to New SMS in the next page.
Click SMS Inbox button, a SMS Inbox List screen appears. User can read or delete
SMS Inbox N/A SMS, reply SMS or forward SMS from this screen. Refer to SMS Inbox List in the
next page.
Refresh N/A Click the Refresh button to update the SMS summary immediately.
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New SMS
You can set the SMS setting from this screen.

« New sms [E2X0 8C

[} Item Setting

(Use "+’ for International Format and *;' to Compose Multiple Receivers)

» Receivers

» Text Message

Length of Current Input: 0

» Result
New SMS
Item Value setting Description
. Write the receivers to send SMS. User need to add the semicolon and
Receivers N/A

compose multiple receivers that can group send SMS.

Write the SMS context to send SMS. The router supports up to a maximum of
1023 character for SMS context length.

Send N/A Click the Send button, above text message will be sent as a SMS.

If SMS has been sent successfully, it will show Send OK, otherwise Send Failed
will be displayed.

Text Message N/A

Result N/A

SMS Inbox List
You can read or delete SMS, reply SMS or forward SMS from this screen.

From Phone

NJ}aber

Timestamp SMS Text Preview Actions

SMS Inbox List

Item Value setting Description
ID N/A The number of SMS.
From Phone
N/A Sender List (Phone Number) for the received SMS
Number
Timestamp N/A What time the SMS is received
SMS Text . . . .
Preview N/A Preview the SMS text. Click the Detail button to read a certain message.
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Click the Detail button to read the SMS detail; Click the Reply / Forward

Action The box is unchecked by button to reply/forward SMS.

default Besides, you can check the box(es), and then click the Delete button to delete

the checked SMS(s).

Refresh N/A Refresh the SMS Inbox List.

Delete N/A Delete the SMS for all checked box from Action.

Close N/A Close the Detail SMS Message screen.

SMS Sent Folder

You can read or delete SMS from this screen.

S et || Giose || Prevous [0+ [ Next

ID Receivers Timestamp

SMS Text Preview Actions

SMS Sent Folder

Item Value setting Description

ID N/A The number of SMS.

Receivers N/A Receiver list for the sent SMS.

Timestamp N/A What time the SMS is sent

SMS Text . . . .

Preview N/A Preview the SMS text. Click the Detail button to read a certain message.

The box is unchecked by

Click the Detail button to read the SMS detail

Action Besides, you can check the box(es), and then click the Delete button to delete
default
the checked record(s).
Refresh N/A Refresh the SMS Sent Folder.
Delete N/A Delete the SMS for all checked box from Action.
Close N/A Close the Detail SMS Message screen.
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7.1.3 SIM PIN

With most cases in the world, users need to insert a SIM card (a.k.a. UICC) into end devices to get on cellular
network for voice service or data surfing. The SIM card is usually released by mobile operators or service
providers. Each SIM card has a unique number (so-called ICCID) for network owners or service providers to
identify each subscriber. As SIM card plays an important role between service providers and subscribers, some
security mechanisms are required on SIM card to prevent any unauthorized access.

Enabling a PIN code in SIM card is an easy and effective way of protecting cellular devices from unauthorized
access. This gateway device allows you to activate and manage PIN code on a SIM card through its web GUI.

Activate PIN code on SIM Card

This gateway device allows you to activate PIN code on SIM card. This
example shows how to activate PIN code on SIM-A for 3G/4G-1 with
default PIN code “0000”.

SIMA
with PIN Code ‘0000”

Gateway

SIM A Settings
-SIM Lock: Enable

-PIN Code: 0000

Change PIN code on SIM Card

This gateway device allows you to change PIN code on SIM card.
Following the example above, you need to type original PIN code
“0000”, and then type new PIN code with ‘1234’ if you like to set new
PIN code as “1234’. To confirm the new PIN code you type is what you
want, you need to type new PIN code ‘1234’ in Verified New PIN Code
again.

- P 7
with PIN Code ‘0000 Gateway

Change PIN Code Settings
-Current PIN Code: 0000
-New PIN Code: 1234
-Verified New PIN Code: 1234

Unlock SIM card by PUK Code

If you entered incorrect PIN code at configuration page for 3G/4G-1

~~ (D)
((© ))1 o
e @
MNO SIMA locked
by PUK code Gateway

‘12345678

PUK Unlock Settings
-PUK Code: 12345678

-New PIN Code: 5678

WAN over three times, and then it will cause SIM card to be locked by
PUK code. Then you have to call service number to get a PUK code to
unlock SIM card. In the diagram, the PUK code is “12345678” and new
PIN code is “5678".
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SIM PIN Setting

Go to Service > Cellular Toolkit > SIM PIN Tab

With the SIM PIN Function window, it allows you to enable or disable SIM lock (which means protected by PIN
code), or change PIN code. You can also see the information of remaining times of failure trials as we mentioned
earlier. If you run out of these failure trials, you need to get a PUK code to unlock SIM card.

Select a SIM Card

Item Setting
» Physical Interface | Cellular-1 v |
» SIM Status SIM-A Ready
» SIM Selection | SIM-A v || Switch |
Physical The box is Cellular-1 by Choose a cellular interface (Cellular-1 or Cellular-2) to change the SIM PIN
Interface default setting for the selected SIM Card.

Note: Cellular-2 is only available for for the product with dual cellular module.

SIM Status N/A Indication for the selected SIM card and the SIM card status.

The status could be Ready, Not Insert, or SIM PIN.
Ready -- SIM card is inserted and ready to use. It can be a SIM card without PIN
protection or that SIM card is already unlocked by correct PIN code.
Not Insert -- No SIM card is inserted in that SIM slot.
SIM PIN -- SIM card is protected by PIN code, and it’s not unlocked by a correct
PIN code yet. That SIM card is still at locked status.

SIM Selection N/A Select the SIM card for further SIM PIN configuration.
Press the Switch button, then the Gateway will switch SIM card to another
one. After that, you can configure the SIM card.
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Enable / Change PIN Code

Enable or Disable PIN code (password) function, and even change PIN code function.

Item

» PIN Lock

» Remaining times

PIN lock

Remaining times
Save
Change PIN Code

Save

N/A

Depend on SIM card

Depend on SIM card
N/A
N/A

Setting

Enable PIN Code (4~8 digits)

Click the Enable button to activate the PIN lock function.

For the first time you want to enable the PIN lock function, you have to
fill in the PIN code as well, and then click Save button to apply the setting.
Represent the remaining trial times for the SIM PIN unlocking.

Click the Save button to apply the setting.

Click the Change PIN code button to change the PIN code (password).

If the SIM Lock function is not enabled, the Change PIN code button is
disabled. In the case, if you still want to change the PIN code, you have to
enable the SIM Lock function first, fill in the PIN code, and then click the Save
button to enable. After that, You can click the Change PIN code button to
change the PIN code.

When Change PIN Code button is clicked, the following screen will appear.

ftem Setting

» Current PIN Code (4~8 digits)

» New PIN Code (4~8 digits)

» Vertified New PIN Code (4~8 digits)

Apply | Cancel

Current PIN A Must filled setting Fill in the current (old) PIN code of the SIM card.

Code

New PIN Code A Must filled setting Fill in the new PIN Code you want to change.

Verified New A Must filled setting Confirm the new PIN Code again.

PIN Code

Apply N/A Click the Apply button to change the PIN code with specified new PIN code.
Cancel N/A Click the Cancel button to cancel the changes and keep current PIN code.

Note: If you changed the PIN code for a certain SIM card, you must also change the corresponding PIN code
specified in the Basic Network > WAN & Uplink > Internet Setup > Connection with SIM Card page. Otherwise,
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it may result in wrong SIM PIN trials with invalid (old) PIN code.

Unlock with a PUK Code
The PUK Function window is only available for configuration if that SIM card is locked by PUK code. It means
that SIM card is locked and needs additional PUK code to unlock. Usually it happens after too many trials of
incorrect PIN code, and the remaining times in SIM Function table turns to 0. In this situation, you need to
contact your service provider and request a PUK code for your SIM card, and try to unlock the locked SIM card
with the provided PUK code. After unlocking a SIM card by PUK code successfully, the SIM lock function will be
activated automatically.

Item

» PUK status

» Remaining times
» PUK Code

» New PIN Code

PUK status

Remaining times

PUK Code
New PIN Code

Save

PUK unlock
N/A

PUK Unlock
/ PUK Lock

Depend on SIM card

A Must filled setting

A Must filled setting

N/A

Setting

(8 digits)

(4~8 digits)

Indication for the PUK status.

The status could be PUK Lock or PUK Unlock. As mentioned earlier, the SIM
card will be locked by PUK code after too many trials of failure PIN code. In this
case, the PUK Status will turns to PUK Lock. In a normal situation, it will display
PUK Unlock.

Represent the remaining trial times for the PUK unlocking.

Note : DO NOT make the remaining times down to zero, it will damage the
SIM card FOREVER ! Call for your ISP’s help to get a correct PUK and unlock the
SIM if you don’t have the PUK code.

Fill in the PUK code (8 digits) that can unlock the SIM card in PUK unlock status.
Fill in the New PIN Code (4~8 digits) for the SIM card.

You have to determine your new PIN code to replace the old, forgotten one.
Keep the PIN code (password) in mind with care.

Click the Save button to apply the setting.

Note: If you changed the PUK code and PIN code for a certain SIM card, you must also change the corresponding
PIN code specified in the Basic Network > WAN & Uplink > Internet Setup > Connection with SIM Card page.
Otherwise, it may result in wrong SIM PIN trials with invalid (old) PIN code.
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7.1.4 USSD (not supported)

Not supported feature for the purchased product, leave it as blank.
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7.1.5 Network Scan

"Network Scan" function can let administrator specify the device how to connect to the mobile system for data
communication in each cellular interface. For example, administrator can specify which generation of mobile
system is used for connection, 3G, 4G or 5G. Moreover, he can define their connection sequence for the gateway
device to connect to the mobile system automatically. Administrator also can scan the mobile systems in the air
manually, select the target operator system and apply it. The manual scanning approach is used for problem
diagnosis.

Network Scan Setting

Go to Service > Cellular Toolkit > Network Scan tab.

In "Network Scan" page, there are two windows for the Network Scan function. The "Configuration" window can
let you select which Cellular module (physical interface) is used to perform Network Scan, and system will show
the current used SIM card in the module. You can configure each Cellular WAN interface by executing the
network scanning one after another. You can also specify the connection sequence of the targeted generation
of mobile system, 3G/4G/5G.

Network Scan Configuration

Item Setting
» Physical Interface [Cellular-1 v| SIM Status: SIM_A
» Network Type [Auto v |
» Scan Approach [Auto v|

. . Choose a cellular interface (Cellular-1 or Cellular-2) for the network scan
Physical The box is Cellular-1 by

function.
Interface default
Note: Cellular-2 is only available for for the product with dual cellular module.
SIM Status N/A Show the connected cellular service (identified with SIM_A or SIM_B).
Network Type Auto is selected by Specify the r?etwork type for the netw?rk scan function. '
default. When Auto is selected, the network will be register automatically;
When Auto selected, cellular module register automatically.
Auto is selected by If the Manually option is selected, a Network Provider List screen appears.
Scan Approach _
default. Press Scan button to scan for the nearest base stations. Select (check the box)
the preferred base stations then click Apply button to apply settings.
Save N/A Click Save to save the settings
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The second window is the "Network Provider List" window and it appears when the Manually Scan Approach is
selected in the Configuration window. By clicking on the "Scan" button and wait for 1 to 3 minutes, the found
mobile operator system will be displayed for you to choose. Click again on the "Apply" button to drive system to
connect to that mobile operator system for the dedicated 3G/4G interface.

= Network Provider List 201 X200

Provider Name

Mobile System Network Status Action
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Chapter 8 Status

8.1 Dashboard

" Device Dashboard =
'@’ Status Device Dashboard
@ Dashboard
- Basic Network B i ° = System Information History .°
. Time: . Qer v
. Security Device Up-Time:  3day Ohr 22min 32sec |Sec v |
CPU: 8% 100%
- Administration ! : i
— Memory: s 59% CPU2
- Statistics & Reports . 80% |HHHHHHHHHHHHH LV L o ey 3
Connection Sessions: 0%
3 709 |- LU EELEEL PRV L L LELLL L () CPU 4
' Basic Network '
« Network Inferface Stati °° 60% |-H-H-HHHHHEEEE LR
'@ Object Definition l Current 50% |HH-H-HHHHHEE PR LR L L
) Download Current
Device| Type | Upload Traffic Download
Traffic Upload Traffic Traffic 40%
'@ Flelanmmumcauonl eth? | Ethernet 190 (VB) 311 (MB) 3(KB) 2(KB) 30% fHH-HHHHHHHHHH L L U LU L L
' Security ' eth2.1 | Ethernet 24 (MB) 49 (KB) 18 (Bytes) 0 (Bytes)
eth2.2 | Ethemet| 147 (MB) 273 (MB) 3(KB) 2 (KB)
| € Administration B0 [Eremetl 19 0ve) 20 e . 5 Byiee) 100440 100450 100500 100510 100520 100530

8.1.1 Device Dashboard

The Device Dashboard window shows the current status in graph or tables for quickly understanding the
operation status for the gateway. They are the System Information, System Information History, and Network
Interface Status. The display will be refreshed once per second.

From the menu on the left, select Status > Dashboard > Device Dashboard tab.

System Information Status

The System Information screen shows the device Up-time and the resource utilization for the CPU, Memory,
and Connection Sessions.

# System Information . 4

Device Up-Time: 3day 1hr 21min 48sec

CPU: w» 10%
Memory: s 59%
Connection Sessions: 0%
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System Information History
The System Information History screen shows the statistic graphs for the CPU and memory.

- o R Sec v
Sec v 250 MB
100% Memory
’ 225 MB
o CPU1
’ CPU2 200 MB
80% Il CPU3
175 MB
70% Il CPU4
150 MB s , et
60%
125 MB
50%
o 100 MB
30% . 75 MB
20%| : ! 50 MB
10% | 25MB
0% —— 0MB
110440 110450 110500 11050 10520 1 11:05:20 11:05:30 11:05:40 11:05:50 11:06:00 11:06:10

Network Interface Status

The Network Interface Status screen shows the statistic information for each network interface of the gateway.
The statistic information includes the Interface Type, Upload Traffic, Download Traffic, and Current Upload /
Download Traffic.

e - X

Current Current

. Upload Download
Device Type Traffic Traffic Uploa_ld Downlpad
Traffic Traffic

eth2 | Ethemet| 211 (MB) | 321 (MB) 3 (KB) 3 (KB)
eth2.1 | Ethernet| 24 (MB) 71 (KB) 64 (Bytes) | 0 (Bytes)
eth2.2 | Ethernet| 168 (MB) | 283 (MB) 3 (KB) 3 (KB)

br0 | Ethemet, 19(MB) | 31(MB) | 42 (Bytes) O (Bytes)

Wireless

ra0 LAN 1 (MB) 1(MB) | 0(Bytes) 0 (Bytes)

raio | VISSSS| 21(MB) | 42(MB) | 0(Bytes) | O (Bytes)

Wireless
LAN

) Wireless 362
Al | AN | (Bytes)

ral 0 (Bytes) | O (Bytes) | O(Bytes) | O (Bytes)
4(KB) | O(Bytes) | O (Bytes)

tun0 | Ethernet| O (Bytes) | O (Bytes) | O (Bytes) | O (Bytes)
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8.2 Basic Network

8.2.1 WAN & Uplink Status

Go to Status > Basic Network > WAN & Uplink tab.

The WAN & Uplink Status window shows the current status for different network type, including network
configuration, connecting information, modem status and traffic statistics. The display will be refreshed on every
five seconds.

WAN interface IPv4 Network Status

WAN interface IPv4 Network Status screen shows status information for IPv4 network.

ID | Interface | WAN Type Network Type | IP Addr. = Subnet Mask | Gateway DNS MAC Address | Conn. Status | Action
WAN-1| Cellular | Cellular NAT 0000 | 0000 0000 | J090 N/A Disconnected | E it |
WAN-2 Disable | Edit |
WAN-3 Disable | Edit |
ID N/A It displays corresponding WAN interface WAN IDs.
It displays the type of WAN physical interface.

Interface N/A Depending on the model purchased, it can be Ethernet, Cellular, or WiFi
Uplink.
It displays the method which public IP address is obtained from your ISP.

WAN Type N/A Depending on the model purchased, it can be Static IP, Dynamic IP, PPPoE,

PPTP, L2TP, Cellular.

It displays the network type for the WAN interface(s).
Network Type N/A Depending on the model purchased, it can be NAT, Routing, Bridge, or IP
Pass-through.
It displays the public IP address obtained from your ISP for Internet

IP Addr. N/A
connection. Default value is 0.0.0.0 if left unconfigured.
Subnet Mask N/A It displays the Subnet Mask for public IP address obtained from your ISP for
Internet connection. Default value is 0.0.0.0 if left unconfigured.
It displays the Gateway IP address obtained from your ISP for Internet
Gateway N/A
connection. Default value is 0.0.0.0 if left unconfigured.
DNS N/A It displays the IP address of DNS server obtained from your ISP for Internet

connection. Default value is 0.0.0.0 if left unconfigured.
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It displays the MAC Address for your ISP to allow you for Internet access.

MAC Address N/A . L
Note: Not all ISP may require this field.

Conn. Status N/A It displays the connection .status of the device to your ISP.
Status are Connected or disconnected.
This area provides functional buttons.
Renew button allows user to force the device to request an IP address from
the DHCP server. Note: Renew button is available when DHCP WAN Type is
used and WAN connection is disconnected.
Release button allows user to force the device to clear its IP address setting
to disconnect from DHCP server. Note: Release button is available when
DHCP WAN Type is used and WAN connection is connected.

Action N/A Connect button allows user to manually connect the device to the Internet.

Note: Connect button is available when Connection Control in WAN Type

setting is set to Connect Manually (Refer to Edit button in Basic Network >

WAN & Uplink > Internet Setup) and WAN connection status is
disconnected.

Disconnect button allows user to manually disconnect the device from the

Internet. Note: Connect button is available when Connection Control in WAN

Type setting is set to Connect Manually (Refer to Edit button in Basic

Network > WAN & Uplink > Internet Setup) and WAN connection status is

connected.

WAN interface IPv6 Network Status

WAN interface IPv6 Network Status screen shows status information for IPv6 network.

ID | Interface WAN Type Link-local IP Address Global IP Address Conn. Status
WAN- | oular PV /64 Discon-nected

ID N/A It displays corresponding WAN interface WAN IDs.

Interface N/A It displays the type of WAN physical interface.
Depending on the model purchased, it can be Ethernet, Cellular, etc...
It displays the method which public IP address is obtained from your ISP.

WAN Type N/A WAN type setting can be changed from Basic Network > IPv6 >
Configuration.

Link-local IP Address  N/A It displays the LAN IPv6 Link-Local address.

Action

| Edit |
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Global IP Address

N/A

It displays the IPv6 global IP address assigned by your ISP for your Internet

connection.

Conn. Status

N/A

It displays the connection status. The status can be connected, disconnected

and connecting.

Action

N/A

This area provides functional buttons.

Edit Button when pressed, web-based utility will take you to the IPv6
configuration page. (Basic Network > IPv6 > Configuration.)

LAN Interface Network Status

LAN Interface Network Status screen shows IPv4 and IPv6 information of LAN network.

*1 LAN Interface Network Status

IPv4 Address

IPv4 Subnet Mask

IPv6 Link-local Address

IPv6 Global Address

MAC Address

Action

192.168.123.254

255.255.255.0

fe80::250:18ff-fe00:fie

164

00:50:18:00:0F:FE

| Edit IPv4 | Edit IPv6 |

 LAN Interface Network Status

Item Value setting Description
IPva Address N/A It (?is.plays the current IPv4 IP Address of the gateway ~
This is also the IP Address user use to access Router’s Web-based Utility.
IPv4 Subnet Mask N/A It displays the current mask of the subnet.
IPv6 Link-local It displays the current LAN IPv6 Link-Local address.
N/A . , o
Address This is also the IPv6 IP Address user use to access Router’s Web-based Utility.
IPV6 Global Address  N/A It displays the cu.rrent IPv6 global IP address assigned by your ISP for your
Internet connection.
MAC Address N/A It displays the LAN MAC Address of the gateway
This area provides functional buttons.
Edit IPv4 Button when press, web-based utility will take you to the Ethernet
Action N/A LAN configuration page. (Basic Network > LAN & VLAN > Ethernet LAN tab).
Edit IPv6 Button when press, web-based utility will take you to the IPv6
configuration page. (Basic Network > IPv6 > Configuration.)

Cellular Modem Status

Cellular Modem Status List screen shows status information for Cellular WAN network(s).

# Cellular Modem Status List

Interface Card Information Link Status Signal Strength Network Name

Cellular 334 Disconnected N/A

N/A

3G/4G Modem Status List

305



5G WAN Extender

Item ‘ Value setting Description
Physical . L
Interface N/A It displays the type of WAN physical interface..
Card . ,
. N/A It displays the vendor’s cellular modem model name.
Information

. It displays the cellular connection status. The status can be Connecting, Connected,
Link Status N/A . . .
Disconnecting, and Disconnected.

Signal

Strength N/A It displays the cellular wireless signal level.
Network ) . .

N/A It displays the name of the service network carrier.
Name
Refresh N/A Click the Refresh button to renew the information.

This area provides functional buttons.
. Detail Button when press, windows of detail information will appear. They are the

Action N/A

Modem Information, SIM Status, and Service Information. Refer to next page for

more.

When the Detail button is pressed, cellular modem information windows such as Modem Information, SIM
Status, Service Information, Signal Strength / Quality, and Error Message will appear.

Interface Traffic Statistics

Interface Traffic Statistics screen displays the Interface’s total transmitted packets.

« Interface Traffic Statistics ‘ x

ID | Interface Received Packets(Mb) Transmitted Packets(Mb) Action

W/;‘N' Cellular 0 0

WAN-

Interface Traffic Statistics

Item Value setting Description
ID N/A It displays corresponding WAN interface WAN IDs.
Interface N/A It displa'ys the type of WAN physical i.nterface.
Depending on the model purchased, it can be Ethernet, Cellular, etc...
Received Packets It displays the downstream packets (Mb). It is reset when the device is
N/A
(Mb) rebooted.
Transmitted N/A It displays the upst kets (Mb). It is reset when the device is rebooted
Packets (Mb) isplays the upstream packets . It is reset when the device is rebooted.
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8.2.2 LAN & VLAN Status
Go to Status > Basic Network > LAN & VLAN tab.
Client List

The Client List shows you the LAN Interface, IP address, Host Name, MAC Address, and Remaining Lease Time
of each device that is connected to this gateway.

*] LAN Client List -

LAN Interface IP Address Host Name MAC Address Remaining Lease Time

Ethemnet Dynamic / 192.165.66.100 amit25613572 00-13-3B-0E-5B-1D 00:15:00

LAN Client List

Item Value setting Description
LAN Interface N/A Client record of LAN Interface. String Format.
IP Address N/A Client record of IP Address Type and the IP Address. Type is String Format and
the IP Address is IPv4 Format.
Host Name N/A Client record of Host Name. String Format.
MAC Address N/A Client record of MAC Address. MAC Address Format.
Remaining . - . .
L . N/A Client record of Remaining Lease Time. Time Format.
ease Time
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8.2.3 WiFi Status

Go to Status > Basic Network > WiFi tab.

The WIiFi Status window shows the overall statistics of WiFi VAP entries.

WiFi Virtual AP List

The WiFi Virtual AP List shows all of the virtual AP information on each WiFi module. The Edit button allows for
quick configuration changes.

= WiFi Module One Virtual AP List ° *

Op.Band ID | WiFiEnable Op. Mode SSID Channel WiFi System @ Auth.&Security MAC Address Action
246 | VAP AP Router | Staff_24G | Auto(3) | big/n Mixed | WPA2-PSK(AES) | 00:50:18:00:07:F0 [ Edit |[ QR Code |
24G Vﬁ;P- AP Router default Auto(3) | b/g/n Mixed | WPA2-PSK(AES) | 02:50:18:10:07:F0 QR Code
24G W;P- AP Router default Auto(3) | b/g/n Mixed | WPA2-PSK(AES) | 02:50:18:20:07:F0 QR Code
24G V;:P— AP Router default Auto(3) | b/g/n Mixed | WPA2-PSK(AES) | 02:50:18:30:07:F0 QR Code
24G V/ZP- AP Router default Auto(3) | b/g/n Mixed | WPA2-PSK(AES) | 02:50:18:40:07:F0 QR Code
24G VA(;P- AP Router default Auto(3) | b/g/n Mixed | WPA2-PSK(AES) | 02:50:18:50:07:F0 QR Code
24G V/;P' AP Router default Auto(3) | b/g/n Mixed | WPA2-PSK(AES) | 02:50:18:60:07:F0 QR Code
24G WZP' AP Router | Guest_2.4G | Auto(3) | b/g/n Mixed | WPA2-PSK(AES) | 02:50:18:70:07:F0 QR Code

WiFi Virtual AP List

Item \ Value setting Description

Op. Band N/A It displays the Wi-Fi Operation Band (2.4G or 5G) of VAP.

ID N/A It displays the ID of VAP.

WiFi Enable N/A It displays whether the VAP wireless signal is enabled or disabled.

Op. Mode N/A It displays the WiFi Operation Mode of VAP.

SSID N/A It displays the network ID of VAP.

Channel N/A It displays the wireless channel used.

WiFi System N/A The WiFi System of VAP.

Auth. & Security N/A It displays the authentication and encryption type used.

MAC Address N/A It displays MAC Address of VAP.
Click the Edit button to make a quick access to the WiFi configuration page. (Basic

Action N/A Network > WiFi > Configuration tab) .
The QR Code button allow you to generate QR code for quick connect to the VAP
by scanning the QR code.
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WiFi Uplink Status
The WiFi Uplink Status shows all information of connected WiFi uplink network on each WiFi module..

*! WiFi Module One Uplink Status

SSID BSSID Channel Security RSSI0 RSSI Rate | Action

Only_For_Monkey 00:00:00:00:00:00 1 WPA2-PSK(AES) 0 0 0

WiFi Module One Uplink Status

Item \ Value setting Description
SSID N/A It displays the network ID of VAP.
BSSID N/A It displays the theBSSID for the connected wireless network.
Channel N/A It displays the wireless channel used.
Security N/A It displays the authentication and encryption setting for the WiFi uplink
connection.
RSSIO, RSSI1 N/A It displays the Rx sensitivity on each radio path..
Rate N/A It displays the link rate for the WiFi uplink connection.
Action N/A Click the Edit button to make a quick access to the WiFi uplink configuration page.

(Basic Network > WAN & Uplink > Internet Setup tab)

WiFi IDS Status
The WiFi IDS Status shows all the WIDS statistics on each WiFi module.

« WiFi Module One IDS Status ’ %

Authentication Association Re-association RProbet Disassociation Deauthentication ReEAuiZst Malljigigus Action
Frame Request Frame Request Frame CANes Frame Frame a
Frame Frame Frame

0 0 0 0 0 0 0 0

WiFi IDS Status

Item Value setting Description
Authentication It displays the receiving Authentication Frame count.
N/A
Frame
Association N/A It displays the receiving Association Request Frame count.

Request Frame

Re-association N/A It displays the receiving Re-association Request Frame count.
Request Frame

Probe Request

It displays the receiving Probe Request Frame count.

Frame N/A
Disassociation It displays the receiving Disassociation Frame count.
N/A
Frame
Deauthentication N/A It displays the receiving Deauthentication Frame count.
Frame
EAP Request Frame N/A It displays the receiving EAP Request Frame count.
Malicious Data N/A It displays the number of receiving unauthorized wireless packets.
Frame
Action N/A Click the Reset button to clear the entire statistic and reset counter to 0.
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Ensure WIDS function is enabled
Go to Basic Network > WiFi > Advanced Configuration tab

Note that the WIDS of 2.4GHz or 5GHz WiFi should be configured separately.

WiFi Traffic Statistic
The WiFi Traffic Statistic shows all the received and transmitted packets on each WiFi module.

« WiFi Module One Traffic Statistics ° %
Op.Band| ID Received Packets Transmitted Packets Action
VAP-
246 | VA 269 80
VAP-
246 | VA 26 8
VAP-
VAP-
VAP-
VAP-
VAP-
WiFi Traffic Statistic
Item Value setting Description
Op. Band N/A It displays the Wi-Fi Operation Band (2.4G or 5G) of VAP.
ID N/A It displays the VAP ID.
Received Packets N/A It displays the number of reveived packets.
Transmitted Packet N/A It displays the number of transmitted packets.
Action N/A Click the Reset button to clear individual VAP statistics.
Refresh Button N/A Click the Refresh button to update the entire VAP Traffic Statistic instantly.
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8.2.4 DDNS Status

Go to Status > Basic Network > DDNS tab.

The DDNS Status window shows the current DDNS service in use, the last update status, and the last update
time to the DDNS service server.

DDNS Status

Host Name Provider Effective IP

Last Update Status Last Update Time

DDNS Status

Item Value Setting Description

Host Name N/A It displays the name you entered to identify DDNS service provider

Provider N/A It displays the DDNS server of DDNS service provider

Effective IP N/A It displays the public IP address of the device updated to the DDNS server
Last Update It displays whether the last update of the device public IP address to the

N/A

Status DDNS server has been successful (Ok) or failed (Fail).

It displays time stamp of the last update of public IP address to the DDNS
server.

Last Update Time N/A

Refresh N/A The refresh button allows user to force the display to refresh information.
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8.3 Security

. Widget
' @’ Status Firewall

- Dashboard

- Basic Network #) IPSec Tunnel Status W=t

O Security |

Firewall

- Administration Remote IP/FQDN Virtual IP/Mac Conn. Time

OpenVPN Client Name Interface Remote IP/FQDN Remote Subnet Virtual IP Conn. Time Conn. Status

- Statistics & Reports

f Basic Network f

. @ Object Definition i Master_client WAN 1 m2mcluster.de / 172.17.0.190 00:00:00:44 Connected

.@ Field Communication i

. Security "
' Administration

Remote IP Remote Virtual IP Remote Call ID Conn. Time

ID L2TP Client Name | Interface Virtual IP Remote IP/FQDN Default Gateway/Remote Subnet Conn. Time

8.3.1 VPN Status

Go to Status > Security > VPN tab.

The VPN Status widow shows the overall VPN tunnel status. The display will be refreshed on every five seconds.

IPSec Tunnel Status

IPSec Tunnel Status windows show the configuration for establishing IPSec VPN connection and current
connection status.

= IPSec Tunnel Status m ' %

Remote IP/FQDN

Tunnel Name Tunnel Scenario Local Subnets Remote Subnets Conn. Time

IPSec Tunnel Status

Item Value setting Description

Tunnel Name N/A It displays the tunnel name you have entered to identify.
Tunnel Scenario N/A It displays the Tunnel Scenario specified.

Local Subnets N/A It displays the Local Subnets specified.

Remote IP/FQDN N/A It displays the Remote IP/FQDN specified.
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Remote Subnets N/A It displays the Remote Subnets specified.
Conn. Time N/A It displays the connection time for the IPSec tunnel.

It displays the Status of the VPN connection. The status displays are
Connected, Disconnected, Wait for traffic, and Connecting.

Click on Edit Button to change IPSec setting, web-based utility will take
you to the IPSec configuration page. (Security > VPN > IPSec tab)

Status N/A

Edit Button N/A

OpenVPN Server Status

According to OpenVPN configuration, the OpenVPN Server/Client Status shows the status and statistics for the
OpenVPN connection from the server side or client side.

# OpenVPN Server Status

User Name Remote IP/FQDN Virtual IP/Mac Conn. Time Status
OpenVPN Server Status
Item Value setting Description
User Name N/A It displays the Client name you have entered for identification.
Remote N/A It displays the public IP address (the WAN IP address) of the connected
IP/FQDN OpenVPN Client
Virtual IP/MAC N/A It displays the virtual IP/MAC address assigned to the connected OpenVPN
client.
Conn. Time N/A It displays the connection time for the corresponding OpenVPN tunnel.
Status N/A It displays the connection status of the corresponding OpenVPN tunnel.
The status can be Connected, or Disconnected.

OpenVPN Client Status

= OpenVPN Client Status[[Z T [RE0

OpenVPN Client Name Interface Remote IP/FQDN Remote Subnet Virtual IP Conn. Time Conn. Status
OpenVPN Client Status
Item Value setting Description
OpenVPN Client N/A It displays the Client name you have entered for identification.
Name
Interface N/A It displays the WAN interface specified for the OpenVPN client connection.
Remote N/A It displays the peer OpenVPN Server’s Public IP address (the WAN IP address)
IP/FQDN or FQDN.
Remote Subnet N/A It displays the Remote Subnet specified.
TUN/TAP N/A It displays the TUN/TAP Read Bytes of OpenVPN Client.
Read(bytes)
TUN/TAP N/A It displays the TUN/TAP Write Bytes of OpenVPN Client.
Write(bytes)
TCP/UDP N/A It displays the TCP/UDP Read Bytes of OpenVPN Client.
Read(bytes)
TCP/UDP N/A It displays the TCP/UDP Write Bytes of OpenVPN Client.
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Write(bytes) Connection
Conn. Time N/A It displays the connection time for the corresponding OpenVPN tunnel.
Conn. Status N/A It displays the connection status of the corresponding OpenVPN tunnel.

The status can be Connected, or Disconnected.
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L2TP Server/Client Status

LT2TP Server/Client Status shows the configuration for establishing LT2TP tunnel and current connection status.

Remote Call ID

Conn. Time

Remote IP Remote Virtual IP

L2TP Server Status
Item Value setting Description
User Name N/A It displays the login name of the user used for the connection.
Remote IP N/A It displays the public IP address (the WAN IP address) of the connected
L2TP client.
Remote Virtual IP N/A It displays the IP address assigned to the connected L2TP client.
Remote Call ID N/A It displays the L2TP client Call ID.
Conn. Time N/A It displays the connection time for the L2TP tunnel.
It displays the Status of each of the L2TP client connection. The status
Status N/A . .
displays Connected, Disconnect, Connecting
Edit N/A Click on Edit Button to change L2TP server setting, web-based utility will
take you to the L2TP server page. (Security > VPN > L2TP tab)

= L2TP Client Status m a x

Virtual IP

Interface Remote IP/FQDN

L2TP Client Name Default Gateway/Remote Subnet Conn. Time Status

L2TP Client Status

Item Value setting Description

Client Name N/A It displays Name for the L2TP Client specified.

Interface N/A It displays th.e WAN inte.rface with which the gateway will use to request
PPTP tunneling connection to the PPTP server.

Virtual IP N/A It displays the IP address assigned by Virtual IP server of L2TP server.
It displ he L2TP S ’s Public IP add the WAN IP address) or

Remote IP/FQDN N/A t displays the erver’s Public IP address (the )
FQDN.

Defaul It displays the specified IP address of the gateway device used to connect

efault to the internet to connect to the L2TP server —the default gateway. Or

Gateway/Remote N/A " ) .

Subnet other specified subnet if the default gateway is not used to connect to the
L2TP server —the remote subnet.

Conn. Time N/A It displays the connection time for the L2TP tunnel.
It displays the Status of the VPN connection. The status displays

Status N/A . .
Connected, Disconnect, and Connecting.

. Click on Edit Button to change L2TP client setting, web-based utility will
Edit N/A

take you to the L2TP client page. (Security > VPN > L2TP tab)
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PPTP Server/Client Status

PPTP Server/Client Status shows the configuration for establishing PPTP tunnel and current connection status.
# PPTP Server Status m

User Name Remote IP Remote Virtual IP Remote Call ID Conn. Time Status
PPTP Server Status
Item Value setting Description
User Name N/A It displays the login name of the user used for the connection.
Remote IP N/A It dispIaTys the public IP address (the WAN IP address) of the connected
PPTP client.
Remote Virtual IP N/A It displays the IP address assigned to the connected PPTP client.
Remote Call ID N/A It displays the PPTP client Call ID.
Conn. Time N/A It displays the connection time for the PPTP tunnel.
It displays the Status of each of the PPTP client connection. The status
Status N/A ) . .
displays Connected, Disconnect, and Connecting.
. Click on Edit Button to change PPTP server setting, web-based utility will
Edit Button N/A .
take you to the PPTP server page. (Security > VPN > PPTP tab)

= PPTP Client Status m

Interface Virtual IP Remote IP/FQDN

ID PPTP Client Name Default Gateway/Remote Subnet Conn. Time | Status

PPTP Client Status

Item Value setting Description
Client Name N/A It displays Name for the PPTP Client specified.
Interface N/A It displays th.e WAN inte.rface with which the gateway will use to request
PPTP tunneling connection to the PPTP server.
Virtual IP N/A It displays the IP address assigned by Virtual IP server of PPTP server.
It displ he PPTP S ’s Public IP add the WAN IP address) or
Remote IP/FQDN N/A t displays the erver’s Public IP address (the a )
FQDN.
It displays the specified IP address of the gateway device used to connect
Default Gateway / N/A to the internet to connect to the PPTP server —the default gateway. Or
Remote Subnet other specified subnet if the default gateway is not used to connect to the
PPTP server —the remote subnet.
Conn. Time N/A It displays the connection time for the PPTP tunnel.
Status N/A It displays the. Status of the VPN conn.ection. The status displays
Connected, Disconnect, and Connecting.
. Click on Edit Button to change PPTP client setting, web-based utility will
Edit Button N/A .
take you to the PPTP server page. (Security > VPN > PPTP tab)
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8.3.2 Firewall Status

Go to Status > Security > Firewall Status Tab.
The Firewall Status provides user a quick view of the firewall status and current firewall settings. It also keeps

the log history of the dropped packets by the firewall rule policies, and includes the administrator remote login
settings specified in the Firewall Options. The display will be refreshed on every five seconds.

By clicking the icon [+], the status table will be expanded to display log history. Clicking the Edit button the
screen will be switched to the configuration page.

Packet Filter Status

Detected Contents

Activated Filter Rule

Packet Filter Status

Item Value setting Description
Activated Filter - .
Rule N/A This is the Packet Filter Rule name.
This is the logged packet information, including the source IP, destination IP,
Detected N/A protocol, and destination port —the TCP or UDP.
Contents String format:
Source IP to Destination IP : Destination Protocol (TCP or UDP)
IP N/A The Source IP (IPv4) of the logged packet.

The Date and Time stamp of the logged packet. Date & time format. ("Month"
"Day" "Hours":"Minutes":"Seconds")

Note: Ensure Packet Filter Log Alert is enabled.

Refer to Security > Firewall > Packet Filter tab. Check Log Alert and save the setting.

Time N/A

URL Blocking Status

Activated Blocking Rule Blocked URL IP Time
URL Blocking Status
Item Value setting Description
Activated - .
Blocking Rule N/A This is the URL Blocking Rule name.
Blocked URL N/A This is the logged packet information.
IP N/A The Source IP (IPv4) of the logged packet.
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Time N/A The Date and Time stamp of the logged packet. Date & time format. ("Month"
"Day" "Hours":"Minutes":"Seconds")

Note: Ensure URL Blocking Log Alert is enabled.
Refer to Security > Firewall > URL Blocking tab. Check Log Alert and save the setting.

Web Content Filter Status

= Web Content Filters m

Activated Filter Rule Detected Contents IP Time

Web Content Filter Status

Item Value setting Description

Activated Filter .

Rule N/A Logged packet of the rule name. String format.

Detected ) .

Contents N/A Logged packet of the filter rule. String format.

IP N/A Logged packet of the Source IP. IPv4 format.

Time N/A Logged pacl'<et of the Date Time. Date time format ("Month" "Day"
"Hours":"Minutes":"Seconds")

Note: Ensure Web Content Filter Log Alert is enabled.
Refer to Security > Firewall > Web Content Filter tab. Check Log Alert and save the setting.

MAC Control Status

Activated Control Rule Blocked MAC Addresses

MAC Control Status

Item Value setting Description
Activated -
N/A This is the MAC Control Rule name.
Control Rule
Blocked MAC .
Addresses N/A This is the MAC address of the logged packet.
P N/A The Source IP (IPv4) of the logged packet.
Time N/A The Date and Time stamp of the logged packet. Date & time format. ("Month"
"Day" "Hours":"Minutes":"Seconds")

Note: Ensure MAC Control Log Alert is enabled.
Refer to Security > Firewall > MAC Control tab. Check Log Alert and save the setting.
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Application Filters Status

*| Application Filters

Filtered Application Category Filtered Application Name

Application Filters Status

Item Value setting Description
Filtered Application s .
Category N/A The name of the Application Category being blocked.
Filtered Application
NI PP N/A The name of the Application being blocked.
ame
IP N/A The Source IP (IPv4) of the logged packet.
Time N/A The Date and Time stamp of the logged packet. Date & time format. ("Month"
"Day" "Hours":"Minutes":"Seconds")

Note: Ensure Application Filter Log Alert is enabled.
Refer to Security > Firewall > Application Filter tab. Check Log Alert and save the setting.

IPS Status

Detected Intrusion

IPS Firewall Status

Item Value setting Description

Detected . . . .

Intrusion N/A This is the intrusion type of the packets being blocked.
IP N/A The Source IP (IPv4) of the logged packet.

The Date and Time stamp of the logged packet. Date & time format. ("Month"
"Day" "Hours":"Minutes":"Seconds")

Time N/A

Note: Ensure IPS Log Alert is enabled.
Refer to Security > Firewall > IPS tab. Check Log Alert and save the setting.
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Firewall Options Status

# Options

Stealth Mode SPI

Discard Ping from WAN

Remote Administrator Management

Disable Disable

Disable

IP: 192.168.121.54, User Name: admin, Time: Apr 1 11:14:54

Firewall Options Status

Item

Value setting

Description
Enable or Disable setting status of Stealth Mode on Firewall Options.

Stealth Mode N/A ] )

String Format: Disable or Enable
SPI N/A Enable or Disable setting status of SPI on Firewall Options.

String Format : Disable or Enable

Enable or Disable setting status of Discard Ping from WAN on Firewall
Discard Ping from N/A Options.
WAN

String Format: Disable or Enable

Enable or Disable setting status of Remote Administrator.

If Remote Administrator is enabled, it shows the currently logged in
Remote administrator’s source IP address and login user name and the login time.
Administrator N/A Format:
Management IP : "Source IP", User Name: "Login User Name", Time: "Date time"

Example:
IP: 192.168.127.39, User Name: admin, Time: Mar 3 01:34:13

Note: Ensure Firewall Options Log Alert is enabled.
Refer to Security > Firewall > Options tab. Check Log Alert and save the setting.
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8.4 Administration

8.4.1 Configure & Manage Status

Go to Status > Administration > Configure & Manage tab.

The Configure & Manage Status window shows the status for managing remote network devices. The type of
management available in your device is depended on the device model purchased. The commonly used ones
are the SNMP, TR-069, and UPnP. The display will be refreshed on every five seconds.

SNMP Linking Status

SNMP Link Status screen shows the status of current active SNMP connections.
# SNMP Linking Status

User Name IP Address Community Auth. Mode Privacy Mode SNMP Version

SNMP Link Status

Item Value setting Description

It displays the user name for authentication. This is only available for SNMP
User Name N/A .
version 3.
IP Address N/A It displays the IP address of SNMP manager.
It displays the port number used to maintain connection with the SNMP
Port N/A
manager.
Community N/A It displays the community for SNMP version 1 or version 2c only.
Auth. Mode N/A It displays the authentication method for SNMP version 3 only.
Privacy Mode N/A It displays the privacy mode for version 3 only.
SNMP Version N/A It displays the SNMP Version employed.

SNMP Trap Information

SNMP Trap Information screen shows the status of current received SNMP traps.
#] SNMP Trap Information

Trap Level Trap Event

SNMP Trap Information

Item Value setting Description

Trap Level N/A It displays the trap level.

Time N/A It displays the timestamp of trap event.

Trap Event N/A It displays the IP address of the trap sender and event type.
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TR-069 Status

TR-069 Status screen shows the current connection status with the TR-068 server.

* TR-069 Status

Link Status

Off

TR-069 Status
Item

Link Status

Value setting

N/A

Description

It displays the current connection status with the TR-068 server. The
connection status is either On when the device is connected with the TR-068
server or Off when disconnected.
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8.4.2 Log Storage Status

Go to Status > Administration > Log Storage tab.

The Log Storage Status screen shows the status for selected device storage.

Log Storage Status

Log Storage Status screen shows the status of current the selected device storage. The status includes Device
Description, Usage, File System, Speed, and status.

Device Description File System
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8.5 Statistics & Report

8.5.1 Connection Session

Go to Status > Statistics & Reports > Connection Session tab.

Internet Surfing Statistic shows the connection tracks on this router.

# Connection Session List (2 entries)

User Name

Protocol

Internal IP & Port

Export (.xml) || Export (.csv)

MAC NAT-host IP & Port| External IP & Port

Duration Time

TCP

192.168.123.173:51464

192.168.123.254:80

2020/10/29 03:57~

UDP

192.168.123.173:68

192.168.123.254.67

2020/10/29 03:57~

Internet Surfing Statistic

Item Value setting Description

Previous N/A Click the Previous button; you will see the previous page of track list.
Next N/A Click the Next button; you will see the next page of track list.

First N/A Click the First button; you will see the first page of track list.

Last N/A Click the Last button; you will see the last page of track list.

Export (.xml) N/A Click the Export (.xml) button to export the list to xml file.

Export (.csv) N/A Click the Export (.csv) button to export the list to csv file.

Refresh N/A Click the Refresh button to refresh the list.
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8.5.2 Network Traffic

Go to Status > Statistics & Reports > Network Traffic tab.

Network Traffic Statistics screen shows the historical graph for the selected network interface.

You can change the interface drop list and select the interface and sampling time interval you want to monitor.

WAN v seconds ¥ || \wWAN1 v
5Mb
WAN 1 Inbound
Il WAN 1 Outbound
4Mb
3Mb
2Mb
1.9Mb
1.4Mb
1Mb
0.5Mb
OMb
12:11:00 12:11:10 12:11:20 12:11:30 12:11:40 12:11:50 12:10
. 11.6 Kbits/sec . 14 .8 Kbits/sec . 357.3 Kbits/sec
Ll (1.4 KBytes/sec) Average: (1.9 KBytes/sec) Peak (44 .7 KBytes/sec)
» WAN 1
. 16.4 Kbits/sec . 51 Kbits/sec . 24317 Kbits/sec
QutBound: ) Kpytes/sec) Average: g 4'Kpytesisec) Peak’ (304 0 KBytes/sec)
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8.5.3 Login Statistics

Go to Status > Statistics & Reports > Login Statistics

Login Statistics shows the login information.

* Device Manager Login Stafistics By G\ CICH B8 WS Export (.xml) || Export (.csv)

User Name Protocol Type IP Address Info Duration Time
admin HTTP 192.168.123.190 Admin 2018/01/01 00:00~
admin HTTP 192.168.123.190 Admin 2018/01/01 00:02~
admin HTTP 192.168.123.190 Login Fail 2019/06/05 16:30~
admin HTTP 192.168.123.190 Admin 2019/06/05 16:30~

Device Manager Login Statistic

Item Value setting Description

Previous N/A Click the Previous button; you will see the previous page of login statistics.
Next N/A Click the Next button; you will see the next page of login statistics.

First N/A Click the First button; you will see the first page of login statistics.

Last N/A Click the Last button; you will see the last page of login statistics.

Export (.xml) N/A Click the Export (.xml) button to export the login statistics to xml file.
Export (.csv) N/A Click the Export (.csv) button to export the login statistics to csv file.
Refresh N/A Click the Refresh button to refresh the login statistics.
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8.5.4 Cellular Usage

Go to Status > Statistics & Reports > Cellular Usage tab.

Cellular Usage screen shows data usage statistics for the selected cellular interface. The cellular data usage can
be accumulated per hour or per day.

Data Usage Records

Cellular-1 v| [SIMA v
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Appendix A GPL WRITTEN OFFER

This product incorporates open source software components covered by the terms of third party copyright
notices and license agreements contained below.

GPSBabel

Version 1.4.4

Copyright (C) 2002-2005 Robert Lipe<robertlipe@usa.net>
GPL License: https:/www.gpsbabel.org/

Curl

Version 7.19.6

Copyright (c) 1996-2009, Daniel Stenberg, <daniel@haxx.se>.
MIT/X derivate License: https:/curl.haxx.se/

OpenSSL

Version 1.0.2m

Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
GPL License: https:/www.openssl.org/

brctl - ethernet bridge administration

Stephen Hemminger <shemminger@osdl.org>

Lennert Buytenhek <buytenh@gnu.org>

version 1.1

GNU GENERAL PUBLIC LICENSE Version 2, June 1991

tc - show / manipulate traffic control settings

Stephen Hemminger<shemminger@osdl.org>

Alexey Kuznetsov<kuznet@ms2.inr.ac.ru>

version iproute2-ss050330

GNU GENERAL PUBLIC LICENSE Version 2, June 1991

dhcp-fwd — starts the DHCP forwarding agent

Enrico Scholz <enrico.scholz@informatik.tu-chemnitz.de>
version 0.7

GNU GENERAL PUBLIC LICENSE Version 2, June 1991

Iftp - Sophisticated file transfer program

Alexander V. Lukyanov <lav@yars.free.net>

version:4.5.x

Copyright (c) 1996-2014 by Alexander V. Lukyanov (lav@yars.free.net)

dnsmasq - A lightweight DHCP and caching DNS server.
Simon Kelley <simon@thekelleys.org.uk>
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version:2.72
dnsmasq is Copyright (c) 2000-2014 Simon Kelley

socat - Multipurpose relay

Version: 2.0.0-b8

GPLv2
http:/www.dest-unreach.org/socat/

LibModbus

Version: 3.0.3

LGPL v2
http:/libmodbus.org/news/

LibIEC60870

GPLv2

Copyright (C) 1989, 1991 Free Software Foundation, Inc. 59 Temple Place, Suite 330, Boston,
MA 02111-1307 USA

https:/sourceforge.net/projects/mrts/

Openswan

Version: v2.6.38 GNU GENERAL PUBLIC LICENSE Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc. 59 Temple Place, Suite 330, Boston,
MA 02111-1307 USA

Everyone is permitted to copy and distribute verbatim copies

of this license document, but changing it is not allowed.

https:/www.openswan.org/

Opennhrp

Version: v0.14.1

OpenNHRP is an NHRP implementation for Linux. It has most of the RFC2332
and Cisco |I0S extensions.

Project homepage: http:/sourceforge.net/projects/opennhrp

Git repository: git:/opennhrp.git.sourceforge.net/gitroot/opennhrp
LICENSE

OpenNHRP is licensed under the MIT License. See MIT-LICENSE.txt for
additional details.

OpenNHRP embeds libev. libev is dual licensed with 2-clause BSD and
GPLv2+ licenses. See libev/LICENSE for additional details.

OpenNHRP links to c-ares. c-ares is licensed under the MIT License.
https:/sourceforge.net/projects/opennhrp/

IPSec-tools

Version: v0.8

No GPL be written
http:/ipsec-tools.sourceforge.net/
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PPTP

Version: pptp-1.7.1

GNU GENERAL PUBLIC LICENSE Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc. 675 Mass Ave, Cambridge, MA 02139, USA
Everyone is permitted to copy and distribute verbatim copies

of this license document, but changing it is not allowed.

http:/pptpclient.sourceforge.net/

PPTPServ

Version: 1.3.4

GNU GENERAL PUBLIC LICENSE Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc. 675 Mass Ave, Cambridge, MA 02139, USA
Everyone is permitted to copy and distribute verbatim copies

of this license document, but changing it is not allowed. http:/poptop.sourceforge.net/

L2TP

Version: 0.4

Copying All software included in this package is Copyright 2002 Roaring
Penguin Software Inc. You may distribute it under the terms of the
GNU General Public License (the "GPL"), Version 2, or (at your option)
any later version.

http:/www.roaringpenguin.com/

L2TPServ

Version: v 1.3.1 GNU GENERAL PUBLIC LICENSEVersion 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc.59 Temple Place, Suite 330, Boston,
MA 02111-1307 USA

Everyone is permitted to copy and distribute verbatim copies

of this license document, but changing it is not allowed.
http:/www.xelerance.com/software/xI2tpd/

Mpstat: from sysstat, system performance tools for Linux
Version: 10.1.6
Copyright: (C) 1999-2013 by Sebastien Godard (sysstat <at> orange.fr)

SSHD: dropbear, a SSH2 server
Version: 0.53.1
Copyright: (c) 2002-2008 Matt Johnston

Libncurses: The ncurses (new curses) library is a free software emulation of curses in System V Release
4.0 (SVr4), and more.
Version: 5.9
Copyright: (c) 1998,2000,2004,2005,2006,2008,2011,2015 Free Software Foundation, Inc., 51
Franklin Street, Boston, MA 02110-1301, USA
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MiniUPnP: The miniUPnP daemon is an UPnP IGD (internet gateway device) which provide NAT
traversal services to any UPnP enabled client on the network.

Version: 1.7

Copyright: (c) 2006-2011, Thomas BERNARD

CoovaChilli is an open-source software access controller for captive portal (UAM) and 802.1X access
provisioning.

Version: 1.3.0

Copyright: (C) 2007-2012 David Bird (Coova Technologies) <support@coova.com>

Krb5: Kerberos is a network authentication protocol. It is designed to provide strong authentication for
client/server applications by using secret-key cryptography.

Version: 1.11.3

Copyright: (C) 1985-2013 by the Massachusetts Institute of Technology and its contributors

OpenLDAP: a suite of the Lightweight Directory Access Protocol (v3) servers, clients, utilities, and
development tools.

Version: 2.4

Copyright: 1998-2014 The OpenLDAP Foundation

Samba3311: the free SMB and CIFS client and server for UNIX and other operating systems
Version: 3.3.11
Copyright: (C) 2007 Free Software Foundation, Inc. <http:/fsf.org/>

NTPClient: an NTP (RFC-1305, RFC-4330) client for unix-alike computers
Version: 2007 _365
Copyright: 1997, 1999, 2000, 2003, 2006, 2007 Larry Doolittle

exFAT: FUSE-based exFAT implementation
Version: 0.9.8
Copyright: (C) 2010-2012 Andrew Nayenko

ONTFS_3G: The NTFS-3G driver is an open source, freely available read/write NTFS driver for Linux,
FreeBSD, Mac OS X, NetBSD, Solaris and Haiku.

Version: 2009.4.4

Copyright: (C) 1989, 1991 Free Software Foundation, Inc., 51 Franklin Street, Fifth Floor, Boston, MA
02110-1301 USA

mysql-5_1_72: a release of MySQL, a dual-license SQL database server
Version: 5.1.72
Copyright: (c) 2000, 2013, Oracle and/or its affiliates
FreeRadius: a high performance and highly configurable RADIUS server
Version: 2.1.12
Copyright: (C) 1999-2011 The FreeRADIUS server project and contributors
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Linux IPvé Router Advertisement Daemon - radvd

Version: V 1.15

Copyright (c) 1996,1997 by Lars Fenneberg<If@elemental.net>
BSD License: http:/www.litech.org/radvd/

WIDE-DHCPv6

Dynamic Host Configuration Protocol for IPvé (DHCPvé) clients, servers, and relay agents.

Version: 20080615
Copyright (C) 1998-2004 WIDE Project.
BSD License: https:/sourceforge.net/projects/wide-dhcpvé/

Python version 2.7.12

This Python distribution contains no GNU General Public Licensed
(GPLed) code so it may be used in proprietary projects just like prior
Python distributions. There are interfaces to some GNU code but these
are entirely optional

OpenPAM Radula

This software was developed for the FreeBSD Project by ThinkSec AS and
Network Associates Laboratories, the Security Research Division of

Network Associates, Inc. under DARPA/SPAWAR contract N66001-01-C-8035
("CBOSS"), as part of the DARPA CHATS research program.

ISC DHCP Version 4.3.5
Copyright (c) 2004-2016 by Internet Systems Consortium, Inc. ("ISC")
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